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Chapter 

 

1

 

: Basic Concepts

 

his chapter contains a short tutorial designed to familiarize you with the basic 
concepts of making movies with the Adobe Premiere

 



 

 program. For information 
on installing and configuring the program, see the 

 

Getting Started

 

 booklet 

 

accompanying this guide. For information on basic Macintosh

 



 

 features, see your 
Macintosh documentation.

Adobe Premiere is powerful video and audio-editing software designed to be a useful tool 
for the professional and novice alike. Adobe Premiere provides a comfortable and familiar 
working environment for those with both film and video experience. Those with no video 
experience will find the software to be a thorough introduction to the world of desktop 
video. Video and multimedia professionals will find Adobe Premiere a valuable tool for 
tasks such as video editing (both online and off-line) or creating QuickTime

 



 

 movies for 
presentations and CD-ROMs. Many of the program’s features were previously available 
only on high-end professional video-editing systems. 

In many instances, you will encounter terminology and interface designs drawn from 
traditional video production and post-production. For information on the fundamentals 
of video and audio, see Appendix A, “Video Basics.” 

 

Note:

 

 In this manual, commands in submenus are indicated by a preceding slash. For 
example, the instruction: “Choose Import/Project from the File menu,” means that you should 
choose Import from the File menu and Project from the submenu.

 

CREATING DESKTOP VIDEO WITH ADOBE PREMIERE

 

Adobe Premiere lets you combine source material, or 

 

clips

 

, to make a movie, and then view 
and play the movie using any application that supports the QuickTime

 



 

 movie format. 
Your final Adobe Premiere movie is a file you create after assembling and editing clips.

Clips can include the following:

 

O

 

Digitized video captured from cameras, VCRs, or tape decks

 

O

 

QuickTime movies made using Adobe Premiere or other sources

 

O

 

Animations

 

T
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O

 

Scanned images or slides

 

O

 

Digital audio recordings and synthesized music and sound

 

O

 

Adobe Illustrator

 



 

 files

 

O

 

Adobe Photoshop

 



 

 files

 

O

 

FilmStrip format files created in Adobe Premiere and edited in Adobe Photoshop

 

O

 

Titles

 

O

 

Backdrops

You can create your own video and audio clips by recording material to your Macintosh 
hard disk using a variety of hardware products. For more information on recording to 
your hard disk, see Chapter 9, “Capturing Video.” 

 

CREATING AN ADOBE PREMIERE MOVIE: A TUTORIAL

 

Every Adobe Premiere movie starts as a 

 

project

 

—a collection of clips organized along a 
timeline. This section provides step-by-step instructions for building a simple Adobe 
Premiere movie using clips supplied on your program disks. 

Creating an Adobe Premiere movie involves the following basic tasks: 

 

O

 

Starting a new project and importing clips

 

O

 

Assembling clips in the Construction window

 

O

 

Viewing and editing clips in the Clip window

 

O

 

Applying transitions and filters to the assembled clips

 

O

 

Adding a superimposed title to the movie

 

O

 

Previewing the movie

 

O

 

Compiling the assembled clips into a movie and playing it 

 

Note:

 

 The steps for making a movie vary depending on the intended use of the medium. If your 
goal is to make a videotape with full-frame images, you must understand the capabilities and 
limitations of your hardware. For information on hardware requirements, see Chapter 8, 
“Compiling and Videotaping Movies,” and Chapter 9, “Capturing Video.”
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Create a new project and import clips

 

Before you start this tutorial, make sure that you have installed the sample clips included 
with the program in your Adobe Premiere folder on your hard drive.

 

1

 

Double-click the Adobe Premiere program icon to start the program. When you start 
the program, the New Project Presets dialog box appears. 

Every new Adobe Premiere project must be assigned a 

 

preset

 

. A preset specifies the project 
time base, the movie frame rate, and options for compression, previewing, and output. 
Project presets are described in detail in Chapter 2. For now, choose Presentation 
(160 x 120) from the Available Presets list and click OK.

 

2

 

After you choose a preset, six windows appear:

 

O

 

Project window, for importing and storing clips

 

O

 

Construction window, for assembling clips

 

O

 

Info window, for displaying detailed information about clips

 

O

 

Transitions window, for selecting special effects transitions between clips

 

O

 

Preview window, for previewing the movie as you assemble it in the 
Construction window

 

O

 

Commands palette, for quick access to frequently used commands
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When the program opens, the Project window is the active window. You use the Project 
window to stockpile clips for your movie. 

 

3

 

Choose Import/File from the File menu. The Import dialog box appears. In the Adobe 
Premiere folder, locate the sample movie clips supplied with the program. 

 

4

 

Choose 

 

Spotlight

 

, and click Import. The clip name and a thumbnail of the first frame of 
the clip appear in the Project window. For a movie clip, the thumbnail displays an approx-
imation of the first frame in the clip.
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5

 

To import additional clips, choose Import/Multiple from the File menu. The Import 
dialog box appears. In the Adobe Premiere folder, locate the sample movie clips supplied 
with the program.

 

6

 

Choose 

 

Twirl

 

, and click Import. The 

 

Twirl

 

 clip is imported, and the Import dialog box 
remains open.

 

7

 

Use the same procedure to import the video clip

 

 Overhead spin

 

, the title clip 

 

Circus.title

 

, 
and the audio clip 

 

Circus audio. 

 

When you have imported these clips, click Done.

 

Assemble clips in the Construction window

 

You use the Construction window to assemble clips into a movie. The Construction 
window contains multiple tracks for placing video and audio clips. The video tracks 
include the main video tracks A and B, the T track for transitions, and the S track(s) for 
superimposed video clips. The lower set of tracks is for audio clips. Tracks are identified 
in the vertical bar at the right of the window.

At the top of the Construction window is a 

 

time ruler

 

 that indicates elapsed time in the 
movie. The tick marks on the ruler can represent anything from a single frame to a 
2-minute interval, depending on the time unit selected. You can use the slider at the 
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bottom of the Construction window to change the time unit, thereby changing the level 
of detail displayed in the window; a smaller time unit causes more 

 

thumbnails

 

 (frames in 
the clip) to be displayed. 

 

1

 

Position the pointer over the thumbnail of the 

 

Spotlight

 

 clip in the Project window; the 
pointer changes to a hand. Hold down the mouse button, and drag the clip onto the top 
track (track A) of the Construction window. The track turns dark gray to show where the 
clip will be placed. 

 

Video track B

Play button

Time ruler

Video track A

Transition track

Superimpose

track

Audio track A

Audio track B

Current time unit

Time unit selector

Tools palette

Work area bar
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2

 

Drag to align the left edge of the clip with the left edge of the Construction window. 
Release the mouse button to place the clip.

When you place a clip in the Construction window, it is displayed as a series of thumbnails 
that represent frames of the clip. The width of the strip of thumbnails represents the dura-
tion of the clip. You can move clips in the Construction window simply by dragging them. 

 

3

 

Drag the 

 

Twirl

 

 clip from the Project window onto track A so that the left edge of the clip 
butts up against the right edge of the 

 

Spotlight

 

 clip. 

Positioning the two clips like this creates a 

 

cut

 

, or transition, from the 

 

Spotlight

 

 clip to the 

 

Twirl

 

 clip.

 

Preview the movie

 

You can preview the movie at any time to view the results of your work in the Construction 
window. 
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1

 

Place the pointer in the time ruler at the top of the Construction window; the pointer 
changes to a downward-pointing arrow. 

 

2

 

Hold down the mouse button. The Preview displays the movie frame that corresponds 
to the current location in the time ruler. 

 

Note:

 

 If the pointer is not positioned correctly, the Controller window may appear when 
you hold down the mouse button. If this happens, simply close the Controller window and 
try again.

 

3

 

To see a preview of the movie play in the Preview window, drag to the right while 
holding down the mouse button. Note that when the first clip ends, the second clip begins 
playing.

 

Change the duration of a clip

 

After previewing, you may decide that you don’t need to include an entire clip in your 
movie. You can use the Clip window to view a clip and choose which frames you want to 
include in the Construction window. The frames that are included are defined by the clip’s 

 

in point

 

 and 

 

out point

 

. The process of changing these points is called 

 

trimming

 

 the clip. 
Changes made to a clip in the Clip window are automatically applied to the clip in the 
Construction window.

Cursor position

in the time ruler
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1

 

Double-click a thumbnail of the 

 

Twirl

 

 clip in the Construction window. 

The Clip window opens with the starting frame of the 

 

Twirl

 

 clip. Notice that an in point 
indicator appears in the upper left corner of the window.

Controls for viewing and playing the clip are located in the lower portion of the window. 
The frame indicator in the center displays the address of the current frame in the Society 
of Motion Picture and Television Engineers (SMPTE) timecode format (Hours:Minutes:-
Seconds:Frames). Below the frame indicator, the duration of the clip is displayed using the 
same format. (For more information on timecode, see “SMPTE Timecode” on page 298.)

 

2

 

Click the play button to play the clip in the Clip window. You can also drag the slider 
control or the jog control to view the clip as it plays in the forward or reverse direction.

 

3

 

Drag the slider bar (located to the left of the play button) back to rewind the clip until 
00:00:02:17 appears in the frame indicator. The displayed frame will be the new out point 
for the clip. For more precision in locating the frame, drag the jog control above the slider 
bar, or use the Frame Forward and Frame Backward buttons.

Play button

Stop button

Jog control

Frame forward

and backward

In point 

indicator

Play In/Out button

Loop button

Clip duration

Slider bar Clip duration
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4

 

Set the new out point by clicking the Out button in the lower right corner of the window.

An out point marker appears in the upper right corner of the window. The clip is short-
ened in the Construction window accordingly. 

To keep the screen from becoming too cluttered, close the Clip window when you have 
finished adjusting the clip duration. 

 

Note:

 

 You can also drag the edges of a clip in the Construction window to change its in and 
out points. For more information on setting in and out points, see “Trimming Clips” 
on page 79.

 

Trim clips at the cut point

 

The most accurate way to change the in points and out points of clips while getting instant 
feedback on the effect in the Construction window is to use the Trimming window. The 
Trimming window lets you simultaneously change the in points and out points of the clips 
on both sides of a cut. 

Out button
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1

 

Click the right arrow under the Construction window’s play button to move the edit line 
to the cut between the 

 

Spotlight

 

 clip and the 

 

Twirl

 

 clip.

 

2

 

Choose Trimming from the Window menu. 

The Trimming window appears, displaying the frames on the left and right sides of the cut: 
the out point of the 

 

Spotlight

 

 clip and the in point of the 

 

Twirl

 

 clip, respectively.

In this case, the out point of the 

 

Spotlight

 

 clip is also the last frame of the source clip, as 
indicated by the red page peel icon in the corner of the clip. Likewise, the in point of the 

 

Twirl

 

 clip is also the first frame of that source clip.

 

3

 

Click –1 under the left clip (

 

Spotlight

 

) three times to subtract three frames from the out 
point of that clip. 

Edit line

Edit line right button

Page peel icons

Collapse preview button

Edit line left 

and right buttons

Play button Add and subtract

frames
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Notice that the edit line moves to the left in the Construction window as the out point 
changes, and the clip to the right of the edit point (

 

Twirl

 

) shifts left. The total number of 
frames subtracted from the out point appear at the bottom of the Trimming window.

When you trim clips in the Trimming window, clips and transitions on other tracks shift 
right or left in order to maintain their positions relative to the clip being trimmed. You can 
lock individual tracks to keep their contents from shifting during editing. For information 
on track locking, see “Locking Tracks in the Construction Window” on page 97.

 

4

 

Click –5 under the right clip (

 

Twirl

 

) to subtract five frames from the in point of that clip. 
Notice that the 

 

Twirl

 

 clip shortens in the Construction window. Now click +1 to add back 
one frame to the in point.

 

5

 

Click the Play button to preview the edits in the Trimming window. The window plays 
the five seconds of the clip that surround the edit point. (You can set a different number 
of seconds to include in the Preview as one of the Trimming window options.)

 

6

 

Close the Trimming window.

 

Add a transition 

 

You can create gradual transitions between clips. However, clips must be located on 
separate video tracks A and B to apply a transition between them. 

 

1

 

Make the Construction window active by clicking in the window or by choosing 
Construction from the Windows menu.

Total number of frames subtracted
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2

 

Drag the 

 

Twirl

 

 clip from track A to track B and position it so that the clip overlaps 
approximately one inch (slightly less than one second on the time ruler) with the 

 

Spotlight

 

 
clip on track A. The amount of overlap determines the length of the transition.

 

3

 

In the Transitions window, scroll to the Cross Dissolve transition. (You can also type the 
first letter of a transition to scroll to that transition.)

 

4

 

Click and drag the transition onto the T track between the two movie clips. As you drag 
the transition onto the space where the two movie clips overlap, the program automati-
cally adjusts the length of the transition to fit the overlapping section.

 

5

 

Preview your movie again by holding down the mouse button and dragging the arrow 
through the time ruler. Notice how the 

 

Spotlight

 

 clip gradually fades out while the 

 

Twirl

 

 
clip fades in.
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Add a third clip and another transition

 

1

 

Drag the 

 

Overhead

 

 

 

spin

 

 clip from the Project window onto track A and position it so it 
overlaps the clip on track B by approximately one second on the time ruler.

 

2

 

In the Transitions window, scroll to the Iris Round transition. 

 

3

 

Drag the transition onto the T track between the 

 

Twirl

 

 clip on track B and the 

 

Overhead 
spin

 

 clip on track A.

In most situations, Adobe Premiere automatically sets the correct direction of a transition 
when it is placed between clips in the Construction window. In this case, a circular wipe 
should reveal the image on track A as it replaces the image on track B.
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4

 

To check the direction of the Iris Round transition, double-click the transition in the 
Construction window. The Iris Round Settings dialog box appears. 

The animated display in the lower right corner of the dialog box should indicate that 
image A is wiping over image B. If this is not the case, click the blue arrow to the left of the 
display so that the arrow is pointing upward.

 

5

 

Click OK.

 

Change the time unit in the Construction window

 

At this point, your movie is approximately 8 seconds long. Depending on the size of the 
Construction window on your monitor, the entire movie may not be visible. To see more 
frames of your movie in the Construction window, change the time unit. The time unit is 
currently set to 1 second, which means that the Construction window displays 1 thumb-
nail for each second of a clip.

Animated display
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Drag the slider at the bottom of the Construction window to the right one notch. The time 
unit changes to 2 seconds, which means that the Construction window now shows 2 
thumbnails for every 2 seconds of a clip. Consequently, you can see more of the movie in 
the Construction window.

To quickly see the entire movie in the Construction window, no matter how long the 
movie is, you can press the backslash key (\) while the Construction window is active. The 
time unit selector adjusts accordingly.

 

Apply a filter to a clip

 

You can apply filters to clips to change their appearance or sound. Adobe Premiere 
includes more than 40 movie and still-image filters and five audio filters. 

 

1

 

Click the 

 

Twirl

 

 clip on track B to select it; a dashed line appears around the border of 
the clip.

 

2

 

Choose Filters from the Clip menu. The Filters dialog box appears.

Time unit selector
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3

 

Scroll through the Available list and select the Hue & Saturation filter. 

 

4

 

Click Add. The Hue & Saturation Settings dialog box appears.

 

5

 

Drag the Hue slider to change the color of the clip. 

 

6

 

Drag the Lightness slider to lighten the clip. 

 

7

 

Click OK when you have finished.

 

Apply another filter to the same clip

 

You can add multiple filters to a clip. Adobe Premiere applies the filters in the order that 
you list them in the Current list in the Filters dialog box.
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1

 

Select the Crop filter from the Available list; then click Add. The Crop Settings dialog 
box appears. 

The dialog box contains a preview image from the clip and slider controls for trimming 
unwanted pixels from the edges of the clip. It also contains a zoom tool and a hand tool 
for observing the effects of a filter more clearly. Note that the preview of the clip shows the 
effects of the Hue & Saturation filter.

 

2

 

Click the zoom tool and position it in the lower left corner of the preview image.

 

3

 

Click twice to magnify the preview image by two levels. 

Note the dark border along the bottom and left edges of the clip. You can eliminate these 
borders by cropping the edges.

 

4

 

Drag the Bottom slider to the right until it reads 1 (pixel). Do the same with the Left 
slider. This crops the image by 1 pixel on the bottom and left sides. (Adobe Premiere auto-
matically resizes the clip to its original size after it is cropped.)

 

5

 

Double-click the hand tool to return the display to the entire preview image.

Zoom tool
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6

 

Click OK to close the Crop Settings dialog box; then click OK to close the Filters dialog 
box.

The program adds a blue line at the top of the clip in the Construction window to indicate 
that one or more filters have been applied.

 

Use the Preview command to preview the transitions and filter effects

 

The Preview command provides a more accurate way to preview than dragging through 
the time ruler. You specify which part of the Construction window is previewed by posi-
tioning the yellow bar at the top of the window. All clips, transitions, and filter effects 
located beneath the yellow work area bar are previewed when you choose the Preview 
command.

 

1

 

Before previewing the movie, save the project by choosing Save from the File menu and 
typing a name for the project. (You cannot preview an unsaved project.)

 

2

 

Position the pointer over the red triangle at the right edge of the yellow bar. If the bar is 
not visible, double-click the gray bar above the time ruler at the top of the Construction 
window.

 

3

 

Click and drag to the right until the right edge of the yellow bar aligns with the right 
edge of the 

 

Overhead

 

 

 

spin 

 

clip on track A.

Work area bar
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4

 

Choose Preview from the Project menu, or press Return. 

Adobe Premiere displays the Building Preview dialog box and gives a time estimate for 
compiling the preview. After a few moments, the preview plays in the Preview window, 
showing the 

 

Spotlight

 

 clip, the 

 

Twirl

 

 clip with the filters applied, and the two transitions. 
Press Return to see the preview again. This time, you don’t have to wait for the preview to 
build.

 

Add a superimposed title to the S1 track

 

Adobe Premiere treats titles as clips. They are usually added to a superimpose (S) track so 
that they can be superimposed, or 

 

keyed

 

, over a movie clip. The duration of a title clip can 
be changed by choosing Duration from the Clip window or by dragging the edges of the 
clip in the Construction window.

 

1

 

Drag the 

 

Circus.title

 

 clip from the Project window onto track S1 so that the left edge of 
the clip aligns with the beginning of the track.

 

2

 

Position the pointer over the right edge of the 

 

Circus.title 

 

clip. The pointer changes into 
a stretch pointer.

Stretch pointer
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3

 

Drag the edge of the clip until it aligns with the left edge of the 

 

Twirl

 

 clip on track B. This 
extends the duration of the title clip to approximately 2 seconds.

 

4

 

With the 

 

Circus.title

 

 clip selected in the Construction window, choose Transparency 
from the Clip menu. The Transparency Settings dialog box appears.

 

5

 

To key the title against the background image of the 

 

Spotlight

 

 clip, choose White Alpha 
Matte from the Key Type pop-up menu. Adobe Premiere uses the title’s existing alpha 
channel to create a mask for superimposition. For more information on working with 
superimpositions, see “Superimposing Clips” on page 179.
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6

 

To see a preview of the title over the actual background image, click the page peel icon 
under the Sample box.

The title is shown superimposed over the first frame of the 

 

Spotlight

 

 clip. 

 

7

 

Click OK.

 

Note:

 

 The 

 

Circus.title

 

 clip was created with the Adobe Premiere Titler. For information on 
using the Titler, see “Creating Titles” on page 193.

 

Add sound to the movie

 

You add sound to a movie by dragging audio clips onto the audio tracks in the Construc-
tion window.

 

1

 

Drag the thumbnail of the 

 

Circus audio

 

 clip from the Project window onto audio track 
A in the lower half of the Construction window. 

 

2

 

Align the left edge of the audio clip with the left edge of the Construction window.

 

3

 

To preview your movie with sound, adjust the yellow work area bar to select the part of 
the movie you want to preview and press Return.

Page peel icon
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Compile and play the final movie

 

When you have finished assembling clips in the Construction window and are satisfied 
with the previewed results, you are ready for the program to create, or 

 

compile

 

, the final 
QuickTime movie file.

 

1

 

Before creating the movie, save the changes you have made to the project by choosing 
Save from the File menu. It’s always a good idea to save your project often as you work.

 

2

 

Choose Movie from the Make menu. The Make Movie dialog box appears.

 

3

 

Click Output Options. The Project Output Options dialog box appears.

This dialog box lets you change characteristics of the final movie, including size, frame 
rate, compression type, and format. See Chapter 8, “Compiling and Videotaping Movies,” 
for a complete description of output options.

 

4

 

Make sure that the Open Finished Movie option at the bottom of the dialog box is 
selected. This option tells the program to automatically open the movie when it has 
finished compiling and saving the movie.
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Leave the other options at their current settings (these were set when you chose a project 
preset), and click OK.

 

5

 

Name the movie in the Make Movie dialog box, and click OK. A progress bar appears 
while Adobe Premiere compiles the movie. 

When the movie has been compiled and saved, Adobe Premiere opens the movie in a 
Clip window. 

 

6

 

To play the movie, press the Play button in the Clip window.

 

Play the movie using Print to Video

 

You can use the Print to Video command to play a movie in the center of your screen, with 
the rest of the screen blacked out. Print to Video is also used to output a finished movie to 
videotape. For information on making videotapes with Adobe Premiere, see Chapter 8, 
“Compiling and Videotaping Movies.”

 

1

 

Click the Clip window to make sure that it is the active window.

 

2

 

Choose Export/Print to Video from the File menu. The Print to Video dialog box 
appears.

 

3

 

Leave the options as they are, and click OK.

 

4

 

The screen goes blank for 1 second, and then the movie plays in the center of the screen.

The Adobe Premiere program disks include a sample project and its clips, which you can 
open and make into a movie. You should look through this guide to familiarize yourself 
with Adobe Premiere’s features; then examine the sample project and make a movie to 
learn more about how Adobe Premiere handles clips, transitions, and superimposed 
images. 

Play button
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Chapter 

 

2

 

: Assembling an Adobe 
Premiere Movie

 

his chapter describes how to start an Adobe Premiere project and how to work 
with the Project and the Construction windows to assemble a movie. It also 
introduces some tools to help you keep your clips and editing session organized.

 

A basic approach to assembling a movie consists of importing clips into the Project 
window and assembling them in the Construction window. As you work in the Construc-
tion window, you may want to preview how the movie will play. Depending on the type of 
movie you want to create, you can perform more advanced editing operations. As you read 
this chapter and the following chapters on previewing, creating transitions, special effects, 
and superimpositions, keep in mind that there is no absolute order in which tasks must be 
performed. Once you are familiar with the various Adobe Premiere windows, you will be 
able to decide at which point you want to perform a given task.

 

PLANNING THE MOVIE

 

Before creating a movie with Adobe Premiere, you may want to write a simple description 
of the sequence of major actions, or 

 

shots

 

, in the movie. You may also want to create a series 
of sketches, called a 

 

storyboard

 

, that outlines the beginning, transitions, special effects, 
sound, and ending of the movie.

Next, decide what source files, or 

 

clips

 

, you want to include in your movie. For example, 
an Adobe Premiere movie might include a portion of a movie (a 

 

movie clip

 

), a sampled 
recording (an 

 

audio clip

 

), and an Adobe Photoshop or Adobe Illustrator image.

 

HOW ADOBE PREMIERE WORKS WITH FILES

 

When you import a clip into an Adobe Premiere project, the source file does 

 

not 

 

become 
part of your Adobe Premiere project. The actual files can take substantial quantities of 
memory, which would make working with them difficult. Instead, an Adobe Premiere clip 
contains a pointer to the source file stored on your hard-disk. The clip behaves as if it were 
the source video or audio recording, but it is actually a sample, or a set of 

 

thumbnails

 

, of 
the source file. You work exclusively with the thumbnails. If other users have access to your 
source files (on a hard drive or on a network), they will be unable to use or manipulate 
them while you are working with them in Adobe Premiere. 

 

T



 

Premiere User Guide 6/1/94 10:36 c2.pdf.frame

 

Right master page

 

Note: 

 

Because a clip is only a reference to its source file, do not throw away the source files 
while you are using them as clips in an Adobe Premiere project. Once you have used the Make 
Movie command to build a movie, you can discard the source files if you do not plan to 
continue editing the project. 

 

WORKING WITH PROJECTS

 

Once you have decided which clips you want to use in your movie, you are ready to create 
a new project. A project is analogous to a road map of your movie. All of your editing deci-
sions are saved in the project. You cannot have more than one Adobe Premiere project 
open at a time.

You start a new project by choosing New/Project from the File menu. This procedure is 
presented in “Create a New Project and Import Clips” on page 5.

 

Setting up a new project

 

To start a new project, you must select a preset. Presets specify the project time base, movie 
frame rate, compression scheme, preview options, and output options for the project. 
Each new project opens with the New Project Presets dialog box.

Each available preset is optimized for a particular type of project, such as off-line editing 
or outputting to video tape. Adobe Premiere comes equipped with several presets, and you 
can edit these or add your own. You can see a short description of each preset by clicking 
in the list. All settings can be changed once the project has been created.

 

Loading or modifying project presets

 

You can load any existing preset into an open project. The project will be updated to reflect 
all settings in the new preset. In addition, you can modify existing project presets for later 
use when opening new projects.
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To load an existing preset:

 

1

 

Choose Presets from the Make menu. The Presets dialog box appears.

 

2

 

Select an available preset from the right column. A description of the preset appears in 
the lower right corner of the dialog box.

 

3

 

To load the selected preset into the project, click Load. 

 

4

 

Click OK. The selected preset is loaded, and the current settings for the project are 
updated.

 

To add or modify a preset:

 

1

 

Choose Presets from the Make menu. The Presets dialog box appears.

 

2

 

To base the new or modified preset on an existing preset, load the preset using the 
preceding procedure.

 

3

 

To change the current settings listed on the left side of the dialog box, use the Time Base, 
Compression, Output Options, and Preview Options buttons. 

For more information on output and compression options, see Chapter 8, “Compiling 
and Videotaping Movies.” For more information on preview options, see Chapter 4, 
“Previewing a Movie.”

 

4

 

Click Save. The Preset Name dialog box appears.

 

5

 

Enter a name and description for the preset. Use a new name if you are adding a 
new preset.

 

6

 

Click OK. The preset is modified or added to the Available Presets list.

 

7

 

Click OK in the Presets dialog box. The preset is loaded and the current settings for the 
project are updated.

 

Setting a project’s time base

 

Every project has a 

 

time base

 

. The time base determines how Adobe Premiere interprets 
imported clips and lets the program know how many frames make 1 second of a movie. 
The time base is expressed as a rate, but has nothing to do with the actual playback rate of 
your movie. (The playback rate is determined by the value you specify in the Compression 
Settings dialog box and by the limitations of the target platform.)
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The time base affects the way clips are represented in the Project, Clip, and Construction 
windows. For example, the tick marks in the Construction window’s time ruler reflect the 
value of the time base. Since there are several standards in use today, specifying the one 
you want Adobe Premiere to use ensures that you and Adobe Premiere are measuring clips 
in time in the same way.

You initially set the time base when you choose the preset for a new project, as described 
in the preceding section. The time base can be set to 29.97 frames per second (fps), which 
is the National Television Standards Committee (NTSC) standard; 30 fps, which is a 
rounded version of NTSC video; 25 fps, the European television standard; or 24 fps, the 
rate at which film is projected. The time base for a project is changed by clicking the Time 
Base button in the Presets dialog box. 

When setting the time base for a project, you should consider the frame rate of your final 
movie. For example, if you want to output a final movie at 15 frames per second, you 
should set the time base at 30 fps because it is a multiple of 15. This will ensure that data 
will not be lost through interpolation when Adobe Premiere translates data from the 
project frame rate into the compiled movie frame rate.

 

Note:

 

 The time base you use should match the conform frame rate you set when the clips were 
captured. If the clips were not conformed during capture, you should conform them before 
importing them into the project, using the same frame rate as the one you specify for the 
project’s time base. For information on conforming clips during capture, see “Selecting 
Recording Options” on page 239. For information on post-capture conforming, see 
“Correcting the Duration of Frames in a Clip” on page 39.

 

Saving projects

 

Saving a project saves all of your editing decisions and pointers to source clips. It also saves 
the last arrangement of the program’s windows. It is a good idea to save your projects 
frequently as you work with them. If you want Adobe Premiere to save projects automat-
ically at specified intervals, use the Auto Save preference in the File menu.

To work with a project again, all of the original source material must be available. To avoid 
having to relocate your source files each time you open a project, you should not use the 
Finder to move or rename the source clips or preview files associated with the project.

 

Opening existing projects

 

You open an existing Adobe Premiere project by double-clicking the file in the Finder or 
by choosing Open from the File menu.
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Upon opening an existing project, you may be asked to locate some of the clips or preview 
files associated with the project. If you have changed the file names, click the Find button 
in the Open File dialog box to let Adobe Premiere find the files for you, or use the scroll 
list to locate and select the files. You can choose not to relocate the missing files by selecting 
Skip or Skip All in the Open dialog box. Adobe Premiere then opens the project with the 
available files. You will have to regenerate any missing preview files during the Preview or 
Make Movie operations.

 

Merging projects

 

Adobe Premiere lets you add the contents of an existing project to the current project. This 
feature allows you to break up a large project into smaller, more manageable pieces and 
then merge the individual pieces back together when you are ready to assemble your 
movie. You can add a project to the beginning or end of the current project, or insert the 
project at the edit line.

When you merge a project, its clips are added to the Project window in a folder, and its 
assembled clips are added to the Construction window at the location you specified. All of 
the merged project’s special effects (transitions, filters, motion settings, and so on) are also 
added. If additional tracks are required in the Construction window, they too are added.

 

To merge a project with the current project:

 

1

 

Choose Import/Project from the File menu. The Import dialog box appears.

 

2

 

Select the project you want to merge, and click Import. The Import Project dialog box 
appears.

 

3

 

To specify where you want the project added to the current project, select Beginning, 
Edit Line, or End. 

If you add the project at the edit line, the effect will be the same as performing an insert 
edit. All unlocked tracks are split at the edit line, and their contents shift to the right to 
accommodate the added project. For more information on insert editing, see “Performing 
Insert and Overlay Edits” on page 93.

 

Trimming projects

 

As you work on a project, you set new in points and out points for clips. (For information 
on setting in and out points, see “Trimming Clips” on page 79.) Your project may end up 
with many segments that are a fraction of the size of their source clips. The project could 
also use several segments from the same source clip but in different locations. Because 
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video clips can take up large amounts of hard disk space, you may want to trim the project 
so that unused frames are removed. Project trimming is especially useful for archiving 
projects. 

When you trim a project, Adobe Premiere creates a copy of the project. In the new project, 
each clip’s original in and out points become the new beginning and ending of the clip, 
respectively. The program also creates trimmed copies of the source clips. You can also 
preserve a few seconds of frames at the beginning and end of each trimmed clip.

 

Note:

 

 Instead of creating trimmed copies of the project’s clips, you can also create a batch list 
for redigitizing trimmed clips. Doing so is especially useful if you used low-resolution clips for 
the initial editing. For information on redigitizing low-resolution clips, see “Using Low-Reso-
lution Clips to Improve Performance” on page 44.

 

To trim a project:

 

1

 

Make the Project window or Construction window active.

 

2

 

Choose Tools/Project Trimmer from the File menu. The Project Trimmer dialog box 
appears. 

 

3

 

Select Copy Trimmed Source Files, and deselect Create Batch List. 

The trimmed copies will be stored in the same folders as the source clips, and their names 
will be appended with numerical extensions. For example, if a project contained three 
different segments from a source clip named 

 

Dancers

 

, the Project Trimmer would create 
three trimmed clips named 

 

Dancers.1

 

, 

 

Dancers.2

 

, and 

 

Dancers.3

 

.

 

4

 

To preserve a few extra seconds (

 

handles

 

) at the beginning and end of each trimmed clip, 
enter the number of seconds you want to preserve in the Keep Handles area.

Creating handles leaves the possibility of making minor editing changes in the newly 
trimmed project. Doing so is more important when creating a batch list for redigitizing 
than for basic project trimming.

 

5

 

Click Create Project. Use the standard Save dialog box that appears to name and store 
the new project. The new project uses the new trimmed clips with the numerical exten-
sions.

 

Note:

 

 If the project uses two segments from the same source clip, and their in and out points 
overlap, the Project Trimmer creates a single clip for those two segments. Similarly, if you 
specify handles, and the handles of two segments in a clip overlap, the Project Trimmer creates 
a single clip for those two segments.
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Exporting file lists

 

Adobe Premiere lets you create a list of the names of all clips used in a project. A file list is 
a quick way to scan the contents of a large project. The list displays the clip names in the 
order in which they appear in the Project window. Clip folders and their contents are also 
included in the list.

 

To export a file list:

 

1

 

Choose Export/File List from the File menu. 

 

2

 

Use the standard Save dialog box that appears to store the list. If you want to include the 
pathname for each file in the list, select the Include Full Pathnames option.

 

IMPORTING AND OPENING CLIPS

 

When a new project is created, Adobe Premiere opens a new, untitled Project window. 
Clips must be imported before they can be used in a project. All imported clips are placed 
in the Project window. 

After importing clips, you assemble them in the Construction window. 

There are several ways to import clips into a project. You can import a single clip, multiple 
clips, or an entire folder of clips directly into the Project window. If you want to examine 
a clip before importing it into the project, you can open it in a Clip window first and then 
move it to the Project or Construction window. You can import multiple copies of a clip 
that is displayed in a Clip window.

 

To import a single clip into the Project window: 

 

1

 

Choose Import/File from the File menu. The Import dialog box appears.

 

2

 

Locate and select the clip you want to import. If the clip is a movie or a PICT image, a 
small preview of the clip appears in the dialog box (if the Show Preview option is selected). 
For some file types, you will need to click Create to see a preview. 
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Note: 

 

If Adobe Premiere cannot show a preview of a file, a file icon is displayed in the preview 
area. For example, you cannot create previews of Adobe Illustrator files.

 

3

 

Click Import to import the clip into the Project window.

Clips are arranged in alphabetical order in the Project window with the number 1 
appearing after the name. If the same clip is imported again, Adobe Premiere makes 
another entry in the Project window and assigns it the number 2. Each time the clip is 
imported, Adobe Premiere makes a new entry and numbers it in ascending sequential 
order. 

 

To import multiple clips into the Project window:

 

1

 

Choose Import/Multiple from the File menu. The Import dialog box appears.

 

2

 

Select a clip, and click Import. The clip is placed in the Project window. Select additional 
clips using the same procedure.

 

3

 

Click Done when you have finished importing clips. 

 

To import a folder of clips into the Project window:

 

1

 

Choose Import/Folder from the File menu. The Import dialog box appears.

 

2

 

Locate the folder containing the desired clips, and click Select. 

All the clips in the selected folder are imported into the Project window. Any folders within 
the folder will not be imported. 

 

Second instance of this clip

in the project
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To examine a clip and then add it to the project:

 

1

 

Use the Open command in the File menu to open the clip you want to examine. The clip 
appears in a Clip window. 

 

2

 

To examine QuickTime and audio clips in the Clip window, click the play button. For 
information on playing clips in the Clip window, see “Using the Clip Window” on page 71.

 

3

 

To import the clip, drag it from the Clip window into the Project or Construction 
window. You can also drag a clip directly into a Library window or a Sequence window.

 

4

 

To import a copy of the clip, hold down the Option key and drag it to the Project or 
Construction window. You can also choose Add This Clip from the Project menu to 
import a copy of the clip to the Project window. Importing copies of clips is useful when 
you want to use multiple segments from the same source clip. Do do this, set the in and 
out points for the first segment in the Clip window, and then import the segment as a copy. 
Repeat the process for each subsequent segment. For information on setting in and out 
points, see “Trimming Clips” on page 79. 

 

Note: 

 

You can also use one of the Copy to Construction commands to perform an insert edit 
from the Clip window to the Construction window. For information on insert editing, see 
“Performing Insert and Overlay Edits” on page 93.

Play button
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Compatible formats for clips

 

Adobe Premiere accepts source files in a variety of formats, as shown in the following table. 
Compatible formats include those for movie files, animation files, still-image files, and 
audio files. 

The file formats preceded by a pound sign (#) represent a series of numbered images. 
When Adobe Premiere imports a sequence of numbered files, each numbered file repre-
sents a single frame of a clip, all of which are combined to create a single clip. Some utilities 
and programs, such as Adobe Dimensions

 



 

 and MacroMedia Director

 



 

, can generate a 
series of numbered PICT files that represent the sequence of single frames used to create 
animation.

You can use a QuickTime-compatible video digitizer to capture video and make movie 
files, use animation programs to make PICS files or a series of numbered files, use graphics 
applications to make PICT still-image files, and use presentation programs to convert 
spreadsheet charts and graphs to drawings. You can scan photos, line art, charts, and other 
visuals with a high-quality scanner, and then convert the scanned images to PICT or 
Adobe Photoshop files. 

TYPE OF CLIP

Movie FilmStrip

QuickTime

Animation PICS

#Adobe Illustrator

#Adobe Photoshop

#PICT

#Targa

Still Image Adobe Illustrator

Adobe Photoshop

Backdrop

PICT

Photo CD

Targa

Title

Audio Audio CD

Audio Interchange (AIFF)

QuickTime

SoundEdit

SoundEdit Pro

SoundDesigner I

SoundDesigner II 

snd

FILE FORMATS

Sequences of 

numbered images
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You can record and edit sounds with sound-editing programs, or use the built-in audio 
capabilities of Apple computer. If your Macintosh computer does not have built-in sound 
capabilities, you will need an additional audio input device, such as the MacRecorder

 



 

 
from MacroMedia.

 

 

 

Note:

 

 Sounds saved in the snd resource format are compatible with Adobe Premiere when the 
creator type is sfil. Some programs, such as SoundEdit

 



 

, save snd files with different creator 
types. To make these sound files work with Adobe Premiere, change the creator type using a 
program such as DiskTop.

 

Opening and rasterizing Adobe Illustrator files

 

An Adobe Illustrator file must be rasterized into a filmstrip before it can be imported into 
an Adobe Premiere project. Adobe Premiere automatically creates an 

 

alpha channel

 

 for the 
filmstrip clip when it rasterizes an Illustrator file. An alpha channel is an invisible grayscale 
channel in an image that is often used for creating masks that isolate part of the image.

 

To rasterize and import an Adobe Illustrator file:

 

1

 

Choose Open from the File menu. The Open dialog box appears, listing available clips 
and projects. 

 

2

 

Select the Adobe Illustrator file, and click Open. The Adobe Illustrator File dialog box 
appears.

 

3

 

Enter the image size at which you want the Adobe Illustrator file rasterized. To retain the 
aspect ratio of the Adobe Illustrator file, select the Lock Aspect option.

 

Note:

 

 You can control how an Adobe Illustrator image is rasterized by setting crop marks in 
the file. For more information on rasterizing Adobe Illustrator files, see “Creating Rolling 
Credits” on page 292.

 

4

 

To rasterize the image with smooth edges, select the Anti-Alias Edges option.

 

5

 

Click OK. Adobe Premiere rasterizes the image and opens it as a filmstrip in a 
Clip window.



 

Premiere User Guide 6/1/94 10:36 c2.pdf.frame

 

Right master page

 

6

 

To use the clip in the current project, save it and drag it from the Clip window into the 
Project or Construction window.

 

Opening numbered PICT or Adobe Illustrator files

 

To open a series of numbered PICT or Adobe Illustrator files, the filenames must all 
contain a suffix of a period followed by an equal number of digits—for example, 

 

File.000

 

, 

 

File.001

 

, and so on. You have the option of inserting a space between the period and the 
file number—for example, 

 

File. 000

 

, 

 

File. 001

 

, and so on.

 

To open numbered PICT images and compile them into a single clip:

 

 

 

1

 

Choose Import or Open from the File menu.

 

2

 

Select the first numbered image in the series, and click Open. 

The images are compiled and appear as a single clip in the Project or Clip window. By 
default, the images are assigned a frame rate of 1 fps. You can change the frame rate using 
the Speed command in the Clip menu. For a frame rate of 30 fps, enter 3000% for the new 
rate in the Clip Speed dialog box; for 24 fps, enter 2400%; for 15 fps, enter 1500%.

 

To rasterize numbered Adobe Illustrator files and compile them into a filmstrip:

 

1

 

Choose Open from the File menu.

 

2

 

Select the first Adobe Illustrator file in the numbered series, and click Open. The 
Rasterize FilmStrip dialog box appears.

 

3

 

Enter values for anti-aliasing and frame size.

 

4

 

Click OK. The numbered Adobe Illustrator files open as a filmstrip. An alpha channel is 
automatically created for the filmstrip. An alpha channel is an invisible grayscale channel 
in an image that is often used for creating masks that isolate part of the image.

 

Opening QuickTime for Windows files

 

In Adobe Premiere, you can open a QuickTime file created in Microsoft Windows, 
provided it has been converted from a DOS file to a Macintosh file. Adobe Premiere will 
recognize the .

 

mov

 

 (Windows movie), .

 

psd

 

 (Windows Photoshop), and .

 

flm

 

 (Windows 
FilmStrip) extensions when it opens the file. You will be asked to confirm the file type 
before the file is opened.

 

Note: 

 

Adobe Premiere understands three file types assigned by DOS-to-Macintosh conversion 
software: ???? (represented as a series of four question marks), TEXT, and BINA.
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WORKING WITH CLIPS

 

This section describes many of the options for working with clips in Adobe Premiere 
projects. You can set the image size for clips, rename clips, locate clips in other windows, 
delete unused clips, create libraries of frequently used clips, and use miniatures and low-
resolution clips to improve performance.

 

Setting the image size for movie and still-image clips

 

The Adobe Premiere output image size for movies can vary from 60 pixels by 45 pixels to 
4000 pixels by 4000 pixels with a resolution of 72 pixels per inch (ppi). The output image 
size is initially set in the project preset, and can be changed in the Output Options dialog 
box. It is a good practice to match the size of all movie and still-image clips to the output 
size of your movie before importing or adding them to an Adobe Premiere project. For 
more information on output image sizes, see Chapter 8, “Compiling and Videotaping 
Movies.”

You can resize still images using Adobe Photoshop and then import them into Adobe 
Premiere. If you need to resize a movie or still-image clip after it has been imported, you 
can apply the Resize filter. This filter lets you scale an image up or down to match the 
output frame size of the movie. For more information on the Resize filter, see “Movie and 
Still-Image Filters” on page 150.

By default, Adobe Premiere adjusts the height-to-width ratio, or 

 

aspect ratio

 

, of an image 
as needed to match the output frame dimensions. This can result in undesirable distortion 
of an image. You can lock the aspect ratio for any clip in the Project or Construction 
window by selecting the clip and choosing Maintain Aspect Ratio from the Clip menu. 
Adobe Premiere will maintain the height-to-width ratio of the image, regardless of image 
size. For 4still-image clips, you can specify Lock Aspect Ratio as a default setting by 
choosing Preferences/Still Image from the File menu.

 

Correcting the duration of frames in a clip

 

All video tape decks can potentially introduce frame rate errors with a clip during capture. 
In the Adobe Premiere program, it is important that all frames in a clip have the correct 
duration. Before importing clips, you can use the Conform Movie command to ensure 
that all captured frames in the clips have exactly the same duration.

 

To correct the duration of frames:

 

1

 

Choose Tools/Conform Movie from the File menu.
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2

 

In the standard Open dialog box that appears, select the clip file or folder of clips that 
you want to correct and click Conform. The Conform Movie dialog box appears, 
displaying the movies current frame rate.

 

3

 

Choose from the pop-up menu the frame rate to which you want to conform the movie, 
and click Conform.

 

Renaming clips

 

You can rename a clip by giving it a name alias. This is especially useful when you have 
used a clip more than once in a movie, or have duplicated a clip and set new in and out 
points. Giving the clip a name alias helps to avoid confusion when viewing duplicated clips 
in the Project and Construction windows.

A clip with an alias has an italicized filename when viewed in the Project and Construction 
windows. Creating a name alias does not rename the file on your hard disk. You can read 
the original filename of a clip at any time by selecting the clip and choosing Name Alias 
from the Clip menu. 

 

To assign a name alias:

 

1

 

Select the clip in the Project or Construction window, or open the clip in a Clip window. 
You can select multiple clips in the Project or Construction window.

 

2

 

Choose Name Alias from the Clip menu. The Set Clip Name Alias dialog box appears.

 

3

 

Specify a name alias for the clip, and click OK. If you selected multiple clips, the dialog 
box reappears for each clip.

 

To remove a name alias:

 

1

 

Select the clip in the Project or Construction window, or open the clip in a Clip window. 

 

2

 

Choose Name Alias from the Clip menu. The Set Clip Name Alias dialog box appears.

 

3

 

Click None to remove the name alias.

 

Finding clips in other windows

 

When you are working with a clip in one window, you can use the Find Clip command to 
see where the clip appears in another window. 

 

To find a clip in another window:

 

1

 

Select the clip in the Construction, Project, or Clip window.
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2

 

Choose Find Clip from the Clip menu.

 

O

 

If the Clip window is active, the corresponding clip in the Project window or Folder 
window is highlighted.

 

O

 

If the Project window is active, the corresponding clip in the Construction window 
is highlighted.

 

O

 

If the Construction window is active, the corresponding clip in the Project window 
or Folder window is highlighted.

 

O

 

If a virtual clip is selected, its source will be highlighted in the Construction window 
or Folder window. For information on virtual clips, see “Working with Virtual Clips” 
on page 103.

 

Deleting unused clips

 

Adobe Premiere has a folder-cleaning utility that allows you to search a folder for unused 
clips and delete them. The Folder Cleaner examines the selected folder, disk volume and 
its subfolders, or all mounted volumes and their contents. The utility identifies clips that 
are not referenced by projects, libraries, and sequences in the folder. It also identifies clips 
that are not in the correct locations as referenced by the projects, libraries, and sequences 
in the folder. Once the unused clips are identified, you can use the Folder Cleaner to select 
the ones you want to delete.

The Folder Cleaner examines only the projects, libraries, and sequences in the selected 
folder, volume, or mounted volumes. You should be careful not to delete clips that may be 
associated with projects, libraries, or sequences in other folders or on other volumes that 
may not be mounted.

 

Note: 

 

The Folder Cleaner actually identifies all unused files, not just clips. If the folder 
contains other types of importable files, such as Adobe Photoshop and Illustrator files, they too 
will be identified.

 

To delete unused clips:

 

1

 

Close all Project, Library, Sequence, and Clip windows that are open.

 

2

 

Choose Tools/Folder Cleaner from the File menu. The Find Folder dialog box appears.

 

3

 

Locate and select the folder you want to clean. You can also select an entire volume or 
click Clean All. The Clean All option examines all folders on your computer except 
attached network volumes.
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Adobe Premiere examines the folder and its subfolders and opens the Folder Cleaner 
dialog box. All files not associated with the folder’s projects, libraries, and sequences 
appear in the bottom half of the Folder Cleaner dialog box and are selected to be deleted. 
Clips that are referenced, but that have been moved from their original locations in the 
folder or volume, appear in the top half of the dialog box. These clips are not automatically 
selected to be deleted.

 

4

 

Select or deselect the clips in either list.

 

5

 

Click Delete to permanently delete all selected clips from the folder. A warning dialog 
appears, which you can use to cancel the operation.

 

Creating libraries

 

An Adobe Premiere library stores clips from one or several projects. For example, you may 
want to store all the clips from one project in a library or you may want to store frequently 
used clips in a library rather than open each clip separately as you need it. Once you have 
created and saved a library, you can open it along with any project. All attributes, such as 
markers and in and out points, are saved with the clips you place in a library. 

You can search for clips in the Library window based on their names or on their attached 
comments and labels. You search for clips in the Library window in the same way as you 
search for clips in the Project window. For information on searching the Project window, 
see “Locating Clips in the Project Window” on page 50.

 

To create a library:

 

1

 

Choose New/Library from the File menu. An untitled Library window appears. 

 

2

 

Import clips into the Library window using one of the following methods:

 

O

 

With the Library window active, choose the Import command from the File menu.

 

O

 

Drag the desired clips from the Project or Clip window into the Library window.

 

O

 

Copy and paste clips from the Construction window into the Library window. 
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3

 

Use the Save command in the File menu to save the library. Do not give a library the 
same name as a project. If you do, the library will overwrite the project. 

 

To open a library:

 

Use the Open command on the File menu to open a library. 

 

To change the display of the Library window:

 

Choose Library Window Options from the Windows menu. You change clip formats and 
icon sizes for the Library window in the same way you change them for the Project 
window. For information on changing the display of the Project window, see “Changing 
the Project Window Display”on page 47.

 

Making miniatures to improve performance

 

For better performance during editing and previewing, you can use the Miniatures feature 
to scale down the image size of your original clips. When you are ready to make the final 
version of the movie, you retrieve the original images using the Re-Find Files command. 
For more information, see “Replacing Miniatures and Low-Resolution Clips” on page 46.

 

To create a set of miniature clips:

 

1

 

Choose Tools/Miniatures from the File menu. The Select Source Folder dialog box 
appears. 

 

2

 

Select the folder containing the source clips, and click Select. The Create Miniatures 
Folder dialog box appears, with the default output and compression options displayed in 
the lower half of the dialog box. 
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3

 

To change the output options, click Output Options. For best results, select an image 
size between 120 pixels by 90 pixels and 320 pixels by 240 pixels. For more information on 
output options, see “Selecting Project Output Options” on page 210.

 

4

 

To change the compression options, click Compression. For information on compres-
sion options, see “Selecting Compression Options” on page 219.

 

5

 

Specify a name for the Miniatures folder, and click OK.

The miniature clips are saved in the newly created folder, from which they can be imported 
or opened for use in your project. When you are ready to output the final movie, use the 
Re-Find Files command to retrieve the original files. For information on using the Re-Find 
Files command, see “Replacing Miniatures and Low-Resolution Clips” on page 46.

 

Using low-resolution clips to improve performance

 

You can save disk space and improve editing and previewing performance in Adobe 
Premiere by working with low-resolution clips and then redigitizing the clips at higher 
resolution when you are ready to output the movie. 

When working with low-resolution clips, you should store still images and any titles you 
create in separate folders from the video and audio clips—you can work with the still 
images at their final dimensions, and the titles are automatically resized when you compile 
the movie. Only the video and audio clips will need to be redigitized. For instructions on 
creating low-resolution clips, see the tip “Using Low-Resolution Clips to Construct a 
Movie” on page 290.

Before redigitizing, you use the Project Trimmer to create a batch list of the clips in your 
project. The batch list includes only those segments of each source clip that are actually 
used in the Construction window, based on the in and out points you have set. (For infor-
mation on setting in and out points, see “Trimming Clips” on page 79.) Trimming the 
project can significantly decrease the size of your project, depending on how much editing 
you have done on the clips. The Project Trimmer also creates a copy of the project. The 
new project uses the trimmed clips that you will redigitize from the batch list. 

You use the Batch Capture command to redigitize the trimmed clips in the batch list. To 
redigitize clips, the original source clips must have been recorded with timecode when 
they were captured. For more information on using Batch Capture, see “Batch Capturing 
with Device Control” on page 250.

 

To redigitize low-resolution clips at higher resolution:

 

1

 

Make the Project window or Construction window active. 
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2

 

Choose Tools/Project Trimmer from the File menu. The Project Trimmer dialog box 
appears. 

 

3

 

Select Create Batch List, and deselect Copy Trimmed Source Files. 

 

4

 

To preserve a small number of extra frames (handles) at the beginning and end of each 
trimmed clip, enter the number of seconds you want to preserve in the Keep Handles area. 

Preserving handles is important when creating a batch list for redigitizing because you 
may want to make minor in and out point adjustments later, and because most digitizing 
boards currently duplicate the first and last few frames of a clip. For redigitizing purposes, 
you should preserve handles of at least 1 second.

 

5

 

Click Create Project. Use the first Save dialog box that appears to name and store the new 
project. Use the second Save dialog box to name and store the batch list.

 

6

 

Open the batch list. The list appears in a Batch List window. 

The batch list includes only those parts of each source clip that are actually used in the 
Construction window. The new clip names are appended with numerical extensions. For 
example, if a project contains three different segments from a clip named 

 

Dancers

 

, the 
batch list would include three trimmed clips named 

 

Dancers.1

 

, 

 

Dancers.2

 

, and 

 

Dancers.3

 

. 
The new project that was created by the Project Trimmer will look for these clip names 
instead of the original ones.

 

Note:

 

 If the project uses two segments from the same source clip, and their in and out points 
overlap, the batch list designates a single clip for those two segments. Similarly, if you specify 
handles, and the handles of two segments in a clip overlap, the batch list designates a single 
clip for those two segments.

 

7

 

Adjust the recording options and settings for digitizing the clips at a larger size or reso-
lution, using the commands in the Batch Capture menu. For more information on these 
commands, see “Capturing with Device Control” on page 247. 

 

8

 

Make sure that your tape deck is connected to your Macintosh, and click Capture in the 
Batch List window. You will be asked to create a library for batch capture. Be sure to create 
the library on your fastest hard drive because Adobe Premiere will capture the clips using 
that drive. For more information on batch capture, see “Capturing Clips Using a Batch 
List” on page 253.

Adobe Premiere saves the clips in the batch list in the folder that contains the library. If this 
is the same folder that contains the original clips, you can open the new project that was 
created by the Project Trimmer, and the project will automatically use the newly digitized 
clips. If this is not the folder that contains your original clips, you will need to link the 
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newly digitized clips to the project created by the Project Trimmer using the Re-find Files 
command. For more information on using the Re-find Files command, see the next 
section, “Replacing Miniatures and Low-Resolution Clips.”

 

Replacing miniatures and low-resolution clips

 

The Re-Find Files command is used to replace miniature clips with their source clips, or 
to replace low-resolution clips with clips that have been redigitized at higher resolution. 
For more information, see the preceding sections, “Making Miniatures to Improve Perfor-
mance” and “Using Low-Resolution Clips to Improve Performance.” 

 

To use the Re-Find Files command:

 

1

 

Save your project. 

 

2

 

Choose Re-Find Files from the Project menu. The Re-Find Files dialog box appears.

 

3

 

Use the dialog box to locate and select the clip indicated at the top of the dialog box. 

If you have placed all of the original clips in the same folder, Adobe Premiere automatically 
exchanges the miniature clips in the Project window and the Construction window with 
the original clips in the folder. If you have built your movie with miniatures from different 
folders, you will have to locate each folder individually. If you want to skip one clip and 
locate the next, click Skip in the Re-Find Files dialog box.

 

USING THE PROJECT WINDOW

 

Clips imported to a project appear in the Project window. Clips in the Project window can 
be organized in folders, which helps make large projects more manageable.

For each clip, the default Project window displays the name, a thumbnail, the general type, 
and the duration. The window also displays a Comment box, and two Label boxes.

Comment box

Label  box

Size box

Audio clip

Still-image clip

Movie clip with

linked audio

Folder

Movie clip

without audio

Clip information
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O

 

The thumbnails vary depending on the type of clip in the Project window. For a movie 
or animation clip, the thumbnail displays an approximation of the first frame of the clip. 
For an audio clip, the thumbnail is a sketch of a portion of the audio waveform. For a still 
image, the thumbnail displayed is an approximation of the image. If marker 0 is set in a 
clip, the thumbnail displays that frame.

 

O

 

The clip type label may be “Movie,” “Audio,” “Still Image,” “Filmstrip,” “Backdrop,” 
“Background Matte,” or “Title.”

 

O

 

The duration of a clip (how long a clip runs) is measured in the standard format 
approved by the Society of Motion Picture and Television Engineers (SMPTE), which is 
Hours:Minutes:Seconds:Frames. A clip with a duration of 0:00:05:15 plays for 5 seconds 
and 15 frames. At the rate of 30 frames per second, this clip would play for 5.5 seconds. 
For more information on setting timecode, see “SMPTE Timecode” on page 298.

 

O

 

The size of a movie frame or still-image clip is the image’s dimensions measured in 
pixels; for audio clips, the Project window displays frequency in kilohertz, sample resolu-
tion, and whether the clip is mono or stereo. 

 

O

 

The Comment box and two Label boxes to the right of the clip name let you attach notes 
to a clip. For example, you may want to add information about the contents or quality of 
a clip that can’t be represented by the thumbnail. To add a comment or a label, click the 
appropriate box and type the text you want associated with the clip. You can use the stan-
dard Macintosh Cut, Copy, Paste, and Clear commands to edit the text you enter.

You can display clips in the Project window in several icon views, similar to viewing by 
icon on the Macintosh desktop. In name view, clips are displayed in alphabetical order 
by filename. They can also be alphabetized according to comments or labels. Grouping or 
prioritizing your clips with attached notes can make it easier to keep your project 
organized.

 

Changing the Project window display

 

You can vary how clips appear in the Project window by choosing among three clip 
formats and four thumbnail sizes. The default view uses medium thumbnails and displays 
clips by name, showing the type of clip and its duration. You can also view clips by icon, 
positioning the names of the clips below or beside the icon.
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To change the Project window display:

 

1

 

Make the Project window active, and choose Project Window Options from the 
Windows menu. The Project Window Options dialog box appears.

 

2

 

To select a clip format and icon size, click the appropriate buttons. If you want to turn 
off the display of thumbnails so that they appear in the Project window as gray boxes, dese-
lect the Show Icons check box. Not displaying thumbnails speeds up access time when 
working in the Project window. 

 

Note: 

 

You can also toggle between views when the Project window is active by holding down 
the Option key and using the left and right arrow keys to change clip format, or the up and 
down arrow keys to change icon size.

 

3

 

To specify how the clips in the Project window are sorted alphabetically (in name view 
only), click Name, Comment, Label 1, or Label 2.

You can also click on a column heading in the Project window (Name, Comment, Label 1, 
or Label 2) to sort the clips alphabetically. 

 

4

 

To sort thumbnails in the Project window when in icon view, use the Clean Up by Name 
command in the Project menu. Thumbnails can also be arranged in a rectangular grid by 
selecting the Snap Clips to Grid option in the Project Window Options dialog box.

Name view

Icon views
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Using folders in the Project window

 

Clips in the Project window can be arranged in folders, just as files are arranged in folders 
on your hard drive. Project folders are particularly useful when you are working with a 
complex project that has scenes from many clips. Arranging the clips in a series of folders 
makes the project easier to manage.

 

To create a folder in the Project window:

 

1

 

Make the Project window active.

 

2

 

Choose Add Folder from the Project menu. The Folder Name dialog box appears.

 

3

 

Type a name and click OK.

 

To open a Folder window and add clips:

 

1

 

Double-click the folder you want to open. The Folder window appears, displaying the 
contents of the chosen folder.

 

2

 

Drag clips or other folders from the Project or Clip window to the Folder window. If you 
add a clip from a Clip window, Adobe Premiere creates a new copy of the clip in the folder. 
If the Folder window is not open, you can add a clip or folder by dragging it over the folder 
icon in the Project window.

 

To change the display of the Folder window:

 

1

 

Open the Folder window.

 

2

 

Choose Folder Window Options from the Windows menu. The Folder Window Options 
dialog box appears.

You change the display of the Folder window in exactly the same manner as for the Project 
window—you can choose from three clip formats and four thumbnail sizes. For informa-
tion on changing the display of the Project window, see “Changing the Project Window 
Display” on page 47.

 

Deleting clips and folders from the Project window

 

You can delete one or more of the clips or folders in the Project window if you don’t want 
them in your project. You can also have Adobe Premiere delete all clips in the Project 
window that are not currently used in the Construction window. If you try to delete a clip 
that is currently in use in the Construction window, a warning indicates that the clip will 
be removed from both the Project and Construction windows. 
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To delete a clip or folder from the Project window:

 

1

 

Select the clip or folder you want to delete. Hold down the Shift key to select more than 
one clip or folder.

 

2

 

Press Delete, or choose Clear or Cut from the Edit menu. The clip or folder is deleted 
from the Project window and the Construction window. 

 

To delete all clips not currently in use:

 

1

 

Make the Project window active.

 

2

 

Choose Remove Unused from the Project menu.

 

Locating clips in the Project window

 

You can have Adobe Premiere search for clips in the Project window based on their names 
or on their attached comments and labels. This is useful, for example, if you need to locate 
all clips with a common label, such as 

 

Opening Scene

 

.

 

To locate clips in the Project window:

 

1

 

Click the Project window to make it active.

 

2

 

Choose Goto/Search from the Project menu. The Project/Library Search dialog box 
appears.

 

3

 

Select which columns in the Project window will be searched: Name, Comment, 
Label 1, or Label 2.

 

4

 

Type a character string to be used as an identifier in the search. 

 

5

 

Click Find to locate and select the first clip in the Project window associated with the 
character string identifier; continue clicking Find to locate and select successive clips asso-
ciated with the character string.

 

6

 

Click Find All to locate and select all clips in the Project window associated with the 
character string identifier.

 

7

 

Click Done when you have completed your search.
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USING THE CONSTRUCTION WINDOW

 

The Construction window displays all the clips in your movie from left to right, in the 
sequence in which they will appear when the movie is played. This window is Adobe 
Premiere’s “cutting room,” because it is here that you do the work of assembling clips and 
editing the movie. 

The Construction window contains a time ruler for aligning clips, a tools palette for 
selecting and editing clips, and a variable number of tracks. At the default setting, the 
Construction window displays seven tracks. 

 

Traversing the Construction window

 

To traverse the Construction window, use the scroll bar at the bottom of the window. If 
you have an extended keyboard, press the Home key to display the beginning of the assem-
bled movie or the start of the selected clip. Press the End key to display the end of the 
assembled movie or the end of the selected clip.

Video track B

Play button

Edit line left 

and right buttons

Video track A

Transition track

Superimpose

track S1

Edit line

Superimpose

track S1

Audio track A

Audio track B

Audio track X1

Size box

Current time unit

Time unit selector

Tools palette

Snap tool

Work area bar

Edge viewing tool

Time ruler

Preview status bar Playback head
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Changing the number of tracks in the Construction window

 

The Construction window can contain up to 99 video and 99 audio tracks. You set the 
number of tracks with the Add/Delete Tracks command in the Project menu. You can 
specify different numbers of video and audio tracks, but for each type, you can have no 
fewer than three tracks (the default setting).

Additional video tracks are added as superimpose (S) tracks. When video tracks are added, 
they are labeled sequentially from S2 to S97, depending on the number of tracks added. 
Similarly, audio tracks are labeled X2 to X97. When deleting tracks, Adobe Premiere 
removes those with the highest numbers in the Construction window. If you attempt to 
remove a track that has contents, you will be given a warning and be allowed to cancel the 
operation. Deleting tracks cannot be undone.

 

Viewing tracks

 

When working with a large number of tracks, you may have to enlarge the Construction 
window to see all of them. If you can’t enlarge the window, you can scroll through the S 
and audio tracks using the scroll bars on the right side of the Construction window. The 
area of the Construction window allocated to video and audio tracks can be adjusted by 
dragging the splitter bar located between the two scroll bars.

 

Adjusting the track display

Splitter bar
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Assembling clips in the Construction window

 

To assemble your clips in the Construction window, drag a thumbnail of each of the clips 
you want to use from the Project or Clip window onto a track in the Construction window. 
The clip type must correspond to the track type. For example, you cannot place an audio 
clip on a video track. Adobe Premiere places the clip in the Construction window when 
you release the mouse button. 

After you drag a clip into the Construction window, a small icon appears in the clip’s infor-
mation box in the Project window to show that the clip is in use. The icon is a color wheel 
for a movie or still-image clip and a waveform for an audio clip. If a linked clip is used, 
both icons are displayed in the clip. 

You can also add clips to the Construction window by performing an insert edit. Doing so 
allows you to set precise cut points and durations for clips as you insert new material. For 
information on performing insert editing, see “Performing Insert and Overlay Edits” 
on page 93.

Movie or still-image icon

Audio icon



 

Premiere User Guide 6/1/94 10:36 c2.pdf.frame

 

Right master page

 

To copy multiple clips from the Project window to the Construction window:

 

1

 

Click a clip to select it; then hold down the Shift key and click each additional clip you 
want included in the selection. If the Project window is displayed in icon view, drag to 
create a selection marquee around the clips.

 

2

 

Drag the clips to the Construction window. Clips are placed on a single track in the 
order that they appear in the Project window.

 

To copy all clips from the Project window to the Construction window: 

 

1

 

Choose Select All from the Edit menu. 

 

2

 

Drag the clips to the Construction window. Clips are placed on a single track in the 
order that they appear in the Project window.

 

Using linked clips

 

If a clip contains both video and audio, it is called a 

 

linked

 

 clip. When you drag a linked 
clip to the Construction window, both the video and audio portions of the clip are placed 
on their appropriate tracks. For example, if you drag a linked clip onto video track S12, 
then the audio portion of the clip will be placed on audio track X12, provided that the 
track exists.

It is possible to separate linked clips permanently or temporarily. It is also possible to have 
linked audio and video on differently numbered tracks if you have temporarily released 
the link and moved the audio or video portion to a different track. For more information 
on editing linked clips, see “Separating and Rejoining Linked Clips” on page 99.

 

To delete the audio or video portion of a linked clip without affecting the other 
component:

 

1

 

Click the portion of the clip in the Construction window that you want to delete.

 

2

 

Press Delete or choose Clear from the Edit menu. 

 

Changing the Construction window display

 

You can display clips in the Construction window using thumbnails, filenames, or both. 
You can choose from four icon sizes for thumbnails. You can also specify which tracks are 
displayed in the Construction window. If you are working exclusively with video tracks, 
for example, you can choose to turn off the display of audio tracks. By default, all the 
tracks appear in the Construction window.
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 To change the Construction window display:

 

1

 

With the Construction window active, choose Construction Window Options from the 
Windows menu. The Construction Window Options dialog box appears.

 

2

 

Select a track format. The Construction window will draw fastest on-screen when the 
Track Format is set to Filename only. The middle option, showing only the first and last 
frames of clips, also allows relatively fast redrawing of the window. 

 

3

 

To select an icon size, click the appropriate button. Use the smallest icon size when you 
have many tracks to view in the Construction window.

 

4

 

Select which tracks to display in the Construction window from Track Display area.

 

5

 

Choose the frame numbering format used to count frames in the Construction window 
from the Count pop-up menu.

 

Changing the number of thumbnails in the Construction window

 

The default time unit for the Construction window is 1 second, which means that the 
Construction window displays one thumbnail for each second of a clip. Assigning a larger 
value to the time unit, such as one minute, results in the display of fewer thumbnails for 
each clip, but allows you to view a larger portion of the Construction window.

In general, the more detail you want to see in a clip, the smaller the time unit you should 
select. For more of an overview of a clip, select a larger time unit. Once you become 
familiar with the Adobe Premiere program, you will have a better idea of when to use a 
small time unit and when to use a larger one.
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To change the time unit for the Construction window:

 

Drag the time unit selector at the bottom of the Construction window, or use the zoom 
tool in the tools palette. The time unit can be set to a value ranging from 1 frame (1/30th 
second for a 30 fps project) to 2 minutes. For more information on the zoom tool, see 
“Using Tools in the Construction Window” on page 59.

 

Default time unit (1 second)

Time unit in Construction window set to 8 frames

Time unit in Construction window set to 4 seconds

 

.

Time unit selector



 

Premiere User Guide 6/1/94 10:36 c2.pdf.frame

 

Right master page

 

To view the entire project in the Construction window:

 

Make the Construction window active, and press the backslash (\) key. The number of 
thumbnails shrinks so that the entire project fits in the Construction window, and the time 
unit selector at the bottom of the window adjusts accordingly.

 

Changing the display of audio clips in the Construction window

 

You can display audio clips in the Construction window with waveforms or with straight 
gray bars. The gray bar approximation is beneficial when the time unit is small (one to 
eight frames) because bars are displayed more quickly than waveforms. 

 

To change the audio display: 

 

1

 

Choose Preferences/Audio from the File menu. The Audio Preferences dialog box 
appears. 

 

2

 

Choose a time scale threshold from 1 frame to 1 minute for the audio approximation; 
or choose Always or Never.

 

3

 

Click OK. 

If the time unit in the Construction window exceeds the threshold you selected, the audio 
clip will appear as a gray bar. 

 

Audio approximation

Waveform display
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Disabling clips in the Construction window

 

Clips that have been placed in the Construction window can be 

 

disabled

 

 so that they won’t 
be included when you build a preview or compile a movie. This feature is useful if you wish 
to keep several versions of a clip available for previewing or compiling, or you want to 
disable the audio or video portion of a linked clip. It is also useful if you have many 
composited clips on multiple tracks, but you only want to see how two of the clips interact. 
In this situation, the disabled clips are not visible and do not take up processing time.

You can toggle the status of a clip between enabled and disabled by selecting the clip in the 
Construction window and choosing Enable from the Clip menu. A disabled clip is marked 
with a crosshatched line pattern. You must disable the audio and video portions of a linked 
clips separately.

 

Deleting clips from the Construction window

 

If you decide that you don’t want to use a clip in your project, you can delete it from the 
Construction window. Deleting a clip from the Construction window does not delete the 
clip from the Project window. When you delete a clip, you can leave an empty space on the 
track where the clip was, or you can perform a “ripple” delete, which shifts the contents of 
all other tracks over to close the gap left by the deleted clip.

 

To delete a clip from the Construction window and leave an empty space:

 

Select the clip or clips in the Construction window. Press Delete, or choose Clear from the 
Edit menu.

 

To perform a ripple delete:

 

Select the clip or clips, and choose Ripple Delete from the Edit menu, or press Option-
Delete. If you do not want a clip on another track to shift over, lock the track before 
performing the ripple delete. For information on locking tracks, see “Locking Tracks in the 
Construction Window” on page 97.
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Using tools in the Construction window

 

The Construction window contains a set of tools for selecting and editing the clips in your 
movie. Tool icons are displayed in the tools palette, located in the lower left corner of the 
Construction window. The tools palette initially displays a range select tool under which 
resides an extended tools pop-up menu. When you choose a tool from this menu, the 
chosen tool takes the place of the range select tool in the palette.

To select a tool, click its icon in the tools palette, or press the tool’s corresponding letter on 
the keyboard. After a tool is selected, the pointer changes to the tool’s icon when posi-
tioned over an appropriate part of the Construction window. 

Extended tools pop-up menu
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Construction Window Tools

Selection tool (s from keyboard)


This tool selects and moves clips, transitions, and 
markers one at a time. 


It changes into a stretch pointer when positioned 
over the edge of a clip, allowing you to shorten or 
lengthen the clip by dragging. For information on 
using the selection tool to change a clip’s duration, 
see “Trimming Clips in the Construction Window” 
in Chapter 3.


When another tool is in use, you can hold down 
the Command key to access the selection tool.


Range select tool (e from keyboard)


This tool drags to select multiple items in the 
Construction window.


Zoom tools (z from keyboard)


These tools perform the same function as the 
time unit slider at the bottom of the Construction 
window. The zoom-in tool decreases the time 
unit; the zoom-out tool (hold down the Option 
key) increases the time unit. 


This tool can also draw a marquee and fill the 
Construction window with the selected view. The 
time unit is adjusted accordingly. For information 
on how the time unit value affects the display, 
see “Changing the Number of Thumbnails in the 
Construction Window” earlier in this chapter. 


To select zoom-in when the selection tool is in 
use, hold down the spacebar and Command key. 
To select zoom-out when the selection tool is in 
use, hold down the spacebar and the Option key.


Hand tool (h from keyboard)

This tool scrolls the contents of the Construction 
window to display different areas of your movie. 
Scroll the window by dragging. 


Block select tool (b from keyboard)


This tool selects a segment of equal length from 
all tracks in the Construction window. For more 
information, see “Splitting Clips” and “Working 
with Virtual Clips” in Chapter 3.


Track tool (t from keyboard)


This tool selects all clips on a track, from the first 
clip clicked to the end of the track. To add to a se-
lection, hold down the Shift key and click.


Multitrack tool (m from keyboard)


This tool selects all clips in the Construction 
window that are placed to the right of the point 
you click. This includes clips that start at an earlier 
point on the timeline and extend beyond the 
point you click. 


To select all clips and linked clips associated with 
a particular track, beginning with the first clip se-
lected, hold down the Option key and click. Both 
the audio and video portions of the linked clips 
are selected. To add tracks to a linked clip selec-
tion, hold down the Shift key and click.
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Razor tool (r from keyboard)


This tool cuts a clip into two or more distinct 
clips. For more information, see “Splitting Clips” 
in Chapter 3.


In point tool (i from keyboard)


This tool sets in points for movie clips, audio clips, 
transitions, and the work area bar. For more infor-
mation, see “Trimming Clips in the Construction 
Window” in Chapter 3.


To select the in point tool when the selection tool 
is active, hold down the Control and Shift keys.


Out point tool (o from keyboard)


This tool sets out points for movie clips, audio 
clips, transitions, and the work area bar. For more 
information, see “Trimming Clips in the Construc-
tion Window” in Chapter 3.


To select the out point tool when the selection tool 
is active, hold down the Control key.

Ripple edit tool (extended tools pop-up 
or p from keyboard)


This tool adjusts the duration of a clip without af-
fecting the duration of other clips on the track. 
For more information, see ”Using the Ripple and 
Rolling Edit Tools in the Construction Window” in 
Chapter 3.


Rolling edit tool (extended tools pop-up 
or y from keyboard)


This tool adjusts the duration of a clip and its 	
adjacent clip to maintain the original combined 
duration of the two clips and all subsequent clips. 
For more information, see “Using the Ripple and 
Rolling Edit Tools in the Construction Window” in 
Chapter 3. 


Link override tool  (extended tools 	
pop-up or u from keyboard)


This tool lets you move the video or audio portion 
of a linked clip independently. For more informa-
tion, see “Separating and Rejoining Linked Clips” 
in Chapter 3.


Note: Although the video or audio portion of a 
linked clip can be moved independently when 	
you use the link override tool, the audio and video 
portions of the clip remain linked when you 	
release the tool. 


Soft link tool (extended tools pop-up

or l from keyboard)

This tool creates a soft link between an audio 
clip and a video clip. For more information, 
see “Separating and Rejoining Linked Clips” 
in Chapter 3.


Fade scissors tool (extended tools 
pop-up or k from keyboard)


This tool creates two handles next to each other 
in the Fade control section of an audio or superim-
posed clip. With two handles, you can make 	
adjustments that sharply increase or decrease 	
the fading at a point. For more information, see 
“Mixing Audio Clips” in Chapter 3 or “Adjusting 
the Intensity of Superimposed Clips” in Chapter 7. 


Fade adjustment tool (extended tools 
pop-up or g from keyboard)


This tool uniformly adjusts a segment in the Fade 
control section of an audio or supermiposed clip. 
For more information, see “Mixing Audio Clips” 
in Chapter 3 or “Adjusting the Intensity of Super-
imposed Clips” in Chapter 7.
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Using the time ruler

 

The time ruler at the top of the Construction window reflects the selected time unit. It 
displays the current position of the pointer and any place markers that have been set in the 
Construction window. From the time ruler, you can also determine the starting and 
ending positions of each clip and the duration of the entire movie. 

The large tick marks on the time ruler represent the current time unit; the small tick marks 
represent frames or seconds, depending on the current time unit. As you move the mouse 
in the window, a hairline marker moves in the time ruler to indicate the current pointer 
position. 

You can scroll in the Construction window to move to a location on the time ruler, or you 
can use the Goto/Search command. 

 

To move to a specific location on the time ruler:

 

1

 

Make the Construction window active, and choose Goto/Search from the Project menu. 
The Goto Location dialog box appears, displaying a miniaturized version of the Construc-
tion window. 

A bracket at the top of the dialog box indicates the range of the time ruler that is currently 
displayed in the Construction window.

 

2

 

To move to a specific location, use one of the following methods:

 

O

 

Enter the time or frame number of the location using SMPTE timecode format. For 
more information, see “SMPTE Timecode” on page 298.

 

O

 

Click an area of the display, and the timecode for that location will be entered 
automatically. 

 

O

 

Slide the bracket at the top of the dialog box to select the range of the time ruler you 
want to move to.
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3

 

Click OK. 

 

Note: 

 

You can use colons, semicolons, or periods interchangeably as separators for a 
time entry. 

 

Arranging clips in the Construction window

 

Adobe Premiere plays all the clips in the Construction window in order from left to right. 
The simplest arrangement for a movie is to assemble the clips end-to-end on a single video 
track so that the out point of one clip butts against the in point of the next clip. 

If you want to create a movie with less abrupt transitions between clips, you can place clips 
on the A and B video tracks so that they overlap, and use the T track for transitions. You 
use the S tracks for movie clips, still-image clips, or titles you want to superimpose. 

You can arrange clips in the rough order in which you want them to play; then position 
them precisely using the Snap to Edges option, the time ruler, or the timecode displayed 
in the Info window. You can also use place markers to align clips. For information on place 
markers, see “Setting Place Markers for Clip Alignment” on page 75.

When you drag a clip to move it or to change its duration, Adobe Premiere brackets the 
edges of the clip with alignment guides. These guides help to align the clip with clips on 
other tracks. When you release the mouse button, the alignment guides disappear. 

 

To position clips, use one of the following techniques: 

 

O

 

To snap a clip to the edge of another clip when you drag it, use the Snap to Edges option. 
This is the default setting for aligning clips in the Construction window. As you drag a clip, 
its alignment guides will snap to the edges of clips or transitions on other tracks. This 
enables precise edge alignment on all tracks. 

To toggle Snap to Edges on and off, choose Construction Window Options from the 
Windows menu and select Snap to Edges, or click the snap tool in the upper left corner of 
the Construction window. 

Alignment guides
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O

 

To make a clip start at a certain time in the movie, align the left edge of the clip with the 
desired time on the time ruler, or drag the clip to the desired starting point using the Info 
window for reference. 

 

 

 

O

 

To make a clip stop at a certain time, align the right edge of the clip with the ruler mark 
for that time. You cannot stretch movie and audio clips beyond their original length.

 

O

 

To select all clips on a track at once, click the track tool and then click the first clip you 
want included in the selection. All subsequent clips on the track are selected. Drag to align 
the selected track of clips. To add other tracks to the selection, hold down the Shift key and 
click.

 

O

 

To include linked clips when selecting all clips on a track, choose the multitrack tool and 
then Option-click the first linked clip you want included in the selection. All subsequent 
clips (linked and unlinked) are selected. To add to or subtract from a selection with the 
multitrack tool, hold down the Shift key and click. 

 

Note: 

 

You will not be able to align clips precisely if the time unit you have set is too large. For 
more information on adjusting the time unit, see “Changing the Number of Thumbnails in 
the Construction Window” on page 55.

 

Deleting empty space between clips

 

As you place clips in the Construction window, you can quickly delete empty space 
between clips on a track. To do so, select the space and choose Ripple Delete from the Edit 
menu or press Option-Delete. Adobe Premiere shifts over all clips and transitions on any 
unlocked tracks to close up the space. 

For information on locking tracks, see “Locking Tracks in the Construction Window” on 
page 97.

 

USING THE INFO WINDOW

 

The Info window displays information about a selected clip or transition. When you select 
a clip in the Construction window, the Info window displays the name of the clip, the type 
of clip, the speed of the clip (if a speed other than the default setting has been entered), the 
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duration of the clip, the size of the clip, the fade control levels of selected points in the clip, 
the starting and ending times of the clip, and the current location of the pointer. It is some-
times helpful to watch the starting and ending time in the Info window as you drag to align 
a clip in the Construction window. 

If you select a clip in the Project window, the Info window displays the clip’s name, type, 
duration, size, starting and ending points, and the current location of the pointer.

If you select a transition in the Construction window, the Info window displays the tran-
sition’s name, duration, starting and ending points, and the current location of the 
pointer.

If you select an empty space in the Construction window, the Info window displays the 
space’s duration and starting and ending times.

If a Title window is active, the Info window displays information about a selected object, 
including its size and position in the window.

 

To display the Info window:

 

Choose Info from the Windows menu, or press Command-8 to alternately display and 
hide the Info window. 

If you want the Info window to stay displayed on top of other overlapping windows, 
choose Float from the pop-up menu in the upper right corner of the window.

Info window

pop-up menu
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USING THE MOVIE ANALYSIS TOOL

 

The Movie Analysis feature provides detailed information about any QuickTime movie, 
including the file size, number of video and audio tracks, duration, average frame rate, 
audio rate, and compression settings. 

 

To analyze a movie:

 

1

 

Choose Tools/Movie Analysis from the File menu. 

 

2

 

Use the standard Open File dialog box to locate the QuickTime movie. You can click 
Find and enter the filename to locate the file.

Information about the movie appears in the Analysis window. You can print the contents 
of the Analysis window, as well as save it in a file.

 

Note:

 

 You can analyze the clip in the active Clip window by holding down the Option key and 
choosing the Movie Analysis command. Information about the current clip appears in the 
Analysis window.

 

USING THE COMMANDS PALETTE

 

Adobe Premiere lets you set up a palette of your most frequently used commands. The 
Commands palette can remain visible on-screen while you work, making command selec-
tion fast and easy. 
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You use the Commands Editor to add and delete commands from the palette, and to save 
and use multiple palettes.

 

To display the Commands palette:

 

1

 

Choose Commands from the Windows menu.

 

2

 

To display the Commands palette on top of other Adobe Premiere windows, choose 
Float from the pop-up menu in the upper right corner of the palette.

 

3

 

To change the number of columns in the palette, choose Preferences/Commands from 
the File menu, or choose Options from the pop-up menu in the upper right corner of the 
palette. Specify the number of columns in the lower left corner of the Commands Editor.

 

One-column palette Three-column palette

 

To add and remove commands in the palette:

 

1

 

Choose Preferences/Commands from the File menu, or choose Options from the pop-
up menu in the upper right corner of the palette. The Commands Editor appears.

 

2

 

To add a command to the palette, click Add. An undefined entry appears in the scroll 
list.

 

3

 

Choose the command you want to add to the palette from the Adobe Premiere menus. 
The undefined entry is replaced by the chosen command. 

 

4

 

Specify the Item Details as follows:

 

O

 

Type the title you want to appear in the palette.

 

O

 

Choose from the pop-up menu a function key shortcut for the command, or press the 
function key on the keyboard.

 

O

 

Choose from the pop-up menu the color in which you want the command displayed in 
the palette.

 

O

 

Select Do Option Key if the command has an Option key function, and you want the 
palette command to behave as if the Option key had been pressed. 



 

Premiere User Guide 6/1/94 10:36 c2.pdf.frame

 

Right master page

 

For example, if you hold down the Option key while choosing the Movie Analysis 
command, Adobe Premiere analyzes the clip in the current Clip window instead of 
requesting a movie to analyze. If you select Do Option Key when adding the Movie Anal-
ysis command to the Command palette, clicking Movie Analysis in the palette causes the 
command to behave as if you had held down the Option key.

 

5

 

To rearrange the order of commands in the palette, drag them to the new positions.

 

6

 

To remove a command from the palette, select the command you want to delete from 
the scroll list, and click Delete. 

 

7

 

Click OK.

 

To save and load multiple palettes:

 

1

 

Use the Commands Editor to set up a palette exactly as you want it.

 

2

 

Click Save, and assign a name to the palette.

 

3

 

To use a saved Commands palette, click Load in the Commands Editor and select the 
palette. When you click OK in the Commands Editor, the selected palette appears.

 

SAVING WINDOW LAYOUTS

 

Adobe Premiere lets you save window layouts that you use frequently in the current 
project. (You can also save layouts as files for use in other projects.) For example, you may 
consistently use certain windows in specific screen locations when you edit clips, and use 
a different set of windows when you preview movies. By saving your frequently used 
window layouts, you can quickly move from task to task without having to manually 
rearrange the windows each time. 

When you save a layout, the locations and settings of the following windows are saved: 
Project, Construction, Transition, Preview, Info, Commands, Lock, Project Controller, 
and Trimming. All other open windows, such as the Clip window, are ignored. Saving the 
window arrangement also saves each open window’s settings, such as the Construction 
window’s icon mode and icon size, or the Trimming window’s frame offsets.

When you change to a saved layout, Adobe Premiere opens any windows in the layout that 
are not open. Any currently open windows that are not part of the chosen layout close, 
except those windows not saved in layouts, such as the Clip window.

 

To save a window layout:

 

1

 

Choose Arrange/Layouts from the Windows menu. The Window Layouts dialog box 
appears.
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2

 

Click Add Current to display the Name This Layout dialog box.

 

3

 

Type a name for the layout, and click OK. The name is added to the scroll list, and an 
outline representation of the layout appears in the middle of the dialog box.

 

To change to a saved window layout, use one of the following methods:

 

O

 

Choose Arrange from the Windows menu, and choose the layout you want to use from 
the submenu.

 

O

 

If you want to preview window layouts before selecting one, choose Arrange/Layouts 
from the Windows menu to display the Window Layouts dialog box. As you select layouts 
from the scroll list, their outline representations are displayed. Select the layout you want 
to use and click OK.

 

Note:

 

 You can add frequently used window layouts to the Commands palette for easy access. 
For information on using the Commands palette, see “Using the Commands Palette” 
on page 66.

 

To delete a layout:

 

1

 

Choose Arrange/Layouts from the Windows menu. The Window Layouts dialog box 
appears.

 

2

 

Select the layout you want to delete from the scroll list, and click Delete or press the 
Delete key. Click OK. 

 

To save a layout for use in other projects:

 

1

 

Choose Arrange/Layouts from the Windows menu. The Window Layouts dialog box 
appears.

 

2

 

Click Save, and use the standard Save dialog box to name and store the layout.

 

3

 

To use a saved layout from another project, click Load. Use the standard Open dialog 
box to locate and open the layout. The layout name is added to the scroll list.

 

PRINTING THE CONTENTS OF WINDOWS

 

You can print the contents of the Project window, the Construction window, or a movie 
clip in the Clip window. Printed windows can be useful as a storyboard of your project.

 

To print a paper copy of a window:

 

1

 

Click the Project, Construction, or Clip window to make it active.

 

2

 

Choose Print from the File menu. The Print dialog box appears.

 

3

 

Click Print.
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Chapter 

 

3

 

: Editing

 

his chapter describes the basic techniques used to edit clips and construct a movie 
in Adobe Premiere. This chapter also describes how to generate an Edit Decision 
List (EDL) from the Construction window for online editing of source videotape 

 

in a post-production studio.

Until recent years, video editing was strictly 

 

linear

 

; the entire program of video, audio, and 
special effects segments had to be identified and sequenced together in exact order before 
the final videotape was made. The editing process in Adobe Premiere is 

 

nonlinear

 

; you can 
insert, copy, replace, transform, and delete clips at any time. You can experiment with 
various sequences and effects, previewing the changes before compiling your final movie 
or outputting to videotape.

The following editing operations are presented in this chapter:

 

O

 

Viewing a clip

 

O

 

Setting markers in a clip for precise alignment with other clips and effects in the 
Construction window

 

O

 

Trimming a clip (changing its starting and ending frames)

 

O

 

Setting the duration of a still-image clip

 

O

 

Splitting a clip into two new clips

 

O

 

Insert editing

 

O

 

Changing the speed of a clip to achieve motion effects

 

O

 

Mixing audio clips, which is similar to mixing audio tracks in a sound studio

 

O

 

Modifying clips in other applications, such as Adobe Photoshop

 

O

 

Generating an Edit Decision List

 

Note:

 

 More advanced editing techniques involve applying transitions between clips, superim-
posing clips, and adding motion and special effects to clips. These procedures are presented in 
subsequent chapters.

 

T
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You edit clips in Adobe Premiere using the Clip window, the Construction window, and 
the Trimming window. The Clip window is used mainly for viewing clips, setting in and 
out points in clips, and setting markers in clips. The Construction window is used prima-
rily for arranging clips, splitting clips, inserting clips, layering and compositing clips, and 
mixing audio clips. It can also be used to trim clips and to change the speed of clips. The 
Trimming window is used to precisely adjust the edit point between two clips in the 
Construction window and instantly see the effect of the adjustment.

 

Note:

 

 A special type of window, called the Controller window, is used for previewing an area 
in the Construction window. While previewing with the Controller, you can set markers and 
make cuts across tracks in the Construction window. For information on the Controller 
window, see “Using the Controller” on page 122.

 

USING THE CLIP WINDOW 

 

By default, Adobe Premiere plays a movie or an audio clip in the Clip window from begin-
ning to end, as it was originally recorded. You can use the Clip window to change the 
starting and ending frames of a clip, to change the duration of a still-image clip, and to set 
markers in a clip for aligning with other clips, and for quick navigation.

The Clip window controls are similar for video and audio clips. The frame indicator 
displays the current position in the clip. For still images, the Clip window contains a dura-
tion setting control. 

 

Play buttox

Stop button

Jog/Shuttle

control

Slider

Collapse preview

button

Frame forward

and backward

In point

 indicator

Audio level 

toggle

Play In/Out button

Loop button

Out button

In button

Frame indicator

Clip duration

Waveform

control

In point indicator
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You can collapse the Clip window and use the Clip window controls to view the clip in the 
Preview window. This is useful when you have several Clip windows open on-screen or 
when the Preview window is set to full screen on a separate monitor. You collapse or 
expand the clip using the Preview Window button.

 

Opening a clip in a Clip window

 

In most cases, each time you open a clip, a new Clip window opens. Consequently, you can 
have any number of Clip windows open at the same time. The Clip window initially 
displays the first frame of a movie clip or the waveforms of an audio clip. To reduce the 
screen clutter that can occur if too many windows are open at once, you can optionally 
open a clip in an existing Clip window. 

 

To open a clip in a new Clip window, use one of the following methods:

 

O

 

Double-click the clip’s thumbnail in the Project window or the Construction window. 

 

Note:

 

 To open only the audio portion of a linked clip, double-click the audio waveform portion 
of the thumbnail in the Project window.

 

O

 

Select the clip in the Project window or the Construction window, and choose Open 
Clip from the Clip menu. 

 

O

 

Choose Open from the File menu, and use the Open dialog box to select the clip. 

 

To open a clip in an existing Clip window:

 

Drag the clip’s thumbnail from the Project window to the Clip window. The original clip 
in the Clip window closes and is replaced by the new one. If the Clip window is collapsed, 
drag the thumbnail over the window’s timecode area to display the clip in the Preview 
window.

 

Viewing and playing clips in the Clip window

 

The Clip window controls for viewing video clips and playing audio clips are almost iden-
tical. Although QuickTime does not store audio data as individual frames (audio is stored 
as a continuous data stream), audio clips are synchronized to the frame rate of the movie. 
This allows Adobe Premiere to refer to sections of the audio waveform as frames in the 
same way that it refers to the image frames of a video clip.

Collapse preview button
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To view or play clips in the Clip window, use one of the following methods:

 

O

 

To begin playing the clip, click the Play button. To stop playing the clip, click the Stop 
button. You can also press the spacebar to start and stop playing a clip. 

 

O

 

To play the clip in reverse, hold down the Command key as you click the Play button. 

 

O

 

To play the clip between the in and out points, click the Play In/Out button or hold 
down the Option key as you press the spacebar. To play the clip continuously (loop) 
between the in and out points, press the Loop button or hold down the Control key as you 
press the spacebar. 

 

O

 

 To go forward or backward one frame at a time, click the Frame Forward or Frame 
Backward button, or press the right arrow or left arrow key. To go forward or backward 
five frames at a time, hold down the Shift key while pressing the right or left arrow key.

 

O

 

To scrub forward or backward through portions of the clip, hold the mouse button 
down on the Frame buttons or hold down the right or left arrow key.

 

O

 

To advance the clip by one QuickTime frame at a time, use the arrow keys in combina-
tion with the Command and Shift keys. (Note that the QuickTime frame rate is a movie 
compression setting and is not related to the frame rate of the Adobe Premiere project. For 
more information, see “Setting a Project’s Time Base” on page 29.)

 

O

 

To fast-forward, press the F key. To rewind, press the R key (movie clips only).

 

O

 

To move forward or backward through frames or to jump to another part of the clip, 
drag the slider. 

 

O

 

To move to the beginning of the clip (if you have an extended keyboard), press the Home 
key. Press the End key to move to the end of the clip.

 

O

 

To scrub through the clip frame by frame, click at a point in the Jog control and drag left 
or right. You can continue to drag outside the control area if you don’t release the mouse. 

 

O

 

To change the Jog control to the Shuttle control, Option-click the Jog control. To play 
the clip forward or backward at a variable speed, drag the Shuttle control to the right or 
left. The farther you drag the Shuttle control from the center, the faster the clip plays. 
When you release the mouse button, the clip stops playing, and the Shuttle control moves 
back to the center position. (The mode of this control can also be set in the General Pref-
erences dialog box or by choosing Clip Window Options from the Windows menu.)

 

O

 

To move to the in and out points of a clip or to any place marker, click Goto and choose 
from the pop-up list of markers. You can also press I on the keyboard to move to the in 
point or O to move to the out point.
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O

 

To move to a numbered marker, press a number 0 through 9. To move to the next or 
previous marker, hold down the Command key and press the right or left arrow key. 
Doing so is useful for moving to unnumbered markers.

 

O

 

To move to a specific frame, press Tab or click the current frame indicator to select it; 
enter the exact frame you want to move to (using SMPTE timecode format), and press 
Return. For example, if you enter 0:00:43:05, the clip advances to the frame 43 seconds and 
five frames into the clip. 

 

O

 

To move to the frame at the position of the edit line in the Construction window, 
press T on the keyboard. 

 

O

 

To move forward or backward by a specific duration, press Tab or click the current frame 
indicator to select it; enter the duration using SMPTE timecode format, and press Return. 
For example, enter +5:03 to move forward five seconds and three frames. Enter –1:23 to 
move backward 1 second and 23 frames.

 

O

 

To change the frame numbering format used to count frames in the Clip window, 
choose Clip Window Options in the Windows menu and choose a format from the Count 
pop-up menu.

 

O

 

To mute the linked audio in a video clip, click the speaker icon in the lower right corner 
of the Clip window. The three settings are full volume, half volume, and off.

 

Note:

 

 You can use a JL Cooper or other third-party editing controller with Adobe Premiere to 
facilitate viewing and finding frames of movies in the Clip window.

 

Resizing the Clip window

 

You can resize the Clip window by dragging the resize box. When you do, the clip’s display 
snaps to one of several default sizes. To scale the display to match the size of the Clip 
window, hold down the Shift key while you drag.

 

Viewing the audio waveform in the Clip window

 

You can view the audio waveform in the audio Clip window using one of four different 
views: expanded, normal, condensed, and extra condensed. With the expanded view you 
get the most detail, while the condensed views provide a longer duration of sound in 
the window. 

The audio Clip window can be resized by dragging the lower right corner of the window. 
Stretching the window to full-screen makes it easier to find points and set markers. 
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To expand or condense the audio waveform in a Clip window:

 

Click the Waveform control located above the Jog or Shuttle control to toggle between 
expanded, normal, condensed, and extra condensed. Expanded view provides the most 
detail; condensed views provide a longer duration of sound in the window. 

 

Expanded Normal

Condensed Extra condensed

 

Note:

 

 For trimming audio clips, the audio waveform can be expanded to show increments as 
small as 1/600th second. For information on trimming, see “Trimming Clips” on page 79.

 

To see more detail in the low amplitude portions of the waveform:

 

1

 

Make the Clip window active, and choose Clip Window Options from the Windows 
menu. 

 

2

 

Use the Clip Window Options dialog box to set the Waveform Display option to 
Boosted.

 

SETTING PLACE MARKERS FOR CLIP ALIGNMENT

 

Place markers let you mark points in the time ruler and in clips that can be used for align-
ment with other clips and transitions in the Construction window. For example, you may 
want an audio clip to begin fading in at a particular frame in a video clip. By setting place 
markers in both clips, you can drag one marker to another for precise alignment. 

Markers work in conjunction with the Snap to Edges option in the Construction Window 
Options dialog box. When Snap to Edges is turned selected, a clip in the Construction 
window snaps to a marker in the time ruler when it moves within a limited range of the 
marker. Similarly, markers in clips located on different tracks snap to each other when 
brought within a limited range. 
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Using the Snap to Edges option

 

The Snap tool in the upper left corner of the Construction window indicates whether or 
not the Snap to Edges option is selected.

If you do not want markers to snap directly to the center of each other, deselect the Snap 
to Edges option in the Construction Window Options dialog box. To toggle the option, 
click the snap tool, or press Tab with the Construction window active. 

 

Setting place markers in the time ruler 

 

You can set up to ten place markers in the time ruler to indicate where clips should begin 
or end. You can set markers while previewing a movie or by selecting a point on the 
time ruler. 

 

To set a place marker in the time ruler:

 

1

 

Position the hairline in the time ruler at the desired point. (You do not have to drag the 
mouse; simply move the mouse until the hairline in the time ruler is positioned at the 
desired time.) Make sure that a clip is not selected; otherwise, the marker will be placed in 
the selected clip.

 

2

 

Hold down the Shift key and press a number from 0 to 9. A numbered green marker 
appears in the time ruler. 

 

3

 

Drag a clip to the marker to position it at the desired starting or ending time. If the Snap 
to Edges option is turned on, the left or right edge of the clip will snap to the marker.

Snap tool
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To set a marker in the time ruler from a Controller window:

 

1

 

Choose Controller from the Windows menu. The Controller and Preview windows 
appear.

 

2

 

Use the Controller window controls to locate the movie frame you want to mark. These 
controls function the same as those in a Clip window. For more information on the Clip 
window controls, see “Using the Clip Window” on page 71.

 

3

 

Choose a number from the Mark pop-up list. A numbered marker for the displayed 
frame is set in the time ruler.

 

4

 

To set a marker while the preview plays, hold down the Shift key and press a number 
from 0 to 9. The marker is set in the time ruler. 

 

To delete a place marker in the time ruler:

 

1

 

Position the hairline in the time ruler over the marker you want to delete.

 

2

 

Press C. The marker is deleted. Remaining marker numbers are not reordered.

 

Setting place markers in clips

 

You can set up to 1000 place markers in a clip, but only 10 can be numbered. You can accu-
rately position markers in an audio clip while the sound is playing, simplifying the task of 
synchronizing audio tracks with video tracks. 

Numbered and unnumbered clip markers appear as blue tags in the Construction window 
thumbnails. The display of markers can be toggled on and off with the Show Markers 
option in the Construction Window Options dialog box.

 

To set a place marker in a movie or audio clip:

 

1

 

In the Clip window, find the frame of the clip or the area of the waveform you want to 
mark using any of the methods described in the section, “Viewing and Playing Clips in the 
Clip Window,” on page 72.

 

2

 

To set a numbered marker, select a marker number from the Mark pop-up menu. 
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Adobe Premiere places a bullet next to the number in the Mark menu to indicate that 
the marker is in use, and places the marker with the selected number in the frame or 
waveform. 

 

3

 

To set a numbered place marker while a movie or audio clip is playing, hold down the 
Shift key and press the desired number on the keyboard. 

 

4

 

To set an unnumbered marker, press the asterisk (*) key, equal sign (=) key, or plus (+) 
key. Unnumbered markers can be set while a movie or audio clip is playing.

 

To align place markers in the Construction window:

 

1

 

Make sure that the Show Markers option is on by choosing Construction Window 
Options from the Windows menu. 

 

2

 

Position the selection tool on the marker you want to align with another marker. The 
selection tool turns blue. 

 

3

 

Begin dragging the marker. As you drag, an alignment guide appears through the center 
of the marker to help you align the markers. If the Snap to Edges option is turned on, the 
markers will snap to each other.

 

4

 

Release the mouse button when the markers are precisely aligned. 

Place marker

Marker in clip A

Marker in clip B
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To delete a place marker from a movie or audio clip:

 

To delete a marker from a movie clip in the Clip window, position the pointer over the 
frame containing the marker and press C or X on the keyboard. Remaining marker 
numbers are not reordered. 

To delete a marker from an audio clip in the Clip window, select the marker in the wave-
form and press C or X on the keyboard. Remaining marker numbers are not reordered.

 

Finding place markers in clips

 

You can use the Clip window to find frames that have been marked in a clip.

 

To find a marker, use one of the following methods:

 

O

 

Click Goto and select a numbered place marker from the pop-up list. Bullets indicate 
which markers are in use in the clip. 

 

O

 

Press a number from 0 to 9 on the keyboard to go to a marker.

 

O

 

Move to the next marker or previous marker by using the right or left arrow keys in 
combination with the Command key. 

 

TRIMMING CLIPS

 

Trimming

 

 refers to the adding or subtracting of frames to change a clips’s duration. The 
position of a clip’s starting frame is called the 

 

in point

 

 (sometimes referred to as the 

 

head

 

), 
and the position of the ending frame is called the 

 

out point

 

 (sometimes referred to as the 

 

tail

 

). Clips can be trimmed in the Clip window, the Construction window, or the Trim-
ming window. Of these three, the Trimming window gives you the most precise control 
and instant feedback. 

Changes you make to the in or out point of a clip do not affect the source clip on your hard 
disk; they affect only the way that Adobe Premiere uses the source clip when building a 
movie.

You cannot make a movie or audio clip longer than the source clip unless you use the 
Speed command to slow down the clip and extend its duration. The shortest duration for 
any clip is one frame. The longest duration for any clip is one hour. For more information 
on clip duration and speed, see “Setting the Duration of a Clip” on page 88 and “Setting 
the Forward or Backward Speed of Clips” on page 98.

 

Trimming clips in the Clip window

 

A clip opens in the Clip window at the frame corresponding to the current in point. The 
duration counter shows the duration of the clip from the current in point to the current 
out point.
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Note:

 

 You can use the Clip window to set in and out points for a clip before importing it into 
a project. This is useful for importing various sections of a single clip as separate clips. For 
information on importing clips, see “Importing and Opening Clips” on page 33.

 

To change the in and out points in the Clip window: 

 

1

 

Find the place where you want to set the in point for the clip using one of the methods 
described in the section, “Viewing and Playing Clips in the Clip Window,” on page 72.

 

2

 

Click the In button or press Shift-I to set the in point. 

For movie clips, the in point indicator appears in the upper left corner of the Clip window. 
For audio clips, the in point indicator appears at the corresponding point along the 
waveform. 

 

3

 

Find the place where you want to set the out point for the clip, and click the Out button 
or press Shift-O.

For movie clips, Adobe Premiere places the out point indicator in the upper right corner 
of the window. For audio clips, the out point indicator is placed at the corresponding point 
along the waveform. The duration counter at the bottom of the window shows the new 
duration of the clip. 

In point indicator

Out point indicator
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Note:

 

 Changing the in and out points of a movie clip that is linked to an audio clip will affect 
both the movie and audio portions of the linked clip. 

 

Setting precise in points for audio clips

 

You can position the in point for an audio clip with a high degree of precision when sound 
synchronization is critical. The in points of audio clips can be adjusted in increments as 
small as 1/600th of a second.

 

To set a precise in point for an audio clip:

 

1

 

Zoom in on the audio waveform display by choosing Clip Window Options from the 
Windows menu and choosing a new value for Divisions per Second. 

 

2

 

Use the Frame Forward or Frame Backward button, or press the right arrow or left arrow 
key to go forward or backward one division at a time. 

 

3

 

Click the In button or press Shift-I to set the in point. 

Resolutions of 100 and 600 divisions per second are intended for setting the in point only; 
the audio may not play smoothly at these settings. Set the display resolution to its original 
setting of 30 divisions per second after you set the in point.

 

Finding the in and out points of a clip

 

The Clip window can be used to locate the in and out points of a clip. This is done in the 
same manner as finding place markers in a clip.

 

To find the in and out points, use one of the following methods:

 

O

 

Click Goto and choose In or Out from the pop-up list. 

 

O

 

Press I on the keyboard to go to the in point, or press O to go to the out point.

 

Trimming clips in the Construction window

 

Adobe Premiere provides a number of ways to trim clips in the Construction window. You 
can use the in and out point tools or the ripple edit and rolling edit tools, or you can simply 
drag the edges of the clip. Using the ripple edit and rolling edit tools is described in the 
next section, “Using the Ripple Edit and Rolling Edit Tools in the Construction Window.”

For better trimming precision, choose a low time unit in the Construction window. You 
can also use edge viewing (described in this section) to view the frames in the Preview 
window as you drag the edges of the clip. 

When you change the duration of a clip in the Construction window, the Info, Project, and 
Clip windows are automatically updated with the new clip duration. 
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To trim a clip using the in point and out point tools: 

 

1

 

Select the in point or out point tool in the Construction window by clicking the tool 
icon or pressing I or O on the keyboard. 

 

Note:

 

 If you click the in or out point tool once, the tool reverts to the selection tool after one 
use. Double-click the in or out point tools to use them repeatedly. 

 

2

 

Click the in point tool on the left edge of the first frame you want displayed in the movie.

 

3

 

Click the out point tool on the right edge of the last frame you want displayed in 
the movie. 

 

To trim a clip by dragging:

 

1

 

Position the selection tool on the edge of the clip to be shortened or lengthened. The 
selection tool turns into a stretch pointer.

 

2

 

Drag to shorten or lengthen the clip and release the mouse button when the clip reaches 
the desired length. 

 

To trim a clip using the Edge Viewing option: 

 

1

 

Make sure that the Info and Preview windows are visible on the desktop.

 

2

 

Turn on edge viewing by clicking the edge viewing tool in the upper left corner of the 
Construction window. You can also use the Construction Window Options dialog box to 
select the Edge Viewing option.

In point tool Out point tool

Stretch pointer
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3

 

In the Construction window, position the selection tool on the edge of the clip to be 
shortened or lengthened. The selection tool turns into a stretch pointer.

 

4

 

Begin dragging the edge of the clip. As you drag, the frame corresponding to the clip’s 
adjusted in point or out point is displayed in the Preview window, and the timecode 
addresses for the clip’s starting and ending points are displayed in the Info window.

 

5

 

Release the mouse button when you reach the desired in or out point in the clip. 

 

Using the ripple edit and rolling edit tools in the Construction window

 

The ripple edit tool adjusts the duration of one clip on a track while retaining the duration 
of all other clips on the track. All clips and transitions on other unlocked tracks that are 
placed to the right of the adjustment point are moved along the timeline to match the clip 
movement on the rippled track. (For information on locking tracks, see “Locking Tracks 
in the Construction Window” on page 97.) The effect of the duration change in one clip 
adjusts (ripples) the positions of other clips and may change the total duration of the 
movie. Ripple editing is sometimes called 

 

film-style

 

 editing.
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The rolling edit tool adjusts the duration of one clip, but increases or decreases the dura-
tion of the adjacent clip to maintain the original duration of the two-clip sequence and the 
duration of the entire track. Rolling editing is sometimes called 

 

video-style

 

 editing. When 
performing a rolling edit, you can use Edge Viewing to see the edges of the clip and the 
adjacent clip in the Preview window. For information on setting up Edge Viewing, see 
“Trimming Clips in the Construction Window” on page 81.

 

To trim a clip using the ripple edit tool: 

 

1

 

Choose the ripple edit tool from the extended tools pop-up menu in the lower left 
corner of the Construction window.

You can also access the ripple edit tool by holding down the Option and Command keys 
while the selection tool is active.

 

2

 

Position the mouse pointer on the joint between two clips, and drag to adjust the dura-
tion of the desired clip. The clip’s duration is adjusted without affecting the durations of 
the other clips.
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To trim a clip using the rolling edit tool:

 

1

 

Choose the rolling edit tool from the extended tools pop-up menu in the lower left 
corner of the Construction window.

You can also access the rolling edit tool by holding down the Shift and Command keys 
while the selection tool is active.

 

2

 

Position the mouse pointer on the joint between two clips, and drag to trim the clip. One 
clip’s duration is adjusted, and the other clip’s duration is shortened or lengthened to 
offset the adjustment. 
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Trimming clips in the Trimming window

 

If you want to be as precise as possible when trimming clips, use the Trimming window. 
The Trimming window lets you add or subtract frames from clips at edit points along the 
timeline. While making adjustments, you can see the exact frame that appears on each side 
of the edit point.

When trimming a clip this way, the durations of all other clips on the track remain the 
same, as if you were performing a ripple edit. All clips on other unlocked tracks that are 
placed to the right of the edit point are moved along the timeline to match the clip move-
ment on the rippled track. (For information on locking tracks, see “Locking Tracks in the 
Construction Window” on page 97.) You have the option, however, of using the rolling 
edit tool in the Trimming window. The rolling edit tool adjusts the duration of one clip, 
and increases or decreases the duration of the adjacent clip. Doing so maintains the orig-
inal duration of the two-clip sequence and of the entire track. 

While working in the Trimming window, you can return the edit point to its original loca-
tion by clicking the Reset button.

You can change the display of the Trimming window in a variety of ways. The window can 
display up to five frames on either side of the edit point. You can also set the number of 
frames to manipulate with the add/subtract buttons, and how many seconds to preview 
around the edit point.

If you want to display the Trimming window frames in a Preview window (on the same 
monitor or a second monitor, depending on your computer’s configuration), click the 
Preview window button. The Preview window button toggles the display between the 
Trimming window and the Preview window.

Previous edit point

Jog control

Next edit point

Play button

Frame on left side 

of edit point

Add/subtract

frames

Frame on right side

of edit point

Collapse button

Collapse preview 

button

Total number of frames

added/subtracted

Edit line
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To perform a ripple edit in the Trimming window:

 

1

 

Choose Trimming from the Windows menu. The Trimming window appears. 

 

2

 

Click the Next or Previous button to move the edit line to the point you want to adjust. 
The frames on both sides of the edit point are displayed in the Trimming window. If you 
position the edit line on a transition, the last frame of the clip on track A and the first 
frame of the clip on track B are displayed.

 

3

 

To add or subtract a specific number of frames from the clip on the left side of the edit 
point, click either of the + or – buttons on the left side of the window. To add or subtract 
frames from the clip on the right side of the edit point, click either of the + or – buttons 
on the right side of the window.

 

4

 

To add or subtract a larger number of frames, drag the Jog control on either side of the 
window. The edit line moves in the direction and distance you drag.

Alternately, you can add or subtract frames by clicking one of the time displays and typing 
a new time value.

 

5

 

To preview the new edit, click the Play button. 

 

To perform a rolling edit in the Trimming window:

 

1

 

Choose Trimming from the Window menu. The Trimming window appears.

 

2

 

Move the mouse pointer to the joint between the two frames displayed in the window. 
The pointer changes to the rolling edit tool.

 

3

 

Drag to the left or right to trim the clips. As one clip’s duration is trimmed, the other 
clip’s duration is lengthened.

 

4

 

To preview the new edit, click the Play button. 

 

To change the Trimming window settings:

 

1

 

Make the Project Trimming window active.

 

2

 

Choose Trimming Window Options from the Windows menu. The Trimming Window 
Options dialog box appears.
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3

 

Select a format for displaying the frames on both sides of the edit point. You can display 
the single frame on each side of the edit point, the three frames surrounding the edit point 
on each side, or the five frames surrounding the edit point on each side.

 

4

 

Specify the large-frame offset, which is how many frames to move the edit point with 
the larger numbered plus and minus buttons. The default number is 5 frames.

 

5

 

Specify how many seconds (centered around the edit point) of the clip should play when 
you preview the new edit point.

 

6

 

If you want previews to play at the maximum size available in the Trimming window (or 
in the Preview window if you collapse the Trimming window), select Play Preview at 
Maximum Size.

 

7

 

Click OK. 

 

Setting the duration of a clip

 

You can set the duration of any movie clip, still-image clip, or transition while the Clip 
window is active or while the clip is selected in the Project, Construction, or Sequence 
window. 

A new duration setting changes the out point of a clip. Time-based clips (i.e., movies and 
audio) cannot be lengthened beyond the duration of the original clip unless a slower speed 
is assigned to the clip using the Speed command in the Clip menu. For more information 
on the Speed command, see “Setting the Forward or Backward Speed of Clips” on page 98.

Frame on left side 

of edit point

Frame on right side

of edit point

First frame 

of the source clip


Last frame 

of the source clip
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The default duration of still-image clips is 1 second. You can change the default duration 
of still-image clips using the Preferences option in the File menu.

 

To set the duration for a clip: 

 

1

 

Select the clip in the Project, Construction, or Sequence window, or open the clip using 
one of the methods described in “Using the Clip Window” on page 71.

 

2

 

Choose Duration from the Clip menu. If you are setting the duration of a still-image 
clip, you can click the Duration button in the still-image Clip window. The Clip Duration 
dialog box appears. 

 

3

 

Enter a duration for the clip using SMPTE timecode (Hours:Minutes:Seconds:Frames), 
and click OK. If you selected multiple clips, the Clip Duration dialog box reappears for 
each clip.

 

To set a default duration for still-image clips:

 

1

 

Choose Preferences/Still Image from the File menu. The Still Images dialog box appears. 

 

2

 

Enter a default duration for all still-image clips, and click OK. 

 

PASTING CLIPS OR CLIP ATTRIBUTES IN THE CONSTRUCTION WINDOW

 

Adobe Premiere provides the standard Macintosh editing commands for cutting, copying, 
and pasting clips. The program also contains two additional pasting commands: Paste to 
Fit and Paste Special. 

The Paste to Fit command pastes a copied or cut clip or transition into a selected area of 
the Construction window, and changes the duration (sets a new out point) of the clip to 
fit into the selected area. This feature is especially useful for replacing a clip in the 
Construction window with another clip of the same duration.

The Paste Special command pastes part or all of a clip, or a subset of its attributes (such as 
filters, motion settings, fade control, or transparency settings), into a selected clip or 
selected area of the Construction window. 

 

To paste a clip and change its duration to match a selected area:

 

1

 

Use the Copy command in the Edit menu to copy a clip from the Project, Clip, or 
Construction window. 

 

2

 

Select the area or clip in the Construction window where you want to paste the clip.

 

3

 

Choose Paste to Fit from the Edit menu. 
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To paste a clip and choose how to affect the contents of the Construction window:

 

1

 

Use the Copy command in the Edit menu to copy a clip from the Project, Clip, or 
Construction window. 

 

2

 

Click on a track or a clip in the Construction window to select a destination for pasting 
the clip.

 

3

 

Choose Paste Special from the Edit menu. The Paste Special Settings dialog box appears.

 

4

 

Click Content to select a method for pasting a clip into the Construction window. The 
Content options allow you to adjust the duration of clips in the Construction window to 
accommodate the pasted clip, or vice versa. An animated representation of the resulting 
paste operation is provided in the Paste Special dialog box. 

 

5

 

Choose from the following Content options: 

 

O

 

Normal. Pastes the source (copied) clip onto the destination (paste) area you select. If 
the source clip is larger than the destination area, the source clip’s out point is adjusted to 
fit the destination area. However, if the source clip is smaller than the destination area, the 
unused portion of the destination area remains blank (black). 

 

O

 

Move Source Out Point. Adjusts the source clip’s out point to fit the destination space. 

 

O

 

Move Destination In Point. Adjusts the destination clip’s in point to accommodate the 
duration of the source clip. 

 

O

 

Move Source In Point. Adjusts the source clip’s in point to fit the clip into the destination 
space. 

 

O

 

Move Destination Out Point. Adjusts the destination clip’s out point to accommodate 
the duration of the source clip. 
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O

 

Change Speed. Increases or decreases the source clip’s speed (and, as a consequence, its 
duration) to accommodate the destination space. If the destination space is smaller than 
the source clip, the speed of the clip increases. If the destination space is larger than the 
source clip, the speed decreases. For more information on changing a clip’s speed, see 
“Setting the Forward or Backward Speed of Clips” on page 98.

 

O

 

Shift Linked Tracks. Shifts all clips on the track (and linked clips on other tracks) to 
accommodate the duration of the source clip (which may initially be smaller or larger than 
that of the destination area). 

 

O

 

Shift All Tracks. Shifts clips on all tracks to accommodate the duration of the source clip. 

 

6

 

Click Paste.

 

To paste a clip’s attributes to other clips:

 

1

 

Use the Copy command in the Edit menu to copy the clip in the Construction window 
whose attributes you want to paste.

 

2

 

Select the clip onto which you want to paste the attributes.

 

3

 

Choose Paste Special from the Edit menu. The Paste Special Settings dialog box appears.

 

4

 

Click Settings to select options for pasting the filters, motion settings, fade controls, 
or transparency settings from the clip on the Clipboard to the clip selected in the 
Construction window. 

 

5

 

Click Paste. 

 

SPLITTING CLIPS

 

This section describes how to use the Construction window to split a single movie or 
audio clip into two or more independent clips. It also describes how to split multiple clips 
and how to select and move a block of clips.

When you split a clip, you are actually creating two copies of the clip, and the Project 
window is updated to show two clips instead of one. Both clips still point to the entire 
source clip. If you split the video or audio portion of a linked clip, both parts of the clip 
are affected. 

To split a clip at a precise frame, you can first split it at an approximate location and then 
use the Trimming window to refine the cut to the exact frame. Although you cannot rejoin 
the new clips into one clip, you can restore either of the split portions to the original clip 
by using the Trimming window to adjust the cut point. For information on using the 
Trimming window, see “Trimming Clips in the Trimming Window” on page 86.
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You can lock a track in the Construction window so that clips on the track are not affected 
by editing on other tracks. For more information on track locking, see “Locking Tracks in 
the Construction Window” on page 97.

 

To split a clip into two clips:

 

Select the razor tool in the Construction window, and click anywhere on the clip. The clip 
splits into two separate clips, and a new clip is added to the Project window. Each clip 
reflects its individual duration, with new settings for the in point or out point. 

You can hold down the Option key when using the razor tool to split the clips on all 
unlocked tracks.

For more precision when splitting a clip, you can change the time unit in the Construction 
window to display more frames, or you can use the zoom tool to zoom in on the area.

 

Note:

 

 Double-click the razor tool (or hold down the Shift key and press R on the keyboard) to 
use the tool for more than one operation. 

 

To move or copy a block of clips using the block select tool:

 

1

 

Select the block select tool in the Construction window, and drag to create an area of 
equal width across all tracks. 

 

2

 

Move the block select tool anywhere inside the selected area. Press the Control key if you 
want to move the block selection, or press the Option key if you want to copy it.

 

Note:

 

 If you do not use the Control or Option key with the block select tool, the tool functions 
as a virtual clip selector. For more information on virtual clips, see “Working with Virtual 
Clips” on page 103.

Razor tool
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The pointer turns into the hand tool. 

 

3

 

Drag to move or copy the selected block of clips to a valid area; then release the mouse 
button. (A 

 

valid area

 

 is an empty area of equal or greater width than the selected block of 
clips. When you locate a valid area, all tracks in the Construction window are highlighted.) 

The block of clips is placed in the new location in the Construction window. The Project 
window is updated to show any new clips that were created.

 

Selected block of clips moved to a new location

 

Note:

 

 If you include linked clips in your copied selection, the new set of clips will not retain the 
original links. 

 

PERFORMING INSERT AND OVERLAY EDITS

 

There are three types of insert edits that you can perform in the Construction window. 
Adobe Premiere lets you drag a clip between existing clips in the Construction window. 
You can also split clips at a point in the time ruler and insert or overlay a clip. As a third 
option, you can insert a clip by setting the work area to a specific location and size and 
then replacing the frames under the work area with the same number of frames from the 
new clip. 
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When inserting clips, you can protect clips and transitions on other tracks from shifting 
by locking them. Clips on locked tracks do not shift when you perform an insert edit. 
Locking tracks is useful, for example, if you want to insert a video clip in your movie but 
you do not want to alter an audio track. For information on locking tracks, see “Locking 
Tracks in the Construction Window” on page 97.

 

Inserting a clip between two clips

 

You can drag a clip between existing clips in the Construction window. When you insert a 
clip between two clips, the clips and transitions on all unlocked tracks shift over (ripple) 
to make room for the new clip. 

 

To insert a clip between two clips in the Construction window:

 

Drag the clip from the Project, Clip, or Construction window to the joint between two 
clips. (From the Project window, you can select multiple clips to insert.) The joint will 
highlight when the clip is positioned correctly. When you release the mouse button, the 
clip is inserted, and all clips and transitions on unlocked tracks shift to the right to make 
room for the new clip.

 

Before insert

After insert

 

Inserting or overlaying clips using the edit line

 

You can split clips at the edit point in the timeline to insert a clip onto track A. When you 
insert a clip this way, you can shift the contents of all unlocked tracks to the right of the 
split to make room for the new clip, or you can overlay the new clip on the existing mate-
rial to the right of the edit point. If you overlay the new clip on existing material, the full 
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length of the clip between the in and out points is overlaid. Depending on the material to 
the right of the edit point, you may replace frames from more than one clip; wherever the 
new clip ends, a new cut point appears.

 

To insert or overlay a clip using the edit line:

 

1

 

Click in the dark gray area above the time ruler to move the edit line to the point in the 
Construction window where you want to insert or overlay a clip. 

The Controller window appears, and the frame under the edit line appears in the Preview 
window. 

 

2

 

To move the edit line to the exact location for the split, drag the playback head in the 
Construction window. You can also use the Controller window to precisely position the 
edit line. For information on using the Controller window to position the playback head, 
see “Using the Controller” on page 122.

 

3

 

Select the clip you want to insert or overlay from the Project, Library, or Sequence 
window, or open the clip in a Clip window using one of the methods described in 
“Opening a Clip in a Clip Window” on page 72.

Edit line

Playback head
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4

 

To insert the clip on track A and shift the contents of other tracks, choose Copy to 
Construction/Insert at Edit Line from the Edit menu. The clips and transitions on all 
unlocked tracks split at the edit point and shift to the right to make room for the clip 
inserted onto track A. 

The Insert at Edit Line command inserts the clip in the Construction window and adds a 
copy of the clip and the new clips created by the split to the Project window.

 

5

 

To overlay the clip on track A, replacing the frames to the right of the split, make the Clip 
window active and choose Copy to Construction/Overlay at Edit Line from the Edit menu. 
Only the clip on track A is split at the edit point, and the new clip replaces frames to the 
right of the split. 

The Overlay at Edit Line command inserts the clip in the Construction window and adds 
a copy of the clip and the new clips created by the split to the Project window.

Inserted clip

Inserted clip
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Inserting clips to fill the work area

 

You can insert a clip by setting the work area to a specific location and size and then 
replacing the frames under the work area with the same number of frames from the new 
clip. The clips on track A are split at the beginning and end of the work area, and the new 
clip fills the space between. 

 

To insert a clip over frames in the work area:

 

1

 

Position the work area over the location where you want to insert the clip. For informa-
tion on positioning the work area, see “Compiling Effects and Transitions” on page 123.

 

2

 

Select the clip you want to insert from the Project, Library, or Sequence window, or open 
the clip in a Clip window using one of the methods described in “Opening a Clip in a Clip 
Window” on page 72.

 

3

 

Choose Copy to Construction/Replace Work Area from the Edit menu.

The Replace Work Area command inserts the clip in the Construction window and adds a 
copy of the clip and the new clips created by the split to the Project window. 

 

LOCKING TRACKS IN THE CONSTRUCTION WINDOW

 

Tracks in the Construction window can be locked so that clips or transitions on the track 
are not affected by clip movement on other tracks during certain editing procedures. Track 
locking is particularly useful, for example, if you want to insert a video clip in your movie 
but you do not want to affect clips on an audio track. Conversely, you may want to edit an 
audio clip without affecting clips on a video track. This type of editing is often referred to 
as “L” editing.

A locked track is marked by orange and yellow bars across the label. 

 

To lock or unlock a track in the Construction window:

 

Use one of the following methods: 

 

O

 

Option-click the track label located to the right of the track. 

 

O

 

Choose Locking from the Window menu, and click the track name in the Lock window. 
Locked tracks are indicated by a padlock icon in the Lock window.

Track label
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If you want the Lock window to remain in front of other Adobe Premiere windows, choose 
Float from the pop-up menu in the upper right corner of the window.

 

SETTING THE FORWARD OR BACKWARD SPEED OF CLIPS

 

You change a clip’s speed by applying a rate factor or setting a new duration for the clip in 
the Clip Speed dialog box. The default clip speed is 100 percent for both movie and audio 
clips. You can set a speed from between –10,000 percent and 10,000 percent—a negative 
percentage causes the clip to play backwards. When you change a clip’s speed, the Project 
and Info windows reflect the new setting.

Changing the clip speed effectively reduces or multiplies the number of frames in the orig-
inal clip; this affects the quality of motion in movie clips and the quality of sound in audio 
clips, as well as the clip’s duration. For example, setting a movie clip’s speed to 50 percent 
(or doubling its duration) creates a slow-motion effect by doubling the number of frames 
and extending the clip’s original duration; setting its speed to 200 percent (or halving its 
duration) doubles the speed of the clip, creating a high-speed effect and halving the clip’s 
original duration. 

 

Note:

 

 If you are working with 60 fields-per-second clips, and you slow down the clip speed, 
make sure that Deinterlace When Speed is Below 100% is selected in the Field Options dialog 
box. Similarly, if you are working with 60 fields-per-second clips, and you are reversing the 
clip’s direction, make sure that Reverse Field Dominance is selected in the Field Options dialog 
box. Setting these field options eliminates possible jerky motion. For more information on 
working with fields, see “Full-Field Processing of Clips” on page 213.

 

To set the speed for a movie or audio clip:

 

1

 

Select the movie or audio clip from the Project window or the Construction window.

 

2

 

Choose Speed from the Clip menu. 

 

3

 

Enter a rate value from –10,000 percent to 10,000 percent for the New Rate, or enter a 
new duration in SMPTE timecode format. A negative percentage causes the clip to play 
backwards.

 

4

 

Click OK. 
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The movie or audio clip is set to the new speed, and the speed value is displayed next to 
the clip type in the Project window. If you selected multiple clips, the Clip Speed dialog 
box reappears for each clip.

 

CREATING FREEZE-FRAMES FROM VIDEO CLIPS

 

You can 

 

freeze

 

 on the specific frame in a clip that you want to hold for the duration of the 
clip. Doing so creates the same effect as a still image. You can freeze on the clip’s in point, 
or its out point, or at marker 0. 

 

To create a freeze-frame:

 

1

 

Set the in or out point on the frame on which you want to freeze. Alternately, place 
marker 0 at the frame. For information on setting in and out points, see “Trimming Clips” 
on page 79. For information on setting place markers, see “Setting Place Markers in Clips” 
on page 77.

 

2

 

Select the clip in the Construction window, and choose Frame Hold from the Clip 
menu. The Frame Hold dialog box appears.

 

3

 

Choose In Point, Out Point, or Marker 0 from the pop-up menu. 

 

4

 

If you are working with 60 fields-per-second video, select Deinterlace to remove any 
jittering that could be caused by freezing on a frame. For information on working with 
fields, see “Full-Field Processing of Clips” on page 213.

 

5

 

Click OK.

 

SEPARATING AND REJOINING LINKED CLIPS

 

At times, you may want to separate the linked audio and video portions of a clip in the 
Construction window so that the audio can lead the video, or vice versa. You can do this 
by breaking the link completely or by temporarily releasing the link and repositioning a 
portion of the clip. 

Speed at 65%

Normal speed setting (100%)
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You can have two types of links between audio clips and video clips in Adobe Premiere. 
When the linked audio and video clips originate from the same movie file, they are 

 

hard 
linked

 

, and only one clip appears in the Project window. A hard link is established before 
the clip is imported into an Adobe Premiere project. After a hard link is broken, two sepa-
rate clips are created. A hard link cannot be reestablished. 

A 

 

soft link

 

 is a link made in Adobe Premiere’s Construction window. You can create a soft 
link between any audio clip and any video clip in the Construction window (provided that 
the clips are not already part of a hard link). Soft linking provides a way to rejoin clips that 
were once hard linked. A soft link behaves just like a hard link, but the linked clips remain 
as separate entities in the Project window. 

 

To break a hard or a soft link:

 

1

 

Select the clip in the Construction window.

 

2

 

Choose Break Link from the Edit menu. 

The audio and video portions then become separate clips, allowing you to arrange them 
separately in the Construction window. An unnumbered marker is assigned to the 
midpoint of the newly independent audio and video clips. You can synchronize audio and 
video clips by aligning the markers in the Construction window. For more information on 
aligning clips, see “Setting Place Markers for Clip Alignment” on page 75.

 

To create a soft link between an audio clip and a video clip:

 

1

 

Select an audio or video clip in the Construction window.

 

2

 

Choose the soft link tool from the extended tools pop-up menu in the lower left corner 
of the Construction window.

 

3

 

Click the clip that you want to link. If the clip is already part of a hard link, you cannot 
include it in a soft link. If the clip is already part of another soft link, the new soft link will 
replace the old soft link. 
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To temporarily release a link for positioning:

 

1

 

Choose the link override tool from the extended tools pop-up menu in the lower left 
corner of the Construction window. 

 

2

 

Select the video or audio portion of the linked clip and drag it to the desired location.

The selected portion will move independently of the linked portion. The link is reestab-
lished when you release the keys and mouse button. Small, red triangles appear on the left 
edge of the video and audio portions of the linked clip to indicate that the video and audio 
are now out of sync. Click on either of the triangles to see by how many frames the video 
and audio are out of sync.

 

Note:

 

 Links are also temporarily released when you cut the video or audio portion of a linked 
clip from the Construction window. The link is reestablished when the cut portion is pasted 
from the Clipboard back into the Construction window. For information on pasting clips in 
the Construction window, see “Pasting Clips or Clip Attributes in the Construction Window” 
on page 89.

 

MIXING AUDIO CLIPS

 

You can have up to 99 audio tracks playing simultaneously in an Adobe Premiere movie. 
Layering the audio clips on these tracks is similar to sound mixing in audio and television 
production.

The thumbnails for audio clips show images of audio waveforms. Each audio track has an 
Audio Fade control that lets you adjust the volume, or levels, of the clip. By default, the 
Audio Fade control is initially set to mid-volume, which is equivalent to 0 decibels on the 
meter of a tape recorder. 

You can also adjust the gain of the entire audio clip while leaving intact any levels adjust-
ments that have been made to the clip. 
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To adjust the levels of an audio clip:

 

1

 

Position the pointer on the middle line in the Audio Fade control section at the bottom 
of an audio track in the Construction window. The pointer changes to the finger pointer.

 

2

 

Click to create a handle (a black dot). You can create as many handles as needed. 

 

3

 

To delete a handle, drag it out of the Audio Fade control area.

 

4

 

Drag the handles up or down to define when the audio clip fades in or out. 

A line appears between the handles, indicating whether the audio clip is fading in or out: 
an ascending line shows audio fading in; a descending line shows audio fading out. The 
Info window is updated as you adjust the Audio Fade control.

 

5

 

To adjust a segment between two handles uniformly, choose the fade adjustment tool 
from the extended tools pop-up menu in the lower right corner of the Construction 
window, and drag the segment up or down. 
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6

 

To make a cut in the Audio Fade control, choose the fade scissors tool from the extended 
tools pop-up menu in the lower left corner of the Construction window, and click in the 
Audio Fade control. Doing so creates two handles next to each other. These handles are 
useful for making adjustments that sharply increase or decrease the volume for the clip 
at a point.

 

To adjust the gain of an audio clip:

 

1

 

Select the audio clip in the Construction window.

 

2

 

Choose Gain from the Clip menu.

 

3

 

Enter a value from 1 percent to 200 percent.

The horizontal line representing mid-volume is reset to reflect the percent value entered. 
Previous adjustments made to the Audio Fade control do not change.

 

Note:

 

 You can increase the gain if your original recording was recorded too softly; however, 
increasing the gain of a well-recorded audio clip may cause distortion. The distortion may not 
be noticeable through the Macintosh computer’s built-in speaker. For the best audio results, 
you should adjust the levels of the recording before digitizing it.

 

WORKING WITH VIRTUAL CLIPS

 

Adobe Premiere allows you to treat any segment of tracks along the time ruler as an inde-
pendent clip, called a 

 

virtual clip

 

. A virtual clip is a link to all clips in a selected segment of 
the Construction window. With virtual clips you can do things like mix the A and B video 
sources with a transition, and then apply motion settings to the mix, or use the mix as a 
source in another transition. Any changes you make to the source clips of a virtual clip 
affect the virtual clip.

Creating a virtual clip is similar to creating an independent block of clips. Once you create 
a virtual clip, it is treated like an ordinary clip. It can be placed on any video or audio track 
in the Construction window, and it can be moved, copied, and pasted like any other clip. 
You can also apply motion settings and filters to a virtual clip.

A virtual clip can be used as a source clip in another virtual clip. Adobe Premiere allows 
an original clip to be used in up to 64 generations of virtual clips. The default depth setting 
is eight levels. You can change this setting by choosing Preferences/Virtual Clips from the 
File menu. From the Maximum Depth pop-up menu, choose a new limit for levels.

Adobe Premiere uses a feature called 

 

safe layers

 

 that affects the way the track selector works 
when virtual clips are included on a track. To preserve virtual clips as they were originally 
created, the track selector includes all tracks that contain source clips for the virtual clips 
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on the selected track. When the selected track is moved in the Construction window, all 
other tracks associated with the virtual clips are moved accordingly. In this way, the virtual 
clips are preserved. Safe layers is the default mode for working with tracks. The option can 
be turned off by deselecting the Maintain Virtual Clip Source Areas option in the General 
Preferences dialog box.

For illustrated examples of how to use virtual clips, see “Using Virtual Clips to Nest Tran-
sitions” on page 276 and “Creating a 360-Degree Presentation” on page 278.

 

Creating virtual clips

 

For creating virtual clips, it is recommended that you designate an area of your Construc-
tion window that is outside the time ruler of your actual movie, preferably before the 
beginning of the movie. This will minimize confusion over safe layers and ensure that you 
don’t inadvertently make changes to the source clips of your virtual clips as you edit 
your movie. 

 

To create a virtual clip:

 

1

 

Select the block select tool by clicking its icon in the Construction window or by 
pressing B on the keyboard. 

 

2

 

Drag to create a block that encompasses all tracks across the desired segment of 
the time ruler. 

 

3

 

Move the block select tool anywhere inside the block. The pointer turns into the virtual 
clip pointer.

 

4

 

Click inside the block and drag to the desired location in the Construction window. 
A valid location for the clip is indicated by a solid black box the size of the clip.

Virtual clip pointer
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5

 

Place the virtual clip at the desired location by releasing the mouse button.

 

Note:

 

 You can create a virtual clip of only the video tracks or the audio tracks by holding down 
the Option and Shift keys while clicking inside the block selection.

 

To find out where a virtual clip originated, use one of the following methods:

 

O

 

Double-click the virtual clip in the Construction window.

 

O

 

Select the virtual clip in the Construction window and choose Find Clip from 
the Clip menu.

A block area showing the boundaries of the original selection is displayed in the 
Construction window. 

 

Viewing virtual clips

 

You can view a virtual clip in the Construction window by name or by icon. The name 
view includes the starting and ending points of the virtual clip’s origin in the Construction 
window. In icon view, the thumbnails show a compiled version of the clip. These may take 
considerable time to generate, especially if there are virtual clips within virtual clips. For 
faster repainting of the Construction window, the default view of virtual clips is set to 
viewing by name.

 

To display virtual clip thumbnails in the Construction window:

 

1

 

Choose Preferences/Virtual Clips from the File menu. The Virtual Clip Preferences 
dialog box appears.

 

2

 

Deselect the option for viewing virtual clips by name only.
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Applying filters to virtual clips

 

It can take considerable time for Adobe Premiere to preview, compile, or even generate 
icons for virtual clips if they include the use of many filtered clips. 

 

To set options for applying filters to virtual clips:

 

1

 

Choose Preferences/Virtual Clips from the File menu. The Virtual Clip Preferences 
dialog box appears.

 

2

 

Choose one of the following options for controlling how video filters are applied to 
virtual clips:

 

O

 

Never leaves out any of the source clip’s filters when compiling virtual clips. 

 

O

 

Always includes all filters when compiling both the thumbnails and the final movie. 

 

O

 

Larger than Icons applies filters only when the final movie is compiled. This option 
improves performance when thumbnails are being generated in the Construction 
window. 

 

CREATING BACKGROUND COLOR MATTES AND BACKDROPS

 

Adobe Premiere lets you create a full-frame matte of solid color that can be used as you 
would a clip. This feature is useful, for example, if you want to superimpose titles over a 
solid-colored background. It is also useful when you want to fade to black in your movie.

You can also create a grayscale backdrop pattern using a frame from a movie or from a 
still-image clip. The backdrop pattern contains a variable number of tiles—the number of 
tiles is determined by the original image size. You can color the backdrop image after you 
open it in a Clip window in Adobe Premiere.

 

To add a background matte:

 

1

 

Choose Add Color Matte from the Project menu. The color picker appears.

 

2

 

Select a color for the matte using the color picker, and click OK. The Color Matte dialog 
box appears. For information on using the color picker, see “Using the Apple and Premiere 
Color Pickers”on page 143.

 

3

 

Enter a name and duration for the new matte, and click OK. The matte appears as a 
Background Matte clip in the Project window, listed alphabetically under its assigned 
name. 

 

4

 

Drag the matte from the Project window to a video track in the Construction window. 
You can lengthen the matte’s playing time by dragging either edge of the matte. If you want 
to reuse the matte later, use the Library feature to store the matte.
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To export a frame as a backdrop:

 

1

 

From a Clip window, select the single frame from which you want to create the grayscale 
tiled image. 

 

2

 

Choose Export/Frame as Backdrop from the File menu. The Save Backdrop As dialog 
box appears. 

 

3

 

Type a name for the backdrop file, and click Save. The backdrop opens in a special 
backdrop Clip window. 

 

4

 

Use the controls in the Clip window to color the tiled image. The number of tiles created 
in the image is determined by the original size of the image. 

 

To add color to a backdrop:

 

1

 

Open the backdrop image using the Open command from the File menu. The grayscale 
tiled image appears in a Clip window. 

 

2

 

Use the Shadow, Shade, and Hilite sliders to color the corresponding parts of the 
backdrop image. 

 

EDITING CLIPS IN OTHER APPLICATIONS

 

This section discusses how to export clips and edit them in other graphics applications. 
For example, you can export a clip to Adobe Photoshop, modify the clip, and then reopen 
the file in Adobe Premiere. 
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Exporting clips for editing in other applications

 

You can export a movie clip or a section of the Construction window as a filmstrip. You 
can then modify the filmstrip in Adobe Photoshop. You can also export a frame of a clip 
as a PICT file and modify the file in an image-editing application such as Adobe 
Photoshop.

You can export an audio clip as an AIFF (audio interchange file format) file and modify it 
in a sound-editing application such as Macromedia’s Sound Edit.

 

To export a frame as a PICT image:

 

1

 

From the Clip window, select the single frame you want to save as a PICT image.

 

2

 

Choose Export/Frame as PICT from the File menu. The Save Frame As dialog box 
appears. 

 

3

 

Type a name for the file and click Save. 

 

To export a clip as a filmstrip:

 

1

 

From the Clip window, select only the frames you want to modify in Adobe Photoshop 
by setting the in and out points in the clip. 

 

2

 

Choose Export/FilmStrip File from the File menu. The Save FilmStrip As dialog box 
appears.

 

3

 

Choose a frame rate between 1 fps and 30 fps from the Frame Rate pop-up menu at the 
bottom of the dialog box, or enter a value in the Frame Rate field. 

 

4

 

If you are exporting full-screen (640 pixels by 480 pixels), 60 fields-per-second video, 
select one of the Separate Fields options: Separate Fields (1) if the video is field 1 dominant 
or Separate Field (2) if it is field 2 dominant.

For information on working with fields, see “Full-Field Processing of Clips” on page 213.

 

5

 

Type a name for the file, and click OK. 

 

Note:

 

 You can also create a filmstrip with the Make Movie command by selecting the 
FilmStrip option in the Output Options dialog box. In this manner, you can create 
filmstrips from all or part of the Construction window. For more information on output 
options, see “Selecting the Output File Type” on page 211.
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To export an audio clip to an AIFF file:

 

1

 

Open the audio clip you want to export as an AIFF file. 

 

2

 

Choose Export/AIFF Audio File from the File menu. The Save AIFF File dialog box 
appears.

 

3

 

Choose the desired options for audio rate and audio format, and click Save.

 

Modifying filmstrips in Adobe Photoshop

 

The filmstrip you open in Adobe Photoshop is a single file that contains all the frames of 
the clip and has been saved in the FilmStrip file format. If your original clip was recorded 
with its timecode and a reel name, this information will be preserved in the filmstrip.

After saving the edited filmstrip in Adobe Photoshop, you can use the filmstrip as a clip in 
any Adobe Premiere project. You can also use Adobe Premiere to create a QuickTime 
movie of the edited filmstrip.

 

To modify a filmstrip in Adobe Photoshop:

 

1

 

Open Adobe Photoshop, and import the filmstrip as follows:

 

O

 

In Photoshop 2.5 or higher, open the filmstrip using the Open command in the File 
menu.

 

O

 

In Photoshop 2.0, use the Acquire command in the File menu to import the filmstrip.

The filmstrip opens as a series of frames in a column, with each frame labeled by number 
and timecode. The number of frames displayed depends on the duration of the clip and 
the frame rate you selected when you created the filmstrip. 
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2

 

Make the desired modifications to the filmstrip.

When editing a filmstrip in Adobe Photoshop, use the following guidelines for best results:

 

O

 

Channels 1 through 4 (RGB and alpha) can be freely edited; if you are using Photoshop 
2.0, do not edit or delete channel 5. 

 

O

 

Do not resize or crop the filmstrip. 

 

O

 

You can draw on the gray lines dividing the frames of the filmstrip without affecting the 
file’s structure. 

You can cut, copy, move, and paste selections just as you would in a normal Photoshop 
file. In Photoshop 2.5, use the Shift key and arrow keys in conjunction with Photoshop’s 
normal keystroke operations to align selections from frame to frame as follows:

 

O

 

To cut a selection and move it to the same position within an adjacent frame, hold down 
the Shift key and press the up arrow or down arrow keys.

 

O

 

To copy a selection and move it to the same position within an adjacent frame, hold 
down the Option and Shift keys and press the up arrow or down arrow keys.

Cloning out the hand 

from the image



 

Premiere User Guide 6/1/94 10:36 c3.pdf.frame

 

Right master page

 

O

 

To move only a selection border to the same position within an adjacent frame, hold 
down the Command, Option, and Shift keys and press the up arrow or down arrow keys.

 

3

 

With an extended keyboard, view the filmstrip as a simulated movie clip and preview 
your modifications by holding down the Shift key and pressing Page Up or Page Down to 
display the frames in sequence. For the best preview, resize the window to slightly larger 
than a single filmstrip frame.

 

4

 

If you are using Photoshop 2.5, save your modifications using the Save or Save As 
command, saving the file in the FilmStrip file format. With Adobe Photoshop 2.0 you 
must export the file by choosing Export/FilmStrip from the File menu.

 

Note:

 

 Only images that were exported from Adobe Premiere in the FilmStrip file format can 
be saved or exported in the FilmStrip file format from Adobe Photoshop. 

 

5

 

Import the filmstrip into an Adobe Premiere project using the Import command 
from the File menu, or open the file in a Clip window using the Open command 
from the File menu.

 

To create a QuickTime movie from a filmstrip:

 

1

 

Import the filmstrip into an Adobe Premiere project.

 

2

 

Drag the filmstrip clip to a portion of the Construction window.

 

3

 

Compile the filmstrip into a QuickTime movie by using the Make Movie command. 
For information on compiling movies, see “Compiling a Movie” on page 208. 

 

CREATING PICT STORYBOARD IMAGES

 

Adobe Premiere allows you to mark frames in a movie, arrange the frames in storyboard 
fashion, and export the arrangement as a PICT image. The PICT image can be opened and 
printed from Adobe Premiere, Adobe Photoshop, or any other application that can 
support PICT images.

 

Exporting frames as a storyboard

 

When you export frames of a clip as a storyboard, the frames appear in the storyboard in 
the following order: in point marker, numbered markers 0 through 9, unnumbered 
markers in the order they appear in the clip, and out point marker. You can spread the 
storyboard out over several pages. When you save the storyboard, additional PICT image 
files will be automatically created as needed, and they will be saved with the filename and 
a number to identify the page order. 
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To export frames of a clip as a storyboard:

 

1

 

Open the clip in a Clip window.

 

2

 

Set markers in the clip for the frames you want displayed in the storyboard. For more 
information on using markers, see “Setting Place Markers for Clip Alignment” on page 75.

 

3

 

Choose Export/Storyboard Image from the File menu. The Save Storyboard dialog box 
appears.

 

4

 

Specify the image size for the storyboard. As you type the horizontal and vertical pixels, 
the storyboard preview on the right side of the dialog box changes to reflect the new size.

 

5

 

Use the slider controls to specify the arrangement of storyboard images on the page. A 
single page can have up to 64 images. 

 

6

 

Click Save, and type in a name for the storyboard to export it as a PICT image file.

 

Printing storyboard images

 

Storyboard image files created with Adobe Premiere behave like any other PICT image file. 
You can open a storyboard in Adobe Premiere by choosing Open from the File menu. The 
storyboard opens as a still-image clip, which you can print by choosing Print Window 
from the File menu. You can also open a storyboard in image-processing applications such 
as Adobe Photoshop or in page layout programs.

 

GENERATING AN EDIT DECISION LIST

 

This section describes how to generate an Edit Decision List (EDL) from the Construction 
window for online editing of source videotape in a post-production studio.

 

About online and off-line editing

 

Adobe Premiere can be used for both 

 

online

 

 and 

 

off-line

 

 editing of digital video. Tradition-
ally, online editing has meant working with original (source) videotapes to produce a 
master tape for broadcast or distribution. This requires use of high-end video equipment 
that is usually found only in high-cost editing suites. With digital video, online editing is 
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essentially editing for final finished output. If you are using Adobe Premiere to create a 
QuickTime movie or to output a movie to videotape, then you are performing online 
editing.

Off-line editing has traditionally meant working with copies of original tapes and low-cost 
equipment to make edit decisions. The edit decisions are recorded in an Edit Decision List 
(EDL). The EDL contains a list of all of the clips, transitions, and special effects in the 
movie. It is used to assemble a new movie (master) from the source tapes in an online 
editing suite. Off-line editing allows you to use expensive online editing time more 
efficiently.

With Adobe Premiere, you have the ability to create machine-readable EDLs from your 
digitized source video. Unlike many off-line systems, Adobe Premiere shows you what a 
transition effect will look like. Also, you don’t have to watch the off-line edit from begin-
ning to end. Adobe Premiere allows you to preview any part you need to see.

 

Exporting an Edit Decision List

 

Adobe Premiere allows you to export EDLs to many different formats, including the CMX 
3400, CMX 3600, Grass Valley, Sony BVE, and any additional third-party plug-in 
modules. When you create an EDL in Adobe Premiere, the visual editing decisions you 
make in the Construction window are recorded in the EDL in text format. Once you have 
exported the edit decisions to any of the EDL formats, you can view and print the EDL by 
opening it in Adobe Premiere or any word processor that supports a monospaced font 
(such as Courier or Monaco), or output the EDL to a format that can be read directly by 
the editing system. 

 

Note:

 

 If you plan to export your EDL to the CMX or Grass Valley format, the file must be 
written to an appropriately formatted floppy disk. Third parties offer products that create 
CMX-compatible and Grass Valley-compatible file format diskettes on the Macintosh.

 

If you intend to create videotapes from an EDL, it is important to work closely with a post-
production house to achieve the best possible results. In general, Adobe Premiere provides 
many special effects that are unavailable on traditional editing systems, and the post-
production editor can suggest alternate effects to use before assembling the final movie.

 

Note:

 

 To avoid confusion when working with EDLs, you should use a time base of 29.97 fps in 
the Construction and Clip windows. If you set a time base of 30 fps, Adobe Premiere counts 
video frames in true 1/30ths of a second. Because all NTSC video is 29.97 fps, the timecode 
displayed in the Clip window may not match exactly with visual timecode that is superim-
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posed on the video image (window dub). When an EDL is generated, however, Adobe 
Premiere makes the necessary adjustments so that the timecode burned into the source 
video matches the timecode in the EDL.

 

To export a project to an Edit Decision List:

 

1

 

Make sure that all the clips in your Construction window have been assigned a timecode 
either at the time they were captured or later by entering the timecode using the Timecode 
command in the Clip menu. If you do not set the timecode for a clip, Adobe Premiere 
assumes a starting time of 00:00:00:00. For more information on setting timecode, see 
“Setting the Timecode for Clips” on page 119.

 

2

 

Choose Export from the File menu and the desired EDL format from the submenu. 
The Save EDL dialog box appears.

For most EDLs, you can enter the following options for the recording reel:

 

O

 

Title for This EDL. Enter the title you want displayed in the header section of the EDL. 

 

O

 

Start Time Code. Enter the time at which you want recording to start on the record reel. 

 

O

 

Frame Rate. Determine the frame rate by the time base set in the Time Base Settings 
dialog box. The default frame rate is nondrop-frame timecode; click the Drop Frame box 
if you want drop-frame timecode. 

 

O

 

Audio Processing

 

.

 

 See “Audio in the EDL” on page 117 for information on the audio 
export options.

 

O

 

Level Notes

 

.

 

 Choose an option from the pop-up menu to include comments in your 
EDL pertaining to audio levels and superimpositions. 

 

O

 

Create B-roll/B-roll in Separate File

 

. 

 

Create a transition in an EDL only if the clips are 
on different video source reels. The Construction window may contain edits across a 
single source reel. For example, there may be a dissolve from a clip on Reel 1 to another 
clip from Reel 1. These B-roll options allow you to generate a separate list of such 
conflicting edits. This list, called a B-roll conform list, is used by the post-production 
facility to make an additional source reel of clips used in transitions.

 

3

 

Click Wipe Codes to bring up Adobe Premiere’s Wipe Code Editor. Assign the wipe 
patterns to the codes used by your post-production facility. For more information, see 
“Transitions, Special Effects, and Superimposed Clips in the EDL” on page 116.

 

4

 

Click OK to close the Save EDL dialog box.

 

5

 

Type a name for the EDL and click save. The EDL is generated and appears in a text 
window.
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Components of the Edit Decision List

 

While slight differences exist among different EDLs, most contain eight primary columns 
and two auxiliary columns. 

 

O

 

Header. At the top of every EDL is the name of the list and the timecode in which the 
record was created (drop frame or nondrop frame). 

 

O

 

Event Number. The event number is an identifying counter, beginning at 1. An 

 

event

 

 
represents a single edit. The event number can be important in the re-editing process, 
because it calls an individual event. Certain events may use more than one line of the EDL. 
Unnumbered lines accompanying events are called 

 

notes

 

 or 

 

comments.

 

O

 

Source Reel ID. The source reel ID is the name or number of the videotape containing 
the clip. 

 

O

 

Edit Mode. The edit mode indicates whether the edits take place on the video track only 
(V), the audio track only (A), or a combination of both the video and the audio tracks (B). 

Header

Source inTransition

type

Source

reel ID

Edit modeEvent

number

Source out Record in Record out
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O

 

Transition Type. The transition type describes the type of edit: 

 

C

 

 represents a cut, 

 

W

 

 represents a wipe, 

 

K

 

 represents a key (superimposed), and 

 

D

 

 represents a dissolve. 

 

O

 

Source In and Source Out. The first two columns of the timecode are the source in and 
source out points. They describe the timecode of the first frame and the last frame of the 
clip as it appears on the source videotape. 

 

O

 

Record In and Record Out. The last two columns of the timecode represent the time at 
which the source clip is to be recorded on the master tape. 

 

Transitions, special effects, and superimposed clips in the EDL

 

A standard EDL recognizes only the cut, dissolve, and some wipe transitions. The EDL 
modules available in Adobe Premiere attempt to translate the edits from your project to 
the standard EDL format. For example, the Adobe Premiere effect named 

 

Cross Dissolve

 

 is 
interpreted as a “dissolve” transition by the standard EDL. Although many of the Adobe 
Premiere transitions cannot be adequately described in the EDL, the name of the Adobe 
Premiere effect is listed in a comment line in the EDL. 

Adobe Premiere’s filters and motion settings are completely ignored in a standard EDL. 
Superimposed clips are described as 

 

keys

 

. The only transition permitted under a key is a 
Cut; other transitions under keys are removed from the EDL. 

With the exception of the Cross Dissolve and Direct transitions, all transitions in Adobe 
Premiere are interpreted as Wipes by the EDL module. Some transitions correspond 
closely to wipe patterns that can be produced by a video switcher. See the Read Me file for 
a description of how Adobe Premiere transitions are interpreted by a standard EDL. 

Video switchers interpret wipe patterns as codes. You can map the wipe patterns in the 
EDL to the wipe pattern codes used by your post-production facility using Adobe 
Premiere’s Wipe Code Editor. Consult with your post-production facility to determine 
which wipe codes are used by their switchers. You can save EDL wipe code settings and 
load them when needed.

 

To assign wipe codes:

 

1

 

Choose Export from the File menu, and choose the desired EDL format from the 
submenu. 
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2

 

Click Wipe Codes. The EDL Wipe Codes dialog box appears.

 

3

 

Click the wipe icons to see the wipe transitions animated.

 

4

 

Enter the correct wipe codes for the wipe transitions that are used by your video 
switcher.

 

5

 

Load or Save EDL Wipe Code settings using the Load and Save buttons at the bottom 
of the dialog box.

 

6

 

Click OK to apply the wipe codes to the EDL.

 

Audio in the EDL

 

Adobe Premiere and QuickTime control sound in a way that differs significantly from 
traditional editing systems. Traditional tape-based editing systems are designed to record 
from (and to) one or more audio tracks on the videotape, or onto a separate audio tape 
recorder. 

Adobe Premiere provides up to 99 audio tracks in the Construction window for placement 
of audio clips; however, QuickTime mixes the audio tracks, creating a single track that can 
contain more than one channel (such as left and right). In Adobe Premiere, mixing of 
audio tracks is controlled by the fade controls that accompany each audio track. The stan-
dard EDL has no way to mix sound, except for the mixing that occurs when one audio 
source dissolves into another audio source. 

To take advantage of multiple audio tracks on videotape, you can define which audio 
tracks from Adobe Premiere are mapped to the available tracks in the editing system. 
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To map audio tracks in the EDL:

 

1

 

Choose Audio Mapping from the Project menu. The EDL Audio Mapping dialog box 
appears.

 

2

 

Assign audio track A, audio track B, and the rest of the audio tracks to their EDL 
destination.

 

3

 

Click OK.

Adobe Premiere provides three output options for EDLs that affect how audio edits are 
added to an EDL. Consult your post-production house for a recommendation on which 
option to use. 

 

Audio Follows Video option

 

The Audio Follows Video option causes the audio and video to be edited simultaneously, 
according to the edits made on the video track: where video cuts, the linked audio clip 
cuts; where video fades, the linked audio fades; and so on. With this option, the audio fade 
controls are ignored and any audio that is not linked to a video clip in the Construction 
window is dropped.

 

Audio Separately option

 

The Audio Separately option interleaves the audio and video tracks as separate edits 
within the EDL. For these options, the following rules govern the way that Adobe Premiere 
translates sound edits into a format that the EDL can interpret.

 

O

 

If a clip on track A completely overlaps a clip on track B (it has the same or an earlier in 
point and the same or a later out point), only the clip on track A is considered.

 

Note:

 

 A fade point of 0 in any clip effectively splits the clip at that point so that the clip is 
treated as two clips by the EDL.

 

O

 

If a clip on track A and a clip on track B overlap, a transition is created in the overlapping 
area so that the starting clip fades in to the ending clip.

 

O

 

Clips on S tracks are considered only when neither track A nor track B contains clips; 
otherwise, they are ignored.

Once this single “track” has been created, the EDL interprets fade points in the 
following way:

 

O

 

A fade point of 0 in any nontransition area creates a fade between 0 at that point and 100 
at the next nearest point specified in the clip, regardless of the actual value that was spec-
ified for the nonzero point. All other nonzero fade points are ignored.
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O

 

Fade points in any transition areas (that is, areas of clips on tracks A and B that overlap) 
are ignored.

 

Audio at End option

 

The Audio at End option places all the sound edits together at the end of the EDL, 
following the audio translation rules used with the Audio Separately option. 

 

SETTING THE TIMECODE FOR CLIPS

 

The timecode for the starting point of a clip can be assigned when the clip is digitized, or 
by using the Timecode command in the Clip menu. If you do not set the timecode for a 
clip, Adobe Premiere assumes a starting time of 00:00:00:00. For instructions on assigning 
the timecode while capturing video, see “Capturing Timecode” on page 254. For informa-
tion on adjusting the timecode to match a window dub, see “Calibrating Timecode”
 on page 256.

 

To set the timecode for a clip:

 

1

 

Select a clip in the Clip, Project, or Construction window. 

 

2

 

Choose Timecode from the Clip menu. The Clip Timecode dialog box appears.

 

3

 

Enter the following information for setting the timecode:

 

O

 

Timecode. Enter the new starting time for the clip in SMPTE format. The current 
SMPTE timecode address for the starting time of the clip is displayed at the top of the 
dialog box. 

 

O

 

Frame Rate. Choose the frame rate at which you want the clip exported. (Frame rates 
of 24 fps or 25 fps do not support drop-frame timecode.)
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O

 

Format. Choose drop-frame or nondrop-frame timecode. For more information on 
timecode, see “SMPTE Timecode” on page 298.

 

O

 

Set Timecode At

 

.

 

 This option is available only when setting the timecode from the Clip 
window. Choose File Beginning to assign the entered timecode address to the first frame 
in the source clip (default setting). Choose Current Frame to assign the timecode address 
to the currently displayed frame in the Clip window.

 

O

 

Reel Name/Description. Enter the reel name of the source tape on which the clip is 
located. Enter a description of the clip, if desired. Note that the number of characters you 
can enter in this field may be limited by the selected export module.

 

O

 

Revert to Original. Clicking this option causes the clip to revert to its original timecode 
and name settings. If a clip is used more than once in a movie, this option affects all copies 
of the clip. 

 

4

 

Click OK. If you selected multiple clips, the dialog box reappears for each clip.
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his chapter describes how to preview a project and how to set preview options. 
Previewing is a quick way to play part of a movie or an entire movie without 
having to compile the entire contents of the Construction window into a Quick-

 

Time movie, which can take a substantial amount of time.

There are two types of previews: compiled and uncompiled. Compiled previews require 
processing time, but they give you an accurate preview of transitions and effects. Uncom-
piled previews don’t require processing time but they may not provide adequate detail or 
accuracy. Adobe Premiere lets you mix these previewing modes. You can compile selected 
effects and transitions and preview both the compiled and uncompiled sections using the 
Controller.

It’s important to note that previews can be compiled differently than the final movie. 
Preview processing is faster when the frame rate is low and the frame size is small. 
However, many users choose to process previews using the final movie settings for size and 
frame rate. This saves processing time when the final movie is made because Adobe 
Premiere uses the previewed segments, saved as Preview files, when it compiles the final 
movie. For more information on previewing options, see “Setting Preview Processing 
Options” on page 127.

Previews normally play in the Preview window. You can also use the Print to Video 
command to view previews on an NTSC (National Television Standards Committee) 
monitor or in the center of your computer screen with the remainder of the screen 
blacked out. 

 

Chapter 

 

4

 

: Previewing a Movie

 

T
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USING THE CONTROLLER

 

The Controller is used in conjunction with the Preview window to display the contents of 
the Construction window. The Controller controls the position of the playback head in the 
Construction window, which in turn determines the position of the edit line and the frame 
displayed in the Preview window. 

Previewing with the Controller does not display transitions or other effects unless they 
have been previously compiled using the Preview or Snapshot commands. However, the 
Controller functions as a quick previewing tool because you’re not compiling as you 
preview. The uncompiled segments are displayed with an X in the center of the frame for 
the duration of the effect or transition. For more information on compiling effects and 
transitions, see page “Compiling Effects and Transitions” on page 123.

The Controller has all the controls found in the Clip window. You can use the Controller 
to set markers in the time ruler of the Construction window that correspond to the frame 
displayed in the Preview window. You can also go directly to Construction window 
markers or SMPTE frames. For information on using markers, see “Setting Place Markers 
for Clip Alignment” on page 75.

 

To preview using the Controller:

 

1

 

Choose Controller from the Window menu if the Controller is not already open.

 

2

 

Choose Preview from the Window menu if the Preview window is not already displayed. 
The Preview window displays the frame of the movie that corresponds to the position of 
the playback head in the Construction window.

 

3

 

Drag the playback head in the Construction window to scrub through the movie, or use 
the Controller to preview specific frames:

 

O

 

Use the Jog control to move the playback head forward or backward.

 

Playback head

Edit line

Play button

Stop button

Slider

Jog control

Audio level 

toggle

Frame forward

and backward

Play In/Out button

Loop button

Frame indicator

Clip duration
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O

 

Use the Frame forward and Frame backward buttons to preview the contents of the 
Construction window frame by frame. 

 

O

 

Press the Play button to play a sequence of frames starting from the playback head.

 

O

 

Press the Play In/Out button to play the frames under the yellow work area bar. For 
information on adjusting the work area, see the “Compiling Effects and Transitions” 
on page 123.

 

4

 

Use the Mark button to set markers in the time ruler of the Construction window. Use 
the Go To button to go to a marker in the Construction window.

 

Note:

 

 The Play button in the upper right corner of the Construction window has the same 
function as the Play button in the Controller. 

 

Changing the Preview window display

 

The pop-up menu in the upper right corner of the Preview window is used for resizing and 
changing the resolution of the Preview window, and for assigning the Preview window to 
an NTSC or PAL (Phase Alternating Line) monitor. Choose Float from this menu to float 
the Preview window above all other windows.

 

Note:

 

 You can automatically resize the Preview window to many popular sizes by Option-
clicking any portion of the window. If you Control-click the window, Adobe Premiere will 
locate an available NTSC monitor and fill it with the Preview window.

 

COMPILING EFFECTS AND TRANSITIONS

 

When building a movie in the Construction window, you’ll find it useful to compile effects 
and transitions so that they can be accurately previewed. A compiled movie segment is one 
that has been processed and saved to disk. You designate which effects and transitions you 
want compiled by adjusting the work area bar in the Construction window. Adobe 
Premiere normally saves compiled effects and transitions as temporary movie files; these 
files are used in subsequent previewing and, depending on your settings, can be used in 
the compilation of the final movie. The Construction window displays a thin gray bar 
above the timeline to indicate which effects and transitions have been compiled. For more 
information on previewing modes, see “Selecting a Previewing Mode” on page 130.

 

To compile a preview of the work area:

 

1

 

Use one of the following techniques to adjust the yellow work area bar so that it extends 
across the effects and transitions you want to compile:

 

O

 

Drag the red triangle at either end of the work area bar.
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O

 

Choose the in point and out point tools in the Construction window and click above the 
time ruler.

 

O

 

Click the In and Out buttons in the Project controller to adjust the work area bar 
according to the position of the playback head.

 

O

 

Double-click the work area bar to extend it to the width of the Construction window.

 

Note: 

 

You can set the work area for a continuous region in the Construction window by 
Option-clicking above the time ruler. A continuous region can be useful for finding gaps in the 
movie construction. If no gaps exist, the work area will extend across the entire movie.

 

Dragging the red triangle to widen the work area bar

 

2

 

Set options for processing size, previewing mode, and other previewing parameters by 
choosing Preview Options from the Make menu. These options are initially set when you 
choose a preset for a project. In most cases you won’t need to change them. The Preview 
command compiles a preview based on the settings in the Preview Options dialog box. For 
more information on preview options, see “Setting Preview Processing Options” on page 
127.

 

3

 

Choose from several options to compile and view a preview of the work area:

 

O

 

Choose Preview from the Project menu, or press Return. The work area is compiled and 
the preview plays automatically in the Preview window. To interrupt the preview, press 
Command-period (.).

 

O

 

Choose Snapshot from the Make menu. The work area is compiled, and the Controller 
comes forward for viewing the preview. With this method, the preview does not play auto-
matically, but the Controller gives you more control over viewing than the Preview 
command.

Red triangles
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Note: 

 

You can use the Print to Video command to compile a preview of the clips under the 
work area bar if the Construction window is the active window. The desktop is blacked out 
and the preview plays in an NTSC monitor or in the center of the screen. For more informa-
tion, see “Previewing with Print to Video” on page 126.

 

Previewing by dragging through the time ruler

 

You can preview any area of your movie by dragging the cursor through the time ruler. 
This is different than scrubbing with the playback head because effects and transitions are 
processed as you drag. This type of previewing provides a quick way of checking superim-
positions, motion settings, filters, or specific transitions from one clip to another. 
However, you aren’t likely to get a good sense of your movie’s pacing because you control 
the speed of dragging.

Processing takes place in real time as you drag, but the previews are not saved to disk as 
temporary files as they are when you use the Snapshot or Preview commands. Thus, you 
don’t affect any effects and transitions that have been compiled and saved to disk.

 

Note: 

 

By default, processing for this type of preview is based on the settings in the Preview 
Options dialog box. You can speed up the processing by reducing the View Resolution in the 
Construction Window Options dialog box or in the Preview window pop-up menu.

 

To preview a movie by dragging in the time ruler: 

 

1

 

Position the cursor anywhere in the time ruler. The cursor changes into a down arrow.

 

2

 

Drag the arrow along the time ruler. The clips under the arrow play in the Preview 
window. You can drag to the left or to the right to make the preview play forward or 
backward. 

Down arrow
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PREVIEWING WITH PRINT TO VIDEO

 

You can also use the Print to Video command to preview the contents of the Construction 
window. Using this command is similar to using the Preview command, except that the 
preview plays in an NTSC monitor or in the center of the screen instead of in the Preview 
window.

 

To play a movie directly from the Construction window: 

 

1

 

Click the Construction window to make it active.

 

2

 

Select the part of the Construction window you want to play by adjusting the yellow 
work area bar above the time ruler.

 

3

 

Choose Export/Print to Video from the File menu. The Print to Video dialog box 
appears.

 

4

 

Select Print to Video options. (For a description of these options, see “Using Print to 
Video” on page 223.) Do not select the Activate Recording Deck option unless you want 
to record the preview onto a controllable recording device as it plays on-screen.

 

5

 

Click OK.

The preview plays in the center of the screen against a black background. To interrupt the 
playing of the preview, press Command-period (.).

 

Note:

 

 For best performance when playing a preview directly from the Construction window, 
you should preview in Effects to Disk mode. For more information, see “Selecting a Previewing 
Mode” on page 130. 

 

MAKING A PREVIEW MOVIE

 

When a movie contains a number of complex transitions, special effects, filters, or audio 
clips requiring precise synchronization, previewing with the Preview command or by 
dragging in the time ruler may take too long or may not be accurate enough. Alternatively, 
you can make a preview movie by compiling the clips under the work area bar into a 
QuickTime movie. Unlike normal previews, preview movies are not linked to the 
Construction window through the Controller, but can be left on-screen or saved for later 
viewing.
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Preview movies are built using the options specified in the Project Output Options dialog 
box. To build your preview movie faster, set a smaller size and lower frame rate than those 
for your final movie. A size of 160 pixels by 120 pixels and a frame rate of 15 fps are recom-
mended. If you plan to make multiple preview movies for the project, consider creating 
a preset that you can load before building the previews. You can then reload the original 
preset before building the final movie. 

 

To make a preview movie:

 

1

 

Position the work area bar over the clips you want to preview. (See step 1 in the section, 
“Compiling Effects and Transitions.”) 

 

2

 

Choose Movie from the Make menu. The Make Movie dialog box appears.

 

3

 

Click Output Options. The Project Output Options dialog box appears. 

 

4

 

Choose Work Area from the Output pop-up menu. 

 

5

 

Enter any other output options desired. For more information on output options, 
see “Selecting Project Output Options” on page 210.

 

6

 

Click OK. The Project Output Options dialog box closes and the Make Movie dialog box 
reappears. 

 

7

 

Enter a name for the preview movie and click OK.

Adobe Premiere builds and saves the movie, and then opens it in a Clip window. Press the 
Play button to view the preview movie.

 

SETTING PREVIEW PROCESSING OPTIONS

 

Preview options affect the way the preview is processed when you choose the Preview or 
Snapshot commands. Preview options are initially set when you choose a project Preset 
for your project. In most cases you won’t need to change them. You can customize or 
create new Adobe Premiere Presets to include your preferred preview settings. For more 
information on setting up preview setting in presets, see “Loading or Modifying Project 
Presets” on page 28.
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To change preview options:

 

1

 

Choose Preview Options from the Make menu, or double-click the Preview window. 
The Preview Options dialog box appears. Click More Options to set advanced preview 
options.

 

2

 

Set the following options to affect the Preview window:

 

O

 

Preview Window Size. Enter the desired preview image size (in pixels) in this field. 
Adobe Premiere processes the preview at this resolution unless you specify a different reso-
lution using the Process At option in the video portion of the dialog box, as described in 
step 3. Keep in mind that enlarging the Preview window may degrade the preview if you 
are previewing from RAM or if your hardware cannot process the larger images fast 
enough.

Enter a value in either the width or the height field to automatically calculate and update 
the other field based on the aspect ratio set in the Project Output Options dialog box. For 
example,

 

 

 

if the 4:3 Aspect Ratio option is selected in the Project Output Options dialog 
box, a 4 to 3 width-to-height ratio is maintained.

 

Note:

 

 You can also resize the Preview window by choosing a size from the window’s pop-up 
menu, or by dragging the lower right corner of the window. You can automatically resize the 
window to many popular sizes by Option-clicking any portion of the Preview window, or by 
holding down the Option key while dragging the lower right corner of the window.

 

O

 

Center to Screen. Select this option to snap the Preview window to the center of the 
screen. A center position is especially useful when previewing at full-screen on a second 
monitor, where the Preview window should fill the entire screen. 
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O

 

Show Safe Areas. Select this option to display lines that indicate title and animation safe 
areas for NTSC video. These lines appear only when you preview by scrubbing in the time-
line of the Construction window.

 

3

 

Set the following video preview options (if all options do not appear, click More 
Options):

 

O

 

Rate. Select a rate from 1 fps to 30 fps to specify the speed at which the preview plays. 
Note that many Macintosh computers are limited to maximum frame rates below 30 fps.

 

O

 

Mode. Select a new mode if you want to optimize how the preview is built and stored. 
For a discussion of previewing modes, see “Selecting a Previewing Mode” on page 130.

 

O

 

Type. Match this setting to the way your video display board processes NTSC or PAL 
video if previewing in Effects to Disk mode and you intend to output to videotape at full-
frame NTSC or PAL. Otherwise, leave the setting at Full Size Frame. For full-frame video, 
many boards process only half the lines in a frame and double the captured lines to 
complete the frame. To find out how your board processes video, see the documentation 
that comes with your board. For general information on video boards, see “Digitizing 
Hardware” on page 231.

 

O

 

Process At. Click this option to define the processing resolution of the preview, regard-
less of the Preview window size. This option is automatically turned on when you enter 
new values for the horizontal and vertical dimensions. Processing at a smaller size will 
build previews faster, but at degraded quality. If you are previewing in Effects to Disk 
mode, you should consider processing your previews at the same size at which you output 
your movie. This saves you processing time when the Print to Video or Make Composite 
command is selected. For a discussion of how previews are processed, see “Selecting a 
Previewing Mode” on page 130.

 

O

 

Video Filters. Deselect this option to turn off the application of filters (the default 
during previewing) to enhance performance. 

 

4

 

Set the following audio options (if all options do not appear, click More Options): 

 

O

 

Rate. Enter a sampling rate for the audio clips. You can choose a rate of 5, 11, 22, or 44 
kilohertz (kHz). With higher sampling rates, the sound in the audio track will be cleaner. 
44 kHz is CD-audio quality.

 

O

 

Format. Choose between mono and stereo, and between 8-bit and 16-bit for the audio 
processed in the preview. If your source clips contain 8-bit audio, setting the Format to 16-
bit audio will only increase the time and disk space required for previewing without 
improving the audio.
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O

 

Build/Play. Click a button to specify how the audio preview will be built and then played. 
For more information on previewing modes, see the next section, “Selecting a Previewing 
Mode.”

 

O

 

Audio Filters. Deselect this option to turn off the use of audio filters (the default) during 
previewing.

 

Selecting a previewing mode

 

You can specify how the program builds a preview: using available RAM, hard disk space, 
or both. Specifying the processing mode lets you optimize previewing for your hardware 
setup and, for the desired accuracy. The processing mode affects the time required to build 
the preview and to compile the finished movie using the Make Movie command. 

Processing a preview works best when you save the compiled movie segments to your hard 
disk, called previewing in Effects to Disk mode. This is the best previewing mode for most 
projects. In fact, all project Presets shipped with Adobe Premiere set the previewing mode 
to Effects to Disk. 

 

Modes for previewing video

 

Filters, transitions, and superimpositions (collectively referred to here as 

 

effects

 

) must be 
processed before they can be previewed accurately. You can process the effects while the 
movie previews which requires a lot of RAM, or you can have Adobe Premiere process the 
effects and save them to disk before playing back the preview. If your movie contains no 
effects, then you can have Adobe Premiere cache the edits into RAM and play the preview 
at the full frame rate of your machine.

In the Preview Options dialog box, select from the following video previewing modes:

 

O

 

Effects to Disk. Select this mode to have Adobe Premiere process all effects in the work 
area and save the information on the hard disk before playing back the preview. In this 
mode, the program processes the effects before the movie is played back. This frees up 
memory for loading and playing movie frames that would otherwise be required for 
processing during playback, and lets you preview long movies smoothly and accurately.

In Effects to Disk mode, Adobe Premiere creates temporary preview files for each effects 
segment in the Construction window, such as a transition or a title overlay. These files are 
automatically stored in a folder labeled Adobe Premiere Preview Files, located in the folder 
and disk volume that contains your project, or in the volume you specify in Scratch Disk 
Preferences.



 

Premiere User Guide 6/1/94 10:36 c4.pdf.frame

 

Right master page

 

Adobe Premiere uses the temporary preview files for subsequent previewing. Only those 
sections of the Construction window that have changed since the last preview require 
reprocessing. The program also uses preview files when compiling the final movie (using 
the Make Movie or the Print to Video command) if the image dimensions and compres-
sion settings match those in the Output Options and Preview Options dialog boxes. This 
reduces movie compilation time considerably. 

Adobe Premiere displays thin gray bars above the time ruler in the Construction window 
to indicate which portions of the window have been processed and saved to disk as preview 
files. The upper half of the gray bar represents video preview files, while the lower half 
represents audio preview files. 

Changing any variable in a transition, filter, or superimposed clip causes the program to 
delete the associated preview file(s). Such variables include the duration of the transition 
or effect, the fade levels, the key type, and the motion settings. If you change the Rate, 
Type, or Process At options in the Preview Options dialog box, Adobe Premiere will delete 
and reprocess all previously built preview files.

 

Note:

 

 To ensure smooth previews in the Effects to Disk mode, make sure that the dimensions 
of your original clips match the setting of the Process At option in the Preview Options dialog 
box. If the dimensions do not match, Adobe Premiere must resize the clips while it plays the 
preview, which may result in stuttering.

 

O

 

Effects to RAM. In this mode, the video clips are loaded into RAM, and then the effects 
are processed in real time as the preview plays. This method is useful if you are previewing 
short segments or you have lots of RAM. It is also useful when you are experimenting with 
different transitions. However, Effects to RAM may not give accurate results, as some tran-
sitions and effects cannot be processed in real time, resulting in dropped frames in the 
preview.

Processing previews in Effects to RAM mode can be especially helpful when working with 
clips that have large dimensions (larger than 640 pixels by 480 pixels). Building filters and 
transitions for these clips can take considerable time. To create the best RAM-based 
previews, set the Rate option to less than 30 fps and reduce the size of the Preview window 
so that more frames can be loaded into RAM. Once the frames are loaded, effects and 
filters can be applied to the frames with almost no preview delay.

Audio preview file indicator

Video preview file indicator
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O

 

Play Directly. In this mode, there is no pre-loading of video clips. Effects are processed 
as the preview plays. This method generally provides accurate previews only if you have a 
very fast computer and plenty of RAM, or if you don’t have effects in your movie.

 

Modes for previewing audio

 

In the Preview Options dialog box you can choose from three options for processing audio 
previews. The options are:

 

O

 

Build to Disk/Play from Disk. In this mode, all audio is processed, saved to the hard disk, 
and then played back from disk. This is the best mode for working with projects that 
contain only audio. If your project also contains video, you need a very fast disk drive with 
this option to prevent video from degrading. Video degradation is caused by the disk drive 
searching for and playing back two files — audio and video — at the same time.

 

Note: 

 

You can lessen video degradation by caching the audio and video to separate hard disks, 
using the Preview Temps settings in the Scratch Disks Preferences dialog box.

 

O

 

Build to Disk/Play from RAM. In this mode, all audio is processed and saved to the hard 
disk, but instead of being played from the disk, it is moved into a RAM buffer. This option 
allows video to preview more smoothly, but may impose some restrictions based on the 
amount of RAM installed in your system. As a general guideline, 1 minute of audio 
sampled at 22 kHz (mono) requires 1.3 MB of free RAM.

 

O

 

Build to RAM/Play from RAM. In this mode, all audio is processed directly in RAM and 
then played from RAM. Since nothing is saved to disk, the audio must be reprocessed 
when compiling a movie or outputting to videotape. This option has the same RAM 
requirements for playing audio as the preceding option, and works best when you are 
previewing only audio mixes.
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Chapter 

 

5

 

: Using Transitions

 

his chapter describes how you create eye-catching transitions between movie or 
still-image clips in Adobe Premiere. Each transition is unique and has a variety of 
options for controlling the way the image is transformed. The most common 

 

transition between clips is a 

 

cut

 

—an instantaneous switch from one clip to another. The 
term is borrowed from film editing, where a cut is achieved by splicing two shots together. 
To cut between clips in Adobe Premiere, you simply arrange the clips, head to tail, on the 
same track in the Construction window. If, however, you want a less abrupt or more elab-
orate transition between clips, you have many options to choose from.

Adobe Premiere includes more than 60 transitions such as Additive Dissolve Band Wipe, 
Checkerboard, Slide, and Venetian Blinds. In addition, you can apply your own custom 
transitions, which you can save and use over again. The Transitions window includes a 
brief description of each transition, and when the window is active, the transition icons 
become animated.

 

Note:

 

 If you plan to generate an Edit Decision List (EDL) for your movie, see “Generating an 
Edit Decision List” on page 112 for a description of how transitions in Adobe Premiere are 
interpreted by the EDL export modules. 

 

T
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ADDING TRANSITIONS

 

When you create a transition between clips, you must place one clip on video track A in 
the Construction window and the other on video track B. The transition goes on the T 
track, which is located between video tracks A and B. The clips on tracks A and B should 
overlap in time so that the transition can be placed in the overlapping area. 

You control the direction of the transition—from track A to track B, or from track B to 
track A— by the position of the clips on the tracks. If two clips start at the same time, the 
default setting has the transition move from track A to track B; otherwise, the transition 
starts with the clip that plays first (the clip that is furthest left on the timeline). You can 
override the default direction by clicking the transition’s track selector. For information 
on toggling the track selector, see the next section, “Changing Transition Settings.”

 

To add a transition to the Construction window:

 

1

 

If the Transitions window is not visible, choose Transitions from the Windows menu.

 

2

 

Drag the transition you want to use from the Transitions window to the T track in the 
Construction window.

If clips on video tracks A and B overlap, Adobe Premiere adjusts the transition to fit into 
the overlapping area. You can shorten or lengthen its playing time just as you would a clip.

 

3

 

To replace a transition with another transition, use the Copy and the Paste to Fit 
commands in the Edit menu. Doing so lets you paste a transition of the same size into the 
area of the previous transition.
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CHANGING TRANSITION SETTINGS

 

Transitions have a variety of settings. All of settings for a transition can be adjusted using 
the Transition Settings dialog box. In addition, you can access the most frequently used 
settings on the transition’s thumbnail in the Construction window. These include the 
Track selector, the Forward/Reverse selector, the Edge selectors (which are optional, 
depending on the type of transition), and the Anti-aliasing selector. Note that if the 
thumbnail in the Construction window is too short or too small, the controls may not 
be visible.

 

To change transition settings:

 

1

 

Select the transition and choose Transition Settings from the Clip menu, or double-click 
the transition in the Construction window. The Transition Settings dialog box appears 
with a thumbnail of the transition displayed in the lower right corner.

 

2

 

To see the starting and ending frames of the transition in the boxes provided, select 
Show Actual Sources. 

 

Forward/Reverse selector
Anti-aliasing selector

Track selector

Open Point

Color swatchBorder slider

Start slider

End slider
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3

 

To change the starting and ending points of the transition, use the Start and End sliders. 
Hold down the Shift key to simultaneously lock and move the start and end sliders. For 
example, you might use this option to start or end the transition in the middle of the effect.

 

4

 

 To adjust the width of the optional border on the transition, drag the Border slider. 
The default Border is None.

 

5

 

To display the Apple or Premiere color picker, click the color swatch. Use the color picker 
to select a color for the border. For more information on using either of the color pickers, 
see “Using the Apple and Premiere Color Pickers” on page 143.

Transition border



 

Premiere User Guide 6/1/94 10:36 c5.pdf.frame

 

Right master page

 

6

 

To change the starting position of the Iris Cross, Iris Diamond, Iris Round, Iris Square, 
Iris Star, and Zoom transitions, position the pointer on the small, white, repositioning box 
in the Start window of the Transition Settings dialog box, and drag to reposition the 
starting point. 

 

7

 

To display any custom settings for the transition, click Custom Settings. For example, 
you use Custom Settings to set the number of bands used in the Band Slide transition. 
Custom settings are not available for all transitions. 

 

8

 

To change the direction of the transition between clips, click the Track selector on the 
left side of the transition’s thumbnail. The direction can be either down (from track A to 
track B) or up (from track B to track A). Note that you can also set this option from the 
transition’s thumbnail in the Construction window.

 

9

 

To change the orientation of the transition, click an Edge selector on the transition’s 
thumbnail. The Edge selectors are small triangles bordering the transition icon. 

For example, the Barn Doors transition can be oriented vertically or horizontally. Some 
transitions do not have edge selectors because the transition has only one orientation. 

 

10

 

To make the transition play forward or backward, click the Forward/Reverse selector 
in the upper right corner of the transition’s thumbnail. For example, the Clock Wipe tran-
sition can play clockwise or counterclockwise. You can also set the forward or reverse 
direction from the transition’s thumbnail in the Construction window.

 

11

 

To adjust the smoothness of the transition’s edges, click the Anti-aliasing selector in the 
lower right corner of the transition’s thumbnail. Clicking toggles the value between Low, 
High, and Off. 

Repositioning box

Edge selector
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The diagonal line on the selector becomes progressively more or less jagged to indicate its 
value. Anti-aliasing smooths the frames affected by the transition by replacing jagged 
edges between the images with dithered patterns. This makes the transition appear less 
abrupt. You can also set anti-aliasing from the transition’s thumbnail in the Construction 
window.

 

Anti-aliasing set to Off Anti-aliasing set to High

 

12

 

Click OK. If you selected multiple transitions, the Transition Settings dialog box 
reappears for each transition.

 

ALIGNING TRANSITIONS

 

Adobe Premiere lets you check the alignment of transitions in your movie. If a transition 
is not aligned correctly with the surrounding video clips, you can choose whether or not 
to align it.

 

To check for and resolve unaligned transitions:

 

1

 

Choose Align Transitions from the Project menu. 

If a transition is not aligned with a video clip, the Transition Alignment dialog box 
appears, and the edit line moves to the first edge that is not aligned. 
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2

 

Make one of the following selections:

 

O

 

Click Align to align the transition. Continue clicking Align until all of the edges have 
been aligned. 

 

O

 

Click Ignore if you want to move to the next instance of a nonaligned edge. 

 

O

 

Click Align All to align the edges of all of the transitions at once. 

 

CREATING A PICT MASK TRANSITION

 

Adobe Premiere can use a black-and-white PICT image as a transition mask, replacing the 
black in the mask with image A and the white in the mask with image B.

 

To add a PICT mask as a transition:

 

1

 

Drag the PICT Mask transition from the Transitions window to the T track of the 
Construction window. The PICT Mask Custom Settings dialog box appears.

 

2

 

Click Import. The Open dialog box appears.

 

3

 

Select the PICT file you want to use as a transition mask, and click Open. The PICT 
image you have selected appears in the PICT Mask Custom Settings dialog box.

 

PICT image Result of PICT transition 
mask on movie clip

 

The image will be black and white, even if a grayscale image is selected for the PICT mask. 

 

4

 

Click OK.

 

CREATING A GRADIENT WIPE TRANSITION

 

Adobe Premiere can use any importable grayscale image as a gradient wipe. In a gradient 
wipe, image B fills the black area of the grayscale image and then shows through each level 
of gray as the transition progresses until the white area becomes transparent. When you 
create a Gradient Wipe transition, you can specify the “softness” of the transition’s edges.
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The Adobe Premiere program includes sample images that you can use as Gradient Wipe 
transitions. The samples are located in the Gradient Wipes folder in the Adobe Premiere 
folder. You can also create your own Gradient Wipe images in the Adobe Photoshop and 
Adobe Illustrator programs.

 

To create a gradient wipe transition:

 

1

 

Drag the Gradient Wipe transition from the Transitions window to the T track of the 
Construction window. The Gradient Wipe Settings dialog box appears. 

 

2

 

Click Select Image, and use the Open dialog box to select the file you want to use in the 
wipe. The image you select appears in the Gradient Wipe Setting dialog box.

 

3

 

Adjust the softness of the transition’s edges by dragging the Softness slider. As you drag 
the slider to the right, image A increasingly shows through image B.

 

4

 

Click OK.

 

Result of Gradient Wipe transition mask on movie clip

 

CREATING CUSTOM TRANSITIONS

 

In addition to the many transitions included with Adobe Premiere, you can apply your 
own custom transitions using the Transition Factory. You determine how you want the 
transition to affect the channels (alpha, red, green, and blue) of each pixel in the first image 
and the second image by specifying arithmetic expressions. 
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The transitions you create can also include Settings dialog boxes. The Settings dialog box 
provides up to eight sliders for adjusting the transition’s effect. When you design a transi-
tion, you include user-supplied slider information in the expression. You also determine 
the number of sliders and whether they appear in the Settings dialog box individually or 
in pairs.

When you create a transition, you can save its expressions in a text file. Doing so lets you 
use the Transition Factory to edit the transition later.

The next two procedures explain how to use the Transition Factory to apply and save 
custom transitions for use in Adobe Premiere. For a complete discussion of using arith-
metic expressions to achieve an effect, see Appendix B, “Expressions for Creating Transi-
tions and Filters.” The expressions described in Appendix B are used by both the Transi-
tion Factory and the Filter Factory.

 

To create a custom transition:

 

1

 

Drag the Transition Factory transition from the Transition window to the T track of the 
Construction window. The Transition Factory Settings dialog box appears.

The zoom, hand, and Preview window tools work the same as those in the standard Filter 
Settings dialog boxes. For information on using these tools, see “Applying Filters to a Clip” 
on page 146.

 

2

 

Specify the expressions as follows:

 

O

 

To specify an expression in the alpha channel, select Single Expression and type the 
expression in the A field. The evaluation of the alpha channel expression will be applied to 
each of the other three channels: R, G, and B; when the same value is applied to each 
channel of the pixels in an image, the image will be a grayscale image. 

 

O

 

To specify separate expressions for the R, G, and B channels, type the expressions in the 
R, G, and B fields. Even if you specify the same expression in all three channels, their eval-
uations will probably be different.

For information on how to use expressions to achieve a result, see Appendix B, “Expres-
sions for Creating Transitions and Filters.” 

As you type an expression, a small yellow caution sign appears. It will remain visible until 
you have typed a legal expression. If the caution sign does not disappear, it means that 
there is an error in the expression. To see which part of the expression is in error, click the 
caution sign to select the incorrect portion.
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3

 

If the expressions include user-supplied slider information, drag the appropriate Map 
sliders to preview the effects. The Map 0 sliders correspond to sliders 0 and 1; the Map 1 
sliders correspond to sliders 2 and 3; and so on. For information on including user-
supplied slider information in expressions, see “Providing User-Controlled Sliders” 
on page 306.

 

4

 

When you have correctly set up the transition, click Save to save the expressions in a text 
file. Saving the expression allows you to load and edit the transition in the future. You 
should give the text file the same name that you plan to give the transition, but save it in a 
folder other than the Adobe Premiere Plug-Ins folder. 

 

5

 

If you want to use this one instance of the transition only, click OK to apply the transi-
tion. If you want to use the transition more than once, see the next procedure, “To save a 
custom transition for additional use.”

 

To save a custom transition for additional use:

 

1

 

Follow steps 1 through 4 of the previous procedure, “To create a custom transition.”

 

2

 

Click Build. The Build Custom Transition dialog box appears. 

 

3

 

Specify a name for the transition in the Title field.

 

4

 

Use the Credits field to include credits or copyright information in the transition’s 
Settings dialog box; delete any information you do not want from the Credits field.

 

5

 

If the transition’s expressions include user-supplied slider information, select the appro-
priate number of Slider or Map options and specify labels for the sliders in the corre-
sponding text boxes. The labels will appear with the sliders in the transition’s Settings 
dialog box. 

To display the sliders individually in the Settings dialog box, use the Slider options. To 
display the sliders in pairs, use the Map options. Whether you should use individual or 
paired sliders depends on the type of transition you are creating. 

 

6

 

Click OK. A standard Save dialog box appears. Save the transition in the Adobe 
Premiere Plug-Ins folder. 

 

7

 

To make the transition available to users, restart the Adobe Premiere program.
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To edit a custom transition:

 

1

 

Drag the Transition Factory transition from the Transition window to the T track of the 
Construction window. The Transition Factory Settings dialog box appears.

 

2

 

Click Load. Use the Open dialog box to load the text file containing the transition’s 
expressions. You must have saved the expressions in a text file when you created the tran-
sition to be able to edit it.

 

3

 

Follow the steps in the previous two procedures to edit and rebuild the transition. 

 

USING THE APPLE AND PREMIERE COLOR PICKERS

 

The color picker appears when you select a color for a transition’s border, for a superim-
position key, for titles and graphics, and for some filters. You have the choice of selecting 
colors from the Apple color picker or from the Premiere color picker. Specify your choice 
in the General Preferences dialog box by choosing Preferences/General from the File 
menu.

The Premiere color picker lets you visually select colors from the range of colors that can 
be displayed in 24-bit color space. You can choose from the colors displayed in the Color 
Picker dialog box or you can enter RGB color values. The Premiere color picker also lets 
you select colors that are displayed outside of the Color Picker dialog box. For example, 
you can select a color from a PICT image displayed on-screen. 

The Apple color picker lets you select colors based on the HSB or RGB color model. For a 
detailed description of the Apple color picker, see your Macintosh user documentation.
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To select a color using the Premiere color picker:

 

1

 

In the Premiere color picker dialog box, move the pointer (shaped as a circle) to the 
desired color at any point on-screen (inside or outside of the dialog box), and click to 
select the color. Select a shade of gray by clicking the continuous gray scale located along 
the left edge of the window.

The selected color appears in the upper right corner of the Color Picker dialog box, below 
a previously selected color. If the color you have chosen falls outside the NTSC color space, 
a warning sign will appear next to the swatch along with a smaller swatch that contains the 
NTSC-safe approximation of the selected color. Click the small swatch to substitute the 
NTSC-safe color for the chosen color.

 

2

 

Alternatively, specify a color by entering the RGB components of the color in the Red, 
Green, and Blue text boxes. Enter a number between 0 and 255 for each component. The 
color will appear in the lower color swatch, along with a warning if the color falls outside 
the NTSC-safe gamut.

 

3

 

Click OK or press Return to select the color.
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To select a color using the Apple color picker:

 

1

 

In the Color Picker dialog box, move the scroll bar to the right of the color wheel to 
adjust the brightness of the colors shown in the color wheel.

 

2

 

Position the pointer over the color wheel, and click to select a color. 

The selected color appears in the upper left corner of the Color Picker dialog box, in the 
upper of two swatches. A previously selected color appears in the lower swatch.

 

3

 

Alternatively, specify a color by entering the HSB (hue, saturation, and brightness) or 
RGB (red, green, and blue) components of the color in the appropriate text boxes. The 
numbers can range from 0 to 65,535 for each component. The color will appear in the 
upper color swatch.

 

4

 

Click OK or press Return to select the color. 
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: Using

 

 

 

Filters and
Motion Settings

 

dobe Premiere includes a variety of filters that let you distort, blur, sharpen, 
smooth, texture, and color images. There are also a number of special-purpose 
filters, such as the Image Pan filter for panning and zooming in an image that is 

 

larger than the output frame size, and the Vertical and Horizontal Flip filters for flipping 
the image along either axis. Audio filters include the Echo filter, which produces an echo 
effect, and the Fill Left and Fill Right filters, which affect the spatial quality of the sound. 
In addition, you can apply your own custom filters, which you can save and use over again. 

Adobe Premiere also lets you create motion effects in movie and still-image clips that are 
similar to those achieved using an animation camera, such as zooming into an area of 
the clip.

 

APPLYING FILTERS

 

This section describes how to apply filters and filter settings to clips, and how to determine 
quickly which filters and filter settings have been applied to a clip. For examples of how 
filters affect clips, see “Effects of Various Filters” on page 167.

Adobe Premiere provides more than 50 movie and still-image filters and 5 audio filters, 
which are described in the sections “Movie and Still-Image Filters” on page 150 and “Audio 
Filters” on page 166. In addition, Adobe Premiere works with third-party filters in the 
standard Adobe Premiere and Adobe Photoshop formats. Some filters can be applied to a 
clip over time. For example, you can apply brightness that gets progressively brighter as 
the clip plays.

 

Note:

 

 If you have combined the Plug-Ins folders from Adobe Premiere and Adobe Photoshop, 
some of the Adobe Photoshop filters, though accessible, are not appropriate for use in 
Adobe Premiere. 

 

Applying filters to a clip

 

You can apply a filter to more than one clip at a time, and you can apply more than one 
filter to a clip. 

 

To apply a filter to a clip:

 

1

 

Select the clip in the Construction window. To apply a filter to more than one clip, use 
the range select tool to select the clips. You could also select one clip and use the Paste 
Special command later to apply the filter to a number of clips in sequence. 

 

A
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2

 

Choose Filters from the Clip menu. The Filters dialog box appears.

If you have selected a movie or still-image clip, the Filters dialog box displays only those 
filters that can be applied to movie or still-image clips; if you have selected an audio clip, 
the Filters dialog box displays only the audio filters.

 

3

 

Select the filter from the Available list and click Add, or double-click the filter in the 
Available list. 

 

Note:

 

 You can also apply a filter to a clip by positioning the pointer tool over the clip and 
holding down the Option key to turn the pointer into the pop-up menu icon; click the mouse 
button and drag to select Filters from the pop-up menu. 

 

4

 

If the filter has settings, a Settings dialog box appears. Adjust the settings as desired, and 
click OK. You can change a filter’s settings at any time by selecting the filter in the Current 
list and clicking the Start button in the Settings area. 

Many Settings dialog boxes have tools for zooming in on the image to see the effect of the 
filter in more detail and for viewing the image in the Preview window. 

 

Collapse preview button

Hand tool

Zoom tool
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Use these tools as follows:

 

O

 

To zoom in, choose the zoom tool and click the image in the dialog box. 

 

O

 

To zoom out, Option-click with the zoom tool. 

 

O

 

To view the image at its actual size, double-click the zoom tool.

 

O

 

To adjust the close-up view of the image, use the hand tool.

 

O

 

To view the entire image in the window, double-click the hand tool.

 

O

 

To view the image in the Preview window, click the Preview Window button below the 
hand tool. To return the image to the Settings dialog box, click the Preview Window 
button again.

Some filter Settings dialog boxes have slider controls for varying the effect over time. (For 
information on varying Adobe Photoshop filters over time, see “Changing Adobe Photo-
shop Filters Over Time” on page 149.)

Use the slider controls as follows:

 

O

 

To vary the effect over time, adjust the start and end frames of the clip separately.

 

O

 

If you want the effect of a filter to remain constant over time, move the Start and End 
sliders to the same setting. You can lock the Start and End sliders together by holding down 
the Shift key as you make adjustments.

 

5

 

To apply additional filters to the clip, repeat steps 3 and 4. You can also apply the same 
filter to a clip several times to intensify (double, triple, etc.) the effect of the filter on 
the clip. 

Adobe Premiere applies filters in the order in which they appear in the Current list in the 
Filters dialog box; if you want the filters applied in a different order, rearrange the filters 
in the Current list by dragging them up or down.

Slider controls
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6

 

To remove a filter from the Current list, select the filter and click Remove (or press 
Delete), or drag the filter to the Trash.

 

7

 

Click OK to apply the filters. 

In the Construction window, clips with filters applied to them are displayed with a blue 
border at the top. 

 

Note:

 

 A filter is applied to an entire clip at a time. If you want to apply a filter to only part of 
a clip, you must split the clip using the razor tool. For more information on splitting clips in 
the Construction window, see “Splitting Clips” on page 91.

 

Changing Adobe Photoshop filters over time

 

You can apply any Adobe Photoshop filter that lets you specify settings to clips over time. 
For example, you can apply the Tiles filter in such a way that the clip is progressively 
distorted as it plays.

 

Tiles filter applied over time

 

To apply an Adobe Photoshop filter to a clip over time:

 

1

 

Follow the basic procedure described in the previous section, “Applying filters to a clip,” 
to apply the filter. When the Settings dialog box first appears, click OK to return to 
the Filters dialog box. The options in the Settings area of the Filters dialog box become 
available.

 

2

 

Click Start. The filter’s Settings dialog box reappears.

 

3

 

Adjust the settings as desired for the beginning of the clip, and click OK.

 

4

 

Click End in the Filters dialog box. The Settings dialog box appears again.

 

5

 

Adjust the settings as desired for the end of the clip, and click OK. The Vary option in 
the Filters dialog box is now selected to indicate that you have varied the filter over time.

 

6

 

If you want to exchange the Start and End settings, click Swap.

 

7

 

If you want to cancel the time effect and use the Start settings for the entire clip, deselect 
the Vary option.
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Determining which filters have been applied to a clip

 

In the Construction window, clips that have filters applied to them are displayed with a 
blue border at the top. You can quickly view a list of the applied filters for a selected clip 
and then change filter settings if you want to.

 

To determine which filters and filter options have been applied to a clip:

 

1

 

While pressing the Option key, move the pointer over a clip in the Construction 
window. The pointer changes to an icon of a miniature menu.

 

2

 

Hold down the mouse button to display a pop-up menu of filters that have been applied 
to the clip. 

 

3

 

To view or change filter settings set for a clip, select the filter name from the pop-up 
menu. You can also apply additional filters by choosing Filters from the pop-up menu. 

 

MOVIE AND STILL-IMAGE FILTERS 

 

Adobe Premiere includes the following filters that can be applied to movie and still-image 
clips. For samples of many of these filters, see “Effects of Various Filters” on page 167. 

 

Anti-alias 

 

The Anti-alias filter smooths an entire image by averaging the colors in areas of high 
contrast. Averaging colors adds intermediate shades that make transitions between dark 
and light areas appear more gradual.

 

Backwards (Video)

 

The Backwards (Video) filter plays a clip from the last frame to the first frame. This filter 
overrides any filter preceding it in the Filters dialog box. 

An alternate way to play a clip backwards is to set a negative speed for the clip. For infor-
mation on setting clip speed, see “Setting the Forward or Backward Speed of a Clip” 
on page 98.
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Bend

 

The Bend filter bends an image by stretching it horizontally and vertically. You can select 
a sine, circle, triangle, or square for the wave type, and adjust the intensity, rate, and width 
of the wave shape using the sliders in the filter’s dialog box. You can also indicate the direc-
tion in which the wave should move. Choose Left, Right, In, or Out for the horizontal 
direction, and Up, Down, In, or Out for the vertical direction. 

 

Black & White

 

The Black & White filter reduces all colors to shades of gray.

 

Blur and Blur More

 

These filters eliminate noise in the parts of the image where significant color transitions 
occur. The Blur filter has a subtle effect, suitable for high-resolution images. The Blur 
More filter produces an effect three to four times stronger than the Blur filter and is more 
suitable for lower-resolution images. 

 

Brightness & Contrast 

 

The Brightness & Contrast filter adjusts the brightness and contrast of the image. As you 
drag the sliders in the filter’s dialog box, the preview of the image changes to reflect your 
adjustments.

 

Burn Time Code

 

The Burn Time Code filter makes the clip’s nondrop-frame timecode visible in a small 
rectangle at the bottom of the image. If the clip was not captured with a timecode, you can 
specify a timecode value. You can align the timecode display horizontally and choose a 
typeface and style for the text. If you want to make the drop-frame timecode visible, select 
Drop-Frame. 

To choose colors for the background rectangle and for the text, click the corresponding 
color swatches. When you click a color swatch, a color picker appears. For information on 
using a color picker, see “Using the Apple and Premiere Color Pickers” on page 143.
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Camcorder

 

The Camcorder filter simulates the viewfinder of a camcorder. You select what is displayed 
in the viewfinder: frame guides, record indicators, date and time annotation, title. You also 
select a typeface and style, and how many times per second blinking items should blink.

To choose colors for the Frame Guide, Record Indicator, and Text, click the corresponding 
color swatches. When you click a color swatch, a color picker appears. For information on 
using a color picker, see “Using the Apple and Premiere Color Pickers” on page 143.

 

Camera Blur 

 

The Camera Blur filter simulates an unfocused camera lens. It provides a means for 
creating an extreme blur effect. By applying the effect to either the starting or ending frame 
of a clip, you can simulate the image going in or out of focus.

 

Clip

 

The Clip filter trims rows of pixels off the edges of a clip. This can be useful for trimming 
away noise and pixel skew that may result from overscanning during digitizing. Use the 
slider controls to crop each edge of the image separately. You have the option of clipping 
in pixels or image percentage. 

If you want Adobe Premiere to automatically resize the trimmed clip to its original dimen-
sions, use the Crop filter instead of the Clip filter.
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Color Balance

 

The Color Balance filter changes colors in the image by adjusting the RGB levels. Drag the 
sliders in the filter’s dialog box to make a color more or less prominent. As you drag the 
sliders, the preview of the image in the dialog box changes to reflect your adjustments.

 

Color Offset 

 

The Color Offset filter shifts the red, green, or blue channel of your image in one direction 
without moving the other two channels. 

 

Note:

 

 When creating a movie to be viewed through 3D glasses (one red lens and one blue lens), 
shifting the red channel to the left makes the image drop back, while shifting the red channel 
to the right brings the image forward. Small shifts are usually sufficient for considerable three-
dimensional effects. 

 

Color Pass

 

The Color Pass filter changes all colors in an image, with the exception of a single color, to 
black and white. In the Color Pass Settings dialog box, select a color by clicking the color 
in the Clip Sample box (the pointer turns into the eyedropper tool when placed on the 
Clip Sample box), or by clicking the color swatch to display the color picker to select a 
color. (For a description of the color picker, see “Using the Apple and Premiere Color 
Pickers” on page 143.) Drag the Similarity slider to select colors similar to the swatch color. 
Click Reverse to change only the selected color to black and white. 

 

Color Replace 

 

The Color Replace filter replaces all occurrences of a selected color with a new color. To 
select the color to be replaced, click the color in the Clip Sample box or click the color 
swatch to display the color picker; then click the Replace Color box to access the Color 

Eyedropper tool
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Picker dialog box and select the replacement color. Drag the Similarity slider to select 
colors similar to the selected color. Click Solid Colors to create an opaque replacement 
color. 

 

Convolution Kernel 

 

The Convolution Kernel filter changes the brightness values of each pixel in the image 
according to a predefined mathematical operation known as a convolution. The Convolu-
tion Kernel Settings dialog box displays a grid that represents a pattern of pixel brightness 
multipliers, with the source pixel being evaluated in the center of the grid. 

 

To specify the Convolution Kernel settings:

 

1

 

Choose Filters from the Clip menu, select Convolution Kernel from the Available list, 
and click OK. The Convolution Kernel dialog box appears.

 

2

 

Click the center text box. This box represents the pixel being evaluated. Enter the value 
by which you want to multiply that pixel’s brightness value. Values can range from +999 
to –999.

 

3

 

Click a text box representing an adjacent pixel to which you want to assign a weighted 
value. Enter the value by which you want the pixel in that position multiplied. For 
example, if you want the brightness value of the pixel to the right of the current pixel 
multiplied by 2, enter 2 in the text box to the right of the center box.
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4

 

Repeat step 3 for all pixels you want to include in the operation. You don’t have to enter 
values in all of the text boxes.

 

5

 

In the Scale text box, enter the value by which to divide the sum of the brightness values 
of the pixels included in the calculation.

 

6

 

In the Offset text box, enter the value to be added to the result of the scale calculation.

 

7

 

Click OK. The filter is applied to each pixel in the image, one at a time.

 

Crop

 

The Crop filter trims rows of pixels from the edges of a clip and automatically resizes the 
trimmed clip to its original dimensions. This can be useful for trimming away noise and 
pixel skew that may result from overscanning during digitizing. Use the slider controls to 
crop each edge of the image separately. You have the option of cropping in pixels or image 
percentage. 

If you don’t want Adobe Premiere to automatically resize the trimmed clip to its original 
dimensions, use the Clip filter instead of the Crop filter.

 

Crystallize

 

The Crystallize filter creates a distorted mosaic pattern by clumping adjacent pixels into a 
solid color in a polygon shape, or

 

 cell

 

. In the filter’s dialog box, you can set the cell size from 
3 pixels to 999 pixels.

 

Emboss

 

The Emboss filter makes an image appear raised or stamped by suppressing the color and 
tracing the edges with black. 

 

Extract

 

The Extract filter extracts a grayscale mask from a video clip. The Extract Settings dialog 
box displays a histogram and a preview of the grayscale mask. Drag the slider controls 
directly below the histogram to specify the gray levels of the source image that will be 
translated to white. All other areas will become black. The softness control adjusts the 
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intermediate shades of gray. The Invert button inverts the effect. The display at the bottom 
of the dialog box shows the mapping function that is being applied to the image to 
generate the mask.

 

Field Interpolate

 

The Field Interpolate filter recreates a missing field (usually the odd or even scan lines that 
have been dropped during image capture) by using line averages. This filter can be useful 
for full-screen output where a missing field is likely to be noticeable.

 

Filter Factory

 

The Filter Factory filter lets you create your own filters for use by Adobe Premiere. For 
information on using the Filter Factory, see “Creating Custom Filters” on page 169.

 

Find Edges

 

The Find Edges filter outlines the edges of a color image with colored lines and outlines 
the edges of a grayscale image with white lines. 

 

Gamma Correction

 

The Gamma Correction filter lightens or darkens an image without substantially changing 
the shadows and highlights. It does this by changing the brightness levels of the midtones 
(the middle-gray levels) while leaving the black and white areas unaffected. The default 
gamma setting is 1.0. In the filter’s dialog box, you can adjust the gamma from 0.1 to 2.9.
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Gaussian Blur

 

The Gaussian Blur filter blurs an image by a large amount; the effect is similar to that of 
choosing the Blur or Blur More filters several times. (

 

Gaussian

 

 refers to the bell-shaped 
curve that is generated by mapping the color values of the affected pixels.) This filter 
improves the quality of images with sharp edges and can produce a hazy effect. 

 

Gaussian Sharpen

 

The Gaussian Sharpen filter sharpens an image by a large amount; the effect is similar to 
that of choosing the Sharpen or Sharpen More filter several times. 

 

Ghosting

 

The Ghosting filter overlays previous frames of a clip with other transparent frames to 
create a ghost-like effect. 

 

Horizontal Flip

 

The Horizontal Flip filter reverses the image from left to right; the clip still plays in a 
forward direction, however.

 

Hue and Saturation

 

The Hue and Saturation filter adjusts the hue, saturation, and lightness of the image. Drag 
the sliders to maximize or minimize each color component. As you drag the sliders, the 
preview of the image in the dialog box changes to reflect your adjustments.

 

Image Pan

 

The Image Pan filter pans across images larger than the output frame size. You can easily 
create rolling credits, or simulate the pan and zoom movements of a camera. You can also 
use the Image Pan filter to scale an image up or down to match the output frame size. 

In the Image Pan Settings dialog box you set a cropping rectangle to define the starting and 
ending frames of the clip. Adobe Premiere then interpolates the motion between these 
frames. In the dialog box, the size and location of each cropping rectangle are posted above 



 

Premiere User Guide 6/2/94 10:30 c6.pdf.frame

 

Right master page

 

the starting and ending frames of the clip. Adjust the size of the cropping rectangles by 
clicking the corners and dragging. Adjust the location by clicking inside the rectangle and 
dragging.

 

Adjusting the size of the cropping rectangle

Adjusting the location of the cropping rectangle

 

You can produce a zoom effect by varying the size of the crop rectangle in the starting and 
ending frames of the clip. You can produce a pan effect by placing the crop rectangles at 
different locations in the starting and ending frames. If the source clip is large enough, you 
can set the size of the crop rectangles to match the output frame size without causing the 
program to interpolate data (which can cause image degradation). 
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If you apply the Image Pan filter without adjusting the crop rectangles, the full frames of 
the clip will be scaled to the output frame size of the movie. If the source clip has a frame 
size that is smaller than the output frame size, Adobe Premiere will use interpolation to 
produce a clean scale up. Doing so provides better scaling than QuickTime can when it 
adjusts the size during the Make Movie process. Using the Image Pan filter this way is 
equivalent to using the Resize filter.

 

Invert

 

The Invert filter changes all colors to their opposite on the color wheel.

 

Lens Flare

 

The Lens Flare filter simulates the refraction caused by shining a bright light into the 
camera lens. Specify a value (or use the slider) to indicate the percentage of brightness. 
Values can range from 10 percent to 300 percent. Select a lens type, and click anywhere 
inside the image thumbnail to specify a location for the center of the flare.

 

Levels

 

The Levels filter manipulates the brightness and contrast of an image. It combines the 
functions of the Color Balance, Gamma Correction, Brightness & Contrast, and Invert 
filters into one filter.
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The Levels Settings dialog box displays a histogram of the image. The 

 

x

 

-axis of the histo-
gram represents brightness values from darkest (0) at the far left to brightest (255) at the 
far right; the 

 

y

 

-axis represents the total number of pixels with that value. The darkest pixels 
appear to the left; the brightest pixels appear to the right.

Use the slider controls directly below the histogram to increase contrast in the image. The 
black triangle controls the shadows, the gray triangle controls the midtones, and the white 
triangle controls the highlights. Drag the black triangle to the right to increase the 
shadows. Drag the white triangle to the left to increase the highlights. You can also enter 
the values directly into the Input Levels text boxes.

Use the Output Levels slider controls at the bottom of the dialog box to reduce the contrast 
in the image. Drag the black triangle to the right to eliminate the darkest values in the 
image. Drag the white triangle to the left to eliminate the brightest values in the image. You 
can also enter the values directly into the Output Levels text boxes.

 

Mesh Warp

 

The Mesh Warp filter creates a progressive distortion from the first to last, or last to first, 
frames of a clip. You can also create a blend between distortion settings in both the first 
and last frame of the clip. The sample illustrations shown here reflect distortion settings 
created in only the last frame of the clip; the clip begins without distortion and blends to 
the last frame, which contains the distortion settings. 

The Start and End boxes in the filter’s dialog box represent the first and last frames of the 
clip. You use the sample frames at the top of the dialog box to position individual grid 
points around the portion of the image you want to distort; then you drag the points on 
the sample frames at the bottom of the dialog box to distort the image. 
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To create a progressive distortion:

 

1

 

Position the pointing finger on individual grid points; then hold down the Shift key and 
drag to position the points around the edges of the distortion area. Positioning grid points 
around the distortion area gives you greater control over the distortion area. 

 

Positioning points around the area of the image to be distorted

 

2

 

Drag the grid points surrounding the distortion area on the lower frame to distort 
the image on the last frame of the clip. 

 

3

 

Click the Copy buttons to copy the distortion settings from the starting frame of the clip 
to the ending frame of the clip and vice versa. 

 

4

 

Click Exchange to exchange the distortion settings created for the first frame of the clip 
with those created for the last frame of the clip. 
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5

 

Click Save to save the distortion settings you created for a clip; then type a name for the 
distortion settings file. Click Load and select a previously saved distortion settings file that 
you want to apply to another clip. 

 

Mosaic

 

The Mosaic filter divides the image into a grid of squares and makes each square the 
average color of all the colors in the square. You can make the effect of the Mosaic filter 
gradually increase or decrease as the clip plays by adjusting the Start and End controls in 
the filter’s dialog box. 

 

Pinch

 

The Pinch filter distorts an image by stretching the image toward the center from the 
edges. The filter’s dialog box contains an option for setting the percentage of pinching.

 

Pointillize

 

The Pointillize filter breaks up the color in an image into randomly placed dots, like a 
pointillist painting, and uses a black background as a canvas area between the dots. In the 
Pointillize dialog box, you can set the cell size from 3 pixels to 999 pixels; this determines 
the size of the dots.

 

Polar

 

The Polar filter converts a clip from its rectangular to polar coordinates and vice versa. 
This filter can create a cylinder anamorphosis, a type of art popular in the 18th century in 
which the distorted image is difficult to recognize unless viewed in the reflection of a 
mirrored cylinder.

 

Posterize

 

The Posterize filter converts the color spectrum into a limited number of colors and maps 
pixels in the image to the color that is the closest match. You can use this filter to create 
large, flat areas in an image. As you drag the slider in the filter’s dialog box, the small 
preview image changes to reflect your adjustments.

 

Posterize Time

 

The Posterize Time filter displays a new frame at the interval you set in the filter’s dialog 
box to create a halting effect as the clip plays, effectively lowering the frame rate.

 

Radial Blur

 

The Radial Blur filter produces a soft blur by simulating the effect of a zooming or rotating 
camera. Select the Spin blur method to blur along concentric circular lines, as if rotating 
the camera. Select the Zoom blur method to blur along radial lines. You can drag the dot 
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in the Blur Center box to change the origin of the blurring. You can also set the Amount 
of the blur from 1 to 1000. With the Spin blur method, this value reflects the degree of 
rotation; with the Zoom blur method, this value reflects the intensity of the blur. 

 

Replicate

 

The Replicate filter divides the screen into tiles and displays the whole image in each tile. 
You can set the number of tiles by dragging the slider in the Replicate Settings dialog box. 
Hold down the Shift key and drag to adjust both sliders to the same setting.

 

Resize

 

The Resize filter resizes the image to the output frame size using interpolated scaling. This 
provides better scaling than QuickTime can achieve when it adjusts the size during the 
Make Movie process.

 

Ripple

 

The Ripple filter produces an undulating pattern on an image, like ripples on the surface 
of a pond. You can select a sine, circle, triangle, or square for the wave type, and adjust the 
intensity, rate, and width of the wave shape using the sliders in the filter’s dialog box. You 
can also indicate the direction in which the ripple should move; choose Left, Right, In, or 
Out for the horizontal direction and Up, Down, In, or Out for the vertical direction. 

 

Roll

 

The Roll filter rolls an image to the left or to the right, or up or down, as if the image were 
on a cylinder. 

 

Sharpen and Sharpen More

 

The Sharpen and Sharpen More filters improve the clarity of an image by increasing the 
contrast in adjacent pixels. 

 

Sharpen Edges

 

The Sharpen Edges filter finds the areas in the image where significant color changes occur, 
and sharpens them. 

 

Shear

 

The Shear filter distorts an image along a curve. Drag the band in the middle of the dialog 
box to form a curve that indicates how you want the image distorted. You can adjust any 
point along the curve. Select how to treat areas of the image left undefined by the shear:

 

O

 

Wrap Around wraps the image to fill the undefined space, so that the area is filled with 
content from the opposite side of the image.
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O

 

Repeat Edge Pixels extends the colors of the pixels along the edge of the image in the 
direction specified. This creates a banding effect if the edge pixels are different.

 

Solarize

 

The Solarize filter creates a blend between a negative and positive image, creating a “halo” 
effect. This effect is analogous to briefly exposing a print to light during developing.

 

Spherize

 

The Spherize filter wraps an image around a spherical shape, and is useful for giving 
objects and text a three-dimensional effect. You can set the intensity (amount) from –100 
to 100. You can also select the direction in which the effect is applied: Horizontal Only, 
Vertical Only, or Normal (in all directions).

 

Tiles

 

The Tiles filter breaks up an image into a series of tiles. In the filter’s dialog box, you specify 
the number of vertical tiles you want, the maximum distance you want a tile to be offset 
from its original position, and how you want to fill the area between tiles. You can fill this 
area with white (the background color), with black (the foreground color), with an inverse 
image, or with the unaltered image. 

 

Tint

 

The Tint filter applies a tint to an image. To select the tint color, click the color swatch in 
the Tint Settings dialog box to display the color picker. Set the level of the tint (from 1 to 
100 percent) in the filter’s dialog box. (For more information on the color picker see 
“Using the Apple and Premiere Color Pickers” on page 143.)

 

Twirl

 

The Twirl filter rotates an image around its center. The image is rotated more sharply in 
its center than at the edges. In the filter’s dialog box, you enter the twirl angle, ranging 
from –999 to +999. 

 

Vertical Flip

 

The Vertical Flip filter flips an image upside down. 

 

Video Noise

 

The Video Noise filter adds a small amount of video noise to a clip. This can be useful 
when you want to visually blend a clean still image or graphic with a video clip that 
has noise.

 

Wave

 

The Wave filter distorts an image to make it wave-shaped. 
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To specify the Wave settings:

 

1

 

Choose Filters from the Clip menu, select Wave from the Available list, and click OK. 
The Wave dialog box appears.

 

2

 

Specify the number of wave generators, from 1 to 100.

 

3

 

Specify the wavelength and amplitude for the generators. The 

 

wavelength

 

 is the distance 
from one wave crest to the next, specified by a value from 1 to 9999 in the Minimum and 
Maximum Wavelength fields. The 

 

amplitude

 

 is the height of the wave, specified by a value 
from 1 to 9999 in the Minimum and Maximum Amplitude fields. 

 

4

 

Select Randomize if you want Adobe Premiere to randomly select a value that falls 
between the minimum and maximum wavelength and amplitude values; otherwise the 
waves are of a uniform amplitude and frequency. 

 

5

 

Set the horizontal and vertical scale from 1 percent to 100 percent. These parameters 
control the magnitude of the distortion, both horizontally and vertically. Setting them to 
0 gives you an undistorted image. 

 

6

 

Select the type of shape you want the waves to have: Sine (rolling), Triangle (pointed 
crests), or Square (square crests).

 

7

 

Set the Undefined Areas option to select how to treat portions of the image pulled into 
the selection from the edges. The Wrap Around option wraps the image to fill the space; 
the Repeat Edge Pixels option extends the colors of the pixels along the edge of the image.

 

8

 

Click OK.
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Zig Zag

 

The Zig Zag filter distorts an image radially. The Amount field represents the magnitude 
of distortion; enter a value from 0 to 999. The Ridges field represents the number of direc-
tion reversals of the zigzag from the center of the clip to its edge; enter a value from 1 to 
999. Select an option to displace the pixels in the image: the Pond Ripples option displaces 
pixels to the upper left or lower right; the Out From Center option displaces pixels toward 
or away from the center of the image; the Around Center option rotates pixels around the 
center of the image.

 

AUDIO FILTERS

 

Audio filters control selected frequencies and alter the overall sound of your audio clips. 
Adobe Premiere includes five audio filters. 

 

O

 

The Backwards audio filter plays sound backwards. This filter overrides any filter 
preceding it in the Filters dialog box. An alternate way to play a clip backwards is to set a 
negative speed for the clip. For information on setting clip speed, see “Setting the Forward 
or Backward Speed of a Clip” on page 98.

 

O

 

The Boost filter amplifies weak sounds while leaving loud sounds intact.

 

O

 

The Fill Left and Fill Right filters allow you to isolate the audio track to one channel 
or another.

 

O

 

The Echo filter creates an echo effect. The Echo Settings dialog box contains options for 
setting the delay and the intensity of the echo. The Delay option lets you control the length 
of time between the beginning of the original sound and the beginning of its echo. 
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EFFECTS OF VARIOUS FILTERS

 

Original

Original

Brightness & Contrast Camera Blur

Gaussian Blur

Ghosting Horizontal Flip Invert

Mosaic Pinch Pointillize Posterize

Radial Blur Replicate Sharpen Shear

CropClip

Extract Find EdgesEmboss

Lens Flare

Solarize Spherize Tiles Zig Zag
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CREATING CUSTOM FILTERS

 

In addition to the many filters included with Adobe Premiere, you can create your own 
filters using the Filter Factory. You determine how you want the filter to affect the channels 
(alpha, red, green, and blue) of each pixel in the first image and the second image by spec-
ifying arithmetic expressions. 

The filters you create can also include Settings dialog boxes. The Settings dialog box 
provides up to eight sliders for adjusting the filter’s effect. When you design a filter, you 
include user-supplied slider information in the expression. You also determine the 
number of sliders and whether they appear in the Settings dialog box individually or in 
pairs.

When you create a filter, you can save its expressions in a text file. Doing so lets you use the 
Filter Factory to edit the filter later.

The next two procedures explain how to use the Filter Factory to apply and save filters for 
use in Adobe Premiere. For a complete discussion of using arithmetic expressions to 
achieve an effect, see Appendix B “Expressions for Creating Transitions and Filters.” The 
expressions described in Appendix B are used by both the Filter Factory and the Transition 
Factory.

 

To create a custom filter:

 

1

 

In the Construction window, select the clip to which you will apply the filter. 

 

2

 

Choose Filters from the Clip menu. The Filters dialog box appears.

 

3

 

Select Filter Factory from the Available list and click Add. The Filter Factory Settings 
dialog box appears. 

The zoom, hand, and Preview window tools work the same as those in the standard 
Settings dialog boxes. For information on using these tools, see “Applying Filters to a Clip” 
on page 146.

 

4

 

Specify the expressions as follows:

 

O

 

To specify an expression in the alpha channel, select Single Expression and type the 
expression in the A field. The evaluation of the alpha channel expression will be applied to 
each of the other three channels: R, G, and B; when the same value is applied to each 
channel of the pixels in an image, the image will be a grayscale image. 

 

O

 

To specify separate expressions for the R, G, and B channels, type the expressions in the 
R, G, and B fields. Even if you specify the same expression in all three channels, their eval-
uations will probably be different.
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For information on how to use expressions to achieve a result, see Appendix B, “Expres-
sions for Creating Transitions and Filters.” 

As you type an expression, a small yellow caution sign appears. It will remain visible until 
you have typed a legal expression. If the caution sign does not disappear, it means that 
there is an error in the expression. To see which part of the expression is in error, click the 
caution sign to select the incorrect portion.

 

5

 

If the expressions include user-supplied slider information, drag the appropriate Map 
sliders to preview the effects. The Map 0 sliders correspond to sliders 0 and 1; the Map 1 
sliders correspond to sliders 2 and 3; and so on. For information on including user-
supplied slider information in expressions, see “Providing User-Controlled Sliders” 
on page 306.

 

6

 

When you have correctly set up the filter, click Save to save the expressions in a text file. 
Saving the expression allows you to load and edit the filter in the future. The text file 
should have the same name as the filter, but save the text file in a folder other than the 
Adobe Premiere Plug-Ins folder. 

 

7

 

If you want to use this one instance of the filter only, click OK to apply the filter. If you 
want to use the filter more than once, see the next procedure, “To save a custom filter for 
additional use.”

 

To save a custom filter for additional use:

 

1

 

Follow steps 1 through 6 of the previous procedure, “To create a custom filter.”

 

2

 

Click Build. The Build Custom Filter dialog box appears. 

 

3

 

Name the filter using the Title field. The name will appear in the Available list of the 
Filters dialog box and in the title of the filter’s Settings dialog box, if there is one.

 

4

 

Use the Credits field to include credits or copyright information in the filter’s Settings 
dialog box; delete any information you do not want from the Credits field.

 

5

 

If the filter’s expressions include user-supplied slider information, select the appropriate 
number of Slider or Map options and specify labels for the sliders in the corresponding 
text boxes. The labels will appear with the sliders in the filter’s Settings dialog box. 
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To display the sliders individually in the Settings dialog box, use the Slider options. To 
display the sliders in pairs, use the Map options. Whether you should use individual or 
paired sliders depends on the type of filter you are creating. 

 

6

 

Click OK. A standard Save dialog box appears. Save the filter in the Adobe Premiere 
Plug-Ins folder. 

 

7

 

To make the filter available to users, restart the Adobe Premiere program.

 

To edit a custom filter:

 

1

 

In the Construction window, select the clip to which you want to apply the filter. 

 

2

 

Choose Filters from the Clip menu. The Filters dialog box appears.

 

3

 

Select Filter Factory from the Available list and click Add. The Filter Factory Settings 
dialog box appears. 

 

4

 

Click Load. Use the Open dialog box to load the text file containing the filter’s expres-
sions. You must have saved the expressions in a text file when you created the filter to be 
able to edit it.

 

5

 

Follow the steps in the previous two procedures to edit and rebuild the filter.

 

CREATING MOTION

 

Adobe Premiere lets you define a path along which a clip can move in the movie frame. 
You can define a path of movement for any movie or still-image clip. You begin by creating 
points on a motion path; then you can choose from several motion options for each point 
on the path.

 

Note:

 

 Adobe Premiere uses subpixel motion. This positions an image in increments of 
1/256 pixels, resulting in extremely smooth motion and rotation.

 

To define a path of movement for a clip: 

 

1

 

Select a clip in the Construction window.

 

2

 

Choose Motion from the Clip menu. The Motion Settings dialog box appears. 
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In the top left corner of the dialog box, a sample of the selected clip appears as it moves 
along the default path of movement. The default path has only Start and Finish points. 

 

3

 

Begin setting points of movement using one of the following methods:

 

O

 

Move the Start and Finish points.

 

O

 

Position the pointer anywhere on the motion path. The pointer turns into a pointing 
finger. Click to add a point to the path, and drag to adjust its position on the path. When 
you release the mouse, the point is selected and you can add options to the selected point. 

 

O

 

Click above the timeline. 

Timeline

Finish point

Collapse preview button

Start point
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Adjusting points on the motion path

 

Once you have created each of the points on the motion path, you can select and adjust 
each point’s position.

 

To select a point on the motion path:

 

O

 

Click a point with the pointing finger pointer, or press the Tab key to select successive 
points from the Start to Finish positions along the path of movement. 

 

O

 

Hold down the Shift key and press Tab to move from point to point in the opposite 
direction.

 

Note:

 

 If a text entry box is active in the Motion Settings dialog box, pressing Tab will highlight 
successive text boxes rather than select successive motion points.

 

To adjust the positioning of a point on the motion path:

 

1

 

Select the point.

 

2

 

Use one of the following methods to adjust the point’s position:

 

O

 

Press an arrow key to move the selected point 1 pixel at a time in the direction 
of the arrow. 

 

O

 

Hold down the Shift key and press an arrow key to move the point in 5-pixel increments. 

 

O

 

Enter coordinates for the point’s position in the Info field below the timeline.

 

To center the image frame at a point on the motion path:

 

1

 

Select the point.

 

2

 

Enter coordinates of (0, 0) for the point’s position in the Info field below the timeline. 
You can click the Center button to let Adobe Premiere enter these coordinates.

 

To copy the motion settings from one point to another point: 

 

1

 

Select the point from which you want to copy the settings.

 

2

 

Press Command-C. 

 

3

 

Select the point you want to paste settings to, and press Command-V. 

 

To delete a point:

 

Select the point, and press Delete. 
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Observing the effects of motion

 

The motion settings are applied to the sample in the upper left corner of the Motion 
Settings dialog box, letting you see the settings’ effects immediately. If you want to move 
the sample to the Preview window, click the Preview button next to the sample.

You can also preview the motion settings by dragging through the gray bar below the time-
line. To observe the effects for specific points along the path of movement, click the Pause 
button next to the motion thumbnail and click a point on the gray bar below the timeline. 
You can also use the spacebar to start and pause the preview. Click Show All to see the 
other video tracks in your movie included in the preview.

 

Changing the speed of motion

 

Points that have been added to the path of motion are represented on the timeline below 
the path. The length of the timeline represents the duration of the clip. The relative speed 
of motion between path points is determined by the distance between points along the 
timeline. Adjust the speed by dragging points closer together or farther apart along the 
timeline.

The time indicator next to the timeline displays the time setting for the selected point in 
one of two ways:

 

O

 

If you set the blue time indicator toggle so that the two arrows touch, the time shown is 
where the point occurs, measured from the beginning of the clip. 

 

O

 

If you set the toggle so that the two arrows are separated, the time shown is where the 
point occurs, measured from the beginning of the project in the Construction window.

 

Specifying movement options

 

This section describes how to use the Motion Settings dialog box to specify movement 
options along the path of motion for a clip. An image can be rotated, distorted, and 
zoomed in or out along the path. 

Adobe Premiere distributes the effects of movement options between successive points on 
the motion path. For example, consider successive points A, B, and C along a motion path: 
point A has a rotation setting of 0 degrees; point B has a rotation setting of 90 degrees; and 
point C has a rotation setting of 0 degrees. The clip is oriented at 0 degrees at point A. The 

Time indicator toggle

Time indicator
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clip rotates 90 degrees clockwise as it moves between points A and B; then it rotates 90 
degrees counterclockwise as it moves between points B and C to return to its 0 degree 
orientation.

 

To set movement options for a point on a path:

 

1

 

In the Motion Settings dialog box, click to select a point where it falls on the timeline or 
along the path of movement.

 

2

 

Choose from the following options: 

 

O

 

Rotation lets you specify the angle of rotation for a clip at a specific point. The angle can 
range from –1440 degrees to 1440 degrees, resulting in up to eight full rotations of the clip. 
The clip begins to rotate as it moves from the preceding point on the movement path 
toward the selected point on the movement path. Use the tractor tread slider control, or 
type in an angle for the rotation.

 

O

 

Zoom lets you enlarge or decrease the size of a clip at a specific point on the movement 
path. Adjust the zoom level using the tractor tread slider control or by typing in a value 
between 0 percent and 500 percent.

Delay sliderRotation

slider Zoom slider
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O

 

Delay causes a clip to pause for an amount of time on the movement path. To set a delay, 
use the tractor tread slider. A blue bar appears on the timeline, indicating the length of the 
delay. A percentage value for the delay (relative to the total clip duration) appears next to 
the slider.

 

O

 

Motion achieves smooth motion when zooming by speeding up or slowing down move-
ment where necessary. If the clip’s motion is zooming from small to large, select Accelerate. 
If the clip’s motion is zooming from large to small, select Decelerate.

 

O

 

Distortion lets you distort the image at a point along the movement path. Drag the four 
corners of the thumbnail image in the distortion box to define the distortion. 

To spin a distorted image around a center point, hold down the Option key and position 
the pointer on a corner point; then drag to spin the image around a center point. 

Distorting the image

at a point
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To move all four corner points at once, hold down the Shift key and position the pointer 
in the center of the image. 

 

O

 

Reset removes the distortion, delay, rotation, and zoom settings for a selected point. 

 

3

 

Set the following motion options that apply to all points on the path:

 

O

 

Fill Color lets you select a background color for the moving clip. To select a background 
color, click the desired color on the thumbnail in the Fill Color box (the pointer turns into 
the eyedropper tool when it is on the thumbnail), or click the color swatch above the 
thumbnail to access the color picker and choose a color. 

 

O

 

Smooth Motion smooths the path along which the clip travels. This option smooths 
sharp changes in direction, rotation, and distortion.

 

O

 

Alpha: Use Clip’s is used if you are superimposing the clip using its existing alpha 
channel. This is the normal setting for titles or graphics created in another application that 
has alpha channels, such as Adobe Photoshop. This option will only affect clips that have 
been assigned an Alpha Key Type in the Transparency Settings dialog box. 

 

O

 

Alpha: Create New is used to create an opaque fill for clips that do not have an existing 
alpha channel. With this option selected, an alpha channel is created in the shape of the 
clip as it moves. This option only affects clips that have been assigned an alpha key type in 
the Transparency Settings dialog box. 

 

Note:

 

 

 

Choosing the Create New option for an image containing an alpha channel overwrites 
the original alpha channel when the image is superimposed.

 

O

 

Show All displays the image along the motion path as it would be composited in the 
Construction window, including transitions, filters, and transparency settings. Note that 
the motion thumbnail will not play as smoothly with this option selected.
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O

 

Show Outlines displays an outline of each frame along the path of movement. 

 

Saving, loading, and deleting motion settings 

 

You can use the Save and Load buttons in the Motion Settings dialog box to save the 
motion settings you create for a clip for later use with other clips. Motion settings are 
applied to entire clips; they cannot be applied to a limited number of frames of a clip. 

To remove all motion settings applied to a clip, click Remove in the Motion Settings 
dialog box.

 

Note:

 

 Adobe Premiere includes a set of motion path settings, which are contained in the 
Motion Settings folder. 
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Chapter 

 

7

 

: Creating

 

 

 

Superimpositions

 

 

 

and Titles

 

 

 

his chapter explains how to superimpose movie and still-image clips. It also 
describes how to use Adobe Premiere’s Title window to create titles and graphics 
for a movie. The Title window lets you create clips with both stationary and 

 

animated type. Title clips can be superimposed to create titles and credits that play over 
other clips.

 

SUPERIMPOSING CLIPS

 

The process of superimposition, called 

 

keying

 

 in television production and 

 

matting

 

 in film 
production, incorporates various methods of playing a clip over another clip. You make 
areas of the top clip, called the superimposed clip, transparent to allow the bottom clip (or 
background clip) to show through. Adobe Premiere creates transparency in the superim-
posed clip in a variety of ways, from blocking out portions of the clip (creating a matte) to 
specifying ranges of color to be transparent. 

Clips that you want superimposed can go on any of the superimpose (S) tracks in the 
Construction window. Clips that you want playing underneath go on tracks A or B, 
aligned with the clips on the S track. Adobe Premiere constructs superimpositions by first 
assembling the clips on tracks A and B, including any effects on the transitions (T) track, 
and then superimposing the clips on the S tracks onto the assembled clips. Clips on the S 
tracks are superimposed in numerical order as they appear in the Construction window. 
Thus, clips on higher numbered S tracks are played over clips on lower numbered S tracks.

Once you place a clip on an S track, you can specify the parts of the clip that you want to 
make transparent using the Transparency Settings dialog box.

 

T
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To superimpose a clip:

 

1

 

Drag the clip from the Project window to an S track in the Construction window. 

 

2

 

Select the clip on the S track.

 

3

 

Choose Transparency from the Clip menu. The Transparency Settings dialog box 
appears.

The first frame of the clip appears in the Sample box in the upper right corner of the dialog 
box. For some key types the frame will also appear in the color swatch.

 

Note:

 

 Because the effects of any filters applied to a clip are displayed in the Transparency 
Settings dialog box, filters can slow the display of the dialog box considerably. If possible, 
choose transparency settings before applying filters to a superimposed clip. 
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4

 

Choose a key type from the Key Type pop-up menu. For an explanation of key types, see 
“Selecting a Key Type for a Clip” on page 183.

 

5

 

Choose one of three options for the way the background appears in the Sample box: 

 

O

 

Set the background to black or white by clicking the black-and-white icon below the 
Sample box (continue clicking to toggle between white and black). 

 

O

 

Set the background to checkerboard by clicking the checkerboard icon (click again to 
reverse the pattern). 

 

O

 

To see the actual background image in the sample image, click the page peel icon.

 

6

 

Specify the areas of the clip to be transparent by adjusting the settings for the selected 
key type. For a description of the setting, see “Making Key Type Adjustments” on page 190.

For increased control in adjusting transparency settings, use the zoom and hand tools 
located below the Sample box:

 

O

 

To zoom in on the sample image, select the zoom tool and click the image.

 

O

 

To zoom out, Option-click the image with the zoom tool.

 

O

 

To reposition a close-up view of the image in the Sample box, use the hand tool.

 

O

 

To display the sample image in the Preview window, click the Collapse Preview icon.

 

Page peel icon

Zoom tool Hand tool
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O

 

To show the sample image at actual size, double-click the zoom tool icon. The plus or 
minus sign in the zoom tool appears as an outline when the image is being viewed at 
true size.

 

O

 

To fit the sample image in the Sample box, double-click the hand tool icon.

When you have selected the zoom tool, holding down the spacebar selects the hand tool. 
Likewise, you can select the zoom tool while the hand tool is selected by holding down the 
Command key.

If the clip is a movie clip, use the slider under the Sample box to scroll through the clip and 
see the effect of the transparency settings on each frame.

 

7

 

Click OK to apply the transparency settings.

 

Note:

 

 You can also apply transparency settings to a superimposed clip by holding down the 
Control and Option keys and clicking the clip in the Construction window. A pop-up menu of 
key types appears. The Transparency Settings dialog box will appear if the selected key type 
has adjustable settings.

 

Creating a garbage matte

 

With all key types, Adobe Premiere allows you to create a

 

 garbage matte,

 

 which blocks out 
areas of the clip to be transparent. The underlying clip shows through the blocked 
out areas. 

 

To create a garbage matte:

 

1

 

Select the clip for which you want to create the garbage matte, and choose Transparency 
from the Clip menu. The Transparency Settings dialog box appears.
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2

 

Create the shape for the garbage matte by dragging the handles in the corners of the clip 
in the Sample box. 

 

3

 

To make the areas outside the garbage matte transparent, select the Reverse Key option.

 

4

 

Click OK.

 

Movie cropped by
garbage matte

 

Note:

 

 Garbage mattes do not move with clips that have motion settings applied to them. For 
moving masks, the Track Matte key type is recommended.

 

Selecting a key type for a clip

 

Adobe Premiere provides 15 

 

key

 

 options, or superimpose options, that can be applied to 
a clip on an S track. The key type determines what part of the image is “keyed out,” that is, 
what part of the image is made transparent. Although all key types are described in this 
section, the effects of several key types are best displayed in color and are illustrated in 
Chapter 10, “Tips and Techniques.”

 

None

 

The default key type is None. At this setting, no part of the superimposed image is keyed 
out. However, you can set the opacity of the superimposed image by adjusting the Fade 
control beneath the clip on the S track. You can also use the None key type for creating 
garbage mattes. For more information on the Fade control, see “Adjusting the Intensity of 
a Superimposed Clip” on page 191.
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Chroma

 

The Chroma key type allows you to select a color or a range of colors in the clip to be trans-
parent. Use the eyedropper tool to select a color from the image or click the color swatch 
to select from the color picker; use the Similarity slider to select the range of similar colors 
to be keyed out. For more information on choosing a color, see “Selecting a Color to be 
Transparent” on page 191. For an example of using the Chroma key type, see “Superim-
posing Figures Against a Background” on page 267.

 

RGB Difference

 

Like the Chroma key type, the RGB Difference key type lets you select a color or a range 
of colors that will become transparent in the clip. The difference between the Chroma and 
RGB Difference key types is that the Chroma key type lets you adjust the color and the gray 
values of the superimposed pixels independently, while the RGB Difference key type 
adjusts these components together. Use the eyedropper tool to select a color from the 
image or click the color swatch to select from the color picker. Use the Similarity slider to 
select a range of similar colors. For more information on choosing a color, see “Selecting 
a Color to be Transparent” on page 191.

 

Selecting a color to be transparent

Adjusting the Similarity slider to select a range of colors
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Luminance

 

The Luminance key type lets you key out the image’s gray values, while retaining its color 
values. Use the Threshold and Cutoff sliders to adjust the shadows and definition of detail 
in the image. For an example of using the Luminance key type, see “Adding Texture to 
Movies” on page 269.

 

Alpha Channel

 

An 

 

alpha channel

 

 is an invisible grayscale channel assigned to an image, often used for 
creating masks that isolate part of the image. The Alpha Channel key type lets you super-
impose an image by keying out the black areas of an image’s alpha channel and making the 
white areas of the alpha channel opaque. You can select the Reverse Key option to reverse 
(invert) the alpha channel. 

The Alpha Channel key type does not create an alpha channel in an image. When you 
create titles and import Adobe Illustrator images, Adobe Premiere automatically creates an 
alpha channel. You must create the alpha channel in other applications with that capa-
bility, such as Adobe Photoshop. See your application’s user documentation for an expla-
nation of how it creates alpha channels. 

If your image has a 

 

straight

 

 alpha channel, use the Alpha Channel key type. If your image 
contains a 

 

premultiplied

 

 alpha channel, use either the White Alpha Matte or Black Alpha 
Matte key types because the Alpha Channel key type can cause a white or black halo 
around the image. (You can tell the difference between straight and premultiplied alpha 
channel images because a straight image may have some blockiness while a premultiplied 
image will not.) An alpha channel superimposition created on a black or white back-
ground (for example, titles on a white background) works best when using the Black 
Alpha Matte or White Alpha Matte key type. 

 

Note:

 

 Adobe Premiere creates and lets you view alpha channels in Adobe Illustrator images; 
the movie plays through the part of the image that appears black in the alpha channel. For the 
best results, make sure that your Adobe Illustrator file is on white background and use the 
White Alpha Matte key type. 
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The following illustration shows an Adobe Photoshop still image with a gradation (blend) 
in the alpha channel. The gradation in the alpha channel causes the image of the clouds to 
fade as the gradation darkens. The area where the alpha channel is solid black is trans-
parent. The area becomes less transparent as the gradation blends to 50 percent gray, and 
it becomes opaque where the gradation is 50 percent or less gray or all white.

 

Still image with gradation in Gradation in alpha channel
the alpha channel

Cloud image fades as gradation darkens in alpha channel 

 

Black Alpha Matte

 

Choose the Black Alpha Matte key type to superimpose an image that contains an alpha 
channel and that has been created on a black background. (Note that Adobe Premiere 
automatically creates alpha channels for titles and Adobe Illustrator images.) The Black 
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Alpha Matte key type eliminates the remnants (halo) of black around the edges of the fore-
ground image. If the Black Alpha Matte key type does not produce satisfactory results, try 
the Alpha Channel key type.

 

Black Alpha Matte key type selected

 

White Alpha Matte

 

Choose the White Alpha Matte key type to superimpose an image that contains an alpha 
channel and that has been created on a white background. (Note that Adobe Premiere 
automatically creates alpha channels for titles and Adobe Illustrator images.) The White 
Alpha Matte key type eliminates the remnants (halo) of white around the edges of the 
foreground image

 

.

 

 This type of matte is useful for superimposing titles that have been 
created on a white background. If the White Alpha Matte key type does not produce satis-
factory results, try the Alpha Channel key type.

 

White Alpha Matte key type selected
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Image Matte

 

The Image Matte key type lets you play the movie through a still image placed on top of 
the clip on the S track. Once you have chosen the image, it is displayed in the Matte 
sample box and in the Sample box (combined with the superimposed clip) to show how 
the key type affects the superimposed clip. To select an image for the matte, click the 
Choose button in the Matte sample box and use the Open dialog box to open the file you 
want to use.

 

Image Matte key type selected

Background image of clouds 

appearing through image matte
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Difference Matte

 

The Difference Matte key type keys out the identical areas of two clips and retains the 
difference. For example, if two frames contain identical backgrounds but one of the frames 
contains an image in the center of the frame, only the image in the center of the frame is 
retained. To select an image for the difference matte, click Choose in the Matte sample box 
and use the Open dialog box to open the clip you want to use.

 

Difference Matte key type selected

 

Blue Screen and Green Screen

 

The Blue Screen and Green Screen key types are used on images with true chroma blue 
and true chroma green backgrounds. After choosing the desired key type, drag the Cutoff 
slider to the right until the contrast in the foreground image stabilizes; then drag the 
Threshold slider to the left until the blue or green background is transparent. To adjust the 
tightness of the key, drag the Cutoff and Threshold sliders an equal distance to the left. If 
the background is bleeding through, move the Cutoff slider to the right.

Clip containing

Difference Matte



 

Premiere User Guide 6/1/94 10:37 c7.pdf.frame

 

Right master page

 

Chroma blue

 

 is a solid blue containing little or no red or green and corresponds approxi-
mately to PANTONE 2735. C

 

hroma green

 

 is a solid green containing little or no red or blue 
and corresponds approximately to PANTONE 354.

 

Multiply

 

The Multiply key type keys out the areas of the superimposed image that are lighter than 
the underlying image. Use the Cutoff slider to control the opacity of the resulting super-
imposed image. For an example of using the Multiply key type, see “Creating a 360-Degree 
Presentation” on page 278.

 

Screen

 

The Screen key type lightens the areas of the underlying image that are lighter than the 
superimposed image. Use the Cutoff slider to control the brightness of the underlying 
image.

 

Track Matte

 

The Track Matte key type uses the clip on the next S track of the Construction window as 
a matte. A track matte can be created from a moving or still image. A track matte created 
from moving images is called a 

 

traveling matte

 

. For an example of using the Track Matte 
key type, see “Playing a Movie Through a Traveling Matte” on page 274.

 

Non-Red

 

The Non-Red key type is designed for use with images that have green or blue back-
grounds. It is similar to the Blue Screen and Green Screen key types, but its Blend slider 
lets you create semi-transparent objects and helps reduce fringing around the edges of 
non-transparent objects. It works especially well with green backgrounds.

 

Making key type adjustments

 

Once you have selected a key type for the clip, you can adjust the effect of the key and select 
other options associated with that key type. Controls and options are grayed out if they 
are not available for the selected key type.

 

O

 

The Similarity slider is used with the Chroma and RGB Difference key types to select a 
range of colors to be transparent. To select a range of colors similar to the one in the color 
swatch, drag the Similarity slider between None and High; the higher the Similarity 
setting, the broader the range of colors in the selection. 

 

O

 

The Blend slider smooths sharp transitions in color by creating a gradual change in 
opacity in the pixels between the two colors. 

 

O

 

The Threshold slider lets you adjust the amount of shadow in a superimposed clip. 
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O

 

The Cutoff slider lets you adjust the shadow detail with the luminance and chroma keys. 

 

O

 

The Reverse Key option allows you to reverse the transparent area; for example, from 
the area inside a matte to the area outside a matte. 

 

O

 

The Drop Shadow option applies a 50-percent gray shadow slightly below and to the 
right of the transparent portion of the clip. 

 

O

 

The Mask Only option creates a black-and-white or grayscale mask from the trans-
parent portion of the clip.

 

O

 

The Smoothing option creates soft edges where color transitions occur throughout the 
superimposed clip. Choose from None, Low, and High. 

 

Selecting a color to be transparent 

 

The Chroma and RGB Difference key types define a color or range of colors as transparent 
based on the color you select in the color swatch in the Transparency Settings dialog box. 
Use one of the following methods to select a color:

 

O

 

To select a color from the clip, use the slider in the Sample box to scroll through the clip 
until you see the color you want; position the cursor over the desired color in the frame 
shown in the color swatch (the cursor changes to an eyedropper), and click the color. The 
selected color appears in the swatch above the color swatch.

 

O

 

To select a color using the color picker, click the color swatch. The color picker appears. 
Select the color you want, and click OK. For instructions on using the color picker, see 
“Using the Apple and Premiere Color Pickers” on page 143.

 

Adjusting the intensity of a superimposed clip

 

The Fade control at the bottom of the S track lets you adjust the intensity of a superim-
posed clip. 

 

Fading in

 

 makes the superimposed image more visible, while 

 

fading out

 

 makes 
the image less visible.

 

To adjust the fading:

 

1

 

Position the pointer over the top line in the Fade control panel at the bottom of the clip 
on the S track. The pointer changes to a finger pointer.

 

2

 

Click to create a handle (a black dot), and drag the handle up or down to adjust the 
fading; create as many handles as needed. When the handle is at the top of the Fade control 
panel, the superimposed image is fully visible; when the handle is at the bottom of the 
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panel, the superimposed image is invisible. The Info window displays the Fade Level of a 
selected handle as a percent opaque (100 percent = opaque). To delete a handle, drag it out 
of the S track.

 

“The End”

 

 clip fading in over 

 

“Final Bow”

 

 clip

 

The line between two handles indicates the direction, length, and speed of the fade. The 
steeper the angle, the more sudden the change in intensity. 

 

3

 

Adjust the opacity between two points by choosing the fade adjustment tool from the 
extended tools pop-up menu (lower left corner of the Construction window) and drag-
ging the line segment up or down. When using the selection tool, you can also choose the 
fade adjustment tool by holding down the Shift key. The opacity of the superimposed clip 
can be set to a constant value by adjusting the Fade control in this manner before creating 
handles.

 

4

 

To make a cut in the Fade control, choose the fade scissors tool from the extended tools 
pop-up menu (lower left corner of the Construction window) and click the Fade control. 
Doing so creates two handles right next to each other. This is useful for making adjust-
ments that sharply increase or decrease the length and speed of the fade at a point.

Fade control area
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Adding a background matte

 

Adobe Premiere lets you create a full-frame matte of a solid color that can be used like 
a clip. This feature is useful, for example, if you want to superimpose moving titles 
over a solid-colored background. (For instructions on creating a background matte, see 
“Creating Background Color Mattes and Backdrops” on page 106.)

 

CREATING TITLES

 

You create type and graphics in Adobe Premiere’s Title window. Title clips can contain 
both stationary and animated type, straight lines, and various geometric shapes. You can 
superimpose title clips to create titles and credits that play over other clips. Adobe 
Premiere automatically assigns anti-aliased alpha channels to type and graphics generated 
in the Title window. 

When the Title window is active, two additional menus appear in the menu bar. The Title 
menu contains options related to type and objects drawn in the Title window. The Font 
menu lets you choose a font for creating titles. You can set additional options for the Title 
window by choosing Title Window Options from the Window menu.

While creating graphics in the Title window, you have the option of viewing a frame from 
a movie or still image as a background. You can then use the background to position titles 
or select colors using the eyedropper tool. 

 

To create a title:

 

1

 

Choose New/Title from the File menu. The Title window appears, and the Title and Font 
menus appear in the menu bar.

Title safe area

Motion safe area

Toolbox

Preview slider

Shadow control

Object color swatch

Shadow color swatch

Blend swatch

Blend direction

controls

Opacity controls

Line weight slider
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2

 

Use the type and object tools to create the type and drawings you want in the titles. For 
information on using these tools, see “Creating Type and Objects in the Title Window” 
on page 199.

 

3

 

Choose Save from the File menu to save the clip. 

 

4

 

Drag the clip from the Title window directly into the Construction window; however, 
make sure that you do not have any object selected in the Title window when you begin 
dragging. You can hold down the Control key to ensure that no objects are selected when 
you drag the title to the Construction window. Alternatively, saved title clips can be 
imported into a project like any other clip, using the Import command in the File menu.

 

Using the Title window toolbox

 

The Title window toolbox contains tools and controls for creating and editing type and 
objects. To use a tool for a single operation, click the tool in the toolbox; to use a tool for 
more than one operation, double-click the tool.
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Title Window Toolbox

Selection tool 


This tool selects an object or a block of text. Use 
the Shift key in conjunction with the selection 
tool to select multiple objects. The selection tool 
turns into a resize pointer when positioned over 	
a point on a selected object. Hold down the 	
Command key to select the selection tool when 
another tool is in use.


Eyedropper tool


This tool changes settings in the Title window 
based on the attributes of an object or of a 
selected color in the background. Click any object 
or shadow to assign its color, transparency, and 
gradient fill attributes to the object color swatch. 
Option-click any object or shadow to assign its 
attributes to the shadow color swatch. Click a 
pixel anywhere on the background to select a 
color from the background image.


Type tool


This tool creates type and lets you edit text. 


Line tool


This tool draws straight line segments. 


Rectangle tool


This tool draws rectangular shapes. Click the 
filled (right) side of the rectangle tool to draw a 
filled rectangle. Click the left side of the rectangle 
to draw a framed rectangle. 


Polygon tool


This tool draws polygons. Click the filled (right) 
side of the polygon tool to draw a filled polygon. 
Click the left side of the polygon tool to draw a 
framed polygon. Draw the polygon one side at a 
time, clicking to define the end points of each 
straight line segment. To complete the polygon, 
position the cursor over the first point and click 
when a small circle appears next to the cursor. 
You can also double-click at any point to com-
plete the polygon.


Rounded rectangle tool


This tool draws rectangles with rounded corners. 
Click the filled (right) side of the rounded rectan-
gle tool to draw a filled rounded rectangle. Click 
the left side of the rounded rectangle to draw a 
framed rounded rectangle. 


Oval tool


This tool draws oval shapes. Click the filled (right) 
side of the oval tool to draw a filled oval. Click the 
left side of the oval tool to draw a framed oval. 

Draft mode check box


This check box is selected if you want to work 
without previewing color and opacity gradients, 
which enables faster redrawing of type and 
objects in the Title window. This option does not 
affect the quality of the actual title clip. This 
option can also be selected or deselected using 
the accent ( ` ) key. 
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Kerning tools


These tools (visible only in type edit mode) let you add or remove space between two characters 
or between multiple characters in a selected type block. 

Line weight slider


This slider (not visible when you are editing type or filled objects) lets you adjust the line weight 
of a framed object. 


Color swatches


The object color swatch (upper left square) displays the color of the currently selected object; the 
shadow color swatch (lower right square) displays the color of the selected object’s shadow. 


Shadow offset control


This control lets you position a shadow in relation to its object. The shape of the control reflects 
the type of object selected. 


Gradient controls


These controls let you create color and opacity gradients across objects and shadows. The starting 
and ending colors of a gradient are represented by the small color swatches. Opacity settings for 
the starting and ending points are posted above the respective color swatches. A preview of the 
gradient appears in the box below the color swatches. 


Opacity sliders


These sliders pop up when you click the small black arrows above the start and end color swatches. 
They control the opacity for the starting and ending points of the gradient and the uniform opacity 
of a solid fill. 
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Setting up the title area

 

Options for setting up the drawing area of the Title window include setting the drawing 
size, selecting a background color, using NTSC-safe colors, and identifying the perimeter 
area of the Title window that may not show up on a television screen.

As a guide for positioning titles and graphics, you can view a frame from a movie clip in 
the Title window. The frame does not become part of the title clip; it is used as a posi-
tioning guide only. You can, however, use the eyedropper tool to lift colors from the 
displayed frame.

 

To use a clip frame for title positioning: 

 

1

 

Set marker 0 to the frame of the clip you want displayed in the Title window. If no 
marker 0 is set, the in point frame will be displayed. For information on setting markers 
in clips, see “Setting Place Markers for Clip Alignment” on page 75.

 

2

 

Drag the clip from the Clip or Project window into the Title window. The marked frame 
will be displayed in the Title window. 

 

3

 

 Remove the frame from the Title window by choosing Remove Background Clip from 
the Title menu.

 

Note:

 

 You can change the frame displayed in the Title window by setting a new marker 0 for 
the clip. The newly marked frame will automatically appear in the Title window. 
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To select options for the drawing area:

 

1

 

Make sure that the Title window is the active window.

 

2

 

Choose Title Window Options from the Windows menu. The Title Display Options 
dialog box appears.

 

3

 

Enter the following settings and options: 

 

O

 

Drawing Size. Set the size of the drawing area from 60 pixels by 45 pixels to 2000 pixels 
by 2000 pixels. In general, the size of the drawing area should be the same as the output 
size set in the Output Options dialog box. However, this is not critical, as Adobe Premiere 
will scale the title to match the output frame size. Note that if the 4:3 Aspect Ratio option 
is selected, you enter just the width or height; the program updates the other dimension 
to maintain a 4 to 3 width-to-height ratio.

 

O

 

 Background. Select a background color for the title clip by clicking the color swatch to 
display the color picker. (For information on selecting colors, see “Using the Apple and 
Premiere Color Pickers” on page 143.) You can also choose to make the background color 
opaque or transparent. The default background is transparent; the background will be 
keyed out if you apply the Alpha Channel key type. Choose Opaque from the Background 
setting to make the background opaque.

 

Note:

 

 When the Title window is active, you can set the background color to black or white from 
the keyboard by pressing B for black or W for white. 

 

O

 

Safe Title Area. Because a picture tube on a television screen is generally over scanned, 
images may be partially truncated or lost when output to videotape. You can use the Show 
Safe Titles option to see the area in which titles and objects are protected from partial 
truncation. 

 

O

 

NTSC Safe Colors. Select this option to restrict colors in the Title window to NTSC-safe 
colors. NTSC safe colors are those acceptable for television reproduction, preventing over-
saturated colors from bleeding across television scan lines.

Title safe

Motion safe
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Creating type and objects in the Title window

 

This section describes how to create type, rectangles, ovals, polygons, and straight line 
segments in the Title window. It also describes how to create color and opacity gradients 
across type and graphic objects. 

In Adobe Premiere, a geometric object is either framed or filled, but not both. You can, 
however, create the illusion of a framed and filled object by creating two separate objects 
and having the program align them for you.

The Title window enables you to create stationary and animated type. You can modify type 
using commands from the menus or tools from the toolbox. Type is treated as a filled 
object and cannot be converted to a framed object.

 

To create framed and filled objects:

 

1

 

Create a framed or filled object using a drawing tool in the toolbox. Click a point in the 
Title window and drag to create a framed or filled object. Hold down the Shift key as you 
drag to constrain an oval to a circle, a rectangle to a square, or a line to an increment of 
45 degrees. 

 

2

 

With an object selected, use the swatches and tools in the toolbox to adjust the color, 
opacity, or shadow. For information on using these tools, see procedures later in this 
section.

 

3

 

Adjust the line width of a framed object using the Line Weight slider in the toolbox. 
Drag the slider to choose a line weight for an object between 1 pixel and 16 pixels.

Line weight slider
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4

 

To create a framed version of a filled object, select the object and choose Create Framed 
Object from the Title menu; to create a filled version of a framed object, choose Create 
Filled Object from the Title menu. Adobe Premiere will make a copy of the object, convert 
it to a filled or framed object, and align it with the selected object.

 

5

 

To convert a framed or filled object, choose Convert to Framed or Convert to Filled from 
the Title menu.

 

6

 

To resize a selected object, position the pointer tool over a point on the object and drag. 
(Note that you cannot resize type this way. To resize type, use the Title menu commands 
as described in the procedure “To adjust type attributes” later in this section.)

 

To smooth a polygon object:

 

Select an object that was created with the polygon tool, and choose Smooth Polygon from 
the Title menu.

 

To create type: 

 

1

 

Select the type tool. 

 

2

 

Click to position the text in the Title window, and type the desired text. Type can be 
edited within the text entry box by moving the cursor around and using standard cut 
and paste operations.

 

3

 

Click outside the text entry box when you have finished typing. 

Any color, transparency, or gradient settings in the toolbox will be applied to the type. 
By default, newly created type has no shadow.
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To adjust type attributes:

 

1

 

Select the type you want to adjust.

 

2

 

Use the Font menu to change the font. 

 

3

 

Use the Title menu commands to change the type style, justification, and shadow. 

 

4

 

To change the type size, choose Size from the Title menu and select a point size.

You can also hold down the Command and Shift keys and press the Greater Than [>] or 
Less Than [<] key to increase or decrease the point size in 1-point increments. Hold down 
the Command, Option, and Shift keys and press the Greater Than [>] and Less Than [<] 
keys to increase and decrease the point size in 5-point increments. 

 

5

 

To kern the type, click to position the cursor between two characters or drag to select all 
of the characters you want included for adjustment; then choose one of the following 
options:

 

O

 

Click the left kerning tool to reduce spacing between characters; click the right kerning 
tool to increase spacing between characters. 

 

O

 

Hold down the Option key and use the left and right arrow keys to decrease and increase 
the space between characters. 

 

O

 

To reset the kerning, hold down the Command key and click either kerning tool.

 

 

 

6

 

To change the leading, use one of two options:

 

O

 

Hold down the Option key and use the up and down arrow keys to increase or decrease 
the leading in 1-pixel increments.

Kerning tools
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O

 

Hold down the Option and Shift keys and use the up and down arrow keys to increase 
or decrease the leading in 5-pixel increments.

 

Note:

 

 The selected font, type size, and type justification are applied to all type in a text block; 
to mix fonts, type sizes, and type justifications, you must create more than one text block.

 

To center type or objects in the drawing area:

 

1

 

Select the type or object you want to center. If multiple text blocks or objects are 
selected, they are centered as a group.

 

2

 

Choose the Center Vertically and Center Horizontally commands from the Title menu.

 

3

 

To center type or objects horizontally in the lower third of the drawing area, choose 
Position in Lower Third from the Title menu.

 

To create a shadow for type or an object: 

 

1

 

Select the type or object for which you want to create a shadow.

 

2

 

Drag the Shadow Offset control in the toolbox to determine the position of the shadow. 
Hold down the Shift key to constrain the angle of the offset to 45-degree increments. The 
offset coordinates, given in pixels, are displayed above the control. To set no shadow for a 
selected object, drag the shadow control into the center or outside of the control box. 

 

3

 

Click the shadow color swatch in the toolbox to select a color for the shadow. 

 

4

 

With the shadow color swatch selected, use the pop-up opacity sliders to adjust the 
transparency of the shadow. 

Shadow offset

control

Shadow color

swatch

Use middle Opacity slider
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5

 

Choose Shadow from the Title menu to select the Single, Solid, or Soft option for the 
shadow. You can also select the next shadow style by Option-clicking the Shadow Offset 
control.

 

Single Solid Soft

 

To create a gradient fill across an object or shadow:

 

1

 

Select the object you want to fill in the Title window.

 

2

 

Click the object color swatch if you want to create a gradient fill for the object; click the 
shadow color swatch if you want to create a gradient fill for the shadow. You can click the 
curved arrow between the swatches to exchange the object and shadow gradients.

 

3

 

Select a starting color by clicking the left color swatch in the gradient controls to display 
the color picker. (For instructions on using the color picker see “Using the Apple and 
Premiere Color Pickers” on page 143.) Select an ending color by clicking the right swatch 
in the gradient controls. A preview of the gradient appears in the box below the color 
swatches.

Shadow color swatch

Object color swatch

Left color

swatch

Right color

swatch
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4

 

Change the opacity of the starting or ending point by clicking the small black arrow 
above the respective color swatch and dragging the opacity slider to the desired setting. 
Opacity settings for the starting and ending points appear above the respective color 
swatches. Opacity can vary between 0 percent (clear) and 100 percent.

 

5

 

Set a common opacity for the starting and ending points of the gradient (no gradient) 
by clicking the small black triangle between the swatches and adjusting the slider control.

 

6

 

Change the direction of the gradient (in 45-degree increments) by clicking one of the 
eight small arrows around the preview box. The gradient starts from the location of the 
selected arrow.

 

Note:

 

 You can drag the color from either gradient swatch to any of the other color swatches in 
the toolbox. Doing so will set the gradient starting and the gradient ending colors to the same 
color to create a full-spectrum blend.

 

Selecting and moving objects in the Title window

 

You can select and move individual objects in the Title window by dragging them or using 
the Tab and arrow keys on the keyboard. You can also select multiple objects and move 
them as a group.

 

To select and move objects:

 

1

 

Click to select an object using the selection tool. Select multiple objects by Shift-clicking 
with the selection tool. Select all the objects in the Title window by choosing Select All 
from the Edit menu.

To select objects in front-to-back order, press the Tab key. To select objects in the opposite 
order, hold down the Shift key and press Tab. 
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2

 

Drag the object(s) to the desired location. Press the arrow keys to move the object(s) in 
1-pixel increments in the arrow direction. Hold down the Shift key and press the arrow 
keys to move the object(s) in 5-pixel increments in the arrow direction. 

 

3

 

To center a selected object in the drawing area, choose Center Horizontally or Center 
Vertically from the Title menu.

 

4

 

To center a selected object horizontally in the lower third of the drawing area, choose 
Position in Lower Third from the Title window.

 

Changing the order of layered objects

 

By default, multiple objects in the Title window are layered in the order in which they were 
created. You can change the order of layered objects by selecting an object and choosing 
Send to Back or Bring to Front from the Title menu.

 

Creating animated type

 

Adobe Premiere contains sophisticated controls for animating type. You can change the 
size of the type over time, make type expand or contract, and choose from a variety of 
starting points. Type animation is best suited for use with any outline font, including 
Adobe Type 1 and TrueType fonts and Adobe’s multiple master font technology. If 
multiple master fonts are used to create animated type, additional controls become avail-
able that allow you to vary the size, weight, width, and optical scale of the font. 

 

Note:

 

 The motion in animated type may appear jerky at large movie sizes and high frame 
rates. Alternatively, you can create titles as still images and then animate them using 
Adobe Premiere’s motion utility. For information on creating motion, see “Creating Motion” 
on page 171.

 

To create animated type: 

 

1

 

Select the type you want to animate by clicking the selection tool anywhere on the 
desired type. 

You can animate only a single line of type at a time. If more than one line of type is 
selected, the separate lines of type will be combined into one longer line. If any of the 
selected lines contain carriage returns, a note appears indicating that animated type can 
be only one line high and that carriage returns in the type will be removed. 
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2

 

Choose Text Animation from the Title menu or double-click the selected type to display 
the Animation Settings dialog box. The Animation Settings dialog box appears, with the 
selected type centered in the animation window. If you are using a Multiple Master type-
face, additional sliders appear at the bottom.

 

3

 

Click a direction button to indicate the point from which you want type to begin 
moving (the default is from the center). 

Next, you set points on the time ruler to create type of various sizes. 

 

4

 

Position the mouse pointer above the time slider. The pointer turns into a black triangle. 

 

5

 

Click to define a size point on the time ruler. By default, the 100-percent marker on the 
time ruler represents 1 second; if you change the duration of the clip, the time ruler repre-
sents the adjusted duration.

Time slider

Direction buttons
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6

 

Drag the Size slider to adjust the size of the type at the selected point. Hold down the 
Shift key to adjust the horizontal and vertical appearance of the type independently.

 

7

 

Continue adding points; adjust the size of the type at each selected point. 

 

8

 

Click Preview to preview the type animation. 

 

9

 

Click OK to return to the Title window. The animated type block is selected. Note that 
selected animated type objects are identifiable by the hollow appearance of the corner 
handles.

 

10

 

To preview the selected animated type in the Title window, drag the slider in the lower 
left corner of the Title window. To preview all animated type in the title, hold down the 
Option key and click the Preview slider.
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Chapter 8: Compiling and 
Videotaping

 

 

 

Movies 

 

hen you have finished assembling and editing your clips in the Construction 
window, you can play your movie on your computer monitor or NTSC screen, 
compile your movie into a self-contained QuickTime movie, or output the 

 

movie to videotape. 

This chapter provides information that will help you make movies of the highest quality. 
It explains how to compile your clips into a QuickTime movie and how to use the Print to 
Video command to play movies and record them to videotape. It also explains how to 
create a movie by linking shorter movies together.G

 

COMPILING A MOVIE 

 

Clips in the Construction window do not become a self-contained QuickTime movie until 
you compile them into a QuickTime “document” using the Make Movie command. 

After a movie is compiled, you can play it as a QuickTime movie on your computer screen 
or import it into other QuickTime applications. The quality of your finished movie 
depends on a number of factors, such as the type of image compression you use, the frame 
rate at which you output the movie, and the speed of the computer system used to play 
the movie. 

If you used the Miniatures command or Batch Capture window to create a set of smaller 
clips to work with while constructing your movie, you will need to replace the smaller clips 
with the original clips before compiling the movie. For information on this procedure, see 
“Making Miniatures to Improve Performance” on page 43.

 

W
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To compile a movie:

 

1

 

Choose Make/Movie from the Project menu. The Make Movie dialog box appears.

The current settings for output options and movie compression are displayed in the lower 
half of the dialog box. If you are using Apple’s System 7, the available free space on your 
disk is displayed at the bottom of the dialog box.

 

2

 

To change the output options, click Output Options. The Project Output Options dialog 
box appears. (Output options are initially set in the project presets. The options are 
described in “Selecting Project Output Options” on page 210.) Adjust the output options 
as desired, and click OK. The Make Movie dialog box reappears.

 

3

 

To change the compression settings, click Compression. The Compression Settings 
dialog box appears. Compression options are described in “Selecting Compression 
Options” on page 219.

 

4

 

Type a name for your movie, and click OK. 

Adobe Premiere displays a progress bar as the movie compiles. To stop the compilation 
process, press Command-period. Adobe Premiere saves as much of the movie as has been 
constructed. If you have selected the Beep When Finished or the Open Finished Movie 
options in the Project Output Options dialog box, the program beeps or opens the movie 
in a Clip window when it finishes compiling and saving the movie. Play the open movie 
using the controls in the Clip window or by using the Print to Video command. For more 
information on the Print to Video command, see “Using Print to Video” on page 223.



 

Premiere User Guide 6/1/94 10:37 c8.pdf.frame

 

Right master page

 

With Apple’s System 7, you have the ability to switch to the Finder while Adobe Premiere 
is compiling a movie. The compiling will be temporarily interrupted while you perform 
tasks in the Finder. When you switch back to Adobe Premiere, the compiling process 
resumes where it left off.

 

Note:

 

 A QuickTime movie can be an extremely large file. Make sure that you have enough free 
disk space to store the movie before using the Make Movie command. When compiling a 
movie, Adobe Premiere will issue a warning if the available disk space drops below the Low 
Disk Space Warning Level set in the General Preferences dialog box. The warning allows you 
to switch to the Finder to make more space available, or to stop the process and save all of the 
movie that has been compiled so far. You can also continue compiling and risk running out of 
disk space.

 

SELECTING PROJECT OUTPUT OPTIONS

 

The Project Output Options dialog box lets you specify how the movie is compiled. You 
use these options to specify the output file type and which part of the Construction 
window to compile. In addition, you specify the image size and the audio sampling rate, 
among other options.

Output options are initially set by the project preset, which you choose when you create 
the project. You probably won’t need to change the project output options unless the 
intended use of the movie has changed. For more information on choosing a preset, see 
“Setting Up a New Project” on page 28.

 

To set project output options:

 

1

 

Choose Output Options from the Make menu, or click Output Options in the Make 
Movie dialog box. The Project Output Options dialog box appears.

 

2

 

Use the Output pop-up menu to specify which part of the Construction window 
to compile:

 

O

 

Select Entire Project to compile everything in the Construction window.
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O

 

Select Work Area to compile only the segment under the yellow work area bar. 

 

3

 

Select the output file type from the pop-up menu in the upper right corner of the dialog 
box. For more information, see the next section, “Selecting the Output File Type.” 

 

4

 

Specify video output options in the left side of the dialog box. For more information, 
see “Selecting Output Options for Video” on page 212.

 

5

 

Specify audio output options in the right side of the dialog box. For more information, 
see “Selecting Output Options for Audio” on page 214.

 

6

 

Click OK.

 

Selecting the output file type

 

You can choose from four output file types in the Output As menu. 

 

QuickTime Composite 

 

Select this option to apply compression only to areas of your movie that are different from 
the original source clips. Areas to which compression is applied include transitions as 
well as clips with filters, motion settings, and transparency settings. Compression is also 
applied to any clips that must be resized to match the output size. The QuickTime 
Composite option will not recompress any frames that have been cached during 
previewing as long as they have been processed at the output movie size (see the note 
below). The resulting movie may therefore include different compression types and frame 
rates; however, there will be less data loss than with the QuickTime Movie option. The 
QuickTime Composite option allows for faster compiling of movies, since fewer segments 
have to be compressed.

Unless the movie is intended for CD-ROM, most movies are best suited for the Quick-
Time Composite file type. This is especially true if you are using clips that were captured 
with a video board that has JPEG compression.

 

Note:

 

 Clips and cached frames that differ in size from the movie output size will be recom-
pressed when the movie is compiled as a QuickTime Composite file. Also, compressors that use 
key frames (such as Cinepak

 



 

) require all frames to be recompressed because new key frames 
are generated every time the movie is made.

 

QuickTime Movie

 

The QuickTime Movie option generates a movie file in the Apple QuickTime format 
compatible with any software that supports this format. Note that, unlike the QuickTime 
Composite option, this option applies the selected compression method to the entire 
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movie and recompresses every frame. This file type is best for movies that will play on 
CD-ROM, because the entire movie should be recompressed using the Apple Cinepak 
compressor.

 

Numbered PICT files

 

The Numbered PICT files option generates a series of PICT files, one for each frame of the 
final movie. The files are numbered sequentially, beginning with the number 0000. 
Numbered PICT files can be imported into other video systems that may be unable to 
accept QuickTime movies.

 

FilmStrip File

 

The FilmStrip File option generates a FilmStrip format file that can be opened and modi-
fied in Adobe Photoshop. The file you open in Adobe Photoshop is a single file containing 
all the frames of the movie. FilmStrip files are uncompressed and may require large 
amounts of disk space. For more information on FilmStrip files, see “Modifying Filmstrips 
in Adobe Photoshop” on page 109.

 

Selecting output options for video

 

The Project Output Options dialog box includes the following options for the video 
portion of the movie:

 

O

 

Size. The Size fields determine the height and width (in pixels) of the movie frames 
when output. If the 4:3 Aspect Ratio option (see below) is selected, you enter just the 
height or width and the other field is updated automatically. Note that larger images 
usually result in reduced playback rates if you don’t have a board with hardware compres-
sion. With larger images, you may not achieve normal playing speed when playing the 
movie on your computer or outputting it to videotape. Increasing output size also 
increases the file size of the final movie. The aspect ratio of the Preview window is auto-
matically determined by the proportions of the video output frame.

 

O

 

4:3 Aspect Ratio. By default, the dimensions of the movie frames are constrained to 
the standard (analog) video width-to-height ratio, or 

 

aspect ratio

 

, of 4 to 3 (width = 4; 
height = 3). Note that if your original clips were captured from analog video, changing the 
4:3 aspect ratio will distort the image; or if the movie is later played on analog video, 
changing this ratio will cause the analog video image to be distorted.

 

O

 

Type. This setting should match the way your video display board processes NTSC or 
PAL video. Leave the setting at Full Size Frame if your board does not process the separate 
fields in an NTSC video frame. Select 1/2-Horizontal if your board captures full-frame 
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video by capturing half of each alternating field in a 320-pixel by 480-pixel configuration. 
Select 1/2-Vertical if your board captures full-frame video by capturing half of each alter-
nating fields in a 640-pixel by 240-pixel configuration. 

If you have a board that processes full-frame, 60-field video, select the proper field domi-
nance for the board. Select Field 1 for full-field processing with Radius’ VideoVision

 



 

, 
SuperMac’s DigitalFilm

 



 

, and RasterOps MoviePak. Select Field 2 if your board is 
field 2 dominant.

Select Field 1-1/2 H for field 1 dominant boards that process half of each alternating field 
in a 320-pixel by 480-pixel configuration. Select Field 2-1/2 H for field 2 dominant boards 
that process half of each alternating field in a 320-pixel by 480-pixel configuration. 

If your clips were captured with different capture boards, your project may contain some 
clips with field 1 dominance and some with field 2 dominance. 

 

Full-field processing of clips

 

Field processing is an issue when you’re working with full-frame (640 pixels by 480 pixels), 
60-field NTSC or 50-field PAL video. There are some situations where you should specify 
how Premiere processes the fields for a specific clip—when you're changing the speed of a 
clip, exporting a filmstrip, or freezing on a video frame.

Each frame of NTSC video contains two fields, one containing odd scan lines and the 
other containing even scan lines. Most NTSC video is 

 

field 1 dominant

 

. This means that 
the odd field precedes the even field in the designation of the video frame. If the fields are 
reversed, motion can appear jerky. Some video capture boards can capture with field 1 or 
field 2 dominance. Others assume field 1 dominance. 

 

To set field processing options for a clip:

 

1

 

Select the clip in the Construction window.

 

2

 

Choose Field Options from the Clip menu.

 

3

 

Set options for field processing as follows:

 

O

 

Reverse Field Dominance. Select this option to reverse the field dominance of a clip so 
it matches the field dominance used by your video board. The field dominance should be 
the same for all clips in the movie. This option can be useful if your clips weren’t all digi-
tized with the same capture board. 
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O

 

Interlace Consecutive Frames. Select this option to convert consecutive frames into 
interlaced fields of video. Many animation applications don’t consider video fields. For 
smooth animations, use this setting to convert 60-frame-per-second animations into 
30-frame-per-second animations with two fields per video frame.

 

O

 

Always Deinterlace. Select this option if you want Adobe Premiere to convert the inter-
laced fields into frames of video with no discernible fields. The video frames are generated 
from an average of the field data, resulting in no interlacing or time offset. This option 
should be selected if you are working with a freeze-frame.

 

O

 

Deinterlace Fields When Speed is Below 100%. This option should be selected when you 
are reducing the speed of a clip. 

 

Selecting output options for audio

 

The Project Output Options dialog box includes the following options for the audio 
portion of the movie:

 

O

 

Rate. The Rate option determines the sampling rate for the audio clips. The highest 
frequency that you can achieve in the final audio output is equal to half of the sampling 
rate; for example, a 44 kHz sample rate is capable of producing a 22 kHz frequency. 
Compact disc (CD) audio is sampled at a 44 kHz rate. 

 

O

 

Format. The Format option lets you set the audio output to 8-bit or 16-bit mono or 
stereo resolution. By default, the Macintosh produces 8-bit sound; 16-bit sound is compa-
rable in quality to that of a CD and requires a sound board and Sound Manager

 



 

, 
version 3.0 or higher. Contact your audio board manufacturer for the latest version of 
Sound Manager.

 

O

 

Blocks.

 

 

 

This option sets the amount of audio, specified in seconds or minutes, that is to 
be stored in the movie between blocks of video. (This is called interleaving audio and 
video.) Choose an amount from 1/2 second to 5 minutes. In most cases, the default 
amount works best, but if you notice delays in your movie and choppy audio, you may 
want to experiment with different amounts. 

 

Note:

 

 For the smoothest playback, you can load all of the audio into RAM first, which allows 
the video frames to be retrieved from the hard disk without interruption. To load all the audio 
into RAM first, choose a value for the Blocks field that is longer than the duration of the entire 
movie. For this method to work properly, you must have enough RAM available to load the 
entire audio portion of the movie. 
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DIGITAL VIDEO COMPRESSION

 

Compression is the process of removing or restructuring data to decrease the size of a file. 
Digital video files are very large, requiring high data transfer rates for capture and play-
back. As you compile a QuickTime file, you compress the data to reduce file size and facil-
itate playback of the movie. Data decompression takes place as the movie plays back. 
Compression and decompression are critical if the movie is to play off a CD-ROM drive 
or play at full size from a hard drive.

Several compression/decompression algorithms (CODECs) are available for compressing 
QuickTime movies. CODECs can be software-based or hardware-based. Hardware 
compression is significantly faster and more effective than software compression. The 
CODEC you choose affects the visual quality of the movie and the facility with which it 
plays on your computer monitor or NTSC screen. In general, full-frame, 24-bit video 
images can only be played back in real time (that is, at normal playing speed) using hard-
ware compression. However, not all video boards provide hardware compression. Video 
for CD-ROM is normally compressed with software because it allows anyone with a CD-
ROM player to view movies without specialized hardware. 

You can compress QuickTime movies in Adobe Premiere using any of the six software 
CODECs that come with Apple’s QuickTime software. You can also add third-party 
CODECs to your System folder to give you a variety of compression formats from which 
to choose. Some CODECs are optimized for image quality compression while others are 
optimized for speed. 

Several third-party video boards, such as Radius’ VideoVision, SuperMac’s Digital Film, 
and RasterOps MoviePak, offer hardware compression based on the JPEG format. JPEG 
allows display of full-frame images at 30 frames per second, and with some boards, 60 
fields per second. For more information on third-party hardware, see the Read Me file 
shipped with Adobe Premiere 4.0.

 

Note:

 

 Because of the way data travels on a Macintosh Quadra

 



 

 or Centris

 



 

, software compres-
sion schemes allow significantly faster playback on these computers than with other CPUs, 
especially when the internal video of the Macintosh Quadra is used. However, third-party 
hardware compression is still a faster alternative.

 

Outputting full-screen images

 

You can output full-screen images (640 pixels by 480 pixels) to your computer screen or 
to videotape in real time (at the normal playing speed of 30 fps), only if your playback 
system has hardware compression. You can record full-screen images to videotape in 
nonreal time (below normal playing speed) using software compression if you have a 
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controllable tape deck. You can output half-screen images (320 pixels by 240 pixels) at full 
frame (640 pixels by 480 pixels) to your computer screen or to videotape using the Zoom 
Screen feature of the Print to Video command, with either hardware or software compres-
sion. For more information on printing to video, see “Using Print to Video” on page 223. 
For more information on outputting to videotape, see “Outputting a Movie to Videotape” 
on page 227.

 

Note:

 

 You can have Adobe Premiere generate an Edit Decision List (EDL) for creating a video-
tape using traditional post-production techniques. The EDL contains a list of all of the clips, 
transitions, and special effects in the movie, and is used to assemble a new movie (master) 
from the original (source) tapes. For more information on EDLs, see “Generating an Edit 
Decision List” on page 112.

 

Achieving the highest possible playback rate

 

The playback rate of your movie determines how smooth and natural-looking the movie 
appears. At playback rates below 15 frames per second, you notice that the movie is made 
up of frames; the lower the playback rate, the more distinct each frame becomes, until the 
illusion of continuous motion is lost completely. Higher playback rates give the illusion of 
continuous motion; the individual frames are undetectable. For best results, you want the 
highest possible playback rate (up to 30 frames/60 fields per second). 

The highest playback rates are achieved with fast hard drives and video boards capable of 
processing data to the screen very quickly. Hardware compression (for example, JPEG 
boards) yields the best results.

 

Data compression schemes

 

CODECs use several schemes for removing or restructuring data to decrease the size of a 
file. 

 

Lossless

 

 compression schemes preserve the original data, ensuring that the image is the 
same after compression and decompression. Most lossless schemes use 

 

run-length 
encoding

 

, a process that discards continuous regions of duplicate colors. This technique 
works very well for images that are generated electronically where colored areas are often 
composed of solid colors. In general, however, lossless compression is not very effective 
with digitized video and scanned photographs because colors in these images are usually 
represented by high dithering and diffusion and contain few areas of continuous color.

 

Lossy

 

 compression schemes, on the other hand, attempt to remove picture information 
that viewers are not likely to notice. Lossy compressors do not preserve original data; 
image information is lost and cannot be recovered. The amount of data that is lost 
depends on the degree of compression, controlled by the image quality setting in the 
Compression Settings dialog box. A high Quality setting for a QuickTime movie results in 
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much less information being lost than with a low Quality setting. In addition, many lossy 
compressors result in additive loss—as the images are recompressed, even more data is 
lost. Additive loss varies with the compressor; the Apple Video CODEC, for example, has 
been designed to have little additive loss when recompressing.

 

Spatial compression 

 

compresses the data in each frame of a clip, while 

 

temporal compression 

 

compresses the data by comparing frames over time. Common side-effects of spatial 
compression include blurring, blockiness (small blocks of constant color instead of the 
random dithering found in the original content), streaking (lines of constant color), and 
contouring (regions of constant color).

 

Frame differencing

 

 is a type of temporal compression that minimizes the amount of data 
required to represent each frame in a clip by storing data for only the frames that contain 
changes. If a movie does not contain an extreme amount of movement, for example, and 
contains a fair amount of duplication from one frame to the next, frame differencing 
schemes store the data from certain key frames and discard other data. A common side-
effect of frame differencing is blockiness in the video images.

 

Apple software compressors

 

The six CODECs shipped with Apple Computer’s QuickTime 1.6 are software-based. 
These CODECs appear in the Compressor pop-up menu in the Compression Settings 
dialog box. (For information, see “Selecting Compression Options” on page 219.) Choose 
a CODEC based on the type of original images you have and what you are using it for. If 
your video board provides hardware compression, you should refer to the documentation 
that came with your board for recommendations about which CODEC to choose.

 

O

 

Apple Animation. Use the Animation CODEC for compression of images that were 
originally in digital form (animation and computer-generated content) and were not 
obtained from analog videotape. The Animation CODEC employs a compression algo-
rithm developed by Apple based on run-length encoding techniques. 

The Animation CODEC works in either a lossy or lossless mode and supports both spatial 
and temporal compression. This CODEC can play back images at up to 30 fps at full-
screen resolution; the performance and compression ratios you can achieve depend on the 
type of image you are using.

 

O

 

Apple Cinepak. Use the Cinepak CODEC when compressing 16-bit and 24-bit video for 
playback from CD-ROM discs. This CODEC attains higher compression ratios, better 
image quality, and faster playback speeds than the Video CODEC. For best results, use the 
Cinepak CODEC on raw source data that has not been previously compressed with a 
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highly lossy compressor. With Cinepak, decompression is much faster than compression, 
and the data rate for playback can be defined by the user. For more information on setting 
the data rate for playback, see “Selecting Compression Options” on page 219.

 

O

 

Apple Graphics. Use the Graphics CODEC for compressing analog video when you 
need very good picture quality for playback on 8-bit screen displays. The Graphics 
CODEC is intended primarily for use with 8-bit graphics images but it is also effective for 
video. Because the Graphics CODEC does not achieve high compression ratios for video, 
it is suitable for playback from hard disk, but not from CD-ROM. 

 

O

 

Apple None. Use the None option for real-time acquisition of analog video. This option 
provides excellent image quality, since no compression is applied. Data can be compressed 
later or recomputed for playback from CD-ROM. The disadvantage of using the None 
compression option is that large amounts of disk space are required. 

 

O

 

Apple Photo (JPEG). JPEG (Joint Photographic Experts Group) is an international 
standard for compressing still images. Use the Photo CODEC for images that contain 
smooth transitions or that do not contain a high percentage of edges or other sharp detail. 
Most natural images fall into this category. For this type of 24-bit image, the Photo 
CODEC produces a reconstructed image that is virtually indistinguishable from the orig-
inal image at a compression ratio of 10:1. Compression time is equal (or very nearly equal) 
to decompression time.

Because the Photo CODEC achieves high compression ratios with good picture quality, 
you can use it to archive video clips that require a lot of disk space. It is also very useful as 
an interchange compression format between computers made by different manufacturers. 
The Photo CODEC is not recommended for real-time playback or capture because it is too 
slow. 

 

Note:

 

 Many hardware compression boards use JPEG. With QuickTime 1.6 or higher, the 
CODECS for these boards may not be listed in the Compressor pop-up menu unless you hold 
down the Option key when you click the menu. If you select Apple Photo JPEG, the correct 
CODEC will automatically be used. Also, additional options for some boards are found by 
holding down the Option or Control key while choosing the CODEC.

 

O

 

Apple Video. Use the Video CODEC for capture and compression of analog video, high-
quality playback from hard disk, and moderate quality playback from CD-ROM. This 
CODEC supports both spatial and temporal compression and can play back at rates of 10 
fps or more. Data can be recompressed or recompiled later for higher compression ratios. 
The Video CODEC allows recompression with minimal or no quality 
degradation. 
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SELECTING COMPRESSION OPTIONS

 

Compression options are initially set by the project preset, which you choose when you 
create the project. You probably won’t need to change the compression options unless the 
intended use of the movie has changed. For more information on choosing a preset, 
see “Setting Up a New Project” on page 28.

 

To change compression settings:

 

1

 

Choose Compression from the Make menu, or click Compression in the Make Movie 
dialog box. The Compression Settings dialog box appears.

 

2

 

To see how the compression settings will affect your compiled movie, copy a clip from 
your project to the Clipboard. A frame from the clip appears in the Compression Settings 
sample box. The frame display is a snapshot preview of the compiled movie. 

 

3

 

Select which CODEC to use in compiling your QuickTime movie. If your board 
provides hardware compression, select the proper JPEG CODEC. Otherwise, select an 
Apple software CODEC. For more information, see “Apple Software Compressors” 
on page 217.

 

4

 

Select a pixel depth for the movie from the Color pop-up menu. The pixel depth deter-
mines the number of colors that can appear in the images. Smaller depths can reduce the 
file size but may degrade the image quality. No pop-up menu appears for the Apple Video 
CODEC because it is fixed at 16 bits and cannot be changed. 
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5

 

Use the Quality slider to set the spatial compression quality. The lower the quality you 
choose, the more the movie is compressed and the smaller the file size. A high Quality 
setting results in less information being lost than with a low Quality setting. To preview 
the effect of spatial compression on your movie, place a sample image in the box above the 
Quality slider, as described in Step 2. For more information on spatial compression, see 
“Data Compression Schemes” on page 216.

 

6

 

In the Motion settings, set the following options:

 

O

 

Frames per Second. This option specifies the maximum playback rate of the movie in 
frames per second (fps). Choose a rate from 1 fps to 30 fps from the pop-up menu (30 fps 
is the maximum rate for playback on the Macintosh). In general, higher rates yield better 
results, with smoother, more natural-looking motion. However, you should select a rate 
that matches the maximum playback rate of the computer system on which you intend to 
run the finished movie. Selecting a rate that cannot be achieved by the playback system 
will result in dropped frames and possible flutter when you play your movie. The 
maximum rate of the playback system depends on the speed of its components: the CPU, 
the hard drive, and the display card. For more information on playback rates, see 
“Achieving the Highest Possible Playback Rate” on page 216. 

 

Note:

 

 Setting the playback rate higher than the rate of the original clips will replicate frames; 
this does not increase the rate of the original clips. 

 

O

 

Key Frame. This option is available if you have selected a CODEC that uses frame differ-
encing, which is a type of temporal compression. (For more information on frame differ-
encing, see “Data Compression Schemes” on page 216.) A key frame is the baseline frame 
against which other frames are compared for differences. The key frames are saved in their 
entirety, while intervening frames are compressed based on their differences from the key 
frames. The Key Frame option specifies the rate at which the movie is sampled for key 
frames. Using the Key Frame option allows for greater compression and increased play-
back speed, but can cause delays in accessing individual frames in a movie. If you plan to 
view the entire movie from beginning to end, you should set the Key Frame option higher 
than if you plan to skip around to different parts of the movie. As a general rule, you 
should set the Key Frame option to one key frame per second. For example, if the playback 
rate of your movie is 10 fps, you should set the Key Frame option to 10; the movie is then 
sampled for a key frame every 10 frames. If you do not select the Key Frame option, the 
compressor treats every frame as a key frame. With the Key Frame option selected, you can 
adjust the temporal compression by holding down the Option key to change the Quality 
slider to the Temporal slider.
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O

 

Data Rate. This option becomes available when compressing with the Cinepak standard 
for CD-ROM playback. For playback on a regular speed CD-ROM, set the data rate limit 
in the range of 90K to 100K per second. For playback on a double-speed CD-ROM, set the 
rate as high as 200K per second. Adobe Premiere will automatically adjust the spatial and 
temporal quality of the movie to achieve the data rate you specify. 

 

MAKING MOVIES FOR PLAYBACK ON CD-ROM

 

CD-ROM drives process data relatively slowly—in the range of 90K to 250K per second, 
depending on the speed of the drive. At this limited transfer rate data compression is crit-
ical. The quality of your final movies depends on the way you capture the video and 
process the digitized clips.

Current data transfer rates for CD-ROM effectively limit the movie size to 320 pixels by 
240 pixels. Higher frame rates are achieved with a size of 240 pixels by 180 pixels. Capture 
at 30 frames per second (or at the highest rate possible) using the final movie frame size. 
If your hardware allows, you can capture at larger sizes and resize the movie in Premiere, 
but improvements in final image quality may be imperceptible, and working with larger 
images substantially increases compiling time and the amount of disk space required to 
store the data.

Always start with the cleanest analog video source available when you capture movies, as 
video noise increases the amount of data that must be compressed. When capturing, use 
hardware compression if available, and keep your digitized clips at the highest possible 
quality until you are ready to compile your final movie. After building your movie in 
Adobe Premiere, compile it using the Cinepak compressor. Cinepak allows you to limit the 
data rate for the movie. 

 

Note

 

: An Apple software utility called MovieShop

 



 

 can be used to analyze a movie’s data 
spikes (surges in the movie’s data rate) and smooth them out by optimizing the compression 
parameters of the Cinepak CODEC. If you are going to use MovieShop for final compression, 
keep your movie at the highest possible quality (using JPEG or Apple Video) when you compile 
the movie in Adobe Premiere.

 

For best results when making movies for playback on CD-ROM, use the following settings 
in the Compression Settings and Project Output Options dialog boxes. (These settings are 
used automatically if you have selected the project preset for CD-ROM mastering.)

 

O

 

Output As: QuickTime Movie 

 

O

 

Size: 240 pixels by 180 pixels

 

O

 

Rate: 15 frames per second
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O

 

Audio Rate: 11 kHz sound rate

 

O

 

Audio Blocks: 1/2 or 1 second

 

O

 

Compressor: Apple Cinepak

 

O

 

Key Frame option: selected

 

O

 

Quality (Temporal) setting: Normal 

 

O

 

Data Rate: 90K/second for single-speed drives; 150K/second to 200K/second for 
double-speed drives

 

BATCH COMPILING MOVIES

 

The Adobe Premiere program includes a command for compiling more than one movie 
at a time. The Batch Movie Maker uses the project and compression options you specify 
for each movie being compiled. You can create and save multiple batch lists for easy 
recompiling of groups of projects.

 

To batch compile movies:

 

1

 

Specify the project and compression options for each project you want to include in the 
batch list. For information on project output options, see “Selecting Project Output 
Options” on page 210. For information on compression options, see “Selecting Compres-
sion Options” on page 219.

 

2

 

Choose Tools/Batch Movie Maker from the File menu. The Batch Movie Maker dialog 
box appears.

 

3

 

To add files to the batch list, click Add. Use the Open dialog box to locate and add the 
projects you want to compile. The projects you add appear in the Projects to Process list, 
and their corresponding compiled movie names appear in the Output Movie list.

 

4

 

To change the name of a compiled movie, select the project in the list and click Target. 
Use the Save dialog box to rename the target movie file.

 

5

 

To make sure that all files associated with a project are still in their proper locations, 
select the project in the list and click Check. If this option is checked, Adobe Premiere will 
prompt you for new file locations, if appropriate, before batch processing. If files have been 
moved and this box is not checked, batch processing will be interrupted.

 

6

 

To compile the projects in a previously saved batch list, click Load. Use the Open dialog 
box to locate and add the batch list you want to compile.
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7

 

To save the batch list after adding all of the files you want to compile, click Save. Use the 
Save dialog box to name and store the list.

 

8

 

Click Make to begin the compiling process.

 

USING PRINT TO VIDEO

 

Adobe Premiere’s Print to Video feature lets you export a QuickTime

 

 

 

movie from the Clip 
window to your Macintosh screen or video monitor while blacking out all other windows. 
The Print to Video command is useful for viewing compiled movies and for recording 
movies onto videotape in real time, as they play on your screen. Print to Video lets you 
perform hardware zooming as you play a clip, so that you can view a quarter-screen movie 
at full-screen size. For information on making videotapes, see “Outputting a Movie to 
Videotape” on page 227.

Print to Video also allows you to output the contents of the Construction window directly 
to your Macintosh screen or video monitor. This is useful for full-screen previews or for 
outputting the contents of the Construction window to videotape without compiling all 
the data. For more information on previewing with Print to Video, see “Previewing with 
Print to Video” on page 126.

 

To play a movie centered on a blank screen: 

 

1

 

Choose Open from the File menu. The Open dialog box appears.

 

2

 

Select the movie you want to play from the file list, and click OK. The movie appears in 
a Clip window.

 

3

 

Move the Clip window to the screen on which you want to play the movie. This should 
be the monitor with the best video board (for example, a board that is driven by hardware 
compression).

 

Note:

 

 If the Clip window is collapsed, Print to Video will use the screen that contains the 
Preview window.
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4

 

Choose Export/Print to Video from the File menu. The Print to Video dialog box 
appears.

 

5

 

Select Print to Video options.

 

O

 

Color Bars.

 

 

 

Set the duration for displaying color bars at the beginning of the movie. The 
default setting is 0 seconds.

 

O

 

Blank Screen. Set the duration of the blank screen displayed at the beginning and end of 
the movie. The default setting is 3 seconds. This setting works well if you are using Print 
to Video to view the movie. For recording on videotape, you should set the duration of the 
blank screen to about 15 seconds.

 

O

 

 Zoom Screen. Select this option to magnify the frame size of the movie by a factor of 
two. This is an effective way of enlarging quarter-screen movies (320 pixels by 240 pixels) 
to full size (640 pixels by 480 pixels). Choose the Hardware option if you have a video card 
that supports hardware zooming and a zooming module in the Plug-Ins folder; otherwise, 
choose Software. The speed with which you can zoom with software is determined by the 
Macintosh CPU you have. If you are using the Apple Video compressor, set the color depth 
of the internal video to 256 colors (8 bits) or to thousands of colors (16 bits) to maintain 
the highest frame speed possible.

 

Note:

 

 Because every pixel is mapped to four screen pixels when the movie is magnified, 
zooming may cause noticeable pixelization or blockiness in the image. If the movie is output 
to tape, encoding will reduce some of this blockiness.

 

O

 

Screen Mode. Use the pop-up menu to select the type of video screen you are using to 
play the clip. Select Current to play the clip on your Macintosh screen. Select NTSC if you 
have an NTSC monitor hooked up to your system. With some video boards, this option 
allows a temporary switch into NTSC mode. This requires a special plug-in module.

 

O

 

 Loop Playback. Select this option to play the movie as a continuous loop. Press 
Command-period (.) to cancel continuous playback. 
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6

 

 Activate Recording Deck. Select this option if you are recording to a controllable device. 
The movie will be recorded to the tape deck that you have selected in the Device Control 
dialog box under the Preferences menu. This option is grayed out if no such device is 
selected. (For a description of these options, see “Outputting a Movie to Videotape” on 
page 227.) Do not select the Activate Recording Deck option unless you want to record the 
movie onto a controllable device as it plays on your screen.

 

7

 

Click OK. The movie plays at full screen or in the center of the screen against a black 
background, depending on the frame size. To interrupt the playing of the movie, press 
Command-period (.).

 

Note:

 

 With a two monitor setup, both the Clip window and the Print to Video dialog box 
should be on the screen you want the movie to play on.

 

LINKING MOVIES

 

You can link together a series of shorter movies using the Sequence window. The Sequence 
window is simpler to use than the Construction window and is good for storyboarding or 
producing quick results with existing clips. When you compile a movie using the Sequence 
window, additional compression is not applied. Each component movie of the composite 
movie retains its original compression and output size. Compilation is relatively fast, 
without the image degradation that can result from recompressing data.

You can use the Print to Video command when the Sequence window is active to output 
the contents of the window directly to your computer screen or to videotape. Using Print 
to Video, you can pause for a mouse click between clips.

 

Note

 

: Only QuickTime movies can be assembled into a composite movie. All other clips in 
the Sequence window are ignored when a composite movie is compiled. Also, the Sequence 
window does not show special effect transitions between the movies you are linking. 

 

To make a composite movie using the Sequence window:

 

1

 

Choose New/Sequence from the File menu. The Sequence window opens.

 

2

 

Use the Import command in the File menu to import the movies you want in the 
composite movie. You can also drag movies from a Clip window or the Project window 
into the Sequence window.
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The thumbnails of the movies you selected appear in the Sequence window. 

The area under the title bar of the Sequence window displays the number of movies in the 
window and the total duration of the combined movies. 

 

3

 

To change the order in which the movies are linked, drag the thumbnails to rearrange 
them in the Sequence window. Press the Shift key to select and move more than one 
thumbnail at a time. To change the icon size of the thumbnails, choose Sequence Views 
from the Windows menu.

 

4

 

Choose Composite from the Make menu. The Save Movie dialog box appears.

 

5

 

Type a name for the movie, and click OK. 

Adobe Premiere begins creating the composite movie. To stop the compilation, press 
Command-period (.). Your options for playing and outputting the composite movie are 
the same as they are for any other compiled movie. These options are explained later in 
this chapter in “Using Print to Video” on page 223 and “Outputting a Movie to Videotape” 
on page 227.

 

To display a sequence using Print to Video:

 

1

 

With the Sequence window active, choose Export/Print to Video from the File menu.

 

2

 

Choose options from the Print to Video dialog box. For a description of these options, 
see “Using Print to Video” on page 223.

 

3

 

Click OK. 

Movie, audio, and still-image clips play in the center of your screen, in the order that they 
appear in the Sequence window. If you clicked the mouse icon in the top right corner of 
the Sequence window before choosing the Print to Video command, the display will pause 
between clips until your next mouse click. In this mode, you can use the right and left 
arrow keys to move forward and backward in the clip sequence as it plays. You can also use 
the Home and End keys to move to the first or last movie in the Sequence window.
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To save a Sequence window: 

 

1

 

With the Sequence window active, choose Save from the File menu. The Save dialog box 
appears. 

 

2

 

Type a name for the Sequence file, and click OK. 

Note that the Sequence file contains only a reference to the movies used to build the 
composite movie; therefore, the file size is very small.

 

OUTPUTTING A MOVIE TO VIDEOTAPE

 

You can record an Adobe Premiere movie or movie sequence to videotape using the Print 
to Video command. You need only one tape deck for recording a movie; time base correc-
tors, switchers, effects generators, and other special equipment are not needed. After the 
movie is output to videotape, you can play the tape on any television or analog video 
monitor equipped with a videotape deck.

You can record Adobe Premiere movies after they have been compiled, or you can record 
movies directly from the Construction window. With either method, you can use the Print 
to Video command to view the movie on your computer monitor before activating your 
recording deck. This provides you with a preview of what the movie should look like on 
videotape. For more information, see “Using Print to Video” on page 223.

You can videotape the movie in real time as it plays on your screen, or in nonreal time if 
you have a controllable frame-accurate recording deck. To achieve acceptable results with 
real-time recording you need a Macintosh system (computer and video display board) 
that is capable of producing an acceptable output rate. If your movie skips frames when it 
plays on your monitor, those frames will be lost in real-time recording.

Recording in nonreal-time means recording at a speed other than the movie’s normal 
playing speed. The advantage of nonreal-time recording is that you are assured of 
capturing every frame of your movie on videotape. However, you need a controllable 
recording deck and a machine controller, such as the DiaQuest, VideoMedia, ARTI, or 
Selectra. In addition, you need a third-party software program, such as QuickPass from 
DiaQuest, that allows nonreal-time frame grabbing and printing to videotape.

Before outputting to video, you should use the Print to Video command to view at least a 
portion of the movie on your monitor before you activate your recording deck. (For more 
information, see “Using Print to Video” on page 223.) If you will be recording in real time, 
this provides you with a preview of what the movie should look like on videotape.
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Note:

 

 You can have Adobe Premiere generate an Edit Decision List (EDL) for creating a video-
tape using traditional post-production techniques. The EDL contains a list of all of the clips, 
transitions, and special effects in the movie, and is used to assemble a new movie (master) 
from the original (source) tapes. For more information on EDLs, see “Generating an Edit 
Decision List” on page 112.

 

To output a movie to videotape:

 

1

 

Make sure that your Macintosh is capable of producing NTSC-compatible signals. (For 
more information, see the next section, “Producing NTSC-Compatible Signals.”) 

 

2

 

Make sure that you have a cable connection from the NTSC encoder (or from your video 
board if the board has a built-in encoder) to your tape deck. If you have an NTSC monitor, 
you should have a cable connecting the encoder output to the monitor input and another 
cable connecting the NTSC monitor output to the tape deck input.

 

3

 

Select one of the following sources for the movie you want to record:

 

O

 

The Clip window, for compiled movies

 

O

 

The Construction window, for uncompiled movies

 

O

 

The Sequence window, for linked movies

 

4

 

If you are using multiple computer monitors, make sure that the window controlling 
your source video—Clip, Preview (for outputting directly from the Construction 
window), or Sequence window—is displayed on the monitor that has the best video 
display card. Adobe Premiere will use that card to output the movie. 

 

5

 

If you have a controllable device and want Adobe Premiere to start and stop the tape 
automatically, select Preferences/Device Control from the File menu and choose the 
controllable device you are using from the pop-up menu in the Device Control dialog box.

 

6

 

Choose Export/Print to Video from the File menu. The Print to Video dialog box 
appears.

 

Note:

 

 Many video board manufacturers supply enhanced export modules for Adobe Premiere. 
These export modules support features unique to the board. Like Adobe Premiere’s built-in 
Print to Video module, these third-party export modules are implemented by choosing a 
command in the Export menu. Refer to the documentation that comes with your video card 
for more information.
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7

 

Select Print to Video options. For a description of these options, see “Using Print to 
Video” on page 223.

 

8

 

Click OK; then, if you are recording in real time without a controllable deck, press 
Record on your tape deck. A Blank Screen setting of 15 seconds in the Print to Video dialog 
box should allow you enough time to activate the deck and get it up to speed before the 
movie starts playing. 

The movie begins recording to the videotape on the tape deck. If you are using a control-
lable deck, the deck stops after the movie has been recorded. If you are not using a control-
lable deck, you must manually stop the deck.

 

Producing NTSC-compatible signals

 

To videotape an Adobe Premiere movie, your hardware must be set up to produce NTSC 
scan rates and encode the video signal for NTSC display. The ability of your computer to 
perform these two tasks depends on the capabilities of your computer and your video 
board. Many boards have both capabilities. The built-in video of most Macintoshes can 
generate NTSC scan rates, but all Macintoshes require an external signal encoder for 
NTSC display. Many third-party video boards have both capabilities. See the documenta-
tion that comes with your Macintosh and your video board for information on their 
capabilities.

 

O

 

NTSC-compatible scan rates

 

.

 

 Before your Macintosh can output a movie to videotape, 
the scan rate of the video board must be set to NTSC-compatible rates. NTSC video is 
scanned at 29.97 Hz. Built-in Macintosh video boards scan at many different rates, 
including NTSC rates, depending on which monitors they are driving. The 13-inch RGB 
monitor that ships with most color Macintosh computers scans at 67 Hz. If your board is 
not capable of NTSC-scan rates, you will need a scan converter such as the Mediator from 
Videologic to output your movie to tape. 

 

O

 

Encoders. NTSC television signals and Macintosh signals also differ in how they are sent 
to the screen. If your video board is capable of outputting NTSC-composite signals (or if 
you already have a scan converter), you can output a movie directly to tape; if your video 
board is capable of outputting only NTSC-RGB signals, you will need an encoder. Many 
encoders that plug directly into the video board of your Macintosh are available from 
third-party dealers, who also provide cabling for the monitor and jacks for connecting the 
Macintosh to a VCR or TV. 
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SELECTING MIDI CONTROL FOR AUDIO

 

You can use Adobe Premiere to trigger a Musical Instrument Digital Interface (MIDI) 
device when playing a movie from a Clip window or when using the Print to Video 
command. To use MIDI triggering, you need the Apple MIDI Manager and Patch Bay 
installed on your Macintosh. (These utilities are provided by your instrument or 
sequencer manufacturer. Refer to the manufacturer’s documentation for further details 
about installation.)

To change the timing of the MIDI signal sent to your instrument, choose MIDI Setup from 
the Preferences submenu under the File menu.

 

EXPORTING MOVIES FOR USE IN OTHER PLATFORMS

 

If you plan to use Adobe Premiere movies on other computer platforms, you may have to 
export them as a 

 

flattened movie

 

. A flattened movie file has the indexing information 
added onto the data fork of the file, enabling it to be read when using other platforms such 
as DOS and UNIX. To export a flattened movie, choose Export/Flattened Movie from the 
File menu. The flattened movie will be saved with the

 

 .mov

 

 extension unless you specify 
otherwise.
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Chapter 

 

9

 

: Capturing

 

 

 

Video

 

his chapter describes how to record video images and sound directly to your 
computer by digitizing, or 

 

capturing

 

, the analog video and audio signals. 
Capturing is performed using Adobe Premiere’s Movie Capture, Audio Capture, 

 

and Batch Capture commands.

 

DIGITIZING HARDWARE

 

To record video, you need a video source (such as a VCR, camcorder, or laserdisc) and a 
QuickTime-compatible video digitizing board (also called a video capture board or digi-
tizer card). For recording sound, you need a Macintosh with a sound input port (for 
example, a Macintosh LC, IIsi, or Quadra), or a sound digitizing device such as Macrome-
dia’s MacRecorder or Digidesign’s AudioMedia board. Some video capture boards offer 
audio digitizing capabilities as well.

Video digitizing boards differ widely in their functions and capabilities. Many function as 
graphics display boards and video output boards. To digitize video using Adobe Premiere, 
the board must be QuickTime-compatible. Your System folder must contain the VDIG 
system extension for your board (supplied by the manufacturer). The VDIG software 
functions as a video device driver and an interpreter between the board and QuickTime. 

If you have a controllable video playback device, you can capture video clips automatically 
by making reference to their timecode. To do this, you need a device controller such as the 
Pipeline Digital Pro VTR, the Diaquest DQ Timecoder, or the Video Media VLAN to 
control the source remotely using Adobe Premiere. With a controllable device, clips can 
also be viewed and logged with reference to their timecode and then batch digitized.

If you are digitizing sound using a digitizing board or the MacRecorder, the audio device 
driver for that device must also be installed in your System folder. The driver functions as 
a link between the audio board and QuickTime. You don’t need a special driver if you are 
using the built-in audio capability of your Macintosh to digitize sound.

The connections between hardware components will vary with the equipment you are 
using. You will need to connect the video out ports of your video source to your video 
capture board, usually through a port in the back of your Macintosh. Your audio source 
(normally the audio out port of your video source) must also be connected to the Macin-
tosh, either routed through an external digitizer or connected directly to the computer’s 
built-in sound digitizer. Refer to the documentation for your Macintosh and your digi-
tizing boards for the proper hardware setup and configuration.

 

T
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GUIDELINES FOR CAPTURING VIDEO

 

Digital recording of full-frame, full-motion video requires a fast computer and lots of disk 
storage space. Only recently have desktop computer systems been capable of processing 
data effectively enough to capture, store, and play back digital video. For more informa-
tion on memory requirements for capturing video, see “Digitizing Video” on page 299.

The three main strategies for reducing data transfer rates are:

 

O

 

Compressing the video data

 

O

 

Reducing the image dimensions of the captured video

 

O

 

Reducing the frame rate of the captured video

Each of these strategies compromises the quality of your digitized video. If you need to 
capture full-frame video at 30 fps, you’ll need some specialty hardware and a lot of data 
storage capacity. If you can compromise the quality or the image dimensions, you’ll be able 
to do a lot more with less. If you are digitizing video for use on CD-ROMs, for example, 
you can capture at less than full frame and 30 fps because CD-ROM players are limited in 
their playback capabilities. For more information, see “Selecting Recording Options” on 
page 239 and “Selecting Video Input Options” on page 241.

Video data can be compressed using both hardware compression and software compres-
sion. Some type of hardware compression, through either the digitizing board or the 
internal video of your computer, is required to capture full-frame video at 30 fps. Several 
software compressors are available in Adobe Premiere. For more information, see “Digital 
Video Compression” on page 215.

 

Capturing the highest quality video

 

Achieving the maximum frame rate and image size during capture and playback is depen-
dent on the following hardware factors:

 

O

 

Speed and compression capabilities of the video capture board or the system’s 
built-in video 

 

O

 

Speed of the computer’s hard drive

 

O

 

Speed of the computer’s central processing unit (CPU)

 

O

 

Data processing load on the CPU

 

O

 

Speed of the computer’s data bus 

 

O

 

Available RAM, if you are capturing to RAM 
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Video capture board

 

The faster your video board, the faster the video frames can be drawn on screen. To 
capture full-frame video at 30 fps, most boards capture only one of two fields (half the 
screen lines) in each frame and replicate the data to complete the frame. This compro-
mises image quality. For capturing images of quarter-screen or smaller, this compromise 
is not usually necessary.

In general, hardware compression on the capture board greatly increases movie capture 
performance. Video boards that have JPEG compression can usually capture full-motion 
video very effectively. You will need to experiment with your Macintosh and video digi-
tizing board to determine what settings in Adobe Premiere produce the best results. 

 

Hard drive speed

 

The faster your hard drive, the faster the Macintosh can read and write data to and from 
the hard disk. For 30 fps capture, it is recommended that your hard disk have an average 
access time of 10 milliseconds (ms) or less, and a data transfer rate of 3 MB per second or 
more. (This data transfer rate is currently available with 5400 rpm drives. As a general rule 
of thumb, the video data transfer rate will be about half the data transfer rate of the drive. 
You may achieve higher transfer rates with special SCSI connections, such as disk arrays, 
SCSI II or fast SCSI.)

 

CPU speed

 

The faster your CPU, the faster your Macintosh will be able to process the data necessary 
to capture and play back digital video. Currently, the fastest Macintosh computers avail-
able are the Quadra AV and the Power Macintosh. Of the Power Macintosh computers, the 
PowerPC 8100 is the best for capturing video.

 

CPU load

 

During capture, make sure that you have as much of the CPU dedicated to the process as 
possible. This means turning off all unnecessary extensions and control panels. You should 
probably be running only QuickTime and any required video digitizer extension or sound 
driver. You should make AppleTalk inactive and close any applications that are running in 
the background under System 7. Turn off Virtual Memory if you are running System 6. 
You should also make sure that all floppy drives or tape drives in your system contain 
diskettes or tapes so that the CPU won’t be continually checking the empty drives.

 

Data bus

 

The computer’s data bus controls the rate of data transfer from the capture device to the 
CPU. Currently, the Quadra AV and Quadra 950 have the fastest data buses. 
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Capturing to RAM versus capturing to hard disk

 

On many computers, the best method is to capture the video directly to RAM. Capturing 
to RAM is faster than capturing to a hard drive; however, the movie’s size is limited to the 
amount of free memory.

 

Capturing to RAM

 

Because capturing a movie to RAM is faster than capturing to a hard disk, it is recom-
mended when you have enough free memory to store the movie being captured. Use the 
following guidelines when capturing video to RAM:

 

O

 

Free up as much memory as possible by closing other applications and turning off 
unnecessary utilities; the more memory you have available, the longer the movie you 
can capture. 

 

O

 

If you have a fast Macintosh (such as the IIfx, Centris, or Quadra) or a video board with 
hardware compression, you can perform compression as the movie is being captured. This 
allows you to record longer clips to memory.

 

Capturing to a hard disk

 

If you do not have enough free memory to capture to RAM, you will need to capture to a 
hard disk. Use the following guidelines when capturing to a hard disk:

 

O

 

Use a high-speed hard disk; the disk’s speed is measured by the disk’s sustained data 
transfer rate. If you have multiple hard disks, capture to your fastest hard disk.

 

O

 

Use a dedicated hard disk or create a separate partition on your hard disk for capturing 
video. 

 

O

 

Do not record to a fragmented hard disk, because it can reduce the frame rate at which 
movies are captured. Use a defragmenting utility, such as Norton Utilities, to optimize and 
defragment the hard disk as often as necessary to keep it efficient.

 

O

 

If you create a separate partition for capturing on your hard disk, use the Scratch Disks 
Preferences to select the partition to which you want to record. To do this, choose Prefer-
ences/Scratch Disks from the File menu. Select the volume name from the list of available 
names in the pop-up menu for Temp/Captured Movies.

 

Capturing without software compression

 

With smaller movies (160 pixels by 120 pixels), higher frame rates can be achieved by 
capturing the movie with no compression (Apple None), since the compression process 
itself requires time. As you increase the size of the movie, however, capturing without 
compression decreases the frame rate. This is because the capturing is limited by the data 
transfer rate of the NuBus (the interface between the digitizing board and the Macintosh).
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Capturing full-screen images

 

Full-screen video (640 pixels by 480 pixels) can be captured two ways: in real time using 
hardware compression, or in nonreal time using a frame-accurate tape deck that is 
controllable by the computer. In general, capturing in real time with hardware compres-
sion provides the fastest and easiest method for capturing full-screen video.

Nonreal-time capture methods grab a single frame of the movie at a time, or make 
multiple passes until they have captured all the needed frames. These methods require that 
you have a frame-accurate tape deck, timecode on your source tape, and a third-party 
utility, such as DiaQuest QuickPass, for controlled capture of the video data. 

Another strategy is to capture the video at quarter-screen (320 pixels by 240 pixels) and 
use the zoom capability of the Print to Video command during playback or recording out 
to videotape. This method requires substantially less disk space for data storage and 
improves editing performance in Adobe Premiere. In many cases, image quality with 
zooming is the same as if the video were captured at full-frame. This is because most video 
capture boards can generally capture all the video data at quarter-screen, but only half the 
video data at full-screen. For information on hardware zooming with Print to Video, see 
“Using Print to Video” on page 223.

 

Note: 

 

When making full-screen movies, you can achieve faster editing performance by 
creating a set of miniatures from the original clips; you then replace the miniatures with the 
original files when you are ready to output the final movie. If you have a controllable tape 
deck, another effective strategy is to digitize clips at low resolution for editing, then re-digitize 
all the clips in your Project window using Batch Capture. For more information on creating a 
set of miniatures, see “Making Miniatures to Improve Performance” on page 43. For more 
information on batch capturing, see “Batch Capturing with Device Control” on page 250. 

 

GUIDELINES FOR CAPTURING AUDIO

 

With Adobe Premiere you can capture audio in the sound channel of a QuickTime file or 
as an AIFF (Audio Interchange File Format) file. For both types of capture, you can select 
options that affect the quality of the audio files.

The quality of digitized audio and the size of the audio file depend on the sampling rate 
and bit depth of the sample. These parameters determine how well the analog audio signal 
is represented when it is digitized. Audio sampled at 22 kHz and 16-bit resolution is far 
superior in quality to audio sampled at 11 kHz and 8-bit resolution. CD audio is normally 
digitized at 44 kHz.
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Until recently, the Macintosh was designed to work with 8-bit audio sampled at 22 kHz. 
Newer models handle 16-bit audio at higher sampling rates. Many third-party audio 
boards, such as Digidesign’s AudioMedia board, can also sample at higher resolution. For 
more information on capturing audio, see “Selecting Audio Input Options” on page 244.

 

CALIBRATING THE INPUT VIDEO SIGNAL

 

Before capturing movies to disk, you can use Adobe Premiere’s Waveform Monitor and 
Vector Scope to adjust the digitized signal being captured. 

For effective calibration, you should have standard color bars recorded onto a segment of 
each source videotape. If your deck has controls for adjusting chrominance and lumi-
nance, use them to adjust the analog video signal before making adjustments in the Wave-
form Scope dialog box.

 

Note:

 

 Any Settings adjustments made in the Waveform Scope dialog box will be reflected in 
the Image control panel of the Video Input dialog box.

 

To calibrate the input video signal:

 

1

 

Press the Play button on your tape deck to play your videotape.

 

2

 

Choose Capture/Waveform Monitor from the File menu. The Waveform Scope dialog 
box appears.
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O

 

Source Video window. This window displays the digitized video image being processed 
by your digitizing board. Use this window to display the standard color bars recorded on 
your videotape (if you have them) while calibrating the input video signal. Use the pop-
up menu below the Source Video window to choose an Adobe Premiere reference image, 
such as standard color bars, for visual comparison with your videotape.

 

O

 

Waveform Monitor window. This window displays the luminance and color saturation 
values in the digitized source video as a series of vertical lines. The vertical axis of the 
display represents the dynamic range of your digitizer board, with black at the bottom 
(0 IRE value) and white (100 IRE) at the top. Saturation is represented by the height of the 
lines. The luminance is the midpoint of each line. Click the Luminance Only option to 
read just the luminance values. 

 

O

 

The Vector Scope window. This window displays the hue and saturation values in the 
source video. The hue is the angle from the 12 o’clock position on the scope. The satura-
tion is the distance from the center of the scope. The optimum range of values for each 
primary color in the standard color bar pattern is enclosed by a small box. The primary 
colors represented are magenta, blue, cyan, green, yellow, and red.

 

3

 

If you have color bars recorded on your source video, compare the Waveform Monitor 
and Vector Scope for your source video against the reference color bars and see if they 
match. Use the slider controls on the left side of the dialog box to adjust the source video 
image:

 

O

 

Click the Luminance Only option below the Waveform Monitor and adjust the black 
level and white level so that the readings match for the black-and-white color swatches.

 

O

 

Adjust the hue and saturation to match the Vector Scope targets.

 

O

 

Adjust the brightness and contrast so that the saturation and luminance readings are as 
close as possible for all areas of the Waveform Monitor.

 

4

 

If you don’t have standard color bars recorded on your source videotape, use the slider 
controls to make qualitative adjustments to the input video as it plays in the Source Video 
window. You can make the same adjustments in the Source control panel of the Video 
Input dialog box. For more information, see “Selecting Video Input Options” on page 241.

 

5

 

Play your videotape to observe the effects of your adjustments, paying special attention 
to flesh tones. Make additional adjustments as needed.

 

Note:

 

 You can save your settings for the source video and load them later using the Save 
Settings and Load Settings commands in the Monitor menu. 
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CAPTURING WITHOUT A CONTROLLABLE DEVICE

 

You can capture video to your hard disk in real time by monitoring the signal in the Movie 
Capture window and recording the frames you want. The effectiveness of this method 
depends on the speed of your CPU, the capabilities of your video digitizing board, and the 
size of the video frames you are capturing. You should close all other applications and turn 
off all unnecessary INITS and CDEVS before capturing. For more information on 
capturing video, see “Guidelines for Capturing Video” on page 232.

 

Note:

 

 If you are using a controllable device to capture a movie, see “Capturing with Device 
Control” on page 247.

 

To capture without a controllable device:

 

1

 

Choose Capture/Movie Capture from the File menu. The Movie Capture window 
appears, and the Movie Capture menu appears in the menu bar.

 

2

 

Select recording options using the Recording Settings command in the Movie Capture 
menu. For more information on recording options, see “Selecting Recording Options” 
on page 239.

 

3

 

Use the Video Input command in the Movie Capture menu to select a video compressor 
and set video options specific to your system configuration. For more information on 
video options, see “Selecting Video Input Options” on page 241.

 

4

 

Use the Sound Input command in the Movie Capture menu to select audio options 
specific to your system configuration. For best capturing performance, be sure to select 
Off or Off While Recording from the Speaker pop-up menu in the Sound Input dialog box. 
For more information on audio options, see “Selecting Audio Input Options” on page 244.

 

5

 

Press the Play button on the tape deck to start the tape. If you are recording images, the 
tape begins to preview in the sample area of the Movie Capture window.

If desired, change the size of the Movie Capture window by dragging the size box in the 
corner of the window. The window will snap to common sizes as you drag. To make the 
window any size while maintaining the current aspect ratio settings, hold down the Shift 
key while dragging the size box; to resize the window without maintaining the current 
aspect ratio, hold down the Option key while dragging.
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6

 

Click the Record button to start the recording. You should start the recording 1/2 second 
to 1 second before the first frame you want in your clip, to ensure that the video capture 
board is digitizing at full speed. 

The cursor disappears during recording. To stop recording, hold down the mouse 
button for a few seconds. When the recording has finished, the clip appears in an untitled 
Clip window.

 

7

 

Use the Save command to save the clip.

 

SELECTING RECORDING OPTIONS

 

The Recording Settings dialog box lets you determine how Adobe Premiere captures video. 

 

To set recording options:

 

1

 

Choose Capture from the File menu to open the Movie Capture or Batch Capture 
window.
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2

 

Choose Recording Settings from the Movie Capture menu. The Recording Settings 
dialog box appears.

 

3

 

Set the following options:

 

O

 

Size.

 

 

 

Select the Record at Current Size option to capture video at the dimensions 
currently displayed in the Movie Capture window (note that you can resize the Movie 
Capture window itself). Select the Record At button to type in different dimensions. If the 
4:3 Aspect Ratio is selected, you can type a value in either the horizontal or vertical field 
and the value in the opposite field is automatically updated to maintain a width-to-height 
ratio of 4 to 3. 

 

O

 

Post-Compress Video.

 

 

 

Select this option if you want compression to take place after the 
video has been captured, rather than during video capture. This option is generally used 
when your digitizing board does not provide compression. Compressing after capture 
may allow a higher frame rate because the compression process itself takes time. However, 
compressing during capture allows for longer movies. You should not select this option if 
your digitizing board provides hardware compression.

 

O

 

Record to RAM. Select this option to record to RAM rather than to disk. Recording to 
RAM is faster, but it requires a great deal of memory. 

 

O

 

Abort on Dropped Frames. Select this option if you want Adobe Premiere to stop 
capturing automatically in the event that a frame is dropped during capturing. This is a 
default setting.
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O

 

Report Dropped Frames. Select this option if you want Adobe Premiere to automatically 
analyze the movie for dropped frames after it has been captured. The Movie Analysis 
window will appear after capturing if frames have been dropped.

 

O

 

Conform Movie To. This is a built-in time base corrector. Use this option to ensure that 
all captured frames have exactly the same duration. All video tape decks have a potential 
for frame rate errors. For precise editing, it is important that all frames have the correct 
duration. With this option selected, Adobe Premiere will adjust each captured frame to 
match exactly the frame rate you select from the pop-up menu. If you’ll be outputting your 
movie to videotape, you should set the conform frame rate to 29.97.

 

O

 

Decode Burned-In Timecode. Select this option if you want Adobe Premiere to use the 
Timecode Decoder to read burned-in timecode (also called visual timecode, or window 
dubs) as it captures. For more information on timecode, see “Capturing and Calibrating 
Timecode” on page 254.

 

4

 

If you are using device control, set the following three options if they appear in the 
Recording Settings dialog box:

 

O

 

Pre-Roll Time. Use this option to adjust the pre-roll time that allows the tape deck to get 
up to speed before digitizing occurs

 

.

 

 The default setting (3 seconds) is usually adequate.

 

O

 

Timecode Offset. Enter an adjustment setting for calibrating the captured frame rate. 
For more information, see “Calibrating Timecode” on page 256.

 

O

 

Use Reel Name and In Time. Click this option if you want Adobe Premiere to use the 
reel name and in point as the file name in the batch capture log. For information on batch 
capturing, see “Batch Capturing with Device Control” on page 250.

 

SELECTING VIDEO INPUT OPTIONS

 

The Video Input dialog box lets you select the video capture board you are using and then 
adjust settings associated with that board. It also lets you choose a video compressor. 
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To select video input options:

 

Choose Video Input from the Movie Capture menu. The Video Input dialog box appears.

The image you are digitizing appears in the window in the upper right corner of the dialog 
box. At the top of the dialog box is a pop-up menu containing a minimum of three choices 
for Video Input control panels: Compression, Image, and Source. The options in the 
Video Input dialog box are determined by the panel you select and the type of video digi-
tizing board you are using. See your hardware documentation for complete information 
on Video Input dialog box options.

 

To select video source options:

 

1

 

Choose Source from the pop-up menu at the top of the Video Input dialog box. The 
Source panel appears.

 

2

 

Select the digitizing board you want to use.

 

3

 

Select the type of source video you are capturing. Choose from the available hardware 
inputs, defined by the board manufacturer. The choices are typically limited to Composite 
Input 1 or S-Video Input 1. 

 

4

 

Select the format in which you want to capture images—NTSC, PAL, or SECAM. (Note 
that certain video digitizing cards select a format automatically.)

 

5

 

Select the video synchronization filter that matches your source video. 

 

To adjust the source image:

 

1

 

Choose Image from the pop-up menu at the top of the Video Input dialog box. The 
Image control panel appears.



 

Premiere User Guide 6/1/94 10:37 c9.pdf.frame

 

Right master page

 

2

 

Adjust the hue, saturation, brightness, contrast, sharpness, black level, and white level 
of the source video using the slider controls. Some of these controls may be dimmed out 
with certain video capture boards. For more information on adjusting the source video 
image, see “Calibrating the Input Video Signal” on page 236.

 

Note:

 

 Any Settings adjustments made in Waveform Scope dialog box will be reflected in the 
Image panel of the Video Input dialog box.

 

To select frame rate and compression options: 

 

1

 

Choose Compression from the pop-up menu at the top of the Video dialog box. The 
Compression control panel appears.

The Compression panel contains the same options as the Compression Settings dialog box 
used for outputting movies. For more information on compression and selecting 
compression options, see “Digital Video Compression” on page 215 and “Selecting 
Compression Options” on page 219.

 

2

 

Select a compressor. For video capture boards with hardware compression, select the 
compressor recommended by the manufacturer.

 

3

 

Select a frame rate from the Frames per Second pop-up menu. Select Best to have Adobe 
Premiere automatically capture at the highest frame rate possible with your system. 

 

4

 

Select a depth from the Depth pop-up menu. Select Best Depth to capture at the depth 
preferred by your digitizer. 

 

Note:

 

 The compression settings for capturing video (selected in the Video Input dialog box) do 
not affect the compression settings for outputting the movie (selected in the Compression 
Settings dialog box) and vice versa.
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To crop the image area for recording a portion of the image:

 

Drag to draw a marquee inside the sample area in the Movie Capture window. Only the 
portion of the image inside the marquee will be captured. (Note that some boards will 
capture at a decreased frame rate if the aspect ratio is set to a ratio other than 4:3.) 

 

SELECTING AUDIO INPUT OPTIONS

 

Audio input options can be set from two different dialog boxes in Adobe Premiere. The 
dialog box you use depends on whether you are capturing audio as an AIFF (Audio Inter-
change File Format) file or as a QuickTime movie file.

 

To select QuickTime audio input options:

 

1

 

Choose Capture/Movie Capture from the File menu. The Movie Capture window 
opens, and the Movie Capture menu appears in the menu bar.

 

2

 

Choose Sound Input from the Movie Capture menu. The Sound dialog box appears. 
(Note that you must have a sound device connected to the Macintosh to open this 
dialog box.)
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The right side of the dialog box contains a meter that displays the strength of the input 
audio signal, a gain control for adjusting the input signal, a volume control for adjusting 
the audio monitor, and a control for turning the speaker on or off.

The left side of the dialog box varies with the hardware you are using and the panel you 
select from the pop-up menu at the top of the dialog box: Compression, Sample, or 
Source. See your hardware documentation for complete information on audio input 
options.

 

3

 

Select Source from the pop-up menu at the top of the dialog box. The Source 
panel appears.

 

O

 

From the Device pop-up menu, select the name of the audio digitizer connected to your 
Macintosh, or select Built-in to use the Macintosh’s built-in sound digitizing capability.

 

O

 

Select the QuickTime audio channel you want to record to from the Input 
pop-up menu.

 

4

 

Choose Sample from the pop-up menu at the top of the dialog box. The Source 
panel appears.

 

O

 

Select an audio sampling rate. For the best quality using the built-in audio digitizer, 
choose 22 kHz. Choose 44 kHz if you have an audio board that can sample at that rate.

 

O

 

Select a sampling depth from the Size pop-up menu. 8-bit audio is the best quality that 
is currently offered with the internal audio of the Macintosh. Many audio boards can 
sample 16-bit audio. 

 

O

 

Select mono or stereo recording.

 

5

 

To apply compression to the digitized audio, choose Compression from the pop-up 
menu at the top of the dialog box and select a compressor from the Compressor pop-up 
menu. Note that in most cases, compressing audio is not advisable.

 

6

 

Select the Speaker On option, start your audio source, and listen to a portion of your 
audio before recording. The signal should be clear, with no distortion. The levels meter in 
the Sound Input dialog box should display the audio signal, but the levels should not 
extend into the red zone to the right of the meter. 

 

7

 

Use the Volume slider control to adjust the Macintosh speaker volume. This control 
does not affect the levels of the input audio signal.

 

8

 

Use one of these methods to adjust the input audio signal:

 

O

 

Increase the output levels of your audio device if the audio signal is too weak. Decrease 
the output levels to reduce distortion.
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O

 

Adjust the Gain control in the Movie Capture window so that the input audio levels do 
not extend into the red zone of the meter. 

 

9

 

Choose Off or Off While Recording from the Speaker pop-up menu unless you need to 
hear sound as you record. Capturing performance improves with the speaker turned off.

 

10

 

Click OK to return to the Movie Capture window.

 

To select AIFF audio input options:

 

1

 

Choose Capture/Audio Capture from the File menu. The Audio Recorder window 
opens, and the Audio Capture menu appears in the menu bar. 

The icon in the upper left corner of the Audio Recorder window indicates the currently 
selected audio digitizing device. A meter displays the strength of the input audio signal.

 

2

 

Choose Sound Input from the Audio Capture menu. The Sound Settings dialog 
box appears.

 

3

 

Select an audio digitizer from the Source pop-up menu.
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4

 

Click Options at the bottom of the dialog box to see additional input options for your 
digitizing hardware:

 

O

 

If you are using the Quadra’s built-in sound digitizer, you can select from Microphone, 
External Audio, or Internal CD for an audio source.

 

O

 

If you are using an audio board, additional input options will vary with your hardware.

 

5

 

Adjust the gain of the input audio signal and select sampling options. These options are 
described in the preceding procedure on selecting QuickTime audio input options.

 

6

 

Click OK to return to the Audio Recorder window.

 

Note

 

: You can convert CD-audio files directly into QuickTime files if you have the Apple’s 
CD300 CD-ROM player. Load your audio CD and double-click on the desktop icon. Quick-
Time software lets you select an audio track and convert it into a QuickTime file.

 

CAPTURING VIDEO OR AUDIO ONLY

 

You can capture QuickTime movies without the video or audio portion. To record images 
only, choose Sound Off from the Movie Capture menu. To record sound only, choose 
Video Off from the Audio Capture menu. 

 

CAPTURING WITH DEVICE CONTROL

 

If you have a controllable tape deck, a device controller, and a plug-in module that allows 
you to control the tape deck through Adobe Premiere, you can control the capture of video 
clips by identifying the timecode address for the starting and ending frames. Your source 
videotape must have been recorded with timecode to be able to capture with device 
control.

Be sure to calibrate your system if you intend to capture timecode with your clips, espe-
cially if you will be redigitizing your clips or you intend to create an edit decision list (EDL) 
from your project. For more information on calibration, see “Calibrating Timecode” 
on page 256.

Using device control has the following advantages:

 

O

 

You can control the tape deck from the computer screen instead of switching between 
the computer and the tape deck.

 

O

 

You can set in points and out points for clips using the Movie Capture or Clip Logging 
dialog boxes and then record between those points automatically. 
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O

 

You can automatically advance your tape deck to the frame displayed in the In or Out 
field of the Movie Capture window by holding down the Option key and clicking the In or 
Out button in the Movie Capture window, or by pressing I or O on the keyboard.

 

O

 

You can stamp timecode onto the digitized movie if your deck has the capability of 
reading timecode. You can also calibrate this timecode if the source video has burned-in 
timecode (also called visual timecode, or window dubs).

 

O

 

You can capture movies in slow motion if your deck is capable of variable playing 
speeds, and then increase the frame rate after the movie has been captured. This lets you 
capture movies at higher frame rates.

 

To record using device control: 

 

1

 

Choose Preferences/Device Control from the File menu. The Device Control dialog box 
appears.

 

2

 

Select the device you are using from the pop-up menu in the Device Control dialog box. 

 

Note:

 

 If you are using a VISCA tape deck, you must have a VISCA driver installed in your 
System folder. The VISCA control panel is included with Adobe Premiere in the Third Party 
folder.

 

3

 

Choose New/Movie Capture (or Audio Capture) from the File menu. The Movie 
Capture window appears.

Note that the controls that appear in the dialog box vary slightly according to the capabil-
ities of the recording device.

 

4

 

Select recording options using the Recording Settings command in the Movie Capture 
menu. For more information on recording options, see “Selecting Recording Options” 
on page 239.
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5

 

Use the Video Input command in the Movie Capture menu to select a video compressor 
and set video options specific to your system configuration. For more information on 
video options, see “Selecting Video Input Options” on page 241.

 

6

 

Use the Sound Input command in the Movie Capture menu to select audio options 
specific to your system configuration. For best capturing performance, be sure to select 
Off or Off While Recording from the Speaker pop-up menu in the Sound Input dialog box. 
For more information on audio options, see “Selecting Audio Input Options” on page 244.

 

7

 

To identify the reel you are using, click the Reel button in the Movie Capture window 
and type a name in the Reel Name text box.

 

8

 

Use the Jog control, Shuttle control, or control buttons at the bottom of the Movie 
Capture window to control the tape deck and locate the frames you want to digitize. 
You can also use the following keyboard shortcuts:

 

O

 

Press P or the spacebar to play or pause the videotape.

 

O

 

Press S to stop the videotape.

 

O

 

Press the right arrow key to advance one frame.

 

O

 

Press the left arrow key to back up one frame.

 

O

 

Press F to fast-forward the videotape.

 

O

 

Press R to rewind the videotape.

The timecode display at the bottom of the window shows the current frame. You can cue 
the tape deck to a specific location by clicking the display, typing in the timecode address, 
and pressing Return. If you type a plus (+) or minus (–) sign before the timecode, the deck 
will advance or rewind by the specified amount of time.

 

9

 

Identify the frames you want captured in one of the following ways:

 

O

 

As the tape plays, click the In and Out buttons to indicate the starting and ending 
frames. The timecode addresses for these frames will be entered automatically into 
the In and Out fields.

 

O

 

As the tape plays, press Shift-I to set the in point frame or Shift-O to set the out point 
frame.

 

O

 

As the tape plays, press the 1, 4, or 7 key in the numeric keypad to set the in point frame. 
Press the 3, 6, or 9 key to identify the out point frame. The timecode addresses for these 
frames will be entered automatically into the In and Out fields.
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O

 

Click the In or Out timecode displays (or press I or O) and type in the timecode address 
for the starting and ending frames. You can cue the tape deck to the frame displayed in the 
In or Out fields by holding down the Option key and clicking the In or Out button, or by 
holding down the Option key and pressing I or O on the keyboard.

 

10

 

Turn the Auto Record option on.

 

11

 

Click the Record button at the top of the Movie Capture window, or press G on the key-
board. The tape deck searches for the displayed timecode and records the selected images. 
When the recording has finished, the tape deck pauses automatically and the clip appears 
in an untitled Clip window. 

 

12

 

Use the Save command in the File menu to save the clip.

 

CAPTURING IN SLOW MOTION

 

Some tape decks are capable of running at 1/5 or 1/10 of their normal speed. If you are 
using device control and your tape deck is capable of playing at variable speeds, you can 
capture a movie at lower frame rates and then increase the frame rate 

 

after

 

 the movie has 
been captured. To do this, use the 1/5 or 1/10 option from the Play pop-up menu in the 
Movie Capture window.

 

O

 

1/5. The tape deck plays at 1/5 of its normal speed. If you choose this option, reset the 
frames per second in the Compression Settings dialog box to 6. Once the video has been 
recorded, you can increase the frame rate by choosing the Speed command from the Clip 
menu and setting the speed to 500 percent.

 

O

 

1/10. The tape deck plays at 1/10 of its normal speed. If you choose this option, reset the 
frames per second in the Compression Settings dialog box to 3. Once the video has been 
recorded, you can increase the frame rate by choosing the Speed command from the Clip 
menu, and setting the speed to 1000 percent. 

 

BATCH CAPTURING WITH DEVICE CONTROL

 

This section describes how you can log the timecode information for the in and out points 
of several clips you want digitized, and then have the program capture the clips automat-
ically. This process is called batch capturing. 

Batch capturing is especially useful if you want to edit a movie using low-resolution clips 
and to redigitize the clips later at higher resolution for outputting your movie. Using this 
approach, you’ll experience improved editing performance in Adobe Premiere and use less 
space on your hard disk. For more information using low-resolution clips, see “Using 
Low-Resolution Clips to Improve Performance” on page 44.
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Generating a list for batch capturing

 

Clips are logged into a Batch List window using the Clip Logging window or the Log 
In/Out feature of the Movie Capture window. These two windows have the same func-
tions, except that the Clip Logging dialog box has no video display window. To display 
video while using Clip Logging, you must use an external video monitor.

The Batch List window stores a

 

 timecode log

 

—a list of clips with their associated capture 
parameters. When digitizing a batch list, Adobe Premiere uses the current settings for 
recording, compression, video input, and audio input unless you have assigned Settings 
files (saved using the Movie Capture menu) to individual clips in the list. Assigned settings 
are loaded automatically when Adobe Premiere digitizes a clip in the batch list.

You can create or open multiple Batch List windows. Create a new Batch List window by 
choosing Capture/Batch Capture from the File menu. Save an active Batch List window 
using the Save command in the File menu. Open an existing Batch List window using the 
Open command in the File menu.

 

Note: 

 

Timecode logs in the Batch List window can be exported and imported as text files. Use 
the Export to Text File command in the Batch Capture menu to save a timecode log. Use the 
Import from Text File command to import a timecode log into an active Batch List window. 
Use the Import/Export Settings command to rearrange the order of the columns in the 
imported or exported timecode log.

 

To generate a timecode log for batch capturing:

 

1

 

Choose Capture/Movie Capture or Capture/Clip Logging from the File menu. The 
corresponding dialog box appears, and the Movie Capture menu or Logging menu 
appears in the menu bar.

 

2

 

Select recording, compression, video input, and audio input options using the proce-
dures described earlier in this chapter. To identify the reel you are using, click the Reel 
button and type a name in the Reel Name text box.

If you want Adobe Premiere to automatically name the files in the batch list, click the Use 
Reel Name and In Time as filename options in the Recording Settings dialog box. 

 

3

 

For each clip you want logged, identify the frames you want to capture using the In and 
Out buttons as the tape plays, or by typing the timecode into the In and Out fields. 
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If you are generating a log from the Movie Capture window, you can use the control 
buttons at the bottom of the window to control the tape deck and locate the frames you 
want to digitize. The timecode display at the bottom of the window shows the current 
frame. Click the display to enter the timecode, and press Enter to cue the tape deck to that 
location.

 

4

 

Click the Log In/Out button or press Return to enter the clip in the timecode log.

If you do not have a batch list open, Adobe Premiere will create an untitled Batch List 
window. The timecode log is updated in the Batch List window each time you click the Log 
In/Out button. For each clip in the list, a set of capture parameters is displayed: reel name, 
in point, out point, filename, and settings.

 

5

 

Use the Sort button in the Batch List window to sort the list alphabetically and numer-
ically by the reel name and the timecode start times.

 

To add comments or change batch capture parameters:

 

1

 

Double-click a clip in the Batch List. The Clip Capture Parameters dialog box 
appears with the current settings for the clip. This dialog box also appears when you 
click Add in the Batch List window, allowing you to add a new clip to the list by typing 
in the parameters.

 

2

 

Enter updated values for the reel name, filename, in and out points, frame rate, and 
timecode format.

 

3

 

Add a comment to a clip by entering text in the Comment field.

 

4

 

Click OK to enter the updated values in the Batch List.

 

To assign settings to a clip in the Batch List:

 

1

 

Select the clip in the Batch List. Shift-click additional clips to apply the same setting to 
multiple clips. 

 

2

 

Choose Attach Settings from the Batch Capture menu. The Attach Settings dialog box 
appears.

 

3

 

Locate the file that contains the settings, and click Open. The name of the attached 
settings file appears in the Batch List. 

To remove the settings, select the clip and choose Remove Settings from the Batch Capture 
menu.
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Note:

 

 When Adobe Premiere digitizes a clip with attached settings, those settings become the 
current Movie Capture settings and will be applied to subsequent clips in the list that do not 
have attached settings.

 

Capturing clips using a batch list

 

A small black diamond next to a clip’s reel name indicates that the clip will be captured 
when you click the Capture button in the Batch List window. You can toggle the diamond 
on and off by clicking to the left of the reel name. After a clip has been captured, a check 
mark appears in place of the diamond. A red 

 

X

 

 indicates that an error occurred when the 
clip was being digitized.

You can use the Handles command in the Batch Capture menu to digitize extra frames 
before the in point and after the out point of each clip. The in point and out point of each 
clip will not change, but the extra frames will enable you to extend the clip later, if desired.

 

Note:

 

 To open a previously saved Batch Capture window, use the Open command in the 
File menu.

 

To capture clips in the Batch list:

 

1

 

Make sure that the clips you want digitized appear with a small diamond next to the reel 
name. 

 

2

 

Click Capture in the lower right corner of the Batch List window. The Library File dialog 
box appears.

 

3

 

Locate the library file where the captured clips are to be placed, or click New to create a 
new library. 

After you have located the library file, Adobe Premiere prompts you to insert the proper 
reel in the tape deck. When you have done so, the tape deck searches for the timecode 
addresses indicated and records the selected images. When all clips have been recorded, 
the tape deck stops automatically. 

The digitized clips appear in the Library window. The clips are stored in the volume and 
folder that contains the library. You can drag clips from the Library window to any Project 
or Construction window. 
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Creating a batch list from an existing project

 

You can redigitize the clips in an existing project using batch capture, and they can be 
automatically logged according to their existing in points and out points. This allows for 
easy redigitizing when higher resolution files are needed for a project, and file sizes can be 
kept to a minimum by recapturing only the needed segments from the original source reel. 
For more information on using low-resolution clips and redigitizing, see “Using Low-
Resolution Clips to Improve Performance” on page 44. 

To redigitize all the clips in a project, use the Project Trimmer to generate a trimmed batch 
list. All clips are logged according to their in points and out points. This minimizes the disk 
space needed because Adobe Premiere will recapture only the trimmed portion of each 
clip in the project. For more information on using the Project Trimmer, see “Trimming 
Projects” on page 31.

To manually log project clips in a batch list, drag them from the Project window into a 
Batch List window. They are automatically logged according to their original duration. 
Any changes to the in and out points are discarded.

 

LOADING AND SAVING RECORDING SETTINGS

 

The recording, compression, video input, and sound input settings for any QuickTime 
digitizing session can be saved as a file by choosing the Save Settings command from the 
Movie Capture menu. You can load settings for digitizing at a later time using the Load 
Settings command in the Movie Capture menu. 

 

Note:

 

 Settings for Video Input or Sound Input will not be saved in the settings file if they have 
been turned off with the Video Off or Sound Off commands in the Movie Capture menu. 

 

CAPTURING TIMECODE

 

Timecode provides a means of accurately locating frames and synchronizing picture and 
audio elements in video. SMPTE (Society of Motion Picture and Television Engineers) 
timecode identifies each video frame with a unique address, in the form Hours: Minutes: 
Seconds: Frames. For more information, see “SMPTE Timecode” on page 298.

There are two ways to capture SMPTE timecode while digitizing video with Adobe 
Premiere. One method requires capturing with device control. The other method requires 
that your source video contains 

 

window dubs

 

, or timecode superimposed on each video 
frame. Window dub timecode is also called 

 

burned-in

 

 timecode, or visual timecode.
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Capturing timecode with device control

 

To ensure that the timecode is accurately recorded when you use controlled movie 
capture, calibrate your device controller (see “Calibrating Timecode” on page 256), and 
turn off AppleTalk and any INITs or other applications that may interrupt your system 
(such as e-mail, file sharing, and special clocks).

During capture, only the in point of the movie needs to be auto-recorded, because the 
pre-roll of the deck guarantees the frame accuracy. By default the out point timecode is 
greater than the length of your tape; thus, the entire tape can be captured without setting 
an out point at the end of the tape. You can stop auto-recording at any point during 
capture by clicking the mouse button.

 

Note:

 

 Timecode capture with controllable devices depends on the capability of your tape deck. 
If your tape deck cannot read the timecode accurately, you may have to calibrate your system 
or manually assign the timecode to your movie by matching frames. For more information, 
see “Calibrating Timecode” on page 256.

 

Capturing burned-in timecode

 

Adobe Premiere uses optical character recognition technology to read timecode from 
burned-in window dubs while capturing.

 

To capture burned-in timecode:

 

1

 

Choose Timecode Decoder from the Movie Capture Window. The Timecode Decoder 
Setup window appears.

 

2

 

Press the play button on the video deck to start the tape. The video frames play in the 
sample window in the Timecode Decoder Setup window.

 

3

 

Click Freeze Video to freeze the video at a frame.

 

4

 

Adjust the rectangular marquee so that it frames the window dub in the sample window.
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5

 

Adjust the contrast slider until Adobe Premiere can read all the digits in the window dub 
timecode. Specific digits that cannot be read are indicated by an 

 

X

 

. The readout displays 
“Unreadable” if any of the digits in the timecode cannot be read.

 

6

 

Click OK close the Timecode Decoder Setup window.

 

7

 

Choose Recording Settings from the Movie Capture window. The Recording Settings 
dialog box appears.

 

8

 

Select the Decode Burned-in Timecode option.

 

9

 

Adobe Premiere will read the burned-in timecode and stamp it to the digitized video.

 

Calibrating timecode

 

When you’re capturing SMPTE timecode with a controllable device you should make sure 
that your system is calibrated. With some device controllers, changes to video and audio 
input options can affect the timecode stamping of QuickTime movies. As a result, the 
timecode reading of the first frame that appears in the Clip window may not correspond 
to the timecode on your videotape. To compensate for these errors, Adobe Premiere 
provides both a manual and an automatic calibration feature. 

The automatic calibration feature requires that the source video have burned-in timecode 
(also called visual timecode, or window dubs). Most professional video decks let you 
superimpose window dubs as the tape plays.
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To calibrate timecode automatically:

 

1

 

Select a device control method.

 

2

 

Insert a tape into the tape deck that has at least 3 minutes of continuous burned-in time-
code, or have the deck generate window dubs as the tape plays.

 

3

 

Set up the Timecode Decoder. For more information, see the preceding section, 
“Capturing Burned-in Timecode.”

 

4

 

Select Calibrate Timecode from the Movie Capture menu.

 

5

 

The Calibration Status window appears. Adobe Premiere plays the tape as it goes 
through several calibration iterations. When calibration has finished, the clip appears in 
the Movie Capture window. The SMPTE timecode displayed at the bottom of the Movie 
Capture window should match the window dub timecode displayed on the clip.

 

Note:

 

 The first few frames may not match because many QuickTime boards duplicate the first 
frame captured. Move a few frames into the movie to check accuracy.

 

The manual calibration feature, called Timecode Offset, appears in the Recording Settings 
dialog box when you have a device controller selected. Timecode Offset allows you to 
adjust the capture rate in quarter frame increments. In most cases, you will see errors in 
whole frame increments. To calibrate by whole frames, enter the numbers in multiples of 
four. If the timecode displayed in the Clip window is greater than the actual timecode, 
enter a positive number in the calibration setting. Otherwise, enter a negative value by 
typing a minus sign (–) before the numeric value.

Even when calibrating timecode manually, it is best to use a video source that has burned-
in timecode. If you do not have a video source with burned-in timecode, you will need to 
visually inspect and compare frames in the Clip window with frames from the video tape. 
If the frames and the timecode addresses do not match, change the Timecode Offset value. 

 

STOP-MOTION CAPTURING

 

Adobe Premiere’s Stop-Motion feature allows single-frame and time-lapse video capture. 
This is especially useful for building stop-frame animations, where you point a camera at 
a scene and record frames as the scene changes. 

 

Note:

 

 Any movie frame can be used as a visual guide for positioning during stop-motion 
capture. The procedure for setting up a background image works the same way for the Stop 
Motion window as it does with the Title window. For more information, see “Setting up the 
Title Area” on page 197.
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To stop-motion capture:

 

1

 

Choose Capture/Stop Motion from the File menu. The Stop Motion window appears, 
and the Stop Motion menu appears in the menu bar.

 

2

 

Choose Recording Options from the Stop Motion menu. The Recording Options dialog 
box appears. 

 

3

 

Set the following recording options:

 

O

 

Size. Select the Record at Current Size option to capture frames at the dimensions 
currently displayed in the Stop Motion window. Select the Record At button to enter 
different dimensions. If the 4:3 Aspect Ratio is selected, you can type a value in either the 
horizontal or vertical field and the value in the opposite field is automatically updated to 
maintain a width-to-height ratio of 4 to 3. 

 

O

 

Manual Recording. Choose this option for manual capture of single frames.

 

O

 

Time Lapse. Choose this option for automatic timed recording of single frames. Enter 
the number of frames you want captured per unit time. 

 

O

 

Minimum Disk Free Space. Set the minimum free space on your disk to be maintained 
during capture. You will be alerted if the free space falls below this value, thus stopping the 
capture before you run out of disk space.

 

4

 

Start your video source (camera or tape deck).

 

5

 

Press the Start button in the Stop Motion window. 

 

O

 

If you have the Tim Lapse option selected, Adobe Premiere will capture frames at the 
rate specified. 
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O

 

If you are capturing manually, press the Step button to capture a frame. Press a number 
on the keypad to capture a specified number of continuous frames. Press Delete to remove 
the last frame captured.

 

6

 

Press the Stop button in the Stop Motion window when you have finished capturing. 
The captured frames appear in an untitled Clip window.

 

7

 

Use the Save command to save the clip.

Additional commands for stop-motion capturing are available in the Stop Motion menu:

 

O

 

Grab Frames. This lets you grab a specified number of consecutive frames from your 
source video when you press the Start button in the Stop Motion window.

 

O

 

Truncate Movie. This command lets you delete frames from the end of the sequence you 
are currently capturing. This command is available only when you are step capturing 
manually. 

 

O

 

Show Previous. This command leaves a ghost image of the last frame captured in the 
Stop Motion window. This allows for an animation technique called 

 

onion skinning

 

, where 
you use a semi-transparent image of the previous frame to position objects in the current 
frame.

 

O

 

Remove Background Clip. This command removes the background frame used for 
positioning.
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his chapter contains a collection of step-by-step procedures for achieving profes-
sional video-editing results using Adobe Premiere. The procedures describe tra-
ditional techniques, such as superimposing figures against a background, as well 

 

Chapter 

 

10: Tips and Techniques

as less conventional techniques, such as rotoscoping filmstrips.

This chapter assumes that you are familiar with the basic features of Adobe Premiere and 
how to use them; for information on a specific feature, see the appropriate section of this 
user guide.

 

T
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Creating insets

This procedure shows how to create an 
inset for simultaneously playing a separate 
clip in the movie frame.

 

1 Start by dragging the clip you want to 
play in the background onto track A and 
the clip you want to play in the inset onto 
track B.

2 Drag a transition, such as the Iris Square 
(shown here), Iris Round, or Zoom transi-
tion, onto the T track. (For an example of a 
Zoom transition inset, see steps 22 and 23 
of “Creating a 360-Degree Presentation” 
on page 278.)

3 Align the left edge of the transition with 
the beginning of the clips and the right 
edge of the transition with the end of the 
clips. Double-click the transition to display 
the Transition Settings dialog box, and 
select Show Actual Sources.

4 To create the inset rectangle, hold down 
the Shift key and drag the Start slider to the 
right. Holding down the Shift key causes 
the End slider to move with the Start slider, 
creating the same size inset rectangles for 
both the start and end points of the clip so 
that the size of the inset remains constant. 
Drag to the right until the inset is the 
desired size.

5 To apply a border to the inset, use the 
Border slider to set the width; then click the 
color swatch to display the color picker, 
and select a color for the border.

 

A clip of an owl 

plays in an inset 

while a field scene 

plays in the back-

ground.
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6 If you want the inset to play on a 
different part of the movie screen, drag the 
dot from the middle of the Start preview 
window to the desired position.

7 To reposition the clip within the inset, 
select the clip on track B, and choose 
Motion from the Clip window to display 
the Motion Settings dialog box. Click the 
Start (left) point on the motion path, and 
apply a delay of 100 percent. This keeps the 
clip stationary and lets you use the Motion 
Settings repositioning feature without 
actually applying motion to the clip.

8 To freeze the motion and preview the 
inset, select the Show All option, and click 
the Pause button to the right of the preview 
window. You’ll see the background clip 
with a cut-out where the inset will play. 
Click the Start point of the motion path 
and drag the point into the Visible area; the 
preview window changes to reflect the 
repositioning of the clip. To move the Start 
point in 1-point increments, select the 
Start point and press the arrow keys. When 
the clip is centered within the inset 
window, click OK.

9 Preview the results.
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Creating a split screen

3 Click the page peel icon to preview the 
garbage matte. Use the slider below the 
garbage matte to preview the clip through 
the matte.

4 Preview the results.

Experiment with different shapes of 
garbage mattes.
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This procedure shows how to create a split 
screen for playing two clips simulta-
neously.

1 Start by dragging two clips into the 
Construction window: one to track A and 
one to the S1 track.

2 Select the clip on the S1 track, and 
choose Transparency from the Clip menu 
to display the Transparency Settings dialog 
box. Use the default key type of None—
you’ll use a garbage matte to create the split 
screen. In the Sample window, drag the 
handles of the garbage matte to crop half of 
the image.

Two skiing 

clips play on a 

split screen.
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You can use a transition twice to give the 

appearance of a new transition.

1 Start by dragging a clip onto track A and 
aligning it with the 0:00:00:00 mark on the 
time ruler. Drag the Spin Away transition 
onto the T track, aligning the end of the 
transition with the end of the clip. Double-
click the transition to display its dialog box, 
and click the Forward/Reverse selector to 
select R (reverse). This causes clip A to play 
and spin away to a black background.

2 Copy the Spin Away transition; then 
click the section of the T track to the right 
of the original, and paste the copy. Drag a 
second clip onto track A, aligning it flush 
left with the first clip.

3 Preview the transition. Notice that the 
second clip opens at full-screen when 
the first clip ends. To make the second clip 
appear to spin back in, double-click the 
second transition to display its dialog box, 
and click the track selector so that it points 
up. Select the right edge selector, and 
change the Forward/Reverse selector from 
R to F. 

4 Preview the results.

Try this technique with other transitions 
that swing in and out such as the Spin, 
Swing In, Swing Out, Split, and Wipe 
transitions.

A clip of one 

Frisbee player 

swings away 

from the screen; 

then a clip of 

another swings in.

Customizing transitions
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Applying filters to isolated areas of clips

You can apply a filter to an isolated area 
of a clip using the Image Matte key type.

1 Start by dragging a clip onto the S1 track 
of the Construction window, and then 
copy and paste the same clip onto track A.

2 Create a still image to use as a key or 
“mask.” You can use a letterform or object 
created in the Title window, as in this 
example; or you can use an image created 
in Adobe Photoshop or Adobe Illustrator.

3 Select the clip on the S1 track, and 
choose Transparency from the Clip menu 
to display the Transparency Settings dialog 
box. Select the Image Matte key type, click 
Choose, and select the still-image key you 
just made. The Sample window previews 
the image matte. Select Reverse Key to 
invert the effect.

4 Select the clip on track A. Choose Filters 
from the Clip menu to display the Filters 
dialog box and select a filter to apply to the 
clip. This example used the Black & White 
filter to convert the color image to gray-
scale. Keep in mind that if you use a filter 
that doesn’t alter the clip’s color, the results 
may be subtle.

5 Preview the results.

As a swimmer 

moves across 

the screen, the 

image outside 

the S is 

converted to 

grayscale.
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The gray values 

of a clip of running 

horses are superim-

posed over a still 

image of stone.

The Luminance key type allows you to 
superimpose movies over textured back-
grounds, so that the superimposed movie 
assumes the texture of the background. 
This procedure works best with images 
with a wide range of gray values because 
the Luminance key option keys just the 
gray values of an image without keying 
the color. 

1 Choose a clip to play over the back-
ground; the clip should have a wide range 
of gray values. Next, choose a textured 
background for the movie, either a still-
image clip or a movie clip. 

2 Drag the texture clip onto track A, and 
drag the clip you want to superimpose 
onto the S1 track. 

 

Note:

 

 When using a still-image clip for your 
texture, you can save compiling time by first 
applying filters or effects to the clip in Adobe 
Photoshop. Then import the still image into 
Adobe Premiere.

3 Select the clip on the S1 track. Choose 
Transparency from the Clip menu to 
display the Transparency Settings dialog 
box, and select the Luminance key type. 
Click the page peel icon to preview the 
effect of the key on the clip on track A. 
Drag the Threshold and Cutoff sliders to 
control which gray values are superim-
posed and to adjust the brightness of those 
gray values.

4 Preview the results.
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Using the Chroma key type, you can isolate 

a figure and then superimpose it over a dif-

ferent background.

1 Start by videotaping a figure against a 
bright, plain background. The background 
should be a color that contrasts with the 
figure, because the goal is to isolate the 
figure from the background. This example 
uses a uniformly lighted, intense blue 
(called chroma blue) background. The blue 
background works well because skin tones 
typically contain no blues. The contrast 
between skin tones and background means 
that the keying process in Adobe Premiere 
won’t key out (that is, make transparent) 
anything other than the background.

2 Drag the clip of the figure onto the S1 
track, and drag a clip of the background 
you want to use onto track A. You can use 
anything for the background clip; this 
example (see step 7) used a still-image clip 
of a map.

3 Select the figure clip on the S1 track, and 
choose Transparency from the Clip menu 
to display the Transparency Settings dialog 
box. Select the Chroma key type.

4 Specify the color to key out (in this case, 
blue); the default masking color is white. In 
the Color section of the Transparency 
Settings dialog box, use the eyedropper 
tool and click to sample the blue back-
ground of the clip. The preview in the 
Sample window changes to reflect the 
sampled color; the areas that appear white 
will be the areas through which the clip on 
track A plays. Click the page peel icon to 
preview the clip through the key.

A figure and its 

shadow are superim-

posed over a map.

Superimposing figures against a background
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5 Use the Similarity slider to adjust the 
range of colors that are keyed out. Drag the 
slider to the right until all of the back-
ground appears white in the Sample box. 
You may need to experiment by sampling 
different blue pixels from different areas of 
the Color box, and then readjusting the 
Similarity slider to see which settings give 
the best results. Use the Smoothing option 
to soften the edges between the figure and 
the keyed-out background. Click the zoom 
tool, and then click the preview to see the 
keying effects. The hand tool lets you scroll 
around the preview.

Note: Click the collapse preview icon in the 
Transparency Settings dialog box to see a 
larger preview of the keying effects.

6 Use the Threshold slider to control how 
shadows in the clip are keyed out; moving 
the slider to the right increases the amount 
of shadow that will be included in the key. 
Use the Cutoff slider to control the trans-
parency of the shadows.

7 Preview the results. 
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Creating a split edit

A common edit in video is a 

 

split edit 
where, for example, a clip’s audio leads the 
video while another video clip plays on-
screen. Starting the second clip’s audio 
before its video produces a more gentle 
transition. To create a split edit, you lock 
either the audio or video track, and then 
edit the unlocked track. This procedure 
maintains a synchronized link between the 
audio and video clips.

 

1 Drag a movie clip that has linked audio 
onto track A in the Construction window. 
Drag a second clip that has linked audio 
onto track A next to the first clip. Lock the 
audio track by opening the Lock window 
and clicking the track name, or by Option-
clicking the track label to the right of the 
track. Locking the track lets you edit linked 
tracks independently.

 

Note: You can also perform this procedure by 
locking the video track and editing the audio 
track.

2 To precisely adjust the edit point 
between the two video clips, open the 
Trimming window and click the Next Edit 
button to view the frames on either side of 
the edit point. To perform a rolling edit 
(that is, adjust the duration of the adjacent 
clip as you edit the first clip), move the 
cursor between the two frames and drag 
left or right to trim the clips. The other 
clip’s duration is shortened or lengthened 
to offset the adjustment.

Editing breaks the link between the video 
and audio, inserts a soft link, and inserts 
blue markers for realigning the video and 
audio. If necessary, use the blue markers to 
realign the clip’s video and audio. If the 
audio and video get out of synch, a red tri-
angle will appear at the beginning of the 
clip. Resynchronize the clip by clicking the 
red triangle, and then clicking the arrow 
keys by the amount indicated.

3 Unlock the audio track that you locked 
in step 1.

 

A video clip of 

artifacts plays while 

an audio clip of a 

man talking leads 

his video.
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Rotoscoping filmstrips

Rotoscoping is the technique of drawing 
on or painting individual frames of a clip. 
You can apply the effects to an entire film-
strip or to a sequence of frames. This pro-
cedure requires use of the Adobe 
Photoshop program. The uncompressed 
Filmstrip file format lets you edit a film-
strip without having to recompress it and 
lose quality. 

1 In Adobe Premiere, open the clip that 
you want to rotoscope in a Clip window. To 
determine the total number of frames in 
the clip you will export, note the clip dura-
tion. Alternatively, if you don’t need to 
know the total number of frames you will 
export, choose the first and last frames on 
which you wish to paint, and set in and out 
points to mark the series of clips; then skip 
to step 4.

2 Choose Tools/Movie Analysis from the 
File menu; click Analyze. Note the frame 
rate of your clip.

3 To determine the total number of frames 
to be exported, multiply the clip duration 
from step 1 by the frame rate from step 2. 
For example, if the clip duration is 2 
seconds and the frame rate is 10 fps, the 
total number of frames would be 20.

As an alternative to steps 1 and 2, if you 
know that your original clip was captured 
at 30 fps, open the Clip Window Options 
dialog box, select Frame Count from the 
Frame Number Format pop-up menu, and 
click OK. The Clip window displays the 
total number of frames in your clip, based 
on the time base set in project presets, 
typically 30 fps.

Note: Exporting a filmstrip at a higher rate 
causes Adobe Premiere to duplicate frames to 
maintain the frame rate, resulting in a larger 
filmstrip file and more frames to edit. 

4 With the clip open in the Clip window, 
choose Export/Filmstrip file from the File 
menu. Specify the same rate as the clip. 

5 If you are exporting full-screen video 
(640 pixels by 480 pixels) with interlaced 
fields as a filmstrip and want 60 fields per 
second so that you can work on all fields, 
select a Separate Fields options. Most video 
boards are Field 1 dominant. (If you select 
the incorrect Field option, the image will 
appear jumpy when you open it in Adobe 
Photoshop.)

In most full-screen video, each frame con-
sists of two images to compensate for the 
fact that television scans every frame twice. 
For example, a 1-second, 30-fps clip con-
tains 30 images, but 60 fields—two fields 
per frame. You must separate the fields to 
be able to paint the frames. For more infor-
mation, see “Capturing Full-Screen 
Images” on page 235.

6 Name the file and save it as a filmstrip.

A variety of 

design elements, 

including loose, 

hand-drawn 

marks, appear in 

a clip of a dancer.
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Note: Exported filmstrip files lose any audio. 

Be sure to save the source c lip with in and out 

points if you will need to relink a filmstrip to 

its original audio. 

7 In Adobe Photoshop 2.5 or higher, open 
the filmstrip (import the file in versions 2.0 
and lower). The filmstrip opens as a series 
of frames in a column, with each frame 
labeled by a number and a timecode.

If your filmstrip contains many frames, 
Adobe Photoshop will open the file at a 
very low zoom level in an attempt to fit all 
the frames in the window. To display the 
frames at actual size, double-click the 
zoom tool in the toolbox.

Use any of the Adobe Photoshop painting 
tools to draw on or paint the frames. You 
must repeat the design over several frames 
for it to appear when you play the movie. 
The number of frames to paint depends on 
the frame rate of your movie. 

For example, with a frame rate of 15 fps, 
you should paint a design in 15 frames to 
have it play for 1 second. If you selected a 
Field option in step 5, there will be two 
filmstrip frames per source frame. 

For editing guidelines, see “Modifying 
Filmstrips in Adobe Photoshop” 
on page 109.

Adobe Photoshop 2.5 and higher has spe-
cial commands for moving selections pre-
cisely from frame to frame in a filmstrip. 

Using any of the Photoshop painting tools, 
you can retouch flaws in the original foot-
age, or make random marks from frame to 
frame. You can also use the rubber stamp 
tool to clone parts of one frame onto 
another.
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This example shows the lasso tool used to 
select background areas. The areas then 
were filled with color and patterns.

You can paint over the gray borders 
between frames. Do not, however, scale or 
crop the filmstrip.

8 When you have finished painting, save 
your file in the FilmStrip format. (If you 
are using Adobe Photoshop 2.0 for roto-
scoping, see “Modifying Filmstrips in 
Adobe Photoshop” on page 109, for more 
information on opening, editing, and 
saving filmstrips.) 

9 In Adobe Premiere, open the rotoscoped 
filmstrip in a Clip window, and preview 
the results. If you created the filmstrip with 
separate fields in step 5, choose Field 
Options from the Clip menu, and select the 
Interleave Consecutive Frames option; this 
instructs the program to interleave the 
fields back together. 

Note: If you must relink your filmstrip with 
audio, drag the original video and audio clip 
onto a track in the Construction window and 
cut the video portion. Drag the edited film-
strip clip onto the empty video track, and 
select both the clip and the audio to create a 
soft link.
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Playing a movie through a traveling matte

This procedure shows how to layer a movie 
that plays within a moving mask—called a 
traveling matte—on top of a background 
movie.

1 Start by dragging the clip that will play 
in the background onto track A in the 
Construction window. Drag the clip that 
will play within the moving mask onto the 
S1 track in the Construction window. 
Adjust the length of the clips so that they 
match.

2 Next, create the mask in which you want 
a clip to play. This example used four 
simple shapes created with the polygon 
tool in the Title window; save the title when 
you have finished.

You can also import a file from Adobe
Photoshop or from Adobe Illustrator for 
your mask. 

Note: When importing files from Adobe 
Photoshop or Adobe Illustrator, you should 
use either a black-and-white file or grayscale 
file; color files may produce unexpected 
results.

3 To apply the mask to the clip on the S1 
track, first make the Construction window 
active and add another superimpose (S) 
track by choosing Add/Delete Tracks from 
the Project menu, and entering 4 in the 
Total Video Tracks field. This adds a track 
labeled S2 below the S1 track. Drag the 
mask clip onto the new S2 track, and adjust 
its length to match the other clips.

4 Select the movie clip on the S1 track; 
choose Transparency from the Clip menu 
to display the Transparency Settings dialog 
box. Choose Track Matte from the Key 
Type pop-up menu. The Track Matte key 
type uses the lightest areas of the clip on the 
track below as a mask, and “tracks” any 
motion applied to the clip.

A clip of clouds 

in motion plays in 

the background 

while a clip of a 

cyclist plays within 

a zooming mask 

of squares.
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Click the page peel icon and drag the 
slider below the Sample window to pre-
view the effect; the movie clip on track A 
should appear in the mask, and the 
movie clip on the S1 track should appear 
in the background behind the mask. 
Select Reverse Key to make the movie 
clip in S1 appear within the mask. 

5 Now apply motion settings to the mask 
to make it move by selecting the mask clip 
on the S2 track and choosing Motion from 
the Clip window. The Motion Settings 
dialog box appears. Select the Show All 
option to preview the masked clip in 
motion. Click the Pause button to freeze 
the motion.

6 Move the Start and Finish points of the 
motion path, or add points to the path to 
create the motion you want.

For example, create a zoom effect by 
selecting the Start point and entering 0 in 
both coordinate fields to center the Start 
point in the frame; then apply a zoom of 
25 percent to the point.

7 Next, select the Finish point on the path 
and center it in the frame by entering 0 in 
both coordinate fields; leave the zoom level 
at 100 percent. This makes the masked clip 
appear to zoom in from the center of the 
background clip. 

Note: To select successive points on the 
motion path when they are positioned pre-
cisely on top of each other, press the Tab key.
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Using virtual clips to nest transitions

This example shows how to use the virtual 
clip feature to create a transition between 
two clips that are playing within an inset. A 
virtual clip is a “snapshot” of an area in the 
Construction window that is used as a clip 
elsewhere in the Construction window.

1 Start by importing three clips: one to 
play as the main movie and two to play in 
the inset. Drag the first clip for the inset 
onto track A in the Construction window 
and drag the second clip for the inset onto 
track B. Arrange the clips so that they 
overlap by at least one second.

2 Drag the Clock Wipe transition onto 
track T and align it between the two movie 
clips. Adobe Premiere automatically 
adjusts the length of the transition to 
match the amount of overlap.

3 To make the clips and transition act as 
one clip, combine them into a virtual clip. 
To do so, select the virtual clip tool and 
drag to select the block of clips and the 
transition. Then place the cursor inside the 
selection; it changes to the virtual clip icon.

4 Drag the selected block of clips to an 
open space on track B. Preview the virtual 
clip by dragging through the time ruler.

 One clip of a 

sports scene makes 

the transition into 

another behind 

a sportscaster.
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5 Drag the Zoom transition onto the T 
track above the virtual clip, and adjust 
the length of the transition to match the 
length of the virtual clip. Drag the third 
clip onto track A (this example used 
footage of a sportscaster), and adjust its 
length to match the virtual clip and 
Zoom transition.

6 Now use the Zoom transition to make 
the virtual clip play in an inset window. To 
do so, double-click the Zoom transition to 
display the Zoom Settings dialog box and 
select the Show Actual Sources option. 
Hold down the Shift key and drag the Start 
slider to the right until the inset window is 
the desired size; holding down the Shift key 
causes the End slider to move with the Start 
slider. 

The Zoom transition scales the virtual clip 
to fit within the inset; setting the Start and 
End sliders to the same value constrains the 
zoom inset window to the same size for the 
duration of the clip.

7 In the center of the Start window, posi-
tion the cursor over the small square; when 
the cursor changes to a finger, drag the 
square to reposition the inset window. 
Click OK.

8 In the Construction window, adjust the 
work area bar to extend across the virtual 
clip and preview the results.



Adobe Premiere User Guide 6/2/94 14:36 c10b.pdf.frame

Right.start master page

 

This procedure shows how to use transi-

tions and a series of virtual clips to create a 

three-dimensional space effect with movies 

playing on five separate “walls.” This two-

part procedure requires five clips of equal 

duration to play on the walls. 

In the first part of this procedure, you 

create gradient fills that will be superim-

posed over each clip and add dimensional-

ity to the final movie.

1 Start by dragging the clip that will play 
on the ceiling onto track A and align the 
clip with the start of the time ruler; then 
drag the next three clips onto track A in 
following order: floor, right wall, and left 
wall. Leave the clip that will play on the 
back wall in the Project window.

2 Next, create a grayscale gradient that 
will be superimposed over the clips. To do 
so, open a new Title window by choosing 
New/Title from the File menu. Set the 
gradation start color to black and the 
gradation end color to a medium gray. 
Then use the filled rectangle tool to draw a 
rectangle that covers the lower half of the 
window. 

3 Reverse the direction of the gradient 
by clicking the triangle at the bottom 
center of the gradient swatch; change the 
opacity of the gradient end color to 1 
percent by clicking the right triangle above 
the end color swatch and dragging the 
gradient swatch to 1 percent. Save the title 
as ceiling gradient.

Creating a 360-degree presentation

 Five clips of 

sea scenes play 

simultaneously on 

the surfaces of a 

three-dimensional 

space.
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4 Drag the title onto the S1 track in the 
Construction window, aligning its left edge 
with the beginning of the project. Stretch 
the right edge of the title clip until its dura-
tion matches the ceiling clip on track A.

5 With the title clip selected, choose 
Transparency from the Clip menu to 
display the Transparency Settings dialog 
box. Apply the Multiply key type. Click the 
page peel icon below the Sample window to 
preview the key applied to the clip. The clip 
is darkened at the bottom where the super-
imposed gradient is black and changes to 
its actual color gradually where the 
gradient is gray and then white.

When the clip plays on the “ceiling,” the 
shading makes the clip appear darker as it 
recedes to the back wall.

6 Repeat steps 2 through 5 to create three 
additional superimposed gradients for the 
other walls of the room. Use the triangles 
located along the sides of the gradient 
swatch to change the direction of the gradi-
ents as follows: the gradient for the floor 
clip should start with black at the top and 
fade to 1 percent opacity in the middle; the 
right wall gradient should start with black 
on the right side and fade to 1 percent 
opacity in the middle; the left wall gradient 
should start with black on the left side and 
fade to 1 percent opacity in the middle.
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In the final part of the procedure, you use 
the virtual clips feature with the four clips 
to build the three-dimensional movie.

7 Select the range select tool, and drag to 
select just the ceiling clip on track A and its 
superimposed gradient on the S1 track. 
Move the cursor inside of the selection; the 
cursor changes to the virtual clip icon.

8 Drag the selection onto the blank space 
at the end of track A. The two clips are 
composited as a virtual clip. 

9 Repeat steps 1 and 2 for each clip and its 
superimposed gradient, placing the virtual 
clips on track A in the same order as the 
source clips.

10 To make the first virtual clip appear to 
play on the ceiling, drag the Swing In tran-
sition from the Transitions window onto 
the T track in the Construction window. 
Adjust the transition’s duration to match 
the first virtual clip on track A.
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11 Double-click the Swing In transition to 
display the Swing In Settings dialog box. 
Select the Show Actual Sources option. 
Hold down the Shift key and drag the Start 
slider to 25 percent. (Holding down the 
Shift key adjusts the Start and End sliders 
simultaneously, keeping the effect constant 
throughout the clip.) Click the track 
selector so that the blue arrow points up; 
then click the top edge selector to make the 
clip play on the ceiling.

12 Using the range select tool, drag to 
select the first virtual clip and the Swing 
In transition.

13 Drag the block of clips onto track B, 
creating a new virtual clip, and align its 
in point with the end of the Swing In 
transition.

14 To create the floor and combine it with 
the ceiling, select the Swing In transition 
on the T track, copy it, and paste the copy 
onto the blank area of the T track next to 
the original. 
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15 Double-click the copied Swing In tran-
sition, displaying the Swing In Settings 
dialog box, and select the Show Actual 
Sources option. Click the bottom edge 
selector, and click OK.

16 Using the range select tool, drag to 
select the second column of clips 
containing the ceiling and floor clips.

17 Drag the column of clips onto the blank 
space on track B, next to the ceiling 
virtual clip, to create a second virtual clip 
on track B.
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This appendix provides a basic introduction to analog and digital video. Like film, video 
is a sequence of individual images, called 

 

frames

 

, projected on a screen before a viewer. 
Projecting several images per second creates the illusion of a motion picture because the 
brain cannot register the individual images. With a frame rate typically ranging from 24 
frames per second (fps) to 30 fps, video projects motion that appears smooth and contin-
uous. Normally, one or more audio tracks are synchronized with the video frames to 
provide sound to the experience. 

 

RECORDING AND ENCODING ANALOG VIDEO

 

This section discusses how video cameras record video signals, including how video 
cameras interpret color and measure the resolution of video signals.

Conventional video cameras contain light-sensitive devices called 

 

charge-coupled devices

 

 
(CCDs), which digitize or 

 

capture

 

 the individual images as optical images and convert or 

 

encode

 

 them into electrical signals. Once an analog video signal has been encoded by the 
camera, it can be broadcast, recorded onto analog videotape, or recorded digitally onto a 
disk storage device. The electrical signals captured by a video camera represent the color 
and brightness information of the image. Cameras are rated, among other things, by their 
characteristic color response and image resolution. 

 

How video cameras interpret color

 

Video cameras interpret color as a combination of the three additive primaries: red, green 
and blue. This light-based color model is commonly referred to as 

 

RGB

 

 color. Video 
cameras differ in how they encode this color information into a video signal. Some high-
end cameras process separate signals for each of the RGB components, or they process 
signals for the chrominance (color) and luminance (brightness) information, which 
results in a 

 

component

 

 video signal. A more common process encodes the RGB and lumi-
nance information into one signal, known as a 

 

composite

 

 signal. 

In the United States and Japan, the standard composite signal adopted by the television 
and video industries is known as the NTSC signal (for National Television Standards 
Committee). An NTSC signal has a frame rate of 30 fps (or, more precisely, 29.97 fps). In 
Europe, the most common composite video signal is PAL (Phase Alternating Line), which 
has a frame rate of 25 fps.

 

Appendix A: Video

 

 

 

Basics
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Image resolution

 

Another important concept in describing a video signal is 

 

image resolution

 

, which 
measures the quality of a video image based on the number of picture elements, called 

 

pixels

 

, that make up the image.

A projected video image is a conglomeration of tiny picture elements, called pixels, which 
project the color and brightness of the image. Picture quality increases as the number of 
pixels increases in a unit area of the image. A video camera encodes the image information 
as a grid of pixels, much like a collection of tiles in a mosaic. An NTSC video frame 
contains 486 horizontal lines of visible pixels, with each line containing 720 pixels. Thus, 
an NTSC video frame is made up of approximately 350,000 pixels (720 by 486). 

 

Displaying the video signal 

 

For the analog video signal to be converted to a recognizable image, the signal must be run 
through a decoder. The decoder splits a composite signal into RGB signals so that the 
image can be displayed on-screen. Television screens are made up of tiny phosphors that 
emit varying intensities of red, green, and blue light when struck by a carefully controlled 
electron beam. For a standard television signal to be projected, the electron beam must 
scan across 525 lines on the screen 30 times every second. In actuality, the electron beam 
scans a television screen in 

 

interlaced

 

 mode—that is, the beam scans all the even lines of a 
frame and then all odd lines of that frame. The even lines and the odd lines of each frame 
are referred to separately as 

 

fields

 

. To maintain a frame rate of 30 fps, the electron beam 
must scan at a rate of 60 fields per second. When you freeze on a video frame, you actually 
see the two fields being alternately scanned on the NTSC monitor. 

A computer screen operates in 

 

noninterleaved

 

 mode. That is, the electron beam scans all 
rows of phosphors sequentially to create the image on-screen and repeats the process 
about 60 to 75 times per second to refresh the screen.

 

SMPTE timecode

 

The duration of a video clip and its starting and ending frames are commonly measured 
using a unit or address called 

 

timecode

 

. Timecode is a way to identify each frame of a 
videotape for control in editing and broadcasting. Use of timecode allows those editing 
video to locate frames accurately and to synchronize picture and audio elements (also 
called 

 

frame-accurate

 

 synchronization). 
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The timecode used by the Society of Motion Picture and Television Engineers (SMPTE) 
identifies each frame with a unique address in the form hours:minutes:seconds:frames. A 
clip with a duration of 00:02:31:15 plays for 2 minutes, 31 seconds, and 15 frames. At the 
rate of 30 frames per second, a clip with a duration of 00:02:31:15 plays for 2 minutes and 
31.5 seconds.

There are several SMPTE timecode standards targeted for the different frame rates used in 
the film, video, and television industries. For technical reasons involved with 
broadcasting, the NTSC adopted a standard of 29.97 fps rather than the 30 fps originally 
used in early black-and-white television programming. The SMPTE timecode for NTSC 
video assumes a frame rate of 30 fps, which results in a 0.1 percent discrepancy between 
real playing time and the timecode’s duration measurement. 

To address the discrepancy between the playing time measured by SMPTE timecode and 
real playing time, the 

 

drop-frame

 

 format was developed. With drop-frame timecode, two 
frame counts are dropped (actual frames are not dropped) from the count every minute, 
for 9 out of every 10 minutes. The

 

 nondrop-frame

 

 timecode ignores this discrepancy and 
thus is not duration accurate.

Most video-editing systems handle both drop-frame and nondrop-frame timecode 
formats. While you can use either format, it is important to know which format was used 
in recording your video source material and to edit your videotape using the same format 
throughout so that you know how real time is being represented. 

 

DIGITIZING VIDEO

 

NTSC and PAL video signals are analog in nature. Computers, however, display infor-
mation digitally. So NTSC and PAL video signals must be digitized, or 

 

sampled

 

, before 
they can be used by the computer. The process of digitizing video is commonly called 

 

capturing

 

. A video-graphics adapter, often called a frame grabber or video capture board, 
is used to digitize an analog video signal and convert it into a computer graphics signal. 
There are many video capture boards on the market, and they differ widely in their 
features and capabilities. It is beyond the scope of this document to rate video boards. 

Digital recording of a video signal requires substantial amounts of disk storage because the 
color and brightness information for each pixel in every image frame must be stored. A 
full-screen image on a 13-inch computer monitor measures 640 pixels by 480 pixels. Thus, 
each full-screen frame of video contains 307,200 (640 by 480) pixels. To display the full-
screen image in 24-bit color, each pixel must represent 24 bits of information (or 8 bits per 
RGB component). Twenty-four bits of information are equal to 3 bytes. That figure 
multiplied by a full-screen, 307,200-pixel image results in a storage requirement of 
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921,600 bytes for each frame of digitized video. At a frame rate of 30 fps, storing 1 second 
of digitized NTSC video requires more than 27 megabytes! Such use of disk space to store 
digitized video is not feasible for most computer users. 

An even bigger obstacle is the computing power required to play back the stored infor-
mation at sufficient frame rates. Bringing video to the desktop computer has involved 
advances in data compression technology and compromises in frame size, color depth, 
and image resolution. By far, the most important advances to date have occurred with the 
way the data is compressed. (For more information, see “Digital Video Compression” in 
Chapter 8.)

 

DISPLAYING AND OUTPUTTING DIGITAL VIDEO

 

Once a video signal has been digitized and compressed it can be manipulated and 
organized in much the same way that still images are manipulated in image-editing 
programs such as Adobe Photoshop. In fact, many of the graphics tools found in Adobe 
Photoshop, such as image adjustment, filters, and text generators, are available in Adobe 
Premiere. The major difference with the digital processing of video is the time-based 
aspect of the medium.

Desktop video became popular on the Macintosh when Apple Computer released its 
QuickTime system software extension. QuickTime enables you to store, edit, and play 
digitized video and audio on any Macintosh, without specialized hardware. QuickTime 
movies are stored on disk as files, and can be played on their own or within applications 
designed to support QuickTime, such as Adobe Premiere.

 

Outputting the video image

 

To output, or transfer, a digital image to videotape requires several conversions. The video 
board encoder first converts the color of each pixel from the digital color standard of RGB 
to the television color standard, which represents a color as a combination of hue and 
saturation. The digital information is converted to an analog waveform, and the encoder 
then adds calibration pulses to the data and outputs a standard NTSC video signal. 

Some video capture boards now available on the market include the capability of 
outputting black-and-white or color NTSC signals to videotape. 
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DIGITIZING AUDIO

 

Audio is an important component of most media productions. Like video, analog sound 
must be digitized, or sampled, to be used with videotape. Fortunately, audio is not nearly 
as hard to digitize as is video. Sampling analog sound breaks up the sound into discrete 
frequencies. There are two steps in digitizing audio—setting the audio level controls to 
avoid distortion and setting the audio resolution or quality.

The quality (or 

 

resolution

 

) of digitized audio and the size of the audio file depend on the 
sampling rate and bit depth of the audio. The 

 

sampling rate

 

, similar to the frame rate for 
digitizing video, measures the number of frequencies into which the sound is broken. The 

 

bit dept

 

h, similar to color depth, measures the number of tones per sample. The higher the 
sampling rate and bit depth, the better the sound quality. Think of audio sampled at 11 
kHz and 8-bit resolution as similar to mono sound, and audio sampled at 22 kHz and 
16-bit resolution (which requires twice the file size for the audio clip) as similar to stereo 
or CD sound. CD audio is normally digitized at 44 kHz and 16-bit resolution.
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The Adobe Premiere program lets you create your own transitions and filters. Using the 
Transition Factory to create transitions is described in Chapter 5, “Using Transitions.” 
Using the Filter Factory to create filters is described in Chapter 6, “Using Filters and 
Motion Settings.” This appendix explains how to set up the arithmetic expressions that 
describe what the transition or filter will do. 

 

ABOUT DIGITAL IMAGES

 

A digital video image is a conglomeration of tiny picture elements, called 

 

pixels

 

. Pixels 
project the color and brightness of the image. Each pixel in an image is uniquely identified 
by its coordinates. The first coordinate is the horizontal position of the pixel, and the 
second coordinate is the vertical position of the pixel. The horizontal coordinates start 
counting at the left edge of the image and increase as you move to the right. The vertical 
coordinates start counting at the top of the image and increase as you move down. There-
fore, the top left corner of the image has the coordinates (0,0). The range of coordinates 
for an image depends on its resolution.

In RGB format, the color of a pixel is stored as three numbers: the amount of red, the 
amount of green, and the amount blue. The three color values are called 

 

channels

 

. Channel 
values can range from 0 to 255. 

 

O

 

If a channel value is set to 0, none of its color is present in the pixel. 

 

O

 

If a channel value is set to 255, the maximum amount of that color is present in the pixel. 
For example, if a pixel has the channel values (255,0,0), the pixel is entirely red: 255 red,
 0 green, 0 blue. 

 

O

 

If all three channels have the same value, the pixel is a shade of gray. For example, 
(80,80,80) is a dark gray, (128,128,128) is a medium gray, and (200,200,200) is a light gray.

 

O

 

If all three channels are 0, the pixel is black. If all three channels are 255, the pixel is 
white.

The transitions and filters you create affect the channel values of the pixels in an image. 
You specify an expression for each channel, and each operation is performed on the appro-
priate channel for every pixel in the image. Expressions can include specific pixel coordi-
nates whose channel values are evaluated and used in the calculation. 

 

Appendix 

 

B

 

: Expressions for Creating 
Transitions and Filters
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Note:

 

 If an expression evaluates to a number greater than 255, the channel is set to 255. 
Likewise, if an expression evaluates to a number less than 0, the channel is set to 0.

 

COMPONENTS OF EXPRESSIONS

 

A transition or filter performs an operation on the channels of each pixel in an image. 
These channel operations are described by arithmetic expressions. Expressions are 
made up of combinations of four types of components: constants, variables, functions, 
and operators. The following sections describe these four components. For a quick 
reference of all allowable variables, functions, and operators, see “Expression Reference” 
on page 310.

The Transition Factory and Filter Factory allow only integer numbers in expressions—no 
fractions or decimal numbers are allowed. Variables and functions will always evaluate to 
integers.

 

Constants

 

A constant is a number that is supplied directly in the expression. Constants can be used 
to construct simple expressions such as 10+5, and these expressions can always be replaced 
by another constant; in this case, 15. 

Constants can also be written in hexadecimal form. To use hexadecimal values, prefix the 
number by 0x, as in 0xaf10.

 

Variables

 

A variable is a short name, such as x, that can be evaluated. The value of a variable depends 
on the current image, the current pixel, or the current channel for which an expression is 
being evaluated. For example, the variable x always evaluates to the horizontal coordinate 
of the current pixel, and the variable 

 

y

 

 always evaluates to the vertical coordinate. The vari-
ables for the current pixel’s channel values are r (red), g (green), and b (blue). 

If you are creating a transition, you specify whether you are affecting the first image or the 
second image. To do so, include a 0 or a 1 with the variable. For example, 

 

r

 

0 is the red 
channel value for the current pixel in the first image, while 

 

r

 

1 is the red channel value for 
the current pixel in the second image.

You can combine variables and constants to form expressions. For example, the expression 
r+g retrieves the red and green channel values for the current pixel and adds them 
together. 
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Functions

 

Functions are short names that can be evaluated, and they require one or more arguments. 
For example, the rnd function requires two arguments. It evaluates to a number that is 
greater than or equal to the first argument and less than or equal to the second argument. 
The expression rnd(1,10) evaluates to a number between 1 and 10, inclusive. (The rnd 
function is called a random number generator, and it is useful for adding noise or texture 
to an image.)

Arguments are written within parenthesis and are separated by commas. The arguments 
can be expressions. For example, the expression rnd(r–10,r+10) evaluates to the red 
channel of the current pixel, plus or minus 10.

Another function, src (source), retrieves channel values for a particular pixel. It requires 
three arguments: the horizontal coordinate of the pixel, the vertical coordinate, and the 
channel index. (The index for the red channel is 0; the green channel is 1; the blue channel 
is 2.) For example, the expression src(10,20,0) retrieves the red channel value for the pixel 
at coordinates (10,20). The expression src(x,y,0) retrieves the red channel value for the 
current pixel. The expression src(x+1,y,0) retrieves the red channel for the pixel to the 
right of the current pixel.

The remaining available functions are described in the section “Expression Reference” 
on page 310.

 

Operators

 

The operators include all of the arithmetic that can be used in an expression. There are five 
types of operators: basic, relational, logical, conditional, and bitwise.

 

O

 

The basic operators are +, –, *, /, and %. The % (modulo) operator calculates the 
remainder of a division. For example, the expression 11%3 evaluates to 2. 

 

O

 

Relational operators compare two expressions and evaluate to 0 (false) or 1 (true). For 
example, the < operator evaluates to 1 if the expression on the left is less than the expres-
sion on the right. The expression r<g evaluates to 1 when the red channel of the current 
pixel has a lower value than the green channel. Otherwise, it evaluates to 0. The set of rela-
tional operators includes <, <=, >, >=, ==, and !=.

The == operator evaluates to 1 when the two expressions surrounding it evaluate to the 
same thing. The != operator evaluates to 1 when the two expressions surrounding it eval-
uate to something different. For example, the expression 1==1 evaluates to 1, and the 
expression 2==1 evaluates to 0. The expression 1!=2 evaluates to 1, and the expression 
1!=1 evaluates to 0.
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O

 

Logical operators let you combine several relational expressions. For example, you could 
evaluate whether the horizontal coordinate of a pixel is between 10 and 30, inclusive. The 
appropriate relational expressions are x>=10 and x<=30. You can use the logical && oper-
ator to combine them into the single expression (x>=10)&&(x<=30). The && operator 
evaluates the expressions on both sides. If neither expression evaluates to 0, the && oper-
ator evaluates to 1. If either expression evaluates to 0, the && operator evaluates to 0. 

The logical operator || is similar to the operator &&, but it performs a slightly different 
logical operation. The || operator is also placed between two relational expressions. If 
either of the expressions evaluate to anything but 0, the || operator evaluates to 1. If both 
expressions evaluate to 0, the || operator evaluates to 0. For example, the expression 
(x>10||(y>10) evaluates to 1 when the horizontal coordinate is greater than 10. The only 
time this expression evaluates to 0 is when the horizontal coordinate is <=10 and the 
vertical coordinate is <=10. The following chart shows the difference between the && and 
|| operators: 

Finally, you place the ! operator before an expression to invert the expression’s evaluation. 
If the expression evaluates to 0, the ! operator evaluates to 1. If the expression evaluates to 
anything but 0, the ! operator evaluates to 0.

 

O

 

The single conditional operator ? lets you make a choice between two alternatives. A 
conditional expression includes a condition expression and two alternative expressions. 
The conditional operator evaluates the condition expression and uses the result to decide 
which of the two alternatives it should evaluate. If the conditional expression evaluates to 
anything but 0, the first alternative is evaluated. If the conditional expression evaluates to 
0, the second alternative is evaluated. 

For example, in the expression (x%2)?r:g, the ? conditional operator separates the condi-
tion expression (x%2) from the two alternative expressions r and g. The alternative expres-
sions are separated by a colon (:). The condition expression divides the horizontal coordi-
nate of the current pixel by 2 and returns the remainder of the division. If the horizontal 
coordinate is an odd number, the result is something other than 0, and if the horizontal 
coordinate is an even number, the result is 0. Therefore, if the pixel has an odd horizontal 

 

LEFT EXPRESSION RIGHT EXPRESSION LEFT&&RIGHT LEFT||RIGHT

 

0 0 0 0

0 1 0 1

1 0 0 1

1 1 1 1
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coordinate, the conditional operator returns the value of the red channel. If the current 
pixel has an even horizontal coordinate, the conditional operator returns the value of the 
green channel.

 

O

 

Bitwise operators directly manipulate the bits in a value. The bitwise operators include 
&, |, ^, ~, <<, and >>. You place the &, |, and ^ operators between two expressions. The 
& operator performs a logical-and operation on the corresponding bits of the evaluated 
expressions; the | operator performs a logical-or; and the ^ operator performs a logical-
exclusive-or. The ~ operator takes only one expression, and it performs a logical-not on 
each bit of the evaluated expression.

The << and >> expressions are placed between two expressions. Both operators shift the 
bits in the left expression’s evaluation by some number, which is specified by the right 
expression’s evaluation. The << operator shifts bits to the left. The >> operator shifts bits 
to the right.

 

PROVIDING USER-CONTROLLED SLIDERS

 

When you create a transition or filter, you can provide up to eight slider controls for the 
user to adjust when applying the effect. Slider values can range from 0 to 255. You set up 
the effect’s sliders by using the ctl (control), val (value), and map (mapping) functions in 
your expressions. 

If you use the these functions to retrieve slider information, you should set up the Slider 
or Map options in the Transition Factory’s or Filter Factory’s Build Custom dialog box. For 
information on using the Build Custom Transition dialog box, see “Creating Custom 
Transitions” on page 140. For information on using the Build Custom Filter dialog box, 
see “Creating Custom Filters” on page 169. 

 

O

 

The ctl function retrieves the specified sliders current value. This function requires one 
argument: the slider control index, which is a number between 0 and 7. For example, the 
expression ctl(0) evaluates the current value of the first slider. 

 

O

 

The val function converts the range of possible slider values (always 0 to 255) into a 
range that you specify. For example, to get a value between 1 and 100 from a slider, you 
would use the expression val(0,1,100). If slider 0 is set to 0, the slider value evaluates to 0. 
If slider 0 is set to 255, the slider value evaluates to 100. Slider values between 0 and 255 
are converted into values between 1 and 100.
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O

 

The map function groups the sliders into pairs. Each even/odd slider pair sets the values 
in a table, which is accessed by the map function. There are four mapping tables—one for 
each slider pair. Sliders 0 and 1 set the values for mapping table 0; sliders 2 and 3 set the 
values for mapping table 1, and so on. Each table contains 256 entries, which are calculated 
each time the slider values change.

The map function takes two arguments: the table index and the item index. For example, 
the expression map(1,20) returns item 20 from table 1. The table index must be between 
0 and 3. The item index must be between 0 and 255, inclusive.

 

EXAMPLES

 

This section provides several examples of using expressions to achieve a result. The exam-
ples are presented in the order of their complexity. The Adobe Premiere program also 
provides some sample transition and filter expressions. These samples have been saved as 
text files and are located in a folder in your Adobe Premiere folder. You can use the Tran-
sition Factory or Filter Factory to load a sample file and observe its effect.

 

Affecting a single channel (filter)

 

To make an image more red, you could use the following expressions:

A: 0
R: r+100
G: g
B: b

The first expression evaluates the red channel of each pixel and adds 100 to each one. The 
next two expressions evaluate the other two channels and leave them unchanged.

 

Affecting channels using sliders (filter)

 

To add a user-controlled slider value to the current channel values, you could use the 
following expressions:

A: 0
R: r+ctl(0)
G: g+ctl(1)
B: b+ctl(2)

The first expression evaluates the red channel of each pixel and adds the value of slider 0 
to each one. The next two expressions do the same thing to the green and blue channels, 
using the values of slider 1 and slider 2, respectively.
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Adding noise to channels using slider and random values (filter)

 

To use slider values to determine the range of random numbers, you could use the 
following expressions:

A: 0
R: r+rnd(–ctl(0),ctl(0))
G: g+rnd(–ctl(1),ctl(1))
B: b+rnd(–ctl(2),ctl(2))

The filter defined by these expressions adds noise to all three channels. The amount of 
noise in each channel is determined by the slider controls. The first expression evaluates 
the slider setting from slider 0. This value is used as the argument for the rnd function. If 
the slider setting is 0, the rnd function evaluates to 0. If the slider setting is 100, the rnd 
function can return any number between –100 and 100, inclusive. The result of the rnd 
function is then added to the current value of the red channel. As the slider setting is raised 
from 0 to 255, the random numbers are selected from a wider and wider range, resulting 
in more and more noise being added to the red channel. 

The next two expressions perform the same operation on the green and blue channel, 
using sliders 1 and 2 for input, respectively. 

 

Amplifying or toning down channels (filter)

 

To amplify or tone down a channel based on the values of a different channel, you could 
use the following expressions:

A: 0
R: (b>100)?r+50:r–50
G: g
B: b

The first expression evaluates the blue channel to determine if it is greater than 100. If it is 
greater than 100, the entire expression evaluates to the red channel value plus 50. If it not 
greater than 100, the expression evaluates to the red channel value minus 50. The other 
two expressions do nothing. Therefore, this filter amplifies the red channel if there is more 
blue than you want, or it tones down the red channel if there is less blue than you want.

You could also use slider values in a similar type of filter, as follows:

A: 0
R: (b>ctl(0))?r+ctl(1):r–ctl(1)
G: g
B: (b>ctl(0)?b–ctl(1):b+ctl(1)
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The first expression uses the setting from slider 0 as a “cutoff” value. If the blue channel is 
greater than the cutoff value, the red channel is amplified by the value of slider 1. If the 
blue channel is less than the cutoff value, the red channel is toned down by the value of 
slider 1. The third expression is the opposite of the first one, but it works on the blue 
channel instead of the red channel. The effect is that anything that is added to the red 
channel is subtracted from the blue channel, and vice versa. 

 

Dissolving between two images (transition)

 

To create a simple cross dissolve between the first clip and the second clip, you could use 
the following expressions:

A: mix(c1,c0,t,total)
R: mix(c1,c0,t,total)
G: mix(c1,c0,t,total)
B: mix(c1,c0,t,total)

The first expression combines the current value of the alpha channel in the first clip with 
the current value of the alpha channel in the second clip by using the fraction 
time/total time. The remaining three expressions do the same thing for the current values 
of the R, G, and B channels.

 

Averaging the channel values of neighboring pixels (filter)

 

You can use the src (source) function to retrieve the channel values from neighboring 
pixels and average them together, as follows:

A: 0
R: (src(x–1,y,0)+src(x,y,0)+src(x+1,y,0))/3
G: (src(x–1,y,1)+src(x,y,1)+src(x+1,y,1))/3
B: (src(x–1,y,2)+src(x,y,2)+src(x+1,y,2))/3

The first expression uses the src function to retrieve the red channel value for three 
different pixels: the pixel to the left of the current pixel, the current pixel, and the pixel to 
the right of the current pixel. These three values are added together and then divided by 3. 
The next two expressions do the same thing using the green and blue channels, respec-
tively. 
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Pushing the second image into the first image (transition)

 

To create a transition that would “push” the second image into the first image from left to 
right, you could use the following expressions:

A: 0
R: x*1024/xmax<t*1024/total?src0(xmax+x–t*xmax/total,y,p):src1(x–t*xmax/total,y,p)
G: x*1024/xmax<t*1024/total?src0(xmax+x–t*xmax/total,y,p):src1(x–t*xmax/total,y,p)
B: x*1024/xmax<t*1024/total?src0(xmax+x–t*xmax/total,y,p):src1(x–t*xmax/total,y,p)

In each of these expressions, the comparison before the question mark determines from 
which image to sample pixels. The next two expressions within the expression select 
the correct pixel for each image based on the percentage of the time that has passed for 
the clip.

 

EXPRESSION REFERENCE

 

This section provides a summary of all operator, variables, and functions that you can use 
in Transition Factory and Filter Factory expressions. 

 

Operators

 

You can use the following operators in your expressions. The operators are presented in 
their order of precedence. Precedence determines which operators are evaluated first 
within an expression when the order of evaluation is ambiguous. For example, in the 
expression 2+3*4, the * operator is evaluated first because it has higher precedence than 
the + operator.

 

OPERATORS DEFINITIONS

 

!, ~ Logical not, bitwise not

+, – Add, subtract

*, /, % Multiply, divide, modulo

<<, >> Shift left, shift right

<, <=, >, >= Less than, less than or equal to, greater than, greater than or equal to

==, != Equal to, not equal to

&, ^, | Bitwise and, bitwise exclusive or, bitwise or

&&, || Logical and, logical or

?: Conditional
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O

 

The arithmetic operators +, –, *, /, and % operate on signed, long integers that are 32 
bits wide.

 

O

 

The logical operators &&, ||, and ! treat all expressions as either true or false. Any value 
other than 0 is considered true, and only a 0 value is considered false.

 

O

 

The shifting operators (<< and >>) perform logical, not arithmetic, shifts so the sign of 
the shifted operand is not preserved.

 

Variables

 

You can use the following variables in your expressions. When creating a transition, 
append a 0 to variables describing values for the clip that plays first (such as x0 for the 
horizontal coordinate of the current pixel in the first image). Append a 1 to variables 
describing values for the clip that plays second (such as x1 for the horizontal coordinate of 
the current pixel in the second image).

 

VARIABLES DEFINITIONS

 

r, g, b Red, green, and blue channel values for the current pixel

a Alpha channel value for the current pixel

c Value of the current channel, whichever channel the expression is defining

i, u, v Calculated channel values for the current pixel in YUV space

x, y Coordinates of the current pixel

p Channel index for the current expression

d Direction (angle) of the current pixel from the center of the image, where d is an 
integer between 0 and 1024, inclusive

m Distance (magnitude) from the center of the image to the current pixel

t Current time

total Maximum time

xmin, xmax Range of horizontal coordinates over the width of the image

ymin, ymax Range of vertical coordinates over the height of the image

pmin, pmax Range of channel indexes within one pixel

dmin, dmax Range of angles within the image, where dmin is always 0 and dmax is always 1024

mmin, mmax Range of magnitudes with the image, where mmin is always 0 and mmax is always one
half the diagonal size of the image
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O

 

The 

 

i

 

, 

 

u

 

, and 

 

v

 

 variables do not exist in an RGB image, so they are calculated from the 
RGB channels. Because this calculation takes some time, using these variables is slower 
than using the 

 

r

 

, 

 

g

 

, and 

 

b

 

 variables. The following formulas are used to convert from RGB 
to YUV: 

i=((76*r)+(150*g)+(29*b))/256
u=((–19*r)+(–37*g)+(56*b))/256
v=((78*r)+(–65*g)+(–13*b))/256

 

O

 

The 

 

xmin

 

 and 

 

xmax

 

 variables return the range of possible values for the 

 

x

 

 variable. The 

 

ymin

 

 and 

 

ymax

 

 variables return the range of possible values for the 

 

y

 

 variable. The 

 

pmin

 

 
and 

 

pmax

 

 variables return the range of possible values for the 

 

p

 

 variable. These ranges are 
closed on the minimum and open on the maximum: xmin<=x<xmax, ymin<=y<ymax, 
and pmin<=p<pmax.

 

Functions

 

You can use the following functions in your expressions. Many functions place restrictions 
on the possible values of their arguments. If an argument is out of range, the expression 
will return a 0. For example, the expression ctl(8) evaluates to 0 because the ctl function 
requires an argument between 0 and 7.

When creating a transition, append a 0 to source functions (src, cnv, and rad) describing 
values for the clip that plays first. (For example, the expression src0(10,20,0) evaluates to 
the red channel value for the pixel at coordinates (10,20) in the first image.) Append a 1 to 
source functions describing values for the clip that plays second. (For example, the expres-
sion src1(10,20,0) evaluates to the red channel value for the pixel at coordinates (10,20) in 
the second image.) 

 

FUNCTIONS DEFINITIONS

 

src(x,y,p) Channel p for the pixel at coordinates x,y

cnv(...) Convolution of neighboring channel values

rad(d,m,p) Channel value of pixel p in the source image, which is m units away,
at an angle of d, from the center of the image

ctl(i) Value of slider i, where i is an integer between 0 and 7, inclusive

val(i,a,b) Value of slider i, mapped onto the range a to b

map(i,n) Item n from mapping table i, where i is an integer between 0 and 3,
inclusive, and n is and integer between 0 and 255, inclusive

min(a,b) Lesser of a and b

max(a,b) Greater of a and b
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O

 

The src (source) function is slow compared to the other operators and functions. Several 
evaluations of the src function in one expression can noticeably slow down the processing 
of an image. The coordinates passed to the src function should be within the ranges spec-
ified by the xmin,ymin and xmax,ymax variables; otherwise, the coordinates will be 
pinned.

 

O

 

The cnv (convolution) function retrieves the channel values of the pixel adjacent to the 
current pixel and scales them by the arguments. The adjacent pixels are determined by a 
3-pixel by 3-pixel grid with the current pixel in the center. The first nine arguments to the 
cnv function correspond to the channel values of these nine pixels. 

 

abs(a) Absolute value of a

add(a,b,c) Sum of a and b, or c, whichever is greater

sub(a,b,c) Difference of a and b, or c, whichever is greater

dif(a,b) Absolute value of the difference of a and b

rnd(a,b) Random number between a and b, inclusive

mix(a,b,n,d) Mixture of a and b by fraction n/d

scl(a,il,ih,ol,oh) Scale a from input range (il to ih) to output range (ol to oh)

sqr(x) Square root of x

sin(x) Sine of x, where x is an integer between 0 and 1024, inclusive

cos(x) Cosine of x, where x is an integer between 0 and 1024, inclusive

tan(x) Tangent of x, where x is an integer between 0 and 1024, inclusive

r2x(d,m) x displacement of the pixel m units away, at an angle of d, 
from an arbitrary center

r2y(d,m) y displacement of the pixel m units away, at an angle of d, 
from an arbitrary center

c2d(x,y) Angle displacement of the pixel at coordinates x,y

c2m(x,y) Magnitude displacement of the pixel at coordinates x,y

 

FUNCTIONS DEFINITIONS
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The cnv function multiplies each channel value by its corresponding argument, adds the 
products together, and divides the result by the tenth argument in the list. For example, 
the expression cnv(–1,–2,–1,–2,16,–2,–1,–2,–1,4) scales the channel values as follows:

The channel values of the current pixel, in the center of the grid, are scaled by 16; the 
channel values of the pixels directly above, below, to the left, and to the right of the current 
pixel are scaled by –2; and so on. All of these products are then added together, and the 
result is divided by 4. The effect of this expression is to sharpen the images channel values.

 

O

 

The val (value) function converts the requested slider setting into a value in the 
requested range. The slider setting is multiplied by the size of the range (b–a) and offset 
by the start of the range (a). This function is useful when the range returned by the sliders 
(always 0 to 255, inclusive) does not match the range of values you want to use. For 
example, if the requested range is 1 to 10, a slider setting of 0 returns a value of 1, a setting 
of 255 returns a value of 10, and a setting of 127 returns a value of 5. 

The start of the requested range does not have to be less than the end of the range. For 
example, the expression val(0,10,–10) returns values between 10 and –10.

 

O

 

The map (mapping) function uses tables that are constructed according to the slider 
settings. Each table uses a pair of sliders: table n uses sliders 2n and 2n+1 for the high and 
low values, respectively. The table is constructed as follows, where L is the value of the low 
slider, H is the value of the high slider, and I is an entry: if I<=L, use 0; if I>=H, use 255; 
if L<I<H, use (I–L)*255/(H–L).

 

O

 

The rnd (random) function returns a different random number each time it is called, 
but the entire function resets each time an image is processed. As a result, a transition or 
filter that uses the rnd function will have the same effect each time it is used on the same 
image. 

 

O

 

The mix (mixture) function combines the two input values using the specified fraction. 
A fraction of 1/2 returns the average of the two input values. A fraction close to 1 returns 
the first input value, and a fraction close to 0 returns the second input value. The mix func-
tion is defined as a*n/d+b*(d–n)/d.

 

-1 -2 -1

-2 16 -2

-1 -2 -1
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O

 

The scl (scale) function maps a value from an input range onto an output range. For 
example, an input range of 0 to 255 could be mapped onto an output range of –100 to 100 
by the expression scl(c,0,255,–100,100). In this example, channel values close to 0 are 
mapped starting at –100, and channel values close to 255 are mapped up to 100.

 

O

 

The r2x and r2y functions convert radial expressions to cartesian expressions. The c2d 
and c2m functions convert cartesian expressions to radial expressions. 
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Index

 

A

 

bort on Dropped Frames option 
(capturing) 240

Activate Recording Deck option 
(Print to Video) 225

Add Color Matte command 106

Add Folder command 49

Add This Clip command 35

Add/Delete Tracks command 52

Adobe Illustrator files

alpha channels in 185

creating rolling credits from 293

importing 37, 38

rasterizing 294

Adobe Photoshop 300

alpha channels 186

editing filmstrips in 109, 271

exporting clips to 107

file format 36

filters, changing over time 149

Plug-Ins folder 146

resizing still images 39

AIFF Audio File command 109

AIFF audio files

capturing 246

exporting clips as 109

importing 36

alias, name 40

Align Transitions command 138

aligning

clips in Construction window 75–
79

transitions 138

Alpha Channel key type 185

alpha channels

gradation in 186

in Adobe Illustrator files 185

in Adobe Photoshop files 186

in motion settings 177

 

Alpha: Create New option (motion 
settings) 177

Alpha: Use Clip's option (motion 
settings) 177

animated type 205–207

adjusting size 207

Multiple Master fonts 205

previewing 207

TrueType fonts 205

animation

compatible clip formats 36

creating from graphics 285

safe areas, NTSC video 129

stop-frame 257

superimposing over movie clips 
285

Animation compressor 217

Animation Settings dialog box 206

Anti-alias filter 150

anti-aliasing

in superimposed clips 191

in transitions 138

Anti-aliasing selector (transitions) 
137

Apple color picker, using 145

Arrange Layouts command 68

aspect ratio

locking 39

previews 128

setting output size for movies 212

Attach Settings command 252

audio

adjusting gain 101, 103

adjusting volume 101

amplifying weak sounds 166

bit depth 301

capturing 231, 235, 244–254

converting CD-audio files 247

 

deleting from linked clip 54

digitizing 301

disabling for previewing or 
compiling 58

echo effect, creating 166

exporting as AIFF files 109

filters 166

importing clips 36

in EDLs 117

isolating tracks to specific channels 
166

linked clips and 270

linked to video 54, 72

mapping 118

MIDI device triggering 230

mixing 101–103

multicamera editing and 289

muting in Clip window 74

output options 211, 214

output sampling rate 214

playing backwards 166

playing in Clip window 72

preferences 57

previewing modes 132

previewing options 129

sampling rate 301

setting in points in clips 81

split editing 270

synchronized to movie frame rate 
72

tracks, viewing additional 52

viewing waveforms 57, 74

Audio Capture command 246

Audio Fade control (Construction 
window) 101

audio filters 166. 

 

See also individual 
filter names

 

Audio Mapping command 118
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Audio preferences 57

Audio Recorder window 246

audio tracks 52

audio. See also capturing audio

Auto Save preference 30

 

B

 

B

 

ackdrops 106

adding color to 107

exporting frames as 107

backgrounds

color in Title window 198

mattes 106, 193, 263

superimposing clips over textured 
266

superimposing figures over 267

Backwards filter

audio 166

video 150

batch capturing 250–254

assigning settings in clips for 252

changing parameters for 252

creating handles for 253

redigitizing clips 44

timecode log for 251

using batch lists 253

batch compiling 222

Batch List window 45, 251, 253

adding comments in 252

Batch Movie Maker command 222

Beep When Finished option (Project 
Output) 209

Bend filter 151

bit depth, audio 235, 245, 301

Black & White filter 151, 265

Black Alpha Matte key type 186

Blank Screen option (Print to Video) 
224

block select tool (Construction 
window) 59, 92, 104

Blocks option, audio output 214

Blue Screen key type 189

Blur filter 151

 

Blur More filter 151

blurring images 151, 162

Boost filter 166

borders, around insets 261

Break Link command 100

Brightness/Contrast filter 151

Bring to Front command 205

Burn Time Code filter 151

burned-in timecode 254

capturing 255

 

C

 

c

 

2d/c2m functions 315

calibrating timecode 256

Camcorder filter 152

Camera Blur filter 152

capture boards. 

 

See 

 

video capture 
boards

capturing audio 244, 301

AIFF input options 246

bit depth 235, 245

compression 245

gain control 246, 247

guidelines for 235

hardware requirements 231

input options 244

sampling rate 235, 245

saving settings 254

Video Off command 247

capturing video 297, 299

Batch List window 251

batch, with device control 250–254

compression 234, 243

cropping 244

frame rate 243

full-screen 235

guidelines for 232–235

hardware requirements for 231, 
233

input options for 241

memory requirements 234

nonreal-time 235, 248, 250

previewing during 238

 

real-time 235, 238

recording options 239

scratch disk 234

signal calibration 236

single-frame 257

slow-motion 250

Sound Off command 247

stop-motion 257

timecode logging 251

to hard disk 234

to RAM 234, 240

with device control 241, 247–254

with timecode 254–257

without device control 238–247

CD-ROM

compression for 221

making movies for 221

Center Horizontally command 202, 
205

Center Vertically command 202, 205

Chroma key type 184, 191, 267

Cinepak compressor 217, 222

Clip Capture Parameters dialog box 
252

Clip filter 152

Clip Logging command 251

Clip window 33, 71–75

audio waveforms, viewing 74

backdrops in 107

collapsing 72

described 72

Duration button, still-images 89

duration counter 79

Frame Forward/Backward buttons 
81

frame numbering format, changing 
74

Goto button 81

In button 80

Jog control 73

muting audio 74

opening clips in 72
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opening only audio portions of 
linked clips 72

Out button 80

Play button 73

playing clips in 72

printing 69

resizing 74

scrubbing in 73

Shuttle control 73

Stop button 73

trimming clips in 79

Clip Window Options command 73, 
74

clips

adding to project 33

adjusting volume of 101–103

aligning 75–79

animation 36

assembling in Construction 
window 53

backgrounds and backdrops 106

compatible formats 36

converting color to grayscale 265

copying blocks of 92

correcting frame rate errors in 39

creating miniatures of 43

defined 3

deleting from Construction 
window 58

deleting from Project window 49

deleting space between 64

deleting unused 41, 50

disabling in Construction window 
58

displaying in Construction window 
54

displaying in Project window 47

duration, changing 79–89

duration, viewing 47

exporting 107–111, 271

fade control of superimpositions 
191

field processing for 213

 

filmstrips 108

finding in and out points in 81

finding in other windows 40

finding in Project window 50

folders of in Project window 49

freeze-frame 99, 213

importing 33–34

importing from Adobe Photoshop 
111

in and out points, changing 79–89

information about, displaying 64

insert editing of 93–97

key types 183–191

L editing of 97

linked 54, 81

linked, separating and rejoining 99

low-resolution, using 44, 291

masking 185, 265, 274

mixing audio 101–103

motion settings for 171–178

moving blocks of 92

multicamera editing 289

opening in Clip window 35, 72

overlaying at edit line 94

pasting 89–91

pasting attributes 91

playing backwards 98

playing in Clip window 72

pointers to source files 27

positioning in Construction 
window 63

previewing 121–127

redigitizing 44

renaming 40

resizing 39, 163

scaling 163

setting place markers in 75–79

slow-motion 98

Snap to Edges option 63

soft links 100

speed, changing 98, 213

split editing 270

 

splitting 91

storing in a library 42

superimposing 179–193

timecode for 119

title, creating 193–207

trimmed copies, creating 31

trimming 79–89

viewing in Clip window 72

viewing specific frames 122

virtual 103–106, 276

clips, effects in

blurring 157, 162

brightness, adjusting 151, 159

colors

changing to black and white 153

changing to shades of gray 151

replacing 153

contrast, adjusting 151, 159

cropping pixels 152, 155

darkening 156

distortion, along a curve 163

distortion, creating progressive 160

examples 167

flat areas, creating 162

flipping 157, 164

grayscale masks, extracting from 
155

halo 164

halting 162

lightening 156

mosaic pattern 155

noise 164

outlining edges 156

playing backwards 150

replicating 163

resizing 157

ripple patterns 163

rolling 163

sharpening 157, 163

tiling 164

tinting 164

trimming pixels 152
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trimming pixels from edges 155

twirling 164

clips. 

 

See also 

 

source files

cnv (convolution) function 313

CODECS 215

Color Balance filter 153

Color Bars option (Print to Video) 
224

color mattes, background 106

Color Offset filter 153

Color Pass filter 153

color pickers, using 143

Color Replace filter 153

color swatches (Title window) 194, 
202, 203

colors

adding to backdrop images 107

background for titles 198

breaking into dots 162

changing

to black and white 153

to opposite 159

to shades of gray 151

converting to grayscale 265

eliminating noise around 
transitions between 151

keying out 268

making transparent 191

NTSC-safe 144

pixel depth for compression 219

replacing 153

RGB format and channel values for 
302

selecting using color pickers 143

shifting channels 153

smoothing 150

tinting clips 164

Commands Editor 67

Commands palette 66

Commands preferences 67

Comment box

in Project window 47

 

compiling movies 208–216

batch compiling 222

disabling clips for 58

sequencing 225

compiling movies. 

 

See also 

 

Project 
Output Options dialog box; 
Compression Settings dialog box

compiling previews 121, 123

composite movie 225

compression 215–218, 300

CODECS 215

during capture 234, 243, 245

during QuickTime Composite 
movie making 211

frame differencing 217

hardware vs. software 215

lossless/lossy 216

motion settings 220

options 215–221

Quality setting 220

spatial/temporal 217

Compression command 219

Compression Settings dialog box 209, 
219

compressors

Apple Animation 217

Apple Cinepak 211, 217, 221, 222

Apple Graphics 218

Apple None 218, 234

Apple Photo (JPEG) 218

Apple Video 217, 218

third-party 215

Conform Movie command 39

Conform Movie To option 
(capturing) 241

Construction window 7, 51–58

assembling clips in 53

Audio Fade control 101

audio, viewing in 57

block select tool 92, 104

changing display of 54

deleting clips from 58

 

deleting empty space from 64

described 51

disabling clips in 58

edge viewing 82

edit line, inserting clips at 95

fade adjustment tool 102, 192

fade scissors tool 103, 192

frame numbering format, changing 
55

gray bar above time ruler 131

in point tool 82

link override tool 101

out point tool 82

playback head 95

positioning clips in 63

previewing contents of 126

printing 69

razor tool 92

ripple edit tool 83

rolling edit tool 83

scrolling in 51

scrubbing in 122

Snap to Edges option 75

snap tool 63, 76

soft link tool 100

superimpose (S) track 179

thumbnails, changing number of 
55

time ruler 62

time unit, changing in 55

tools 59

tracks

adding and deleting 52

illustrated 51

locking 97

trimming clips in 81

viewing entire project in 57

virtual clips in 105

waveforms, viewing in 57

work area bar 123

Construction Window Options 
command 55, 75, 78
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Controller window

previewing with 122

setting markers with 77

Convert to Filled command 200

Convert to Framed command 200

Convolution Kernel filter 154

copying clips 92

CPU, load and speed for capturing 
video 233

Create Filled Object command 200

Create Framed Object command 200

credits, rolling 293

Crop filter 155

cropping

during capture 244

pixels from edges of clips 152, 155

Crystallize filter 155

ctl (control) function 306, 307, 308

custom

filters 169–171

transitions 140–143, 264

 

D

 

D

 

arkening images 156

Data Rate option (compression) 221

Decode Burned-In Timecode option 
(capturing) 241

decoding video 298

Delay option (motion settings) 176

deleting

audio or video portion of linked 
clips 54

clips from Construction window 
58

clips from project 41, 49

folders from project 49

points on a movement path 173

space between clips 64

tracks 52

unused clips from project 50

device control

capturing timecode with 248, 255

capturing with 241, 247–254

 

capturing without 238–247

VISCA driver 248

Difference Matte key type 189

digitizing. 

 

See 

 

capturing audio; 
capturing video

disk space, saving 44

Distortion option (motion settings) 
176

distortion, creating progressive 160

dots, creating illusion of 162

Draft Mode check box (Title window) 
194

drop-frame timecode 299

dropped frames, during capture 240

Duration button (still-image Clip 
window) 89

duration counter (Clip window) 79

duration, clips

changing 79–89

displaying information about 65

measurement format 47

 

E

 

E

 

cho filter 166

Edge selector (transitions) 137

edge viewing 82

Edit Decision Lists 112–119

audio in 117

components of 115

generating 113

recording reel options 114

special effects in 116

time base and 113

Wipe Codes dialog box 116

edit line

inserting or overlaying clips at 94

previewing clips at 122

trimming clips at 86

editing clips. 

 

See 

 

clips

Effects to Disk previewing mode 129, 
130

Effects to RAM previewing mode 131

effects. 

 

See 

 

filters, superimposing 
clips, 

 

and 

 

transitions

 

Emboss filter 155

encoders 229

Export AIFF Audio File command 
109

Export FilmStrip File command 108

Export Frame as PICT command 108

Export Storyboard Image command 
112

Export to Text File command 251

exporting

audio clips 109

clips 107–111, 271

file lists 33

filmstrips 213

frames as backdrops 107

frames as storyboards 111

movies 230

expressions for custom transitions 
and filters 302–315

components of 303

examples of 307

function reference 312

operator reference 310

variable reference 311

Extract filter 155

eyedropper tool (Title window) 194

 

F

 

F

 

ade adjustment tool (Construction 
window) 59, 102, 192

fade control

adjusting for audio 101

adjusting in superimpositions 191

demonstrated 290

displaying information about 65

fade rate 290

fade scissors tool (Construction 
window) 59, 103, 192

fading to black 106

Field Interpolate filter 156

fields

changing clip speed and 98

freeze-frames and 99
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output options for video 212

processing for NTSC and PAL 
video 213

recreating missing 156

file lists, exporting 33

files

compatible formats 36–37

output options 211

files. 

 

See also 

 

source files

Fill Color option (motion settings) 
177

Fill Left/Fill Right filters 166

FilmStrip File command 108

filmstrips

creating movies from 111

editing in Adobe Photoshop 109

exporting 213

exporting clips as 108

importing 111

outputting movies as 212

rasterizing Adobe Illustrator files 
into 38

rotoscoping 271

film-style editing 83

Filter Factory 169–171

caution sign in 170

channels 169

expressions in 302–315

specifying sliders 170

tracking errors 170

filters 146–171

applying 146–149

applying to isolated areas of clips 
265

audio 166

changing over time (Adobe 
Photoshop) 149

changing over time (Adobe 
Premiere) 148

creating custom 169–171

described 150–166

editing custom 171

examples 167

 

expressions for creating custom 
302–315

in EDLs 116

intensifying effect of 148

order applied to clips 148

previewing 129, 130

removing 149

Settings area of dialog box 149

Settings dialog box 147

tools in Settings dialog box 148

viewing effects of in Preview 
window 147

virtual clips and 106

Filters command 147

filters. 

 

See also individual filter names

 

; 
clips, effects in

Find Clip command 41, 105

Find Edges filter 156

flattened movie 230

flipping images 157, 164

Folder Cleaner 41

Folder window 49

folders

deleting from Project window 49

importing 34

in the Project window 49

fonts, in animated type 205

Format option, audio output 214

Forward/Reverse selector 
(transitions) 137

Frame as Backdrop command 107

Frame as PICT command 108

Frame Back button (Clip window) 73, 
81

frame differencing 217

Frame Forward button (Clip 
window) 73, 81

Frame Hold command 99

frame indicator 71

frame numbering, changing format 
for 74

frame numbering, changing the 
format for 55

 

frame rate

achieving highest 216

achieving highest during capture 
234

correcting in clips 39

for capturing movies 243

for NTSC video 297

setting for movies 220

frame rate. 

 

See also 

 

time base

frames

capturing single 257

dropped during capture 240

exporting as backdrops 107

exporting as PICT images 108

exporting as storyboards 111

freezing 213

numbering format 74

numbering format, setting 55

painting on individual 271

rotoscoping 271

splitting clips at exact 91

trimming from clips 79–89

viewing 122

viewing specific in Clip window 74

freeze-frame

clips, creating 99

video, fields and 298

full-frame video, playing in real time 
215

full-screen video

capturing 235

outputting 215

functions (Transition Factory/Filter 
Factory)

c2d/c2m 315

cnv (convolution) 313

ctl (control) 306, 307, 308

for creating sliders 306

map (mapping) 307, 314

mix (mixture) 309, 314

r2x/r2y 315

rnd (random) 304, 308, 314
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scl (scale) 315

src (source) 304, 309, 310, 313

val (value) 306, 314

 

G

 

G

 

ain

adjusting for audio clips 101, 103

controlling during capture 246, 247

Gain command 103

Gamma Correction filter 156

garbage mattes 182, 263

Gaussian Blur filter 157

Gaussian Sharpen filter 157

General preferences

color pickers and 143

Jog/Shuttle control and 73

virtual clips and 104

Ghosting filter 157

Goto button (Clip window) 79, 81

Goto/Search command 50, 62

Grab Frames command 259

gradient controls (Title window) 194

Gradient Wipe transition 139

graphics

animating 285

creating in Title window 199–204

superimposing animated 285

Graphics compressor 218

grayscale images

adding color to 107

as backdrops 106

as gradient wipe transitions 139

exporting frames as 107

grayscale masks, extracting from clips 
155

Green Screen key type 189

 

H

 

H

 

alf-screen video, outputting 216

halo effect 164

hand tool (Construction window) 59

handles 253

around trimmed clips 32

 

hard disk

capturing video to 234

speed for capturing 233

hard-linked clips 100

hardware

compression 215

requirements for capture 231

hardware. 

 

See also 

 

video capture 
boards

height-to-width ratio. 

 

See 

 

aspect ratio

Horizontal Flip filter 157

Hue and Saturation filter 157

 

I

 

I

 

mage Matte key type 188, 265

Image Pan filter 157, 293

image resolution, defined 298

image size

achieving maximum during 
capture 232

setting 39

images. 

 

See 

 

clips, still-image clips

Import command 111

Import from Text File command 251

importing

clips 33

from Adobe Illustrator 37

from Adobe Photoshop 36, 111

filmstrips 111

projects 31

in point tool (Construction window) 
59, 82

in points

changing in linked clips 81

finding in clips 81

moving to in Clip window 73

setting in clips 79–88

Info window 64

input video signal, calibrating 236

Insert at Edit Line command 96

insert editing 93–97

insets

creating 261

 

transitions within 276

interlaced mode, video 298

Invert filter 159

 

J

 

J

 

L Cooper editing controller 74

Jog control (Clip window) 73

JPEG compression 218

 

K

 

K

 

erning tools (Title window) 194, 
201

Key Frame option (compression) 220

key frames 211, 220

key types

adjusting 190

Alpha Channel 185

Black Alpha Matte 186

Blue Screen 189

Chroma 184, 191

Difference Matte 189

Green Screen 189

Image Matte 188, 265

Luminance 185

Multiply 190

None 183

Non-Red 190

RGB Difference 184, 191

Screen 190

Track Matte 190

White Alpha Matte 187

keying. 

 

See 

 

superimposing clips

keys, in EDLs 116

 

L

 

L

 

 editing 97

Label boxes, in Project window 47

Layouts command 68

Lens Flare filter 159

Levels filter 159

levels, adjusting audio 101

Library window

changing the display of 43

locating clips in 42
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library, creating 42

lightening images 156

line tool (Title window) 194

Line Weight slider (Title window) 
194, 199

link override tool (Construction 
window) 59, 101

linked clips 54

breaking links 100

creating 100

cutting and pasting 101

deleting the audio or video portion 
54

disabling audio or video for 
previewing or compiling 58

hard links 100

opening only audio portion in Clip 
window 72

out of sync 101

releasing links temporarily 101

separating and rejoining 99

soft links 100

trimming 81

virtual clips 103–106

linking movies 225

locking tracks 97

Loop Playback option (Print to 
Video) 224

lossless/lossy compression 216

Luminance key type 185, 266

 

M

 

M

 

acintosh Quadra, software 
compression with 215

Maintain Aspect Ratio command 39

Make Movie dialog box 209

compression options 219

output options 209, 210

map (mapping) function 307, 314

markers. 

 

See 

 

place markers

masking

clips 185, 265

with Track Matte key 274

masks

 

extracting grayscale from clips 155

PICT mask transition 139

mattes

background 193

Black Alpha 186

color 193

color backgrounds 106

Difference 189

garbage 182, 263

Image 188

Track 190

traveling 190, 274

White Alpha 187

matting. 

 

See 

 

superimposing clips

memory, availability for capturing 
234

merging projects 31

Mesh Warp filter 160

MIDI device triggering 230

MIDI Setup preference 230

miniatures

creating 43

replacing 46

mix (mixture) function 309, 314

mixing audio clips 101–103

monitors, previewing on other 123

Mosaic filter 162

Motion command 171, 262

Motion option (motion settings) 176

motion settings 171–178

adjusting path 173, 262

animating graphics with 287

copying 173

defining path 171

deleting 178

deleting points on path 173

for compression 220

in EDLs 116

keeping clip stationary 262

loading 178

options 174–178

 

previewing 174

saving 178

selecting points on path 173

speed 174

superimposing 177

zooming effect, creating 276

Movie Analysis command 66

Movie Capture command 238, 244

for batch capture 251

Movie Capture window 248

Movie command 209

for previewing 127

movies

360-degree, creating 278

adding texture to 266

analyzing 66

batch compiling 222

capturing 231–259

compatible formats 36

compiling 208–216

compiling for CD-ROM 221

compositing 225

compressing 215–218

creating from filmstrips 111

defined 3

disabling clips when compiling 58

exporting 230

flattened 230

insets, creating 261

layering traveling mattes 274

linking 225–227

output options for 210–214

outputting to videotape 227

NTSC-compatible signals 228

planning 27

playing

in center of screen 223

NTSC-compatible signals 229

previewing Construction window 
contents 126

setting frame rate 220

split-screen, creating 263
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superimposing over textured 
backgrounds 266

Three-D, creating 153

videotaping, NTSC-compatible 
signals 229

moving clips 92

multicamera editing 289

Multiple Master fonts, for animated 
type 205

Multiply key type 190, 280

multitrack tool (Construction 
window) 59, 64

 

N

 

N

 

ame Alias command 40

nondrop-frame

numbering format 55, 74

timecode 299

None key type 183

noninterleaved mode, video 298

Non-Red key type 190

NTSC monitor, previewing on 123, 
125

NTSC video

encoders 229

field processing for 213

outputting a movie to videotape 
228

signals 229

signals and digitizing 297, 299

title and animation safe areas for 
129

type matching for previewing 129

NTSC-safe colors 144

numbered PICT files

file-type output option 212

opening 38

 

O

 

O

 

bjects, creating in Title window 
199–204

off-line editing 112

onion skinning 259

online editing 112

 

Opacity sliders (Title window) 194, 
202, 204

Open Clip command 72

Open command 35

Open Finished Movie option (Project 
Output) 209

out point tool (Construction 
window) 59, 82

out points

changing in linked clips 81

finding in clips 81

moving to in Clip window 73

setting in clips 79–89

output options. 

 

See 

 

Project Output 
Options dialog box

oval tool (Title window) 194

Overlay at Edit Line command 96

overlaying clips 94

 

P

 

P

 

AL monitor, previewing on 123

PAL video

field processing for 213

signals and digitizing 299

type matching for previewing 129

panning, creating effect of 157

Paste Special command 89, 90, 91

applying filters with 146

Paste to Fit command 89

replacing transitions with 134

Phase Alternating Line (PAL) signals 
299

Photo compressor 218

PICS files, creating 36

PICT files

creating 36

exporting frames as 108

exporting storyboards as 111

importing 33

numbered, opening 38

outputting movies as 212

printing 112

PICT Mask transition 139

 

Pinch filter 162

pixels

changing brightness values of 154

channel values for 302

increasing contrast in adjacent 163

trimming from edges of clips 152, 
155

place markers

aligning in Construction window 
78

deleting from clips 79

deleting from time ruler 77

finding 79

moving to in Clip window 73

setting in clips 75–79

setting in time ruler 76

setting while previewing 77

Show Markers option 78

Snap to Edges and 75

Play button (Clip window) 73

playback head (Construction 
window) 95

playback rate. 

 

See 

 

frame rate

playing clips

backwards 98

in Clip window 72

playing movies 223–230

Plug-Ins folders 146

Pointillize filter 162

Polar filter 162

polygon tool (Title window) 194

Position in Lower Third command 
202, 205

Post-Compress Video option 
(capturing) 240

Posterize/Posterize Time filters 162

Preferences

Audio 57

Auto Save 30

Commands 67

Device Control 248
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General

color pickers, choosing 143

Jog/Shuttle control and 73

virtual clips and 104

MIDI Setup 230

Scratch Disks 130, 234

Still Image 39, 89

Virtual Clips 103, 105, 106

Premiere color picker, using 144

Pre-Roll Time option (capturing) 241

presets, loading and modifying 28

Preview command 124

preview files

creating 130

defined 121

finding 31

preview movies 127

Preview Options command 128

Preview window

changing display of 123

resizing 128

using with Controller 122

viewing Clip window contents in 
72

previewing 121–127

adjusting the work area bar 123

audio modes 132

compiled 121, 122, 123

Construction window contents 126

Controller, using 122

creating preview movies 127

disabling clips for 58

dragging in the time ruler 125, 126

filters 129

modes 129, 130–132

options for 127

processing resolution 129

temporary preview files 130

transitions and effects 122, 123, 125

uncompiled 121

while capturing 238

Print command 69

 

Print to Video command

outputting half-screen video 216

outputting to videotape 228

playing movies in center of screen 
223–230

playing sequences 226

previewing with 125, 126

printing

storyboards 112

window contents 69

Project Output Options dialog box 
210–214

audio options 211, 214

Beep When Finished option 209

Open Finished Movie option 209

output file types 211

video options 211, 212

Project Trimmer 32, 45

Project window 46–50

changing display of 47

Comment box 47

deleting clips and folders from 49

folders in 49

importing clips into 33

Label boxes 47

locating clips in 50

printing 69

selecting clips from 54

thumbnails in 47, 48

Project Window Options command 
48

projects

creating 28

defined 4

importing 31

merging 31

opening existing 30

presets 28

previewing 121–132

saving 30

trimming 31, 45

 

viewing entire in Construction 
window 57

 

Q

 

Q

 

uadra, Macintosh, software 
compression with 215

Quality slider (compression) 220

QuickTime Composite file type 211

QuickTime Movie option 211

QuickTime movies

analyzing 66

compiling 208–216

compiling for previewing 126

compressing 215

converting filmstrips into 111

opening Windows version 38

QuickTime movies. 

 

See also

 

 movies

 

R

 

r

 

2x/r2y functions 315

Radial Blur filter 162

RAM

capturing video to 234

loading audio blocks in 214

previewing to 128, 130, 131, 132

range select tool (Construction 
window) 59

rasterizing Adobe Illustrator files 37

Rate option

for audio output 214

for previewing video 129

razor tool (Construction window) 59, 
92

real-time video

capturing 235

outputting a movie in 227

outputting full-screen images in 
215

Record to RAM option (capturing) 
240

Recording Settings dialog box 239

recording. 

 

See 

 

capturing video; 
capturing audio; videotape

rectangle tool (Title window) 194

redigitizing clips 44
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Re-Find Files command 46

refraction, simulating 159

Remove Background Clip command 
259

Remove Settings command 252

Remove Unused command 50

renaming clips 40

Replace Work Area command 97

Replicate filter 163

Reset option (motion settings) 177

Resize filter 163

resizing clips 39

resolution

audio 301

defined 298

reverse, playing clips in 98, 150

RGB Difference key type 184, 191

RGB format, channel values for 302

RGB levels, controlling in clips 153

Ripple Delete command 58, 64

ripple edit tool (Construction 
window) 59, 83

ripple editing, in Trimming window 
87

Ripple filter 163

rnd (random) function 304, 308, 314

Roll filter 163

rolling credits, creating 293

rolling edit tool (Construction 
window) 59, 83

rolling editing, in Trimming window 
87

Rotation option (motion settings) 
175

rotoscoping filmstrips 271

rounded rectangle tool (Title 
window) 194

ruler. 

 

See 

 

time ruler

 

S

 

S

 

afe layers 103

sampling rate

audio 235, 245, 301

audio output options and 214

 

Save Settings command 254

saving projects 30

scaling images 157, 163

scanned images, converting to PICT 
files 36

scissors. 

 

See 

 

fade scissors tool

scl (scale) function 315

Scratch Disks preferences 130, 234

Screen key type 190

Screen Mode option (Print to Video) 
224

scrubbing

in Clip window 73

in Construction window 122

selecting

linked clips 64

multiple clips 64

selection tool

Construction window 59

Title window 194, 204

Send to Back command 205

Sequence window 225

Shadow command 203

Shadow Offset control (Title 
window) 194, 202

shadows

adjusting 269

creating in titles 202

Sharpen Edges filter 163

Sharpen filter 163

Sharpen More filter 163

Shear filter 163

Show All option (motion settings) 
177

Show Outlines option (motion 
settings) 178

Show Previous command 259

Shuttle control (Clip window) 73

single-frame video capture 257

Size command 201

Size option

capturing 240

 

video output 212

slow-motion video

capturing 250

creating 98

Smooth Motion option (motion 
settings) 177

Smooth Polygon command 200

SMPTE timecode 119, 298

in Clip window 47

separators in 63

setting as frame numbering format 
55, 74

SMPTE timecode. 

 

See also 

 

timecode

Snap to Edges option (Construction 
window) 63, 75, 76

snap tool (Construction window) 63, 
76

Snapshot command 124

snd resource format 37

Society of Motion Picture and 
Television Engineers. 

 

See 

 

SMPTE 
timecode

soft link tool (Construction window) 
59, 100

soft-linked clips 100

software compression 215, 217

Solarize filter 164

Sound Input dialog box 244

Sound Off command 247

Sound Settings dialog box 246

sound. 

 

See 

 

audio

source files 27

compatible formats 36

deleting 41

locating 30

making trimmed copies of 31

moving 30

Source Video window 237

spatial compression 217

Speaker On/Off option 245, 246

special effects. 

 

See 

 

transitions; filters; 
motion settings; superimposing clips

Speed command 98
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speed of clips

changing 98

displaying information about 64

field processing and 213

Spherize filter 164

split edit 270

split screens, creating 263

splitting clips 91

src (source) function 304, 309, 310, 
313

Still Image preferences 39, 89

still-image clips

backdrops and 106

backgrounds 267

compatible formats 36

creating from video 99

gradient wipe transitions and 139

PICT mask transitions and 139

setting duration for 89

setting image size for 39

size information for 47

Stop button (Clip window) 73

Stop Motion command 258

stop-frame animation 257

storage requirement, video 299

Storyboard Image command 112

storyboards

defined 27

exporting frames as 111

linking movies as 225

printing 112

window contents as 69

superimpose (S) track 179

viewing additional 52

superimposing clips 179–193

anti-aliasing 191

background mattes for 193

color mattes for 193

EDLs and 116

fade control and 191

over textured backgrounds 266

 

previewing and 130

titles and 187

superimposing isolated figures 267

superimposing titles 106

synchronizing video with audio 77

 

T

 

T

 

elevision 298. 

 

See also 

 

NTSC video

temporal compression 217

Text Animation command 206

text. 

 

See 

 

titles; Title window

texture

adding to movies 266

backdrops 106

Three-D effect, objects and text 164

Three-D movies, creating 153, 279

thumbnails

changing number of in 
Construction window 55

defined 27

in Project window 47, 48

virtual clips and 105

Tiles filter 164

time base 29

creating EDLs and 113

time base. 

 

See also 

 

frame rate

time ruler 7, 62

aligning clips to 64

deleting markers from 77

gray bar above 131

previewing by dragging through 
125

setting place markers in 76

time unit (Construction window)

changing 56

displayed in time ruler 62

selector 56

timecode

burned-in 241, 254

calibrating 256

capturing 254–257

capturing burned-in 255

described 298

 

logging for batch capture 251

making visible in clips 151

setting 119

visual 241, 254

window dubs 241, 254, 255

Timecode command 114, 119

Timecode Decoder option 
(capturing) 255

Timecode Offset option (capturing) 
241, 257

timecode. 

 

See also 

 

SMPTE timecode

time-lapse video capture 257

Tint filter 164

Title command 193

Title window 193

background color 198

color swatches 202, 203

creating graphics for animation in 
285

creating rolling credits with 293

creating type and objects in 199–
204

kerning tools 201

layered objects 205

moving objects 204

Opacity sliders 202, 204

options 198

selecting objects 204

Shadow Offset control 202

title area, setting up 197–198

tools, described 194

type tool 200

Title Window Options command 198

titles

creating 193–207

creating animated 205–207

safe areas for NTSC video 129

superimposing 187

superimposing over a solid 
background 106

tools

Construction window 59
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Title window 194

Track Matte key type 190, 275

Track selector (transitions) 137

track tool (Construction window) 59, 
64

tracks 51

adding and deleting 52

audio 52, 101

displaying 54

locking 97

safe layers for virtual clips 103

superimpose (S) 179

synchronizing using place markers 
77

transition (T) 134

video 52

viewing additional 52

Transition (T) track 134

Transition Factory 140–143

caution sign in 141

channels 141

expressions in 302–315

specifying sliders 142

tracking errors 141

Transition Settings command 135

Transition Settings dialog box 261

transitions 133–145

adding 134

aligning 138

Anti-aliasing selector 137

borders 136

custom, creating 140–143

customizing Adobe supplied 264

direction of, controlling 134, 137

duration of, setting 88

edge selector 137

editing custom 143

expressions for creating custom 
302–315

Forward/Reverse selector 137

gradient wipe 139

in EDLs 116

 

information about, displaying 64

nesting 276

orientation of, changing 137

PICT mask 139

playing forward or backward 137

previewing 123, 125, 130

replacing 134

settings, changing 135

smoothness of edges 137

starting and ending frames 135

starting positions 137

thumbnails 135

Track selector 137

virtual clips and 276

Transparency command 180

Transparency Settings dialog box 180, 
263, 265, 266, 275, 286

Blend slider 190

Color area 191

Cutoff slider 191, 269

Drop Shadow option 191

key color 268

key types 183–191

Mask Only option 191

Reverse Key option 185, 191, 275

sample area 180

Similarity slider 190, 268

Smoothing option 191, 268

Threshold slider 190, 269

tools in 181

transparent colors, selecting 191

traveling matte 190, 274

trimming

clips 79–89

pixels from edges of clips 152, 155

projects 31, 45

Trimming window 12, 86–88

resetting 86

ripple editing in 87

rolling editing in 87

splitting clips and 91

 

viewing frames in Preview window 
86

Trimming Window Options 
command 87

TrueType fonts, for animated type 
205

Truncate Movie command 259

Twirl filter 164

Type option, video output 212

type tool (Title window) 194, 200

type. 

 

See 

 

titles; Title window

 

U

 

U

 

se Reel Name and In Time options 
(capturing) 241

 

V

 

V

 

al (value) function 306, 314

VDIG system extension 231

Vector Scope 236

Vertical Flip filter 164

video

calibrating input signal 236

capturing 231–254

compression options 215

deleting from linked clip 54

disabling for previewing or 
compiling 58

freeze-frame 298

full-frame, playing in real time 215

full-screen, outputting 215

hardware requirements for 
recording 231

linked to audio 54, 270

NTSC signal 297

output options 211, 212

previewing modes 130

previewing options 129

real-time 215, 227

single-frame capture 257

stop-motion capture 257

video cameras, interpreting colors 
297

video capture boards

about 231
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capture quality and 233

capturing full-screen video and 235

producing NTSC-compatible 
signals and 229

selecting, video input options 241

video input options and 242

Video compressor 218

Video Input dialog box 241

Video Noise filter 164

Video Off command 247

video signal

decoding 298

outputting 300

storage requirement 299

video tracks 52

video-style editing 84

videotape

outputting movies to 227

transferring digital images to 300

virtual clips 103–106

applying filters to 106

creating 104

creating Three-D movies with 279

finding source of 105

safe layers 103

thumbnails 105

using to create transitions 276

viewing in Construction window 
105

Virtual Clips preferences 103, 105, 
106

VISCA driver 248

visual timecode 254

volume, adjusting 101–103

 

W

 

W

 

ave filter 164

Waveform Monitor 236

waveforms

displaying in Clip window 74

displaying in Construction window 
57

White Alpha Matte key type 187, 286

 

window dubs 254, 255

window layouts, saving 68

Wipe Codes dialog box 116

wipes, gradient transitions 139

work area bar

adjusting 123

previewing with 123

processing effects under for 
previewing 130

Project Output Options and 211

 

Y

 

Y

 

ellow bar (Construction window). 

 

See 

 

work area bar

 

Z

 

Z

 

ig Zag filter 166

Zoom option (motion settings) 175

Zoom Screen option (Print to Video) 
216, 224, 235

zoom tools (Construction window) 
59

zooming, creating effect of 157, 276
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